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INTRODUCTION

This document is for Consultant and State Employees responsible for working on Capital
Projects. This manual covers the preparation, review, and delivery of capital project documents
across the whole project timeline from project initiation to project completion. This manual also

covers design phase scheduling.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.

Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.

Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.

Transportation Supervising Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988
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DEFINITIONS

ACD — The attribute applied to a revision requested by the Processing unit to an ADP discipline
subset.

ACD2 — The attribute applied to a revision requested by the Processing unit to an ACD discipline
subset.

ADP — The attribute applied to an Addendum discipline subset.
ATLAS — This tool is used to manage the location of various assets, projects, and investigations.

Bluebeam — PDF software similar to Adobe Acrobat. Bluebeam software will be required to
package and markup all Shop Drawing Submittals.

CIM — Civil Integrated Management
CSI — Construction Special provisions Institute

DCD —The attribute applied to a revision requested by the Processing unit to an FDP discipline
subset.

DCD2 - The attribute applied to a revision requested by the Processing unit to a DCD discipline
subset.

Discipline Subset — A multi-page PDF document that includes all the contract plan sheets for a
discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF
document.

DCO —The attribute applied to a design initiated change order discipline subset.

DPD - Digital Project Development Manual.

EED — Electronic Engineering Data

Engineer of Record — The engineer’s digital signature that is applied to the discipline subsets.
For CTDOT staff this would be the Principal Engineer.

FDP —The attribute applied to a final design plans discipline subset.

FIO — The attribute applied to a “for information only” discipline subset.
FPL — The attribute applied to an advertised FDP discipline subset

0365 — Microsoft Office 365

Project Manager — Lead designer on the project. For CTDOT staff this would be the TE 3 or
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

ProjectWise - CTDOT is currently using Bentley’s ProjectWise as a data management software

for digital projects and asset document storage. ProjectWise allows the CTDOT, and authorized
business partners to access its data anywhere internet access is available.
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Set File — Is a consolidated viewer file that is created using Bluebeam. When this file is opened
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels in the
correct order.
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Section 1 Prerequisites and Policies

The following details various requirements and policies that need to be followed when working
on a Capital projects for the Connecticut Department of Transportation (CTDOT).
Software Requirements

1. Document Management Software — CTDOT currently uses Bentley’s ProjectWise for a
document management solution, but is transitioning to COMPASS/0365. See Section 2
for more information.

2. PDF Software — CTDOT has standardized on Bluebeam for our PDF software and shall be
the only PDF software supported by the Connecticut Department of Transportation for
the processes set forth in this manual.

a. Bluebeam Revu was used in the production of all figures and procedures in this
manual. A license of Bluebeam Revu version 16.5 or higher must be purchased
to perform all the procedures in this manual.

b. A CTDOT Bluebeam profile has been created that includes a standard set of
tools in the tool chest. This profile can be found in Appendix A of this manual.

Digital Signatures Requirements

1. All contract plans, working drawings, and applicable engineering reports submitted to
the Department shall be digitally signed by a CT licensed Engineer or CT licensed
Architect in accordance with this manual.

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be
digitally signed in conformance with this manual.

a. Digital signatures must meet the requirements of Adobe’s Certified Document
Services (CDS) or Adobe Approved Trusted List (AATL).

b. AATL and AATL vendor information is provided at the following website:
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html

c. Trial CDS/AATL Signatures will not be accepted by the Department, a signature
must be purchased from one of the CDS/AATL Vendors.

3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract
plans have been advertised, the digital signature is not allowed to be removed.

CAD Standards

1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here

CTDOT CAD Standards Website
Policies

1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using
the [Digital Submission Procedure set forth in this Manual] has the same force and
effect for the purposes of the Consulting Engineer’s agreement with the State as a
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an
authorization for, or endorsement of, the use of this [Digital Submission Procedure]
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed
Professional Engineer or Architect with respect to other work it performs for the State
or work it performs for other clients.

2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally
signed by CTDOT following the procedure in Section 5.6.1 of this manual.

3. When a document reaches a final status a “Final Status” shall be placed on the
document. This will lock for editing and ensure document retention.
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Section 2 Document Management Systems

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT
Capital Projects and CTDOT Assets. ProjectWise has the ability to store documents and
associated business data in one centralized location and allows the CTDOT, and its authorized
business partners access its data anywhere internet access is available. ProjectWise access is
available to all CTDOT employees, consultant engineers, contractors, municipalities, utility
companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.

CTDOT is also working to transition from ProjectWise to a new system called COMPASS. The
objective of COMPASS is to provide CTDOT with project management processes that work in
conjunction with a cloud-based digital Transportation Management Solution, utilizing Microsoft
Commercial Off-the-Shelf Software (MCOTS) to manage the delivery of all capital projects.
Specifically, this solution will provide improved quality and control over complex transportation
projects by providing:

e Submittal and Transmittal Ball-In-Court functionality

e Better collaboration and communication using SharePoint online

e Real-time project scheduling capabilities using integrated MS Project files

e Improved resource management

e Real-time project status dashboards

e Document control and content management

e Improved transparency and accountability

o Improved risk management

This manual will be updated as more functionality is transitioned from ProjectWise to COMPASS,
but to help in this transition period, the following table details what needs to be done in what

system.
Functionality System

Project Team Assignment COMPASS

Engineering Document Submittals ProjectWise

MS Project Engineering Schedules COMPASS

Design Reviews ProjectWise

FDP Submittal and any addenda ProjectWise

Design Initiated Change Order Submittals ProjectWise

Construction Submittals COMPASS

2.1 ProjectWise

The following form can be filled out to gain access to the CTDOT’s ProjectWise Site: ProjectWise
New User Form

Each users working at a consultant firm, contractor, municipality, utility company, and other
supporting agency is given a unique user name. If a person leaves a firm, it is the firm’s
responsibility to notify CTDOT so we can disable that person’s account.

The following links allow the user to change their password or reset the password if it is
forgotten or lost:
Change ProjectWise Password
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Forgot or Lost ProjectWise Password

There are two ways to access CTDOT’s ProjectWise site: Either ProjectWise Thin Client (Web
Version) or ProjectWise Explorer Client (thick client —installed software).

ProjectWise Thin Client

Thin client is a web based version of ProjectWise, which does not require any software
installation. All that is required to access ProjectWise over the web is a user name and
password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere
internet access is available. To use Thin Client, follow this document for the initial setup. This
only needs to be done once: Thin Client First Time Set Up

After the above settings document has been followed, use this link to access ProjectWise Thin
Client: https://ctdot.projectwiseonline.com

ProjectWise Thick Client
The thick client conversely requires the installation of the ProjectWise client software. In
addition to performing all the functions of thin client; thick client has the addition functionality:

- Deltafile transfer — Improves speed of downloads
- Managed workspaces — Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Download ProjectWise Explorer Client from Bentley using your select ID. Once ProjectWise is
installed on your computer use this document to connect to the data source:

Connecting to Data source Using Thick Client

ProjectWise Apps

Users can also get to CTDOT’s ProjectWise data source using the various applications. These
applications require a URL to connect to a ProjectWise data source. The table below lists the
server URL for each application:

Applications URL
ProjectWise ctdot-ws.projectwiseonline.com/pwmobileaccess
WorkSite https://Ctdot-ws.projectwiseonline.com/ws
ProjectWise Edge

Access in ProjectWise
Access to content in ProjectWise is set at the folder level based on the group a userisin. The
following details, at a high level, the access for the various groups. Section 2.3 of this document
provides more information for the folders mentioned below:
e CTDOT Employees - Access to all projects and all asset content.
e Consultants and CE & | Firms
o Active Projects — Can only access projects that the firm is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — Access for asset content if firm is pre-qualified to work on that asset
based on CTDOT’s pre-qualified consultant lists.
e Contractors
o No Access to ProjectWise
e Municipalities
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o Active Projects — Can only access projects in their town.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.
e  Utility Companies
o Active Projects — Can only access projects that a firm is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.
e Other Supporting Agencies
o Active Projects — Can only access projects that an agency is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.

Setting Documents to Final Status in ProjectWise

Once a document has reached it final status, where no more editing is required and it is ready
for permanent storage a final status will be applied to the document as shown below:
1. Right click on the file and select Change State>Set Final Status.

Lebel (User Defined)

Description
173-464_90%_TR_Review_TR_Final 0173-0464
e 90% Design Review Request
New »
beam end repair bearing replacement
Open ject Schedule

Open as Read-Only
Open With..
Markup

View

Check Out

. _ . CheckIn
Right Click on the file free
and select Change

State>Set Final Status

Delete

DMsconform »
Modify...
Modify Spatial Attributes.
Enter filter here Add Comment q
€5 ADMINISTR!

Set

RR[RF X

o
S

-

Send To v =
=

=

Copy List To »

Change State »)

Batch Print &
Properties...
Set Final Status
Change filename to CT_Code Sa— e
Edit attributes for multiple documents
i E F F F =

Figure 1 - Set Final Status

21 F
EER e Eikoie P

N L I

=

This will lock the file so no one can delete it. If a user needs to remove the final status contact
DOT.AECApplications@ct.gov

2.2 COMPASS Overview

COMPASS is a cloud-based application built on Microsoft SharePoint pages. Thus, users require
an Office 365 (0365) account to access the site. This account provides access to COMPASS as
well as many other useful Office 365 applications. CTDOT users are provided with a CTDOT
0365 license. External user invitations are sent to non-CTDOT personnel — such as consultants
and contractors — to grant project-specific COMPASS site access.

Presently, COMPASS provides a single place to display the following project information:
e Rights-of-Way
e Environmental Permits
e CORE data

Viewport data

Composite Project Database (CPD)

Submittal/Transmittal Application

Project Staff Management
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e MS Project Schedule Integration
Document Storage/Control
Security/User Management

e Project Geospatial Location (Polygon)

Office 365 Sign In

The Microsoft Online sign-in page is located at https://www.office.com, or can be found by
internet searching for “Office 365 log-in.”

B® Microsoft
Sign in

Email, phone, or Skype

Can't access your account?

Back Mext

Figure 2 - 0365 Sign In

Sign-In Name
For CTDOT personnel, user sign-in names match computer sign-in names and are not the ct.gov
email addresses. Sign-in names are typically in the following format:

[Full Last Name] + [First Initial] + [Middle Initial] @dot.ct.gov
Examples: LynchKL@dot.ct.gov, MurphyZ@dot.ct.gov
Sign-In Password

For CTDOT personnel, user sign-in passwords match computer sign-in passwords. If the
computer password is changed, the Microsoft Online password is automatically changed.

COMPASS Browser Set Up

It is recommended that users add COMPASS as a web browser trusted site. This needs to be
done one time per each user log-in name and per each device. If the trusted sites are not
added, when a user tries to access COMPASS the following error message may appear (“Loading
Projects...”):

oy

Loading Projects...

Figure 3 - COMPASS Browser Set Up
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Take the following steps to add the COMPASS trusted sites to Internet Explorer (IE).

1. Open an Internet Explorer browser window.
2. Click on the settings gear in the upper-right hand corner of the window. Select Internet

Options.

Print v
File »
Zoom (100%) v
Safety »
Add site to Start menu

View downloads Ctrl+)

Manage add-ons SELECT
F12 Developer Tools INTERNET
Go to pinned sites OPTIONS

Compatibility View settings

Report website problems

Internet options

About Internet Explorer

Figure 4 - COMPASS Trusted Sites

3. Navigate to the Internet Options Security tab. Click Trusted Sites. Then press the Sites

button.
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General  Security | privacy | Content | Connections | Programs | Advanced |
1. CLICK TRUSTED SITES

saaomu«-uwmqlm
Internet Local ntranet Restncted
wtes
Trusted sites
J This 20ne contans websites that you
trust not to damage your computer or
your fies.
You have webstes in ths 2one.
[ Security level for ths zone | |
Alowed levels for ths zone: Al
: 2. CLICK SITES
l - « Prompts before downloading potentaly unsafe
content

- Unsigned ActiveX controis will not be downloaded

¥ Enable Protectad Mode (requires restartng Intermet Explorer)
Customievel.. |  Defatieve |

Reset all zones to default level I

Figure 5 - COMPASS Trusted Sites
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4. Inthe top field labeled “Add this website to the zone,” input the following three sites:

https://compassapis-prod.azurewebsites.net

https://ctgovdot-myfiles.sharepoint.com

https://ctgovdot.sharepoint.com

Press Add after inputting each individual site.

wmpasapis-prod.amewebsihes.neﬂ

Trusted sites l]

You can add and remove websites from this zone, All websites in
this zone will use the zone's security settings.

1. INPUT TRUSTED SITE URL
Add this

Websites:

https: //ctgovdot-myfiles.sharepoint.com ( Remove I

https://portal.office.com
https: //www.ct.gov

2. PRESS ADD

[V Require server verification (https:) for all sites in this zone

_ oo |

Figure 6 - COMPASS Trusted Sites

5. The site names will now show in the Websites section. Press Close to exit the Trusted

sites window.
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You can add and remove websites from this zone. All websites in
this zone will use the zone's security settings.

1. CONFIRM ALL TRUSTED
kS hm’[ SITES ARE ADDED.

| \/ [

Websites:

<Wﬂod.am@ ;] Remove I

https: //ctdotsubtransapis-prod. azurewebsites, net—l
https://ctgovdot.sharepoint.com =
I_>.l'I
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<]

[V Require server verification (https:) for all sites in this zone

2. CLOSE WINDOW m

Figure 7 - COMPASS Trusted Sites
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6. Inthe Internet Options window, select the Security tab. Check Enable Protected Mode.

ﬁ 21X

1. CLICK SECURITY TAB
Select a 2one to view or change security settings.,

@ & v O

Internet  Localintranet [ERSERE] Resticted
stes

Trusted sites o I
, This 20ne contans websites that you

v trust not to damage your computer or
your fles,
You have websites in ths zone,

[~ Security level for ths zone

Alowed levels for this zone: Al

- | - Medum

- I - = Prompts before downloading potentialy unsafe
Tr - Unsgned ActveX controis wil not be donnioaded

= e 2. CHECK THIS BOX
MM (requres restarting Internet Explore)

Reset ol 2ones to default level I

(o] o | |

Figure 8 - COMPASS Trusted Sites

7. Press OK to exit the Internet Options window.
8. Close Internet Explorer.

Accessing COMPASS

For CTDOT users, after logging in to Office 365, navigate to SharePoint, then search for the
COMPASS site. This location can also be reached via the following URL:
https://ctgovdot.sharepoint.com. The first project shown in the list will be highlighted by a blue
bar and display the Landing Page information in the center and right sections of the page.

Good morning CTDOT users select the SharePoint

App after logging in to Office 365.

+ e @ =H $

Start new OneDrive Word Excel PowerPoint OneNote

®

SharePoint

Figure 9 - 0365
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s SharePoint I \ >

Search for COMPASS in
the SharePoint search field

Figure 10 - Searching for COMPASS

<@ View Executive Dashboard

Projects Filter/Search Projects A | ? Help

Filter Projects By

R Search Projects Project Manager v Schedule Phase v

Reset Filters Submit Search

10f15 (2)(3)

No. PROJECT NUMBER UNASSIGNED
o ID. PP054-0002

Project No. Temp ID. PP156-0009

FDP: Start of Construction: Project Manager:

Schedule Phase: > Project Dashboard Project Details
Project No. Temp ID. PP121-0003 [ Copy Project url

FDP: Start of Construction: Project Manager-
Schedule Phase:

Project No. Temp ID. pp036-0001

FDP: Start of Construction: Project Manager-

own(s) Goshen
Schedule Phase:

Figure 11 - COMPASS

2.3 Project Container for an Active Capital Project

ProjectWise and COMPASS are setup to automatically create a project container for any project
that is added to the Obligation Plan. This automatic process runs on a nightly basis. CTDOT
employees will have access to all projects, but access for consultants, municipalities or other
agencies must be requested by the Consultant Liaison Engineer. For ProjectWise the Consultant
Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov. Project
Managers have rights to add any necessary users to the project site. See COMPASS Project Site
Permissions for details on COMPASS project site access.

2.4 Project Folder Structure and Required
Documents for Capital Projects

This section details the project folder structure and the required project documents that must
be submitted for each project. The figure below illustrates a CTDOT project folder structure for
a Capital Project. The folder structure is identical for both the ProjectWise and COMPASS
solutions. The Department is currently transitioning from ProjectWise to COMPASS; see
Document Management Systems for details on what system shall be used during project
delivery. If the project container in ProjectWise or COMPASS does not look like the following,
please report to DOT.AECapplications@ct.gov.
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Section 3 of this manual details the processes for each contract document.

Projectwise COMPASS

&% CTDOT Project Template Jan 2011 Internal Documents

Note:

100_Contract_Plans (PDF) N
110_Contract_Documents poam 2ie e 27, 2018 100_Contract_Flans (PO
112_Centractor Schedules e o

Medified Neme

0_Contract_Documents
120_Contractor_Submittals (PDF) . 120_Contractor. Submittals (POF)
121_Contractor RFls and RFCs ure 27,2018 130 Final. Enginesring Reaorts
122_Contractor Closeout Dacuments 131 Engineering Reports. Confidentis
130_Final_Engineering_Reports - 120 Froject Adminration
131_Engineering_Reports_Confidential 121 Project Aminiaton Confdentis

140_Project_Administration
141_Project_Administration_Confidential
142_Project Administration Cerresponde
130_Quantity Calculations

151_Final Design Calculations
160_Project Photos

170 ROW and GIS Files
210_Construction

220 FHWA,

230_Contract_Administration

240 _Contract_Development

142_Project Administration Corresponde

150_Quantity Calculations

151_Final Design Calculations

160_Project Photes

=

240_Contract_Development
241 _Contract_Development_Confidential
June 27, 2018 June 27, 2018 110_Milestans_Submissions

241_Contract_Develepment_Cenfidential

320_Permit_Development

310 Milestone Submissions

Sleluachshetadsdsastetodohetedudsashatatet:

320 Permit_Development
330 _Design_Data
500_Survey

600 Project Initiation Documents

e

B00_Project Intiation Documents

Figure 12 - Capital Project Folder Structure

In the case where two or more projects are combined or advertised as (1) project, all

contract documents for these projects will be submitted into the lowest numbered project in
ProjectWise or COMPASS.

Project Folder Structure and List of Project Documentation

100_Contract Plans (PDF) — This folder contains only final Contract Plans, which includes the following:
There shall not be any working documents uploaded into this folder.

Final plans

Addendum plans

Design Initiated Change Order plans

As-Built plans

Electronic Engineering Data (EED) — Final Prepared by AEC Applications

110_Contract Documents (PDF) — This folder shall only contain the following final documents. There
shall not be any working documents uploaded into this folder.

Signed Contract

Environmental Permit Applications/Approvals

Pre-Bid Questions and Answers

Contract Special Provisions — Final, Addendum, and Change Order special provisions
State and Federal Minimum Wage Rates and Classifications.
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Project Folder Structure and List of Project Documentation

SOM (Source of Materials)

e Insurance documents

e Pre-Award DBE Review — Specific Contractor
e Bonds

120_Contractor Submittals (PDF) — This folder contains the following:
Working drawings

Shop drawings

e Product data submittals

e RFCs
121_Contractor RFIs— This folder contains the following:
e RFIs

122 Contractor Closeout Documents — This folder contains contractor closeout documents.
e QOperation and Maintenance Manuals
e Warranties

130_Engineering Reports — This folder contains all the final engineering reports. There shall not be any
working documents uploaded into these folders.
e Hydraulic

o Hydraulic Report and Hydraulic Report Data
Scour Report and Scour Report Data
Floodway Report and Floodway Report Data
Final Drainage Reports and Final Drainage Report Data
USGS Bridge and Channel Assessment Reports

o Miscellaneous Technical Data, Studies, Investigations or Reports

e Environmental Compliance

®)
®)
®)
®)

o Task 110

o Task210

o Task310

o Underground Storage Tank System Closure Reports
e Bridge

o Load Rating
e Geotechnical

o Geotechnical Report Project files - including test boring, laboratory testing data file, and
computations

131_Engineering Reports Confidential =This folder is only seen by a select number of people.
e Bid Analysis

140_Project_Administration_Documents— This folder is for final permanent milestone project
administration documents. These project administration documents can be defined as, but not limited
to, deliverables such as agreements, project approvals, project scope, regulatory documents, design
phase schedules, etc. There shall not be any draft documents uploaded into this folder.

e Agreements — Utility, Railroad, Municipal, etc.

e (Categorical Exclusion

e Certification Acceptance Checklist

e Commitment list

e Consultant Selection Documents — Scope of Services, Notice to Proceed, etc.

e Construction Incidental Cost Establishment Report

e DBE/SBE Approval with percentage, participation level
Design Approval
Design Exceptions
Design Phase Microsoft Project Schedule - COMPASS
Environmental Impact Study — EIS
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Project Folder Structure and List of Project Documentation

e Final Design Report

e Finding of No Significant Impact - FONSI
o Lighting Agreement

e Record of Decision —ROD

Rehabilitation Study Report

Risk Management Documents

RPM — Request for Project Memorandum
Sidewalk Maintenance Agreement
Standalone Transportation Management Plan Document, taken from the final design report
Stewardship Agreement

Structure Type Study

Waiver to Obligate Funds

e  White Papers

141_Project Administration Confidential — This folder shall be used for documents that only CTDOT
should have access to.
e Consultant Payroll information

142_Project Administration Correspondence — This folder is for all final project correspondence
documents. This is defined as any request memos, response memos, letters, etc., and does not include
any documents that are defined in the 140 _Project Administration folder. This folder shall not include
any working/draft documents.

e Meeting Minutes

e Request Memos — Survey Request, Design Reviews, Support unit design.

e Response Memos — Response to the Request Memos

150_Quantity Calculations — This folder is where all the final quantity calculations for contract items
shall be stored.

151_Final Design Calculations — This folder is where all the final design calculations shall be stored.

160_Project Photos — This folder is where all project photos shall be stored. Both engineering and
construction photos shall be stored in this folder.

170_ROW and GIS Files - This folder is where the final property maps shall be stored until they are
uploaded into the IRMS. Also the project polygons and parcel polygons file shall be stored here.

210_Construction Folders — See Construction Documentation for more information
e 01 - Project Documents

Semi and Monthly Payment Estimates

Construction Orders with Backup

Copies of Cost-Plus Sheets with backup

All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc.

Material Certifications, etc. (All Laboratory Reports)

Nuclear Density Test and Data Sheets (CON-125, 133)

Pile Driving Logs (CON-87)

Environmental Correspondence, Logs, etc.

Utility Forms (CON-40 and 41)

Contractor Payrolls

EEO/AA Reports (30-60-90s)

Labor Wage Checks (CON-131)

Hazardous Waste Manifests

Stores Requisitions and Transfer Vouchers

Purchase Orders and Requisitions

Correspondence

Consultants Billings with Backup

Computer Disks - properly labeled

O O O O O 0O 0O 0O 0O OO O OO O0oOO0OO0o0OO0oOO0
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Project Folder Structure and List of Project Documentation

Any Other Related Records
Town Correspondence File - Includes:
General Material
Request for and response to matters concerning highway, bridge, signing, lighting, etc.
by town officials
o Written commitments to first officials and/or elected, appointed state, federal officials
o Mapping Prepared by district or filed with district
e 02 - Internal Documents
o Consultant Ratings
o Other Sensitive Documents
o 03 — Measurements and Payments
o Field Books (all) Volumes 1,2,3,& 4s

O O O O

220_FHWA - This folder is used by the FHWA for their purposes

230_Contract Administration — This folder is used by the CTDOT Contracts unit.

240_Contract Development — This folder contains the paper plan order form and the location where the
Designer uploads the following supplemental contract documents:
e All contract special provisions and Notice to Contractors (NTC), in word format, both final and
addendum special provisions
e Estimator Proposal Estimate
e Calendar Day Estimate
e Electronic Engineering Data Files uploaded by the Designer

241_Contract Development Confidential — This folder contains the final engineers estimate and
calendar day estimate developed by the cost estimating unit.

e Final Engineers Estimate

e Final Calendar Day Estimate

310_Milestone_Submissions — The designer shall submit all milestone submission documents into this
folder. This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for
30%, 60%, 90%, and 100% submissions

320_Permit_Development — This folder can be used to store documents for the development of
permits. Note: At FDP, the permit applications and approvals must be uploaded into the 240 Contract
Documents folder. The processing unit then adds the permits and applications to the contract and
uploads the contract into the 110 Contract Documents folder.

e Permits Needs Determination Form (PNDF)

e Wetland Flagging Coordination

e Natural Diversity Database (NDDB) Coordination

e CTDEEP Fisheries Correspondence

e LEAN Meeting Minutes

e Project Manager Meeting (PMM) Minutes

e Permit Review Comments

e Responses to Permit Review Comments

330_Design_Data — This area is used for working on documents such as letters, memos, etc. and
working on CAD files. Under this folder there are discipline specific sub-folders that provide each
discipline an area prepare their design documents. The DOT Confidential subfolder shall be used to
work on draft confidential documents.

500_Survey
e 01_Central_Surveys — This folder is where the approved survey files will be stored for use by
design.
e 02_District_Surveys — This folder is used by the district survey units. The files stored in this
folder are considered working files.
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Project Folder Structure and List of Project Documentation

e 03_Consultant_Survey — This folder is used to store consultant survey information.

e 04_Survey Transfer — This folder is used by District Survey units to transfer their completed
survey files to Central Surveys. Central Surveys will review the files in this folder and then when
they are found acceptable, the files will be transferred into the 01_Central Survey folder for use
by design.

600_Project Initiation Documents — This folder is where any project initiation documents can be stored.
This would include any plans developed by the Project Concepts unit or any other documents created in
the project concepts phase.

2.5 Asset Areas

ProjectWise is also being used to store all asset related documentation and asset information.
In the future these will be transferred over to 0365. The following details the assets and
documents are being stored for that asset:
e (02.0 - Assets — Bridges
o Inspection Reports
o Fracture Critical Reports
o Maintenance Memos
o Load Ratings not performed for a Capital Project
e (2.1 - Assets — Bridges (under 20’ Town owned)
o Inspection Reports
e (2.2 — Assets — Signal Intersections
o Signal Plans — Active and Legacy
e (2.3 — Assets — Sign Structures
o Inspection Reports
e 02.4 - Assets—Towns
o Office State Traffic Administration (OSTA) documents
o Bridge Safety Town Letters
e (2.5 - Assets — Buildings
o Building Inspection Reports
e 02.6 — Assets Radio Towers
o Inspection Reports
e (2.7 — Asset — Railroad Crossing Signals
o Inventory document that provides detail for the crossing.
o Photos

2.6 COMPASS Project Site Permissions

Access to COMPASS project sites is provided using site permission groups. Each permission
group has a unique set of rights and restrictions.

AEC Applications will provide each Project Manager with administrative rights to their projects.
This is accomplished by adding the PM to the Owners site permission group in a COMPASS
project. The PM will then be responsible for granting and maintaining access to all team
members, including CTDOT staff, Consultants and Contractors. Once the PM has administrative
rights they may grant the same authority to any team member(s) by adding that team member
to the site Owners permission granted group. It is recommended to limit the number of staff in
the site Owners group. The majority of participants should be granted access through the
Members site permission group.
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Site Permissions Groups Defined
There are four permissions group per project: Site Owners, Site Members, Site Contractors and
Site Visitors.

Site Owners Group

Staff added to this group will obtain full control of the site, including the ability to add, edit or
delete documents. Site Owners have the ability to grant access to the site to internal and
external users and perform several other administrative functions.

Site Members Group

Site Member is the most common classification for individuals attached to a project. Site
Members may add items to project libraries and folders and edit information in the Contacts
menu. Individuals who need to review submittals and access document folders should be added
to the Members group. Construction Contractors should not be added to the Members group;
they should be added to the Site Contractors Group. External users included in the Members
group do not have access to the Landing, Dashboard and Details pages; they are only able to
access the Submittals / Transmittals (S&T) page and project folders. External users invited to
join a project Members group should follow instructions for Accepting an Invitation (External

Users).

Site Contractors Group

Users in the Site Contractors permissions group have the ability to create new submittals in the
COMPASS S&T application and respond to requests to revise and resubmit. Contractors cannot
access any of the project folders or the comment log. Contractors are limited to viewing
submittals in the Submittals / Transmittals table that a member of the Contractors group
created. If multiple members are included in this group, they will see each other’s submittals in
the S&T table. The project Contractor(s) should be added to this group. The User Manual for
Construction Contractors provides instructions to Contractors on how to accept invitations and
use the COMPASS S&T application.

Site Visitors Group

Site Visitors are limited to read-only access. Site Visitors can view project libraries, menu items
and documents. Site Visitors cannot add, edit or delete any information from the site. By
default, all CTDOT personnel who have a Department issued Office 365 license are members of
the COMPASS Visitors group, which grants Visitor access to all projects in COMPASS (not
including the Submittals/Transmittals Application).

Site Permissions Summary Table

£ 5 g 4

2| § ¢

FUNCTION & g| £| 3

sl 2| 9| &
Add or remove users to site permissions groups X
Delete a submittal X
Start or edit a review cycle on behalf of another user X
Start or finalize a Bluebeam Studio Session on behalf of another user X
Mark workflow status as Revise and Resubmit on behalf of another user X
Mark workflow status as Complete on behalf of another user X
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[7,]
Modify the Approval Matrix X
Create a submittal X X X
Replace a submittal in response to an R&R X X X
Function as a submittal Owner as assigned in the S&T Approval Matrix X X
Review a submittal X X
Access Internal Documents folder X X
View submittal documents X X X X

Setting up Site Permissions Groups

The site permissions should be assigned when a COMPASS project is first created. Thereafter,
the PMs or delegated staff member should maintain access privileges as needed. The PMs are
responsible for adding and removing members of the COMPASS site permissions group

throughout the duration of the project.

Site Settings Gear

To access the Site Settings menu via the gear:
1. Navigate to the Project Details page of the chosen project.

0. 0173-0468 Temp ID. PP092-0019

CLICK TO NAVIGATE
TO PROJECT DETAILS

i S S N S P
MS Project Schedule
J

Figure 13 - Site Settings

2. Navigate to the Submittals/Transmittals page.

NAVIGATE TO SUBMITTALS
/ TRANSMITTALS PAGE

Submittals/Transmittals

Figure 14 - Site Settings
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3. Navigate to the Gear in the upper right hand corner of the Submittals/Transmittals page

Figure 15 - Site Settings

4. Select Site Settings

Settings

SharePoint
Show Ribbon
Shared with...
Edit page

Add a page

Add an app

Site contents
Design Manager

Site settings

Getting started

Figure 16 - Site Settings

5. Select Site Permissions

Site Settings

Users and Permissions

People and groups

Site app permissions

Figure 17 - Site Settings

6. Select the Members, Owners, Contractors or Visitors permissions group, as appropriate.
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Site Settings » Permissions

SELECT THE CONTRACTORS,
MEMBERS, OWNERS OR
VISITORS PERMISSIONS GROUP

Figure 18 - Site Settings

7. To add a new member to the group, press New = Add Users

People and Groups » 0018-0134 Members

1 Users

ers to this group/

Figure 19 - Site Settings

8. To add CTDOT personnel, type and select the correct name into the names / email
addresses field. Contact information is automatically sourced from AD Manager. For
external users, the email address needs to be inputted manually. Multiple users can be
added to a specific site group at one time.

By default, an email invitation will be sent to new users that includes an optional
personal message typed by the Owner. To avoid sending an email notification to CTDOT
personnel, click Show Options and uncheck the box “Send an email invitation.” Email
invitations must be sent to external users. Email invitations should not be forwarded
between users; a separate invitation should be sent to each person who requires site
access.

Once the names, email addresses, optional personal message and optional email
invitation selection are complete, press Share to add individuals to the selected Group.

Share '0018-0134' X

Invite people S VR 12 S

Shared with

SHOW OPTIONS
1. INPUT CTDOT PERSONNEL

NAMES AND/OR EXTERNAL
USER EMAIL ADDRESSES.

2. PRESS SHARE

Figure 20 - Site Settings
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SELECT TO SHOW EMAIL
NOTIFICATION OPTIONS

i

Figure 21 - Site Settings

Include a personal message with this invitation (Optional)

CHECK BOX TO SEND AN EMAIL
NOTIFICATION. UNCHECK BOX TO
NOT SEND AN EMAIL NOTIFICATION.

M send an email invitation

Ca”ce

Figure 22 - Site Settings

Site Settings URL
To access the Site Settings menu for any COMPASS project:

1. After logging into COMPASS, a URL address can be used to assign permissions to any
project. Only COMPASS Owners and Owners of the specific project may modify the
project-specific permission groups. Below is an example of how to enter the URL for
Project No. 0134-0148. Replace the project number in the example (shown in red font)
with the project number in question. All eight digits and the hyphen must be included:

https://ctgovdot.sharepoint.com/projects/0134-0148/ layouts/15/user.aspx

2. Follow steps 6-8 as described in the Site Settings Gear section to add users to the
appropriate permissions groups.

Restricted Elements
Please do not use any of the functionality under the Settings menu.

People and Groups » 0134-0148 Members

@

m rd
o

Figure 23 - Restricted Elements
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Please do not use the menu items in the ribbon.

ar A t
. . «" Permission Levels
™ @ C
a5 & 2 C3¢ Access Request Settings
Jelete unique Grant Create jit User Remove User Check

I permissions Permissions :_:IC‘.[Z' YEIMISSIOr Permissic Permissions

Figure 24 - Restricted Elements

Accepting an Invitation (External Users)

External users (e.g., Contractors, Consultants, Stakeholders, etc.) invited to join a COMPASS
project site will need to take the following steps to accept a COMPASS invitation. External users
should never forward their invitations to other users.

If other individuals need access to a COMPASS project site, a request should be sent to the PM.

Note: Depending on the user’s email settings, the email notification may route to the SPAM or
Junk folder.

1. The external user will receive an email invitation with a direct link to the project page.

NEVER FORWARD COMPASS PROJECT SITE INVITATIONS TO OTHER USERS.
CONTACT PROJECT PM TO REQUEST ADDITIONAL ACCESS.

Hello,

Go To

Figure 25 - Accepting an Invitation

CLICK TO ACCESS
COMPASS LOG-IN

2. On the SharePoint Online invitation acceptance page,

a. External users with an existing work / company Office 365 account should click
Organizational Account and log-in using their company Office 365 user name
and password.

b. External users with an existing personal Microsoft account as described should
select “Microsoft account” and sign-in.

c. External users without an existing Microsoft account should select “Create a
Microsoft account” and follow the steps to set-up a new, free account. Itis

recommended that the user’s company email address be used to set-up this
account.
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Welcome to SharePoint Online

To accept your invitation, sign in with a Microsoft account or an account assigned to you by your
organization. By signing in you allow Connecticut Department of Transportation to use your basic profile
(name and email address) in accordance with their privacy statement. Connecticut Department of
Transportation has not provided links to their terms for you to review. You can remove these permissions

at myapps.microsoft.com. SELECT TO SIGN-IN USING

AN EXISTING PERSONAL
/ MICROSOFT ACCOUNT.
.. Microsoft account

- Sign in with the account you use for OneDrive, Xbox LIVE, Outlook.com, or other Microsoft

services. SELECT TO SIGN-IN USING AN
EXISTING COMPANY OFFICE

/_ 365 ACCOUNT. USE THE SAME
w2l Organizational account USER NAME AND FASSWORD.

g Sign in with the account provided by your work or school to use with Office 365 or other
Microsoft services.

Don't have either account? Create a Microsoft account, it's quick and easy!

| i SELECT TO CREATE A
egal | Privacy NEW, FREE ACCOUNT.

Figure 26 - Accepting an Invitation

**External users will sign in directly to their project sites and do not have access to the
COMPASS Landing Page, Dashboard or Details page.

2.7 Navigating COMPASS

For CTDOT users, follow the instructions provided in COMPASS Overview to log-in to Office 365
and access COMPASS.

COMPASS Landing Page

Searching for Projects

Once within the COMPASS site, search or filter by Project Number, Project Name, Project
Manager or Schedule Phase.
e When searching by Project Number, the hyphen and full eight-digit number should be

used, including leading zeroes (Hi#H-#tHit).
e  Multiple Project Managers and / or Schedule Phases can be selected at the same time.
e Click Reset Filters to clear all filters and begin a new search.

Projects FILTER WITH
DROP-DOWNS

SEARCH BY PROJECT
i sl /~ NAME OR NUMBER

Search Projects

Reset Filters Submit Search

Schedule Phase

Figure 27 - Searching for Projects
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e C(Click the Filter / Search Projects arrow to collapse or expand the filtering section.

/,’_,J Filter/Search Projects v | ? Help

1o

Figure 28 - Searching for Projects

e If a search produces multiple results, scroll between the Project Landing Pages by using
the up and down arrows located on the upper-right hand side of the page.

Figure 29 - Searching Projects

Project Landing Page
The following resources can be accessed from each Project Landing page:
1. Project Dashboard
2. Project Details
3. Copy Project URL — Copies the project site URL to the clipboard.
4. MS Project Schedule —The MS Project schedule button will only be active if there is an
associated schedule and if the user has an MS Project Online license. See COMPASS
Software License Requirements for details.

roject No. 0300-0138 emp |ID. PPOO0O-0000

1 2 3
e
4

Figure 30 - COMPASS Pages

The following information resides on each Project Landing page:
e Project Description
e Schedule details including number of tasks remaining, overall schedule health and
current Schedule Phase
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e Permit and ROW status

e Location map showing the project polygon — Refresh the page to reset the map to its
original position.

e Key dates for the project — Open in CORE and FDP

e Staff assigned to the project with their contact details

e Budget donut graphs — Roll over the graph sections to view monetary details

e Funding data

Project Dashboard

Accessing the Project Dashboard

The Project Dashboard can be reached from the Project Landing page, Project Details page, or
Submittals / Transmittals page by clicking the Project Dashboard button.

Project No. 0076-0204 Temp ID. PPOOO-0000
REHABBRIDGENO. 05845

Construction: 04/01/2008 FDP: 03/07/2007

anager: Baker,Mary E
Schedule Phase: 06_Completed Project No. 00T-0 Temp ID. PPOTI-0003

Project No. 0OTI-0154 TempID. PPOTI-0003 L Proj hboard
ED-Bloomfield CT189 Br#01509

ruction: 07/28/2017 FDP: ]

Figure 31 - Project Dashboard

Project Dashboard Contents
The following resources can be accessed from the Project Dashboard:
1. Project Menu

2. Project Details
3. Submittals/Transmittals
4

Back to Project List button

Project Overview
4

roject 2 3
P No. 0012-0096
é Dashboard & Back to Project List

Temp ID. PPO12-0001 Detalls Submittals/Transmittals
Schedule Phase: Completed

Project Overview PROJECT DESCRIPTION

Contacts nis): Bolton

Internal Documents

Documents extension of Project 76-217. PEis funded under 76-217.

Project Emails

Report of Meetings

PROJECT VALUE

This project involves construction of the Charter Oak Greenway Shared Use Path
Finley Street in Manchester to the Hop River State Park Trail in Bolton. This projq

Figure 32 - Project Dashboard
Issued April 2020 32 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

The following information resides on each Project Dashboard:
o Project Description

e Project Value —roll over graph sections to view monetary details

e Project Schedule FDP dates — obligation date, MS Project Schedule date and the
associated delta

e Project Expenditures Graph (PEG) (under construction)

e Permitting status

e Rights of Way status

Location map showing the project polygon — Refresh the page to reset the map to its original
position.

Project Details

Accessing the Project Details Page

The Project Details page can be reached from the Project Dashboard, Project Landing page or
Submittals / Transmittals page by clicking the Project Details button.

Project Mo. 0076-0204 TempID. PPOOO-0000
REHABBRIDGENOQO. 05845

Start of Construction: 04/01/2008 FDP: 03/07/2007

Project Manager: Baker,Mary E
Schedule Phase: 06_Completed Project No. 0011-0154 emp ID. PPOTI-

Project No. 00TI-0154 Temp ID. PPOTI-0003 l"_J' Project Dashboard B Project Details
ED-Bloomfield CT189 Br#01509

5 struction: O7/28/2017 FDP:
nager. BakerMarv E

Figure 33 - Project Details

Project Details Contents
The following resources can be accessed from the Project Details page:

1. Project Menu
2. MS Project Schedule —The MS Project schedule button will only be active if there is an

associated schedule and if the user has an MS Project Online license. See COMPASS
Software License Requirements for details.

3. Back to Project List button

4. Staff assigned to the project with their contact details, including the ability to edit.
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(R) COMPASS

ho)

Project Overview

Project No. 0012-0096 3
TempID. PPOI2 1 Dashboard Details Submittals/Transmittals
Schedule Phase: Completed

&~ Back to Project List

Project Overview o DATES

Contacts
1/09/2016

PROJECT DESCRIPTION

Internal Documents

s): Bolton 4
Documents STAFF

This project involves construction of the Charter Oak Greenway
Shared Use Path from Finley Street in Manchester to the Hop ENGINEERING LEAD UNIT STAFF - AEC
River State Park Trail in Bolton. This project is the extension of -~ '
Project 76-217. PEis funded under 76-217.

Project Emails

Report of Meetings

Bourgoin, Bruce R

Transportation Supervising Engineer

Figure 34 - Project Details

The following information resides on each Project Details page:
e Town(s)
e Project Description
e Schedule details including number of tasks remaining, overall schedule health and
current Schedule Phase
e MS Project schedule milestone details
e Permitting and ROW details
e Budget donut graphs — Roll over the graph sections to view monetary details
e Funding data

Staff

The Engineering Lead Unit, Engineering Support Units and Construction Districts are responsible
for entering and maintaining project staff information in COMPASS. Each Unit and District is to
decide which employee(s) are responsible for entering and maintaining the project staff; all
CTDOT COMPASS users have the ability to perform this function. Staff information is found on
the right-hand side of the Project Landing and Details pages. When this page is correctly
populated and maintained, it will provide an authoritative resource of all project staff including
Engineering Lead Unit, Engineering Support Units, Consultant staff, Construction staff,
Construction Consultants and Contractors. Titles, units / companies, email addresses and phone
numbers will be readily available to all who have access to the page.

Editing Project Staff

To edit the project staff:
1. Click the Project Details button to navigate to the Project Details page. The Details

button can be accessed from the Landing page, Dashboard or Submittals/Transmittals
page.
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177

W/ 5-0408 Temr PPOS

P CLICK TO NAVIGATE
i o TO PROJECT DETAILS

Figure 35 - Project Details

Dashboard e Submittals/Transmittals

CLICK TO NAVIGATE
PROJECTDESCRIFTION | — TO PROJECT DETAILS

Figure 36 - Project Details

2. Click Edit in the Staff section of the Details page.

Figure 37 - Project Details

3. Add all project staff to the page. Press Show and Hide to expand or conceal the
different staff categories.
a. Engineering Lead Unit Staff: Only one CTDOT unit is to be added to this section.
The Transportation Supervising Engineer (TSE) should be the highest level
employee added to this section. Unit, title and contact information will

automatically populate once a name is added.
b. Engineering Support Unit Staff: All CTDOT engineering support staff are to be
added to this section by their respective units. Unit, title and contact

information will automatically populate once a name is added.

c. Consultant Staff: All design consultant staff are to be added to this section by
the Engineering Lead Unit. Since this section is comprised of external users, all
information needs to be manually entered.

d. Construction Staff: All CTDOT construction staff are to be added to this section
by the Construction District. Unit, title and contact information will

automatically populate once a name is added.
e. Construction Consultant Staff: All construction consultant staff, such as CE&,

are to be added to this section by the Construction District. Since this section is
comprised of external users, all information needs to be manually entered.

f. Contractor Staff: All project contractors are to be added to this section by the
Construction District. Since this section is comprised of external users, all
information needs to be manually entered.
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¥

Close \ Edit Project Staff

m
m

NAME/TITLE UNIT CONTACT INFO

IN EACH SECTION, PRESS THE
"ADD" BUTTON TO INSERT A

NEW STAFF MEMBER FIELD

m
m
m

NAME/TITLE UNIT CONTACT INFO

= IN EACH SECTION, CLICK "SHOW" TO
D Add EXPAND STAFF INFORMATION; CLICK
"HIDE" TO CONCEAL STAFF INFORMATION

MANUALLY INPUT
CONTACT INFORMATION
FOR NON-DOT STAFF

EMAIL PERSON COMPANY TITLE PHONE

CLICK TRASH CAN TO DELETE A STAFF ENTRY.

PRESS SAVE WHEN COMPLETE

Figure 38 - Edit Staff

Project Staff Features

The Staff page has several built-in, automated features, including:

e Engineering Lead Unit Staff: The Engineering Lead Unit Staff section will populate the
lead unit header based on the personnel inputted in this section. Only CTDOT personnel

from one unit should be included in this section.

e Auto-sort by sub-section: Users are to add personnel into the appropriate category on
the Edit Project Staff page. When the changes are saved, COMPASS will automatically
sort personnel by sub-section in all categories except Engineering Lead Unit Staff. For

Engineering Support Unit Staff, sub-groups such as Bridge State Design and Highway

Consultant Design will be created. For Construction Staff, sub-groups will be created

based on Construction District. For the three sections containing non-DOT users,

COMPASS will sort individuals by company name.
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e Auto-sort hierarchy: For the three categories containing CTDOT personnel, COMPASS
will automatically sort individuals by rank. This is not a direct chain of command listing;
rather, COMPASS will sort staff by title within each sub-section.

Contacting a Member of the Project Staff

To contact a member of the project staff, either click on the email address listed to open a new
email window or utilize the phone number provided.

Project Communication

The Project Communication window operates as a message board. It is a location where
members of the project team can post messages, updates or other communications to the rest

of the team.

To create a new message, type in the New Communication box and click post.

PROJECT COMMUNICATION

£ Search Communications

Figure 39 - Project Communications

To respond to a Communication thread, click the Reply button associated with the relevant
communication and insert text.

Ryan Clayton Comment post from IE
B Reph

Thank you Ryan. that is great!

Figure 40 - Project Communications

Project Communication messages can be searched by typing a keyword or phrase in the Search
bar.

PROJECT COMMUNICATION

( Stamford| <)

Clear Search

Figure 41 - Project Communications
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Project Menu

The Project Menu — located on the left side of Dashboard and Details pages — is comprised of
the following sections:

Contacts: The Contacts folder can be used to add contact information for project staff,
stakeholders, agencies or other relevant users.
Internal Documents: The Internal Documents folder is structured to mirror ProjectWise.

Documents routed through the Submittal / Transmittal tool automatically save to pre-
allocated Internal Documents subfolders. Users with access can also save and share
documents directly through the Internal Documents folder.

Documents: Under Construction. Do not use this folder at this time.

Project Emails: Project-related emails that need to be memorialized can be saved to the
Project Emails folder. The contents of this folder are viewable to those with project site
access. Highly confidential project emails that require more restricted access should not
be stored in this location.

Report of Meetings: The Report of Meetings tab provides a project-specific OneNote
notebook. Project staff can use this OneNote to document meeting minutes, or expand

its use to record other notes.

When a selection is made from the Project Menu, a new window will automatically open to
provide the information. For example, if the Internal Documents item is selected, a new
browser window will be created.

Project No. 0012-0096
Temp ID. PPO12-0001
Schedule Phase: Completed

Project Overview

Contacts

Internal Documents
Documents

Project Emails

Report of Meetings

Figure 42 - Project Menu

Executive Dashboard

The Executive Dashboard provides an overall summary of all active projects. The Executive
Dashboard is accessed from the COMPASS Landing Page and any Project Landing page. Select
the blue button to view data.

Rrcompass

@ View Executive Dashboard

Figure 43 - Executive Dashboard
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€ Close Executive Dashboard
Executive Dashboard
OVERALL PROJECTS SCORE PROJECTS HEALTH  * BUDGETS 4 SCHEDULE
Good 101/681 i
At 231/621

249/681

$1,734,747,057 $3,664,119,257

Figure 44 - Executive Dashboard

Click on the question mark (?) option in the upper-right hand corner of each section of the
Executive Dashboard to determine how each assessment is calculated. For details, see
COMPASS Data Sources and Computations table.

Good i

At Risk

Poor m 206/
Calculation: (Schedule Scores+Budget

PROJECTS HEALTH : BUDGETS

6/68 Projects Health

476! Includes all projects not in Completed or
Cancelled status,

Scores) /2
SCORING:

* =89% = Green/Good
s 709%-89% = Yellow/At Risk
* <70% = Red/Poor

Figure 45 - Executive Dashboard

Section 3 Digital Project Processes

3.1 Processes by Project Phase

The following shows the processes included in this manual separated by project phase. Also
included in this table is a link to the process map that corresponds to each document/process:

Project Initiation Phase

Document/Process

Requirements

PPI Process

See Section 14 of this manual.

Project Schedule

Project Schedule should be set up in accordance with Section 11

Preliminary Design Phase

Preliminary
Contract Plans

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2

Preliminary

Contract Special Provisions shall be prepared in accordance with Section 4.5
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Contract Special
Provisions

Cost Estimate

Cost Estimates shall be prepared in accordance with Section 4.6

Preliminary Design
(30%) Review

Design Reviews shall be accomplished in accordance with Section 10

Project Schedule

Project Schedule should be set up in accordance with Section 11

Permit
Applications/
Documents

Shall be uploaded and formatted in accordance with Section 4.7

Rehabilitation
Study Reports

Shall be uploaded and formatted in accordance with Section 4.9

Structure Type e Shall be uploaded and formatted in accordance with Section 4.9
Studies
Categorical e Shall be uploaded and formatted in accordance with Section 4.10
Exclusion
Design Exception |e Shall be uploaded and formatted in accordance with Section 4.10
Design Approval e Shall be uploaded and formatted in accordance with Section 4.10
Letter
Project e Shall be uploaded and formatted in accordance with Section 4.10
Correspondence

Project Polygon

Shall be prepared and uploaded in accordance with section 4.11

Final Design Phase

Document/Process

Requirements

Contract Plans

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2

Contract Special
Provisions

Special Provisions shall be prepared in accordance with Section 4.5

Engineering
Reports

Engineering Reports shall be prepared in accordance with Section 4.9

Project Schedule

Project Schedule should be set up in accordance with Section 11

Cost Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section 4.6

Permit
Applications/
Approvals

Shall be uploaded and formatted in accordance with Section 4.7

Design Calculations

Design Calculations shall be submitted in accordance with Section 4.13

Semi Final (60%)
and Final Design
(90%) Reviews

Design Reviews shall be accomplished in accordance with Section 10

Quantity e Quantity Calculations shall be submitted in accordance with Section 4.6
Calculations
Final Design Report | ¢  Shall be uploaded and formatted in accordance with Section 4.10
Final Design e Shall be uploaded and formatted in accordance with Section 4.10
Statement
Sidewalk e Shall be uploaded and formatted in accordance with Section 4.10
Maintenance
Agreement

Lighting Agreement

Shall be uploaded and formatted in accordance with Section 4.10

DBE/SBE Goals

Shall be uploaded and formatted in accordance with Section 4.10

Commitment List

Shall be uploaded and formatted in accordance with Section 4.10

Waivers

Shall be uploaded and formatted in accordance with Section 4.10

Standalone

Shall be uploaded and formatted in accordance with Section 4.10

Issued April 2020 40

Version 5.01




Connecticut Department of Transportation — Digital Project Development Manual

Transportation
Management Plan

Project e Shall be uploaded and formatted in accordance with Section 4.10

Correspondence

Contract Processing Phase

Document/Process

‘ Requirements

FDP

Contract Plans

e Plans shall be grouped in accordance with Section 4.1
e Plans shall be formatted in accordance with Section 4.2
e Plans shall be checked by the PDF checker in accordance with Section 6.2

Contract Special Provisions

e Special Provisions shall be prepared in accordance with Section 4.5

Proposal Estimate

e Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Federal Estimate

e Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Calendar Day Estimate

e Calendar Day Estimate shall be prepared in accordance with Section 4.6

Permit Applications/
Approvals

e Shall be uploaded and formatted in accordance with Section 4.7

Ordering Paper Copies of
Contract Documents

e Paper copies of contract documents can be ordered in accordance with
Section 3.2.11

EED

e Shall be prepared and uploaded in accordance with Section 4.14.

Project Polygon

e Shall be prepared and uploaded in accordance with section 4.11

DCD

Contract Plans

e Plans shall be grouped in accordance with Section 4.1
e Plans shall be formatted in accordance with Section 4.2
e Plans shall be checked by the PDF checker in accordance with Section 6.2

Contract Special Provisions

e Special Provisions shall be prepared in accordance with Section 4.5

Proposal Estimate

e Preliminary Cost Estimates shall be prepared in accordance with Section

4.6

Federal Estimate e Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Calendar Day Estimate e Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Permit Applications/ e Shall be uploaded and formatted in accordance with Section 4.7
Approvals
Addendum

Contract Plans

e Plans shall be prepared in accordance with Section 7.1

Contract Special Provisions

e Special Provisions shall be prepared in accordance with Section 7.1.5

EED

e Shall be prepared and uploaded in accordance with Section 4.13.

Award Phase

Signed Contract

e Signed Contract will be uploaded into ProjectWise in accordance with

section xx.
Construction Phase
Document/Process Requirements
Contractor e Contractor submittals shall be uploaded in accordance with Section 9
Submittals
Contract Plans e Plans shall be prepared in accordance with Section 7.2
Contract Special e Special Provisions shall be prepared in accordance with Section 7.2.5
Provisions
DCO Memo e DCO memo shall be prepared in accordance with Section 7.2.6
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Plan As-Builts e Plan As-Builts shall be accomplished in accordance with Section 8
Project e Shall be uploaded and formatted in accordance with Section 4.10

Correspondence
EED e Shall be prepared and uploaded in accordance with Section 4.13.

Project Polygon

e Shall be prepared and uploaded in accordance with section 4.11

3.2 Digital Project Process Maps

This section provides high level process maps for the procedures detailed in this manual.

PPI Form

Click Here for Formatting and Submittal Requirements
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Digital Reviews
Click here to go to the Digital Review Section

Join review session and comment on review
documents.

Reviewers
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FDP Contract Plan Processing

Click Here for Formatting and Submittal Requirements

Submit FOP subsets inta the 100
Contract Plans Falder in Projectwise.

Y

Change FDP subsets ta the Processing
State and mark up with comments as
NECESsary,

Revision

Required

Final Design Plans (Discipline Subsets)

Create a new subset(s] with the
required changes and submit DCO, |
DCD2, ete, subsets into the 100
Centract Plans Folder in Projectwise.

Change DCDr subsets to the Processing
State, perform a document compare
between the FOP and DCD subsets and
mark up with comments as necessary, Yes

h

Change the Sub-Category Attribute on
all the subsets to FPL and delete all
previous subset versions [FDP, DCD,

£rc.)

tate Design

I
™D

Revision
Reguired

ol

Project

fes

v

Change the state of all the subsets into
the Manager and Engineenng Admin

Title sheet is signed

THCH

h J

h J

State and notify the designer that the P  and the designer
title shieet of the project can be digitally notifies Processing
signed.
Designer Processing Contracts
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Change the state of all the subsets into
the Contracts state and notify Contracts
that the subsets have been approved
for Advertising

h 4

Change the state of the subsets to the
Advertise state and export the files out

to be posted to the DAS Portal for
Advertising,
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Addenda Plans

Click Here for Formatting and Submittal Requirements

Addendum Plans (Discipline Subsets)

Submit ADP subsets into the 100
Contract Plans Folder in Projectwise.

Create a new subset(s] with the
k required changes and submit ACD,
—] 3 i
Change ADP subsets 1o the Processing . T :It':‘ "'f:b?;“ mt;r::'le L
State and mark up with comments as entract Plans Folder in Projectwise.
NEeCessany.

¥

Change ACD subsets to the Processing
Yes State, perform a document compare
between the ADP and ACD subsets and

Revisin mark up with comments as necessary, Yes
Reguired
Rewvision
Reguired
L]
h 4
Change the Sub-Category Attribute on
all the subsets to ADP and delete all
previows subset versions (ACD, ACD2,
et
I
Change the state of all the subsets inta Change the state of the subsets to the
the Contracts state and notify Contracts o | Advertise state and export the files aut
that the subsets have been approved "l to be posted to the 0WS Partal for
for Advertising Adhvertising
Motify the designer that the subsets
have been approved for Advertising and o
the Red Xs can be placed on the revised o e e e
sheets.
Designer Processing Contracts
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Design Initiated Change Order (DCO) Plans

Click Here for Formatting and Submittal Requirements

Design Initiated Change Order (DCO) Plans
(Discipline Subsets)

Folder in COMPASS

Submit DCO subsets into the 100 Contract Plans

Y

Contractor.

When the DCO plans are to be released to the
contractor, the state of the plans shall be changed to

Y

plans have are available.

MNotify the Contractor and Designer that the DCO

Y

Place Red Xs on the revised sheets located in
COMPASS

Share with DCO Plans with Contractor

v

Open DCO Plans from Projectwise

Designer Construction

Contractor
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Contractor Submittals

See Section 9 for detailed instructions. Process maps for Shop Drawings, Working Drawings,
Product Data Sheets, and RFls are in development.

Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract
plans and special provisions for DOT Projects. This form is located in each project in ProjectWise
and each unit in the Department that needs paper copies of contract plans and special
provisions is required to update this form for their paper needs. This form is then used by the
Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out
using the information indicated on the form. Addendums will be printed and sent out
automatically. When a Change Order is submitted, the designer must notify Engineering records
that a Change Order has been submitted and that paper copies of the Change Order need to
printed and sent to the applicable units indicated on the Paper Plan Order Form.

This following shows the procedure for how the Paper Plan Order Form is filled out and the
prints are made. Contact Information for Engineering Records: Print Shop: 860-594-3086 Plan
and Specification Printing

Step | Project Stage Group Action

1 FDP Processing After the contract plans and special provisions have been
submitted for FDP an email is sent to each unit in the
Department that requires paper copies of contract plans and
special provisions.

2 FDP Units Open the Paper Plan Order Form from ProjectWise and fill out
the form for their unit’s needs. Save the form and check the
form back into ProjectWise.

3 DCD Processing At DCD, lock the form by placing it in the Processing state.

4 Advertise Contracts Notify Engineering Records that the project is going to be
advertised and they can print the required paper copies
indicated on the Paper Plan Order Form.

5 Advertise Engineering Print the required paper copies indicated on the Paper Plan

Records Order Form.
6 All Contracts Notify Engineering Records that an Addendum is going to be
Addendums advertised and they can print the required paper copies
indicated on the Paper Plan Order Form for this Addendum.
Make sure to tell Engineering Records which subsets are
included in the Addendum.

7 All Engineering Print the required paper copies indicated on the Paper Plan

Addendums Records Order Form for the Addendum. Make sure to print all the
subset that were affected by the Addendum including the 02-
Revisions subset.

8 All Change Lead Designer | Notify Engineering Records that a Change Order has been

Orders submitted and they can print the required paper copies
indicated on the Paper Plan Order Form. Make sure to tell
Engineering Records which subsets are included in the Change
Order. If a unit is not listed on the Paper Plan Order Form,
give Engineer Records those units’ contact information so
those units’ can receive a copy of the Change Order.

9 All Change Engineering Print the required paper copies indicated on the Paper Plan

Orders Records Order Form for the Change Order and for any other units’

requested by the Lead Designer. Make sure to print all the
subsets that were affected by the Change Order including the
02-Revisions subset.
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Section 4 Document Preparation and
Format

4.1 Contract Plan Grouping

Contract plans shall be grouped, by discipline into individual multiple page PDF files called
discipline subsets. The project manager is tasked with determining the discipline subset
numbering and grouping and whether to use a single volume or multiple volumes for the
project. The number of sheets in a discipline subset shall contain a maximum of 150 sheets.
The following details each of these options:

Single volume digital contracts are used when each discipline or consulting firm designing the
project is responsible for 3 subsets or less. The following is an example of a single volume
project.
Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03
subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc. FIO subsets shall be numbered at the end of the project before the
standard subsets. The Standards subsets shall not be numbered.

Multiple volumes are used if the project has 1 or more of the following characteristics:

a. The majority of the discipline/firm designers are responsible for more than 3
subsets each. This allows the individual designers to number their subsets
independently of the other disciplines.

b. There are multiple sites on the project. Splitting these sites up into volumes will
provide better organization of the project.

c. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more
specific. The subsets shall be split up by volume and each volume shall be controlled by its
assigned designer. For example, all the subsets designed by the highway designer shall be in
the same volume (02) and each subset shall have a unique subset number.

Note: The first and second subsets when using multiple volumes shall always be 01.01-

General and 01.02-Revisions. The 01.03 subset does not always need to be 01.03-

Highways, the 01.04 does not always need to be 01.04-Structure, etc. FIO subsets shall

be numbered at the end of the project before the standard subsets. The Standards

subsets shall not be numbered.
Combining Projects
In the event 2 or more projects are combined into one project, the following shall be done:
e Each project shall be given its own volume.
e The lowest project shall always be volume 1.
e Each project shall have its own title sheet, which reference each other with a note.
e There shall only be (1) Revisions subset. This subset shall be in volume 1 and named

01.02 — Revisions.

e The Revisions subset shall be the responsibility of the project manager on the projects.

e Each project shall have its own detailed estimate sheets.

e There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when
the projects are combined.

o There shall not be any duplicate special provisions after the projects are combined.

e There shall only be (1) calendar day chart.
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The next two figures show examples of the single volume and multiple volume options.
Single Volume Option

Label File contents
(Discipline Subset) (but not limited to)
01-General Title Sheet

Detail Estimate Sheet
Index of Revisions Sheets

02-Revisions

Index of Plans Boring Logs
Survey Data Highway Plans
Alignments Breakout Drainage
03-Highways ROW . H?ghway Profile
Typ Sections Highway X-
Misc Details Sections
Intersect Grading Landscape Plan
Wetland Mitigation
Index of Drawings
All Structure Sheets
04-Structure Note: Multiple subsets may be required for
multiple Sites
Ex: 04_Structure_Br.N0.1266
Index of Drawings
Signing
05-Traffic Pavement Markings
MPT
Traffic Signal Plans
Etc.

Index of Drawings
All Environmental Compliance Sheets required

06-Environmental

i Utility Design plans. For example 07_AT & T,
7-Util =
07Uty 07_CL & P, 07_MDC, etc.
08-CL&P FIO** CL & P For Information Only plans
09-AT&T FIO** AT & T For Information Only plans

CTDOT Highway Design Standard Index and
Sheets required

CTDOT Traffic Engineering Standard Index and
Sheets required

CTDOT Highway STD

CTDOT Traffic STD

Figure 46 Typical Highway Project Discipline Subset Contents

* |f a discipline has to be broken up into more than one subset, keep the label the same with the
addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.

** For Information only discipline subset shall be submitted as individual pdf files based on the
entity providing the information only.
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Multiple Volume Option

Label File contents Designer/

(Discipline Subset) (but not limited to) Firm
01.01-General Title Sheet, Detail Estimate Sheet Lead
01.02-Revisions Index of Revision Sheets Lead
01.03-WtIind Re-establish Wetland Reestablishment plans Designer 1
01.04-Stg Acc. Staging and Access Plans Designer 1
02.01-Typ Sections Typical Sections Designer 2
02.02-Alignments Alignment Geometry Designer 2
02.03-Plan Plans Designer 2
02.04-Profiles Profiles Designer 2
02.05-ROW Brk Right of Way Breakout Designer 2
02.06-Drain Drainage Plans Designer 2
03.01-Retaining Wall 1 Retaining wall details Designer 3
03.02-Retaining Wall 2 Retaining wall details Designer 3
03.03-Bridge 00456 Bridge_456 Designer 3
03.04-Bridge 01983 Bridge_1983 Designer 3
03.05-Bridge 01984 Bridge_1984 Designer 3
04.01-Stage 1 Stage Construction Details 1 Designer 4
04.02-Stage 2 Stage Construction Details 2 Designer 4
04.03-Stage 3 Stage Construction Details 3 Designer 4
05.01-SPM Signing and Pavement Marking Site 1 Designer 5
05.02-SPM Signing and Pavement Marking Site 2 Designer 5
05.03-SPM Signing and Pavement Marking Site 3 Designer 5
06.01-IMS IMS Plans and Details Sitel,2,3 Designer 6
07.01-Env 1 Environmental Details Site 1 Designer 7
07.02-Env 2 Environmental Details Site 2 Designer 7
07.03-Env 3 Environmental Details Site 3 Designer 7
08.01-"Utiltiy gtgtyogfagrépgzs For example 07_AT & T, 07_CL Designer 8
09.01-CL&P FIO CL & P For Information Only plans Designer 8
09.02-AT&T FIO AT & T For Information Only plans Designer 8
CTDOT Highway STD *CTDOT Highway Design Standard Index and Sheets Designer 1

required
CTDOT Traffic STD CTDOT Traffic Engineering Standard Index and Designer 5
Sheets required
Figure 47 — Multiple Design Firms CTDOT Project Subsets
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4.2 Contract Plan Format

Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in
accordance with the following:

1.
2.

Nousw

10.

Contract Plans shall be in submitted to CTDOT in PDF format
PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized
34" x 22" for projects created after June 2007
PDF plans shall be measurable to scale in the PDF
PDF plans shall be able to be printed to paper and scaled appropriately
Text must be searchable
All levels must have the ability to be displayed on or off, unless approved otherwise.
All information on the digital contract PDF plans shall have been created from
MicroStation or an approved alternate. The only information that shall be added to the
plans using a PDF editing software are as follows:

e Page labels (see Section 4.14.2)

e Sheet numbers (see Section 4.14.2)

e Watermarks and flatten comments(see Section 5.4)

e Any digital signature fields (see Section 5.5)

e Digital Signature (see Section 5.6)
Discipline subsets shall be published directly from a CAD application. Scanned images or
raster image formats will not be accepted with the exception of For Information Only
sheets, these can be scanned. See Publishing CAD Files for more instructions on how
to publish from Microstation.
Each discipline subset shall contain bookmarks; one for each page.
The first page of each subset shall be a subset cover sheet, this includes FIO subsets.
This cover sheet shall contain both; an index of drawings contained within the subset
that includes both drawing numbers and drawing titles and the form field place
holder(s) which receives the digital signatures. This table must include the subset name
and number displayed as a heading in the table as shown in the figure below.

CT_CON_FPL_0092-0640_05-TRAFFIC &
T T T T T I R T Y O T T W T W T N Y N T W X TS T A T T N R AR

Index of Drawings

r~

05 - TRAFFIC
INDEX OF DRAWINGS

Digital Signature form
jfield place holder

with digital signature

Watermark of
Engineer of Record

Figure 48 Discipline Subset Bookmarks, Index of Drawings, and Signature fields
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11. The first page of the subset 01_General shall be the CTDOT digital project title sheet
which includes an index of the subsets contained within the project, sheet count totals
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for
applying the digital signature(s) (see Section 5.5).

Consultants will need to delete the CTDOT signature blocks on the title sheet and place
a digital signature placeholder as detailed in Section 5.5 CTDOT engineers can find the
digital title sheet in the seed files on our W: drive.

12. The 01-General subset shall include all detailed estimate sheets.

13. The 02_Revisions subset must be included in each digital project and there shall only be
(1) revisions subset.

14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See
Section 7.3. These revision sheets are used for tracking all sheet changes due to
addenda and design initiated change order (DCO) with respect to the entire project.
These sheets are originally blank and unsigned, and shall be managed and updated as
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained
here:

CTDOT Designed Projects - 02-Revisions Subset
Consultant Designed Projects - 02-Revisions CE Subset

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based
on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled;
“For Information Only”. The subset numbers shall be selected by the lead designer so
that the FIO subsets are last. Each sheet shall be numbered correctly, see Section
4.14.2. Upload and attribute in accordance with Section 6.1.

16. Utility drawings shall be submitted in accordance with the following:

e  Utility plans For Information Only (FIO) shall be submitted in a utility subset
based on the utility company, AT&T subset, CL&P subset, etc. These subsets do
not require a digital signature, but each sheet shall be labeled; “For Information
Only”. FIO utility subsets shall be numbered so that they are the last subsets.
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page
labels assigned, see Section 4.14.2

e Utility company designed plans that include work being done by the State’s
Contractor shall be submitted in a utility subset based on the utility company,
AT&T subset, CL&P subset, etc. These subsets do not require a digital signature.
Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels
assigned, see Section 4.14.2

o  Utility plans that are designed by a Consultant firm that include work being
done by the States Contractor shall be submitted in a utility subset based on the
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in
accordance with this manual. Example Labels; 10_CL&P, 11_AT&T. These
subsets must have page labels assigned, see Section 4.14.2

17. CTDOT Standard sheets shall also be delivered digitally. See Section 4.4 for how to
prepare and submit CTDOT Standard Sheets.

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset.
See Section 4.14.2, “Sheet Numbering”

19. As-built information shall be digitally applied to the contract subsets by District
Personnel after the job is complete using Bluebeam. See Section 8.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section,
but do not need to be digitally signed. These review documents shall be uploaded into
the 310_Miilestone Submission folders in ProjectWise in accordance with Section 6.1.

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change
orders in accordance with Section 4.15.2.
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22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the
Discipline Subset PDF Checker in accordance with Section 6.2.

4.3 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For
Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These
sheets shall be placed on a border and numbered in accordance with section 4.14.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.
See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be
scanned, but must conform to the following:

e Minimum Size 22”x34”

e  Minimum dpi = 300.

This link shows an optional procedure that can be used to create a For Information Only subset
that uses Bluebeam: Preparing a For Information Only Subset

4.4 CTDOT Standard Plan Sheets

Standard sheets shall also be delivered digitally into ProjectWise. The following shows how to
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital
project.
1. Download the latest standards from the following link for the project: CTDOT Standard
Drawings Website
2. Upload the standard subset into ProjectWise in accordance with Section 6.1.
3. Next open up the standards from ProjectWise by double clicking on it. Once it opens
click on the index sheet.

ctdot_highway_std.pdf =

& PDF Package

Double click on
the index sheet

V2013 11:18 AM

V20131119 A

% Hyw-0506_01.pdf 7E1 KB TB201311:19 Ak

Figure 49 - Preparing the Standard Subsets
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4. Then enter the project number and check the standards to be included in the project.

Enter Project Number
~onty sTaoARD SEETS waRkED Wi an - ane tn s vRd o IR ) amieses oo and check drawings

A
SMEE 1 H H APPROVAL
T ve ot | o) to be included in Project ot
v Y5 01| eNGWALLS, SL0PE PAVED TNETS AND OUTLETS — [ETen Yo foo| w -
twi-Sfs 02 | TVPE DG & "L ENDWALLS e 71312 06 | S0 sy i e

Hw-she 03 | ENDWALLS FOR PIPE ARCH o 51805 07| MISCELLANEOUS DETAILS FOR BARRIER TRANSITIONS
o7 o1 | Tvee e rCL & oRor InET e e freTEn 2 o1 | TEPORARY PRECAST CONCRETE EARRIER CURS
B 112011 | [ frerses o | rences ano sawars

o370 07 | W BER CTAL BEAR RATL TTARGUARE

E EETE

IE EETE COUBLE -1 11-10-11
L' & ROUND FRECAST CONGRETE CB 131011 VI-G10 02 | WETAL BEAM RAIL (TYPE A-B 350) GUIDERAIL

rionr | || fere-05 | mETAL seam Al (vee o8 350)

ECAST CONCRETE CB DOUBLE GRATE TYPE - |

v
v
v
v
v
d
rd
v
4 ITE I PRECAST CONCRETE CB DOUBLE GRATE TYPE 11-10-11 W-910.04 | METAL BEAM RALL (TVFE R-5 350) SYSTEMS 3, 34, 8 &
| vw-shs 07 | Tvpe "ct s 'CL caTck Basin TOPS AND cuRres 11-10-11 Vi-910 05 | METAL BEAM RAIL R-B 350 SPAN TYPE I, 1L, Il SECTIONS
| wwrshr 08| catcH Basi FramEs AND GRaTES 51505 || [] J#-ot0.08 | Ree 350 GRIDGE ATTACHMENT SATETY SHAPE PARAPET
w-Sh7.09 | HEAVY DUTY LOCK DOWN TOPS 121z || JF310-07 | R 350 BRIDGE ATTACHMENT VERTICAL SHAPE PARAFET
| vweshr 10 | manrol - rrame s cover soen || Vi-91008 | R-8 350 BRIDGE ATTACHMENT TRAILING END
| 1w-ch1 01| FIGURES FOR DATES ON BRIDGE PARAPETS &-09-11 Wi-910 093] MISCELLANEOUS GUIDERAIL TRANSITIONS SHEET 1
W/ vw-ch1 01 | c.cM.PIPE INSTALLATIONS IN FILL & ROCK SLOPES & CULVERT TRENCH DETAL| 71212 -910_09E MISCELLANFOUS GUIDERATL TRANSITIONS SHEET 2
| w102 | siomED oram preE 12 15-18%24"300 (305-361-457-610-762) 71212 o010 10| METAL BERM RAIL 87 (203) X & (152) BOX BEAM
twi-cfa o1 | cuLverT enps 71212 w910 11| CURVED GUIGERAIL TREATMENT DETAIL
| vwrf1 01| unDERDRAINS AND UNDERDRAIN OUTLETS 7-12-12 wi-G10_ 120 MERRITT PARKWAY GUIDERAIL ATTACHMENT - SYSTEM 2 & 3
| tw-afs o1 | paveD DITCH AND PAVED APRON 7-12-12 W-810.120) MERRITT_PARKWAY GUIDERAIL
| rw-gdio| cursme 7-12-12 W-o10 12c| MERRITT PARKWAY GUIDERAIL TRAILING EWD ATTACHMENTS
| w3 01| GRANITE STONE TRANSITION CURBING 10-18-10 W-510_12d|  MERRITT PARKWAY MEGIAN GUIDERAIL AND END ANCHOR
o)1 012 TRANSITION 45° (1145) F-SHAPE TO 45° (1145] VERTICAL SHAPE SHEET 1 12612 | || o0 13 THRIEBEAM METAL BEAM RALL HARDWARE
v TRANSLTION 5" (1145 F-GHAPE 10 45' (1145) VERTICAL SHAPE SHEET 2 10-18-10 W-910 13 THRIE-BEAM TRANSITIONS
'd TRANSITION 45" (1145) F-SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 3 12612 W-910_ 143 THRIE-BEAM 350 BRIDGE ATTACHMENT
7 45 (1145 F_SHAPE PAECAST COWCRETE BARRTER CURB SHEET 1 T2z W-310 14  THRIEBEAM 350 GUIGERAIL TRANSTTION T0 FB 550 GUIDERAIL
| 457 (1145) F-SHAPE PAECAST COMCRETE BARRIER CURB SHEET 2 12612 [W-910_15] MO-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE 1
TRANSITICN - 32" {813) JERSEY SHAPE TO 45 (1145) VERTICAL SHAPE SHEET 1| 1.26-12 HW-910.16] MD-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE II
TRANSITION - 32 (B13) JERSEY SHAPE TO 45 (1145) VERTICAL SHAPE SHEET 2| 10-18-10 Hw-010 17 ReB TERMINAL SECTION
TRANSITION - 32° (§13) JERSEY SHAPE TO 45° {1143) VERTICAL SHAPE SHEET 3| 10-18-10 W-310_18 | METAL BEAM RAIL (TYPE MO-1}
v TRANSITION - 32° (B13) JERSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 4| 10-18:10 W-D10 193] METAL BEAM RAIL (MODIFIED TYPE A-I) AND EWD ANCHORAGE TVPE I
HW-E§1.04al MERRITT PARKWAY NARROW MEDIAN BARRIER 6-09-11 W-910.19b] METAL BEAM RAIL (MODIFIED TYPE R-I) AND END ANCHORAGE TYPE II
| Hw-ef oen] MERRITT paRKWAY - 2 (610) WIDE MEDIAN BARRIER AND ROADSIDE BARRIER 6-09-11 Hw-911 D1 R-B END ANCHORAGE TYPE 1AND I £-00-11
K HW-Ef1 050 TRAMSITION - 45" (1145) F-SHAPE 10 54" (1372) VERTICAL SHAPE SHEET 1 1-2622 HW-911.02] MD-B END ANCHORAGE TYPE L 101610
_@, @ CTDOT HIGHWAY
T T TR — — OFFICE OF ENGINEERING

Figure 50 - Enter Project Number and Check Boxes

5. Delete the standards that are not included in the project as shown below:
ctdot_highway_std.pdf* =

1. Click on the

PDF Packzge standards file

1201211158 Ak
1201211158 Ak
Hw-0506_01.gdf 11812013 17:18 AM

Hy/-0506_02.py 1782012 11:18 AM

Hiw-0508_03.pdf 2. Right Click 118120131118 &M
and select delete
on drawings not
e 0507 G2pdt — included in project

Hyw-0507_01.pdf 1782013 11:18 AM
1782013 11:18 AM
Hyw-0507_03.pdf - 1782013 11:18 AM

Hyw-0507_04.pdf 1782013 11:18 AM

Hyw-0507_05.pdf 1182013 11:18 A

Figure 51 - Deleting Drawings from Standard Set

6. Next digitally sign all index sheets in accordance with Section 5.6.4.
7. Then upload the standards into the 100_Contract Plans folder in ProjectWise in
accordance with Section 6.1 of this manual.
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4.5 Contract Special provisions

1. Digital Contract Special provisions shall be submitted in MS Word format and in
accordance with the Departments policies and procedures for Contract Development.
CSlI special provisions shall be submitted in pdf format.

2. Preliminary special provisions and CSl special provisions shall be combined into (1) pdf
document and then uploaded to the applicable folder under the 310_Review
Documents folder under the project in ProjectWise.

3. FDP and Addendum special provisions and CSl special provisions shall be submitted to
CTDOT in accordance with the following:

For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions in WORD format shall be submitted in
(1) zipped folder.

For projects where a CTDOT design unit is the Project Manager on the project,
the Specification and CSl special provisions in WORD format shall be submitted
in individual zipped folders per discipline.

Addendum special provisions shall be submitted in WORD Format in a zipped
folder. Each page of the specification section shall be marked in the bottom
right corner of the footer with “Addendum No. Y”, where “Y” equals the
addendum number. Also a line shall be placed on the right side indicating
where language was changed in the specification.

Special provisions shall be submitted in a zipped folder for the following
submissions: FDP, revised FDP special provisions, Addendum special provisions,
and revised addendum special provisions. Revised FDP and revised addendum
submissions shall only include the revised special provisions.

FDP, revised FDP special provisions, Addendum special provisions, and revised
addendum special provisions shall be uploaded into the 240 Contract
Development folder under the project in ProjectWise in accordance with
Section 6.1 and attributed in accordance with ProjectWise Attribute Table of
this manual.

4. Design Initiated Change Order special provisions shall be prepared and submitted in
accordance with the following:

On each sheet of the revised specification, “C#” and the date shall be placed in
the bottom right corner of the footer. An example would be “Rev. C1 -
mm/dd/yy”.

For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions in WORD format do not need to be
uploaded into ProjectWise.

For projects where a CTDOT design unit is the Project Manager on the project,
the DCO Specification and DCO CSl special provisions in WORD format shall be
submitted in individual zipped folders per discipline.

The project manager shall combine all the DCO specifications into (1) multi-page
PDF document.

The consultant or state design Project Manager shall follow Section 7.2 for the
submission of DICO specs.
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4.6 Estimates and Quantity Calculations

Estimates
Cost Estimates shall be prepared in accordance with the procedures detailed on this website:

Cost Estimating

Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the
applicable project in accordance with Section 6.1 of this manual.

Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development
folder under the applicable project in accordance with Section 6.1 of this manual.

Calendar Day estimates shall be uploaded into the 240 _Contract Development folder under the
applicable project in accordance with Section 6.1 of this manual.
Quantity Calculations

Quantity Calculations shall be formatted and submitted in accordance with the following:

Shall be native PDF whenever possible.

Scanned pages shall be readable and have a minimum resolution of 200 dpi.

Pages in the PDF can be any size. 8.5” x 11” is recommended.

Shall be uploaded into the 150 — Quantity Calculations folder under the project in
ProjectWise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table of this manual. The final status shall also be applied as
shown in Section 2.5.

4.7 Environmental Permits

Environmental permit applications, permit approvals, and other permit documents shall be
uploaded into ProjectWise and formatted in accordance with the following:
Permit Need Determination Form (PNDF) and Other Permit Documents

Shall be native PDF whenever possible.

The PNDF shall be uploaded into the 320_Permit Development Folder under the project
in ProjectWise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table

Environmental Permit Applications:

Shall be native PDF whenever possible.

Scanned pages in the application must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

All pages, except plans sheets, shall be sized 8.5” x 11”. Plan sheets can be sized up to
34”7 x 22",

Before FDP, each permit application shall be in an individual multi-page PDF file. Each
permit shall be shall be then uploaded into the 320_Permit Development Folder under
the project in ProjectWise in accordance with Section 6.1 and attributed in accordance
with the Projectwise Attribute Table

At FDP, the individual multi-page PDF files shall be uploaded into the 240 _Contract
Development folder under the project in ProjectWise in accordance with Section 6.1 and
attributed in accordance with the Projectwise Attribute Table

Environmental Permit Approval

Shall be native PDF whenever possible.

Scanned pages in the permit must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

Shall be sized 8.5” x 11”.

Before FDP, each permit approval shall be in an individual multi-page PDF file. Each
permit shall be shall be then uploaded into the 320_Permit Development Folder under
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the project in ProjectWise in accordance with Section 6.1 and attributed in accordance
with Projectwise Attribute Table

e At FDP, the individual multi-page PDF files be uploaded into the 240_Contract
Development folder under the project in ProjectWise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table

4.8 Contractor Submittals

See Section 9 for format, submittal and review requirements for Contractor Submittals: Working
Drawings, Shop Drawings, Product Data, RFIl, and RFC.

4.9 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with
the following:
e Shall be native PDF whenever possible.
e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34”7 x 22",
e Shall be digitally signed and watermarked in accordance with Section 5 of this manual.
e Any data files that must accompany the PDF report shall be uploaded into ProjectWise
in a zipped folder.
e The reports and zipped folder for any data files shall be submitted into the
130_Engineering Reports folder under the applicable project in accordance with Section
6.1 of this manual. The final status shall also be applied as shown in Section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
ProjectWise.
Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in
accordance with the following. The content of the report shall be in accordance with the Scope
defined by the Division of Environmental Compliance:
e Shall be native PDF whenever possible.
e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34”7 x 22",
e Shall be digitally signed in accordance with Section 5 of this manual.
e These reports shall be submitted into the 130_Engineering Reports folder under the
applicable project in accordance with Section 6.1 of this manual. The final status shall
also be applied as shown in Section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
ProjectWise.
Rehabilitation Study Reports and Type Study Reports: Shall be created and formatted in
accordance with the Bridge Manual:
e Final reports shall be uploaded into the 140_Project Administration folder in
ProjectWise. The final status shall also be applied as shown in Section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
ProjectWise.
Bridge Load Ratings: Shall be created and formatted in accordance with the Bridge Load Rating
Manual:
e Final load ratings shall be digitally signed in accordance with Section 5 of this manual.
e Final reports shall be uploaded into the 130_Engineering Reports folder in ProjectWise.
The final status shall also be applied as shown in Section 2.5.
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e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in

ProjectWise.
Geotechnical Reports:

e Shall be native PDF whenever possible.

e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

o All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34" x 22",

e These reports shall be submitted into the 130_Engineering Reports folder under the
applicable project in accordance with Section 6.1 of this manual. The final status shall
also be applied as shown in Section 2.5.

e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
ProjectWise.

4.10Project Administration and Project
Correspondence Documents

Project Administration Documents
Final project administration documents shall be stored in the 140_Project Administration folder
under the project in ProjectWise in accordance with the following:

e Shall be in PDF Format.

e Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125
dpi.

e The document must be uploaded into ProjectWise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table of this manual. The final
status shall also be applied as shown in Section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the
Highway design unit sends out a memo for a design review, the discipline attribute on this
document shall be HW.

e Draft project administration documents can also be created and worked on in
ProjectWise. These file shall be located under the user’s discipline 330_Design_Data
folder under the project in ProjectWise.

Project Correspondence Documents
Project correspondence documents shall be stored in the 142_Project Administration
Correspondence folder under the project in ProjectWise in accordance with the following:

e Shall be in PDF Format.

e Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125
dpi.

e The document must be uploaded into ProjectWise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table of this manual. The final
status shall also be applied as shown in Section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the
Highway design unit sends out a memo for a design review, the discipline attribute on this
document shall be HW.

This folder is for all final project correspondence documents. This is defined as any request
memos, response memos, emails, letters, etc. and does not include any documents that are
defined in the 140_Project Administration folder. This folder shall not include any working/draft
documents. The final status shall also be applied as shown in Section 2.5.
e Emails — The sender of the email is required to store a PDF of the email message in
ProjectWise.
e letters
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o Meeting Minutes
e Request Memos — Survey Request, Design Reviews, Support unit design.
e Response Memos — Response to the Request Memos

4.11Project Location (Geo-Spatial Boundary or
Route ID and Mileage)

The project location shall be prepared and submitted in accordance with Section 13.

4.12Design Calculations

Design Calculations for all structural elements on a project shall be formatted and submitted in
accordance with the following:

e Shall be native PDF format whenever possible.

e Scanned pages shall be readable and have a minimum resolution of 125 dpi.

e Pages inthe PDF can be any size. 8.5” x 11” page size is recommended.

e Shall be uploaded into the 151 - Final Design Calculations folder under the project in
ProjectWise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table of this manual. The final status shall also be applied as
shown in Section 2.5.

4.13Electronic Engineering Data (EED)

Electronic Engineering Data shall be prepared and submitted in accordance with Section 12.
4.14 Contract Plan Drawing and Sheet Numbering

Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall
consist of the discipline designator followed by a hyphen and the sheet number. Examples of
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

“"TOWN OF WESTPORT [173-420

r DRAWING NO.

DRAWING TITLE: \ HWY-OI
INDEX SHEET SHEET NO.
04.01

Figure 52 Contract Drawing Numbering

Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are
published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the
number pages and header and footer tools within Bluebeam. Page labels and sheet numbers
shall be applied to all submissions of contract plans.
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The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic
subset shall be 05.01.

Created in Microstation

a

CITY OF NEW HAVEN 4_02-640

SHEET NO,

05.01

DRAWING NO.
T [P™We e Created in Bluebeam q‘(‘ TRA-01

DRAWING INDEX

Figure 53 - Drawing and Sheet Numbering

The page label and sheet number place holder shall be determined by the total estimated sheet
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100
sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders
shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly
assemble the contract plans into a properly ordered consolidated set that District Construction
takes advantage of during construction of the project.

Single Volume Projects:

The page labels and sheet numbers, for single volume projects shall be a concatenation of the
discipline subset number, a decimal point, and the sheet number. For example; the page labels
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03,
etc. or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline
their corresponding subset number, see Section 4.1.

Multi Volume Projects:

For a multi volume project the page labels and sheet numbers shall be a concatenation of the
volume number, a decimal point, the discipline subset number, a decimal point, and finally the
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project
Manager only has to deliver to the other engineers their perspective volume numbers, allowing
them to manage their subset numbers independently of the other discipline volumes and subset
counts, see Section 4.1.

Subset numbers shall start at 01 for all volumes.

BLUEBEAM - Applying Page Labels and Sheet Numbers
To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as
shown below, right click on a thumbnail and select Number Pages:
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[@] ~ Nam

Thumbnails ‘ (1) Se'ECt X
thumbnail icon (2) Right click
on a thumbnail

(3) Select
Number

5 I Pages

Ctri+Shift+R

Ctri+Shift+M
A

Markups List ~ Y

= Subject Measurement

Figure 54 - Adding Page Labels

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at
once. Inthe case where there are 10 or more sheets in the subset the following will have to be
done twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply
to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

f F'anélehlumbering and Labeling ) . (1 ) Select this Sty|e ]

Numbering

(2) Type correct prefix ]

::f;mijpaw_m . (3) Start at 1 for
: sheets 1-9 and 10 for
sheets 10-99

(4) Apply to correct

[ (5) Click Ok
pages

J

Figure 55- Page Labeling

3. Now the pages will be labeled:
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SFD Plans Pages: 31

Thumbnails -~ |:_| |—| PT mockup

Pages are
now
labled

Figure 56 - Labeled Pages

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and

then “Header & Footer”
Edit View Document || Batch Tools Window Help

El] E] () [ Document Properties  Ctri+D 3‘

Ctr+Shift+R
SFD Plans Page

A e : s Ctri+Shift+X

Ctr+Shift+Y
Ctri+Shift+D
Crop P . Shift+Alt+0

Jumber P

_reate Page Labels...

Headers & Footers

Security... Ciri+L

Cirl+Shift+0

Figure 57 - Header Footer Tool
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5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted
as necessary. After you select the font, set the margins, and type in <<PagelLabel>> as
shown below. Then click save for save settings. The next time you are going to apply

sheet numbers to a subset, you can simply select the saved settings. Then click OK.

58-308 SFD Plans pdf

Pages

All Pages (1-31)

Fort

(3) Click (e
Save

[] Fit content inside margins
Margins (Inches)

Top: (0.50
Header and Footer

Header Left

Bottom: |1.00

Right: |1.00

| = \(1) Select these
[ I .
Focter Let options
G‘ageLabel» ) &
I:sert.:‘ Page Number ] [ Date ][ Bates Number ] [ File Data ] (<2<)P-raygpeeLabeI>>
"GST O DRAwNGs

CT_CON_FPL_0120_0036_04-T

04.01 | |

Pages Range (16}

(4) Click OK
-—-"'"'—_—
Co Dimes )

Figure 59 - Insert Sheet Numbers
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Addendum and Design Initiated Change Order Page Labeling
and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change
Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet
numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to each sheet in the addendum or change order. This
can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below and then double click on the page label.
Then type in the correct page label for the sheet.
Revu File Edit View Document  Batch

@ B He BvyD B Q

Select the
thumbnail icon

[] ~ Mame:58-308 SFD Plans Pag

Thumbnails ~ = L

=
H]

Double click on
the page
number and
type in the
correct page

L )

Figure 60 - Adding Page Labels
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3. After all page labels have been applied, the sheet numbers can be applied. From
Bluebeam select the Document tab and then “Header & Footer”

Edit View | Document |Batch  Tools  Window Help

Eﬂ E] (\,‘J} Jocument Properties  Ctr+D I r] » S:: FD

) Plans Page i

= I—‘ | == ighway_STD.

IE
<[
i

[

s & Footers

Girl+L

S s

ocuments...

§7

Ctrl+Shift+0

Figure 61 - Header Footer Tool

4. Select your sheet numbers saved settings from before and click OK. Note the margins
and size may have to be adjusted as necessary.

Pages.

58-308 SFD Plans.pdf All Pages (1-31)

Save Setting| [ Fit contert inside margins
Forit Margins (Inches)
Verdana v|[18 vl B I U
(1) Select
Header and Footer you r save
Header Left Center Right -
settings
Footer Left
<<Pagelabel>>
Insert: | Page Number ] [ Date ] [ Bates Number ] [ File Data
Preview
TRAFFIC - LEGENDS &
LIST OF DRAWINGS
(2) Click OK
CT_COM_FPL_0120_0086_04-T 04.01 b Pl Pages Range (16)

Figure 63 - Applying Addendum or DCO Sheet Numbers
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4.15Consolidating Contract Plan Discipline Subsets
The consolidation of the contract plan discipline subsets is accomplished using the Set feature in
Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view
them in order without actually combining the files.

The project manager shall create a Set file for the project at DCD that contains all the discipline
subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or
Change Order is required for the project, the project manager shall update the set file to include
the Addenda or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of
a project.

See Appendix C for general use of a set file.

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF
checker

When a Set File is Created and Updated
Set File Creation
1. The project manager shall create a set file of all the discipline subsets at DCD, see
Section 4.15.2

Set File Updates
2. If any Addendum subsets are required for the project, these Addendum subsets shall be
added to the set file by the project manager.

3. If any Design Imitated Change Order subsets are required for the project, these Design
Initiated Change Order subsets shall be added to the set file by the project manager.

See Section 4.15.3 for updating the set file.

Creating a Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF
checker

After all the discipline subsets have been submitted into ProjectWise for DCD the project
manager shall create the project’s set file in accordance with the following:
1. Launch Bluebeam from the desktop icon on your computer.

2. Next Click on the Set Icon and select New Set as shown below:
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Revu File Edit View Document Batch

e By@ 2 Q

PT mockup CTDOT_

Figure 64 - Creating a Set File

3. Then click Add and then ProjectWise and OK as shown below:

Set: New Set.bex o [=][==]

File: Mame

Open From =]

4| Type Location Status
'm: ' ProjectWise V10 ctdot projectwiseonline. com:CTDOT Ready
— Froject ps.//studio bluebeam.com Heady
Use Relative Paths My Computer
[ Show Paths
[ Cpen... ] [ Save ] [ Save 4

P —

Figure 65 - Adding Files to the Set File

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except
the standard subsets. Then click Open: After you click Open it may take a minute for
Bluebeam to load all the files into the set, please be patient.
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9 Open Document:

Select

Folder

‘ |=7 100_Contract_Plans (PDF)

LY

Diocumerk
Lael (User Defined) Description Main Category  Sub GafEgory | Sub Category Des m

(1) Browse out to your
project's 100 Contract
Plan folder

FPL Pl

T_CON_FPL_0135-0270_CTDOT_HIGHWAY_STD.pdf Plans_04 - Final P
T_CON_FRL_0135-0270_CTDOT_TRAFFIC_STD.pdf CTDOT_TRAFFIC_STD Flans_04 - Final P

(2) Select all the files

< ' except the standard

Address: |pw‘\\ttdut.pru]ettwlseunhna.[nm‘CTDOT\DD(umEnts\Dl.EI - Prajects - Active|0135-02704100_Contract_Plans (PDF)\[ oL SU bsets and C I | Ck OK Zl
Description: [ ™ "REVISTONS *HWY Detalls & Misc” “HIGHWAY PLANS & SUPERELEVATION DIAGRANS" "5 STA, 5+00 TO 125+00" "WIRETA. 12550 1 coortou Asi 314 219U 10 o0y dsomcrirnal s |
Fils Hame: | "CT_con_FeL_0135-0270_01.01 - General.pdf"'CT_CON_FPL_0135-0270_01L.02 - Revisions pef” ”CLCON,FPL,mas—um: OG- HWY Detal & Misc.pdf 'CT_CON_FPL_0135-0270_01.0¢ - lans & |
Applicatian: [crobat PoF \\ v

Open document as read-only

7~

=~
([_open _[J open from bisk Cancel

Figure 66 - Adding Files to the Set File

5. Next Click on Relative Paths and then click options:

Set : New Set.bex = |[@ ] =]

File Name i
01-01-General_CT_FPL_0040-0136 pdf
01-02-A2-Revisions_CT_ADP_0040-0136 pdf E

01-02-Revisions_A3_CT_ADP_0040-0136 pdf
01-02-Revisions_CT_FPL_0D040-0136 pdf
01-03-Highway_A3_CT_ADP_0040-0136 pdf
01-03-Highway_CT_FPL_0040-0136 pdf
D1-04-Structure_A3_CT_ADP_0040-0136 pdf
01-04-Structure_CT_FPL_D040-0136 pdf

01405-Landscaping_CT_FPL_0040-0136 pdf -
4| i | P

lse Relative Paths =

[] Show Paths

[ Cpen... ” Save ][Sa\raﬂs... [ QK ”Canc:al ]

Figure 67 - Set File Options

6. Next on the sorting tab, make sure all the options shown below are set:
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Set Options

Sorting | Categories I Tags

Shiow: 'File Mame and Page Label

Sort By: lPage Label Onty

[7] Sort Tagged Sheets By Shest Number

Sort Order: lehanumeric Ascending

[7] Stack Multi-Page Documents

Revision Fitter: ’Wildcard

Stack Revisions By: | Fage Label

@dcard Syntac: 7

Previous Revisions: [Cross Out

Cument Revisions: ’ Highlight

|| Copy markups to newly added revisions
Unflatten Marups before Copy
Flatten Markups after Copy

[] Stamp previous revisions "Superseded’

The Wildcard

these things

Figure 68 - Configuring the Set File

7. Then on the Categories Tab make sure the categories are turned off:

Set Options
Sorti Categories |Nags
Categories: [ﬁ]
Categorize By: Sheet Number
Categary Filter
ry
B Cavil C
Landscape
E] Structural 5
Architectural Demolition AD
Architectural A
Interiors I
Flumbing P
Mechanical M
Fire: Protection FP
Blectrical E
Telecom

Figure 69 - Set File Categories

8. Then on the Tags Tab make sure nothing is checked and then click OK:

Issued April 2020

69

Version 5.01

Syntax must be 7#

Uncheck all of



Connecticut Department of Transportation — Digital Project Development Manual

Set Options

el

Sorting|Categoﬁ¥ Tags i
S

Add Tags to sheets within a Set. Tags can be applied manually
or by a user-defined region, which finds text on the sheets via AutoMark.

FER)

N

Tag Mame
Sheet Name
Sheet Number
Revision Number

Type
Text
Text
Number

[l o Tag: Revision Number per Sheet Mumber
= o Tag: Discipline per Sheet Mumber (A4 Standands)
= o Tag: Sheet Type per Sheet Number (AlA Standards)

Figure 70 - Tags Tab

9. Next click Save, this may take a while depending on how big the project is, please be

patient. When the box pops up choose ProjectWise and click OK:

Mew Set.be

File Mame

P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdot. projectwigeoniine, com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F/:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Pz ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTS01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdat. projectwizeoniine. com:CTDOTA01.0 - Projects
P ctdot. projectwiseoniine, com CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects

P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects

(1) Click

- Actived013

- Active’0135-02704100_Contract_Plans (PDFIMCT_CON_FPL_0135-0270_01.01 - General pdf. 6761063

- Activerh0135-02708100_Contract_Plans (PDFICT_CON_FPL_0135-0270_01.02 - Revisions. pdf. 67610,28

- Active’0135-02704100_Contract_Plans (PDFNCT_CON_FPL_0135-0270_01.03 - Hw"' Detail & Misc.pdf 67610,32
- Active’h0135-02704100_Contract_Plans (PDFIMCT_CON_FPL_0135-0270_01.04 - Plans & Super Dia.pdf.67610,29
- Actived0135-027045100_Contract_Plans (PDFACT_CON_FPL_0135-0270_071.05 - Cross-Sections.pdf. 67610,25

- Actived0135-02705100_Contract_Plans (PDFRCT_COM_FPL_0135-0270_071.06 - Cross-Sections.pdf. 67610,26

- Active’0135-02704100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_01.07 - Cross-Sections.pdf. 67610,27

- Active’0135-02704100_Contract_Plans (PDFRCT_COM_FPL_0135-0270_02.01 - Structures.pdf. 67610,80

- Achived0135-027045100_Contract_Plans (PDFMCT_COMN_FPL_0135-0270_02.02 - Structures.pdf. 67610.64

- Active’h0135-02708100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_02.03 - Structures. pdf. 67610.65

- Active’0135-02704100_Contract_Plans (PDFMCT_COM_FPL_0135-0270_02.04 - Structures.pdf. 67610,86

- Active’0135-02704100_Contract_Plans (PDFMCT_COM_FPL_0135-0270_02.05 - Structures.pdf. 67610,87

- Achived0135-027045100_Contract_Plans (PDFMCT_COMN_FPL_0135-0270_02.06 - Structures.pdf. 67610.57

- Activedh0135-02708100_Contract_Plans (PDFIRCT_CON_FPL_0135-0270_03.01 - Traffic.pdf.67610,68

- Active’h0135-027045100_Contract_Plans (PDFIMCT_CON_FPL_0135-0270_04.01 - Landscape.pdf. 67E10.81

- Actived1135-02708100_Contract_Plans [PDFMCT_COM_FPL_0135-0270_04.02 - Invasive Removal pdf. 67610,49
- Activedh0135-027008100_Contract_Plans (PDFICT_CON_FPL_0135-0270_05.01 - General pdf. 67610.71

- Activedh0135-02708100_Contract_Plans (PDFIRCT_CON_FPL_0135-0270_0%.02 - Revisions.pdf. 67610,75

- Actived0135-027M 100 Contract Plans (IPOEBCT CAKM FPL 01350270 05 03 - Civil ndf R7R10.72
P ctdot. projectwizeoniine. com: CTDOTA.0 - Projects -
Fif:ctdot. projectwisgeoniine, com: CTDOTA01.0 - Projects -

Status

Logged In _‘I

— Save

Optiong
SotBy [PagelabelOny /v
4

Sort Type: | Alphanurieric As%ding W |

H
Open... l[ Save ]DSaveAs...]
—

Tupe Loca_tion
Projectwize W8i ctdot. projectwizeonline. com: CTDOT
o FTCTIT CITer,

(2) Choose Projectwise
and click OK

o)) core |
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10. Select the Advanced Wizard, and then on the Select target folder browse out to your
project’s 100_Contract_Plans folder. Then click next until you get to the attributes
page. Attribute the Set File as shown below:

Advanced Document Creation Wizard @ ‘

Define Document Attributes

You should define environment specific document attributes.

(1) Select these

Discipline / attributes

cT -

COM All Cortract Plans & Specs
Sub Category Sub Category Description

Set File Blusbeam Set File (2) Type these

Project Number(s)

01710346 / attributes

Main Category Main Category Description ‘

00-Set File
Description

m

Up to Addendum Mo. 1

CT Code (Auto Fill In}
00-Set File_CT_Set File_0171-0346

CTDOT Asset Tags

Bridge No(s) Sign Structures - .
[ o (3) Click Next until

Signal Intersections Building No(s) the docu ment uploads
4 T | »
< Back Next > Cancel |
e —

Figure 72 - Attributing the Set File

11. Click OK after the set file has been saved into ProjectWise:

File Mame

Pw:ctdot. projectwiseonling. com: CTDOTY01.0 - Projects - Activet0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_01-General pdf. 8237611
P ctdot. projectwiseonling. cam: CTDOTSON .0 - Prajects - Activet0001-00014100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_02-Revisions. pdf. 8237613
P ctdot.projectwizeonling. com: CTDOTSN .0 - Projects - Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001 _03-5upporting Docs. pof.
P :ctdot. projectwizeonline. com: CTDOTAM .0 - Projects - Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001 _04-Civil pdf 82376.1

P :ctdot.projectiwizeonling. com: CTDOTAIN .0 - Projects - Activeh0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_05-Architectural pdf. 823,

SCT_COM_| _
NCT_CON_| |
NCT_CON_| |
% _COMN_| _
Pw/:chdot. projectwizeonling. com:CTDOTY0T.0 - Projects - Actived0001-0001%100_Contract_Plans [PDF]\CT:CDN:FPL_UUM -UDU1:UB-Structural.pdf.82378,3
NCT_CON_| _
SCT_COM_| _
NCT_COM_| _
CT_COM_ _
NCT_COM_| _

P :ctdot.projectwizeonling. com: CTDOTHIN .0 - Projects - Activeh0001-0001%100_Contract_Plans [PDFNCT_COM_FPL_0001-0001 _0F-Plumbing, pdf. 823764
P cctdot. projectwiseonling. com: CTDOTS01.0 - Projects - Actives0001-00014%100_Contract_Plans [PDFISCT_COM_FPL_0001-0001_08-Mechanical. pdf. 8237...
P sctdot. projectwiseonling. com: CTDO TS0 - Projects - Active0001-00014%100_Contract_Plans [PDFISCT_COM_FPL_0001-0001_039-Electrical pdf. 823766
P sctdot. projectwiseonline. com: CTDOTY01.0 - Projects - Active0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_10-Enviranmental pdf.82...
Pw/:ctdot. projectwiseonling. com: CTDOTY01.0 - Projects - Activet0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_11-Traffic. pdf. 82376.8

Add
Options

Sort By |Page Label Only V|

Sart Type: |A\phanurnanc Agcending A | C I i C k 0 K
Y

Figure 73 - Creating a Set File
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12. When the Tags box pops up just click OK:

Tags EI@

Edit tag values here...

File MName Page Label Sheet Name Sheet Mumber Eﬁﬂgigrn -
3 01-014General... | 01.01.01 3

01-01-General .. |01.01.02

01-01-General .. |01.01.03

01-02-A2-Revi... |01.02.01.A2

01-02-Revisio... |01.02.01.A3

01-02-Revisio... |01.02.01

01-03-Highwa... |01.03.04.A3

1-03-Highwa... |01.03.01

01-03-Highwa... |01.03.02

01-03-Highwa... |01.03.03

01-03-Highwa... |01.03.04

01-03-Highwa... |01.03.05

0103 -Highwa... |01.03.06 ~ i

Cancel

Figure 74 - Set File Tag Dialog Box

13. Now the set file has been created. As you see below all the sheets from the files are

listed and crossed out accordingly. For use of the Set File see Appendix C:

Issued April 2020
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00_Set File 0063-0703.bex

07.03-Highway_AL

071.03-Highway_CT_FPL_

[k

Figure 75 - Set File
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Updating a Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF
checker
The following will show how to update a set file. When an Addendum or Change Order is
required for the project, the set file shall be updated by the project manager.

Adding a File to the Set File

1.

Double click on the set file from ProjectWise and open as shown below:

while depending on how big the project is, please be patient.

This may take a

g & op 2, @ | 8 - | searcn| D ~| > interface| CTDOT_Da_Cade | : view| Document | | spatial View: Default View ~| : Badkgr
Address| | pur\\ctdot,projectwiseonline.com:CTDOT\Dacuments\0L 0 - Projects - Active\0135-02701100_Contract_Plans (F | B> Go
¢-3- B
L—: 0036-0093 ~ List |@ Geospatial
B gg::g:g; Description Main Category | Sub Category | Sub Category Description Application
tx 0095-0103 # | 00-Plan Set Updated ta FDP Plans con fa s Plans_08 - Consolidated 4j3
% 01020278 con AL Plans_04 - Final Plans {Adv) Acrobat PDF 45
(%% 0102-0317 /Bl o1.02 - Revisions REVISIONS con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 31
% 1020325 7 [B) 01.03 - Huy Detail & Hi¥ Detalls & Misc con FrL Plans_04 - Final Plans {Adv) Acrobat PDF ajey
(% n02-0328 7 [B) 01.03 - Huiv Detail_ant Pages from CT_COW_FPL_0135-0270_01.03 - HW...  CON ADP Plans_05 - Addenda Acrobat PDF 43
[ o104-0154 7 [B) 01.04 - Plans & Super Dia HIGHWAY PLANS & SUPERELEVATION DIAGRAMS  CON FrL Plans_04 - Final Plans {Adv) Acrobat PDF 3t
[ o104-0167 7 [B) 01.05 - Cross-sections XSC 5TA. 500 TO 125400 con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 3t
1 01050206 ./ [B) 01.05 - Cross-Sections C STA. 125450 TO 245450 con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 3t
(% n107-0158 _/‘@ 01.07 - Cross-Sections XSMSTA. 245400 TO 350400 CoN FPL Plans_04 - Final Plans (adv) Acrobat PDF 3
L_: 0108-0178 / Bloz.o1 - structures 135-2% Final design Plans_Structures con FPL Plans_04 - Final Plans (adv) acrobat PDF 3j2
e 0105-0162 2 Bl 0z.02 - structures 89-125 F3Q_Structures con FAL Plans_04 - Final Plans {Adv) acrabat PDF 3
A oLie-nizz /Bl 02.03 - structures 9-126 FOP Nfructures o o "= 4 - Final Plans {Adv) Acrobat PDF 3t
-4 Eﬁggiﬁ /Bl oz.04 - structures 135-304 FOP - Mguctures - 4 - Final Plans (Adv) Acrobat POF 4f
&5 g
B 7 Bl oz.05 - snuc ) Double CI|C|( &| bat PDF af
L—x 0115-0117 /.a 02.06 - Struct w< Open document with . ] . o
i 2 e 0z R on the set file b
[ 01160133 03,01 - Traffid et | at PDF 311
(% piie-n1s / Blos.01 - Lands and click OK bat POF 3z
(2% 0117059 ZBlosoz-owesi| | program bat PDF 32
[ 0118-0163 ./ [B) 05.01 - Gener| bat POF 3pz
7% o120-0081 / [B) 05.02 - Revisi Mame Descriptio Application Enc bat POF 31
% o120-0086 ./a 05.03 - Civil % Blusbeam Revu Set Bluebeam RewMGet "C:\Program FilesiBluebeam Software\Blusbeam RevulRevulRevu.exe”"... Mo bat PDF 3j12
[ o124-0182 /Bl 05.04 - struc] bat POF 3pz
L% 0124-0185 7 Bl 05.05 - Existir bat PDF 3z
[ o1ze-nie2 ./ [B) 05.06 - Envvr hat PDF 3i2
(2% n127-0088 _/‘@ CTDOT_HIGH! bat PDF 211
¥ 1300173 7 Bl cTooT_TRa bat PDF 11
%% 0130-0178
% 0131-0191 ) )
[ 0131-0194 & 0131-0195 -
[ ovato1g7 Document Propeties|
(%% m131-0202 T
%% 0133-0094
(% 0133-0095
=% o135-0270
& €} ADMINISTRA|
[ 100_Conkrack_Plans (PDF) € Ene-admin
L= 110_Contract_Specifications {(PC g CDI-Admin < >
[ 120_Cankrackor_Subrmittals (POF € Qs -admin
s ;iE7?:"\7trthseu\m;|(aliM\s(7Rw [
G onstruction )
-~ a0 e € & Consulant £
=2z .
[ 230_Contract_Administration éac”dec"a” Click here For a st of suggested document viewers
[ 240_Contract_Development CTDOT_Cont
[ 241 _Contract_Devslopment_Col €5 cT00T_Eng |
L 310_Preliminary_Design_Docume € CT0OT Proc) S
[ 320_Permit_Applications € ctat-servic —
[© 330_Design_Data € Dave.Brumba... Dave Brumbaugh BENTLEY 5B F F FFFF F F F C
{7 340_drinistration € Extraction Service Account Ext... B F F F F F F F F F C
LT - I e S = = = = =~ = = = = @—=

Figure 76 - Opening a Set File
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2. Next click on the Set icon and click Add as shown below:

CTDOT_Highwe

TOWN AND

Set: 00_Set File_0063-0703.b = 3
e = = e GROTO!

File Name i | . THOMAS
A :

01.01-General _CT_FPL_0063-0703.pdf : '

01.02Revisiens_ADpef OpenfFrom PA

01.02-Revisions_AQ5.pdf Tuoe Locaiion Statuy PIECT

01.02-Revisions_CT_FPL_D063-0703 pdf
01.03-Highway_AD2_0063-0703 pef
01.03-Highway_A03_0063-0703 pdf
01.03-Highway_ADS_0063-0703 pef
01.03-Highway_CT_FPL_0063-070
01.04_Traffic_AD3_0063-l

ps:/¥etgovdot sharepoint com/sites. e
https .//ctgovdot sharepoint. com/projec...  Ready
ps.//ctgovdot-my sharepoint. com/pe... Logged In
govdot sharepoirt com/teams... Ready

SharePoirt
SharePoirt
I My Computer From

Use Relative Paths
[] Show Paths

PRAVECT LENGTH

SEMI-FINAL DE
APRIL 2

Figure 77 - Modifying a Set File

3. Next browse out to your project and select the files to add to the set and click Open.
This may take a minute to add the additional file to the set so please be patient. After it
finishes click OK.

Select
Folder
[ 100_Cantract_Plans (PDF)
[ ]
Docurnent
Name Description Main Cateqe
7
BT _con L X (1) Browse out to
# Bl cT_con_FrL_0135-0270_01.02 - Revisions pdf 01.02 - Revisions REVISIONS con R
# B CT_CON_FRL_0135-0270_D1.03 - HWY Dietal & Misc.pf 01,03 - HWY Detall & Misc HiY Details & Misc con your p rOJECt
/B CT_con_FRL_0135-0270_D1.04 - Plans & Super Dia.pdf 01.0% - Plans & Super Dia HIGHWAY PLANS & SUPEREL...  CON
# B CT_Con_FRL_0135-0270_D1.05 - Cross-Sections pdf 01.05 - Cross-Sections H5C STA, 5+00 TO 125400 con e Fians_ - rinai
# B CT_coN_FAL_0135-0270_D1.06 - Cross-Sections pdf 01.06 - Crass-Sactions SCSTA, 125450 TO 295450 CON FRL Plans_D4 - Final
# B CT_con_FRL_0135-0270_01.07 - Cross-Sections pdf 01.07 - Crass-Sections HSCSTA, 245400 TO 350400 CON FPL Plans_D4 - Final
# Bl cT_con_FAL_0135-0270_02.01 - Structures.pef 02.01 - Structures 135-270 Final design Plans_St... CON FRL Plans_D4 - Final
& B cr_con_FrL_0135-0270_02.02 - Structures.pef 02.02 - Structures 5125 FDP_Structures con FRL Plans_D4 - Final
# B CT_con_FAL_0135-0270_02.03 - Structures.pef 02.03 - Structures 126 FOP_Structures con FRL Plans_D4 - Final
/B cT_con_FAL_0135-0270_02,04 - Structures.pef 02,04 - Structures 04 FDP - Structures con FRL Plans_D4 - Final
# B CT_con_FAL_0135-0270_02.05 - Structures.pef 02.05 - Structures 135-35 FOP_Structures con FRL Plans_D4 - Final
/B cT_con_FAL_0135-0270_02,06 - Structures.pef 02,06 - Structures FOP_Teal Sign Suppert Det... COH FRL Plans_D4 - Final
# B CT_con_FRL_0135-0270_03.01 - Traffic pdf 03.01 - Traffic con FRL Plans_D4 - Final
/B cT_con_FAL_0135-0270_04.01 - Landscape pof 04.01 - Landscape Landscaps Ygsign Flans con FRL Plans_D4 - Final
# B CT_CON_FPL_0135-0270_04.02 - Invasive Remaval paf 04.02 - Invasive Remaval 04,02 Invasid Vegetation Re...  CON FPL Plans_D4 - Final
/B cT_con_FAL_0135-0270_05.01 - General pdf 05.01 - Gereral con FRL Plans 04- Final
# B CT_CON_FPL_0135-0270_05,02 - Revisions df 05.02 - Revisions Inde of Revisio o« -
/Bl cT_con_FRL_0135-0270_05.03 - Civil,pdf 05.03 - Civil cc (2) Select the flle
# B CT_CON_FPL_0135-0270_05,04 - Structural o 05.04 - Structural =<
7 Bl cT_con_FAL_0135-0270_05.05 - Existing Plans.pdf 05.05 - Existing Plans « to be added to
# Bl cT_con_FRL_0135-0270_05.06 - Envirenmental.pdf 05,06 - Envirenmental c -
# Bl cT_con_FAL_0135-0270_CTDOT_HIGHWAY_STO.pof CTDOT_HIGHWAY_STD Standard Details « the set and click
# B CT_con_FRL_0135-0270_ZTDOT_TRAFFIC_STD.pdf CTDOT_TRAFFIC_STD CTOOT_TRAFFIZ_STD o) pen
< >
Address: pwilictdat projectwiseanling comiCTDOT|Documents|01 .0 - Projects - Active|0135-02701100_Contract_Plans (POFY|CT_COM_ADP_01§5-0270_01.03 - Hwr¥ Detail_a01 pdf ~
Description:
File Hame: CT_CON_ADP_0135-0270_01.03 - HWY Detal_AD1 . pf
Application: Aercbat FOF ~
[¥] Open document as read-only
t Open ,ODEn From Disk Cancel
T m—

Figure 78 - Adding Files to the Set File
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4. Now the file will be added to the set, scroll down and you will see it.

=1 q
[=] =
|=| 00 0063-070
~
HC =
- “““‘%\
o
x\{

“‘».\ ’.—

S P
ol N

- T

: Latest version
:-_:-_— e added

-

Figure 79 - Set File

Deleting a File from the Set

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

1. Double click on the set file from ProjectWise and open as shown below:
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ProjectWise Explore

8 (SELECTseries 4)

N &0 @ © §a - searcn (D v| P> : Interface| CTDOT Doc_Code | i vien| Document ~|  spatial View: Defaut View | i Backar
Address| ] pusictdot. m:CTDOTD! 0 - Projects - Adtive\0135-0270\100_Cantract_Plans £ | B> Go
7% 0098-0093 ] List | @ Geospatial|
"% 009s-0101
% omseoinz Description Main Category | Sub Category | Sub Category Description Application
(% oose-0103 /) 00-Flan et Updated to FDF Plans con hs Flans_08 - Consolidated 43
0% o10z-0278 con L Plans_04 - Final Plans (Adv) Acrobat FDF 45
(% ninz-oar - Revisions REVISIONS con L Plans_04 - Final Plans (adv) Acrobat PDF 3i1
(% 0102-0325 - HY Detal & HWY Detals & Misc con L Plans_04 - Final Plans (adv) Acrobat POF 3127
(% 0102-0328 - HiHY Detall_AD1 Pages from CT_CON_FPL_D135-0270 01,03 - HW...  CON AP Planis_05 - Addenda Acrobat POF o3
{7 0104-0164 - Plans & Super Dia HIGHWAY PLANS & SUPERELEVATION DIAGRAMS  CON L Plans_04 - Final Plans (Adv) Acrobat FDF 3
%% o104-m67 - Cross-Sections ¥5C STA. 5+00 TO 125+00 con L Plans_04 - Final Plans (adv) Acrobat PDF 3
{2f 01050206 - Cross-Sections iC STA, 125+50 TO 245+50 con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3
‘r: 0107-0158 - Cross-Sections ¥SZTA, 245+00 TO 350400 con FRL Plans_04 - Final Plans (Adv) Acrobat POF 3
L;' 0108-0178 - Structures. 13529 Final design Plans_Structures COM FRL Plans_04 - Final Plans (adv) Acrobat PDF 3z
‘r,‘ 0109-0162 - Structures 89-125 FQ_Structures con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3f
= E:ggi: - Structures 89-126 FOPpuctures o - "e=- 4 - Final Plans (adv) Acrabat PDF El
b - - Strucures . 4 Final lans (i) Acrobat POF 4
5 e ; Double click b0 4
U7 01150117 e Open document with st FOE ¥
el -
W oneotzs ) on the set file e o
M 01164 Lands{ H bat POF 3z
(% n116-m134
T niimote “twes] | Program and click OK purr
M 01184 Gener bat: PDF ajz
(% 1180163
{7 01z0-0081 - Revisi Hame Descriptio Application Enz bat PDF 3i
%% 0120-0086 - Civil % Bluebeam Revu Set Bluebeam Reviget "C:\Program Mo bat POF 312
% 01240162 Struct bat: PDF ajz
i, rut at
(% n124-0165 Existi bat: PDF 34z
*t 0126-0162 -
o .06 - Envir bat PDF £
2% nie7-o0ss CTDOT_HIGH bat PDF 2
L‘—" 0130-0173 CTDOT _TRAF] bat POF 1t
% 0130-0178
%% 0131-0191 4]
% 0131-0194 8.0131-0195
E‘ o oios | Document Propeiti
7% 0131-0198 Real (Documen ¥
[ 0131-4
s Zone
0% 01334
% 0133-0095
£ 01350270 € AOMINISTRA|
L:. 100_Contract_Plans (PDF) € brp-Adnin
o 11o,cUntractjueckijmat\u‘ns( (FT € o-adnin L] B
{7 120_Contractor_Subittais (POF CLs-Admin Coome ]
5 130 3l Archaselicel 1R p
L 210_Construction = =
{7 220 FHwA EEconsukant £ ©pen documet: as read-only
{7 230_Contract_Administration € crcotechen] |y e For s of sugaested corument viwers
(= 240_Contract_Development € CTO0T Cont
[ 241 _Contract_Development_Cor €5.CT00T Fng |
i € CTOOT_Proc. o
{7 310_Preliminary_Design_Docume E —_—
| 320_permit_applications € ctdor-servic
[ 330_Design Dats € pave Brumba... Dave Brumbaugh BENTLEY a F FFF FFFFF T
[ 340_Administration € Extraction Servics Accourt Ext... a F F F FF FF F F F F -
ek =0 - - S e e

Figure 80 - Opening a Set File

2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

Set: Mew Set.bex

File Mame

01-01-General _CT_FPL_0040-0136 pdf
01-02-A2-Revisions_CT_ADP_0040-0136 pdf

_FPL_0040-0136 pdf
]

m

—)

Usze Relative Paths

[T Show Paths

[ Cpen... ” Save ][Saveﬁs...

)cancel

Figure 81 - Deleting a File from the Set File
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Section 5 Digital Signatures for Contract
and Other Engineering Documents

The follow contract documents must be digitally signed when submitted to the Department in
accordance with the following section:

e Contract Plans — FDP, Addendum, Change Orders

e Engineering Reports

o Hydraulic Report
Scour Report
Floodway Report
Final Drainage Reports
Bridge Inspection Reports
Bridge Load Ratings
Task 110
Task 220
o Underground Storage Tank System Closure Reports

e Working Drawings for Permanent and Temporary Structures — Plans and Calculations

O O O 0O O O O

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures.
The Engineer of Record or document signer will always digitally sign using a visible certifying
signature. If multiple signatures are required per document, the second signer or sub-engineers
shall always digitally sign using a visible signing signature after the primary signer or engineer
has applied his certifying signature. Certifying signatures allow controlled changes, to the now
certified document. These controlled changes include; allowing PDF digital comments, and the
application of additional signatures. Signing signatures should always be accompanied by a note
listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the
first sheet of the document, regardless of the number of pages the document contains. This
digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following
purposes:
e It shall be attached to the digital signature and displayed when the digital signature is
applied.
e It shall be placed as a watermark on all contract plan sheets a particular engineer of
record is responsible for (digitally signing for).
e It shall be placed on the first sheet by the preparer and checker of an engineering
report.
e The watermark shall be placed on all contract plan sheets and all plan sheets contained
in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the
special provisions of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List
(AATL). The necessary hardware and software needed to apply the required digital signatures
may be purchased from the vendor list provided at the following website:
http://www.adobe.com/security/partners cds.html, additional information on Adobe’s CDS is
also available at this website.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
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5.1 Graphic Image of Signature

Contract Plans

The following figures display an example of both a state designer and a consultant designer’s
digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2.
for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state
employee’s graphic image must contain only his signature. See Below.

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

=~ -| 1% page of Subset

- State Design
Digital Signature

AL W

L. Consultant
““% Digital Signature

Scanned Signature "Graphic Appearance”

Figure 82 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages
be watermarked with a copy of the engineer of records graphic signature before they are
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are
always placed in the border of contract plans and working drawings for permanent structures.
This is to prove validation of a digital document if printed.

Watermark of State Design Graphic
Signature

- — -t ]
SCALE; 33" = 1|_0-.l\j SCA

> W PROIECT T
7| OFFICE OF ENGINEERI
APPROVED BY: DATE: N

plotar ) W/

Watermark of Consultant Designers
Graphic Signature

TS,

B

au ok,

Seeomey  consuient o, &
Address

Figure 83 — Watermarks
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Engineering Reports
Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic,
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital
signature of the Approved Hydraulic Engineer. The digital signature must include the graphic
image of the signer’s PE stamp and signature as shown below, Section 5.2. for instructions on
how to create a graphic image. These reports shall be digitally signed in accordance with

Section 5.6.7

May, 2014
Revised November. 2014

Prepared for:

Siate of Connecticut

Digital Signature oc.oiment o ronssortation

J FINAL HYDRAULIC ANALYSIS REPORT

pproved By: Bl'idge NO. 00]45
W Project No. 170-2811 (P.E.)
‘}i’%:;;%%‘;— David M. Cicia State Project No. 83-261

4 M7 2014.11.03 F.A.P. No. 0951(351)
"g’&ﬁ?ﬁf 09:33:38-05'00 I-95 over Wepawaug River

Lt Milford, CT

Prepared B_\«D:llc: 11/4:2014

Checked By: = Date: 11/4/2014 c h ecC ke r

David Cicia

Figure 84 - Engineering Reports
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Bridge Inspection Reports

The following shows how Bridge Inspection reports are to be digitally signed in the bottom right
hand corner of the report. The digital signature must include the graphic image of the signer’s
PE stamp and signature as shown below, Section 5.2. for instructions on how to create a graphic
image. These reports shall be digitally signed in accordance with Section 5.6.7

Inspection Type: Routine and Fracture Critical

BRIDGE NO.08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015
Inspected by:  TranSystems
- % T_’_g-::

Digital

Signature\;/

Mathew J.
Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 85 - Bridge Inspection Reports
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Bridge Load Ratings
The following shows how Bridge Load Ratings are to be digitally signed. The digital signature

must include the graphic image of the signer’s PE stamp and signature as shown below, Section
5.2. for instructions on how to create a graphic image. The load ratings shall be digitally signed
in accordance with Section 5.6.1

STATE OF CONNECTICUT
DEPARTMENT OF TRANSPORTATION

LOAD RATING

Bridge No. 00634

Silver Street

over

Route 9

Middletown

Andrew Lessard
,2018.01.02
" 16:23:28-05'00'

BY PLACEMENT OF THE PROFESSIONAL ENGINEERING STAMP AND SIGNATURE | HEREBY
STATE THAT | HAVE PERFORMED AN INDEPENDENT CHECK OF THE METHODS, ASSUMPTIONS,
LOAD DISTRIBUTION, COMPUTER INPUT FILE(S) AND ALL CALCULATIONS FOR THIS LOAD
RATING REPORT FOR THE BRIDGE NUMBER STATED ABOVE. BY STAMPING AND SIGNING
ABOVE, | CONFIRM THAT | AGREE WITH ALL METHODS, ASSUMPTIONS, LOAD DISTRIBUTIONS,
AND CALCULATIONS CONTAINED IN THIS RATING REPORT.

% Stantec

Stantec Consulting Services Inc. James Fuller
55 Church Street Suite 601, New Haven, CT 06510 12/22/2017 (203) 495-1645

Version 201610

Figure 86 - Bridge Load Ratings

Environmental Compliance Reports
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure
Reports must include a graphic image of the Professional engineer’s signature or a graphic
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image of the signer’s signature where applicable, see Section 5.2. for instructions on how to
create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7

Working Drawings

Working Drawings for Permanent and Temporary Structures

The following shows the digital signature and Professional Engineering watermark requirements
for the engineer who prepares the working drawing submittal. These types of submittals shall
be digitally signed in accordance with Section 5.6.6 Note: Working Drawing for Temporary
Structures only require that the first sheet in the submittal be digitally signed, watermarks are
not necessary. See Section 5.2 for instructions on how to create a graphic image.

Working Drawing Plans

The first plan sheet in the submittal shall have a digital signature and a watermark placed on it
as shown below. All others sheets will only have the watermark. A place in the border of the
plan sheets shall have a spot for this watermark.

BEAM END PAINTING AND BEARING REPLACEMENT IN DISTRICT 2.

CONNECTICUT DEPARTMENT OF TRANSPORTATION |
STATE PROJECT NO. 172-405

BRIDGE #3415 & #3416 - WORK PLAN

T omwmemon
DRAWING Na. | DRAWING TITLE T
000101 JcoveRsheer
13002-01-02 | GENERAL NOTES
130020103 | JACKING PROCEDURE
130020110 |PLATFORM PLAN
- ; 30020111 [pLATrORM PN
- Digital Sighature LWz |woan pan

130020113 | moana puan
130020120 [PLATFORM SECTION

130020121 _|pLATrORM SECTION
130020122 _|PLATFORM SECTION
13002.01-23 | PLATFORM WALKWAY
130020124 |STARCASE

130020130 | JACKNG DETAL

130020131 | ACKING DETAIL

130020140 _| CONTAINMENT SECTION
13002-0141_| CONTAINMENT SECTION
13002-01-56 | CONTAINMENT DETAIL

A William Pratt
4. 2014.03.12
13:49:10-04'00'

130020160 | CONTAINMENT NOTES
13002.01-61 | CONTAINMENT NDTES

Watermark

Figure 87 - Working Drawing for Permanent Structures

Working Drawing Calculations
The first sheet of the calculations shall have a digital signature as shown below:
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ABHE |
SvosonA
INC.

I BRIDGE BEAM END AND BEARING REPAIR |
IN DISTRICT 2

| CONNECTICUT DEPARTMENT OF |

| TRANSPORTATION |

PRQOJECT NO.172-405, ASI JOB NO.13002 |
(BRIDGE #3415 & #3416) |

i Calculations

DFgltaI y A William Pratt ‘
L i 2014.03.12

Srgnature 43 13:49:10-0400 ‘

|
Abhe & Svoboda, Inc. ‘

| 17066 Revere Way, Prior Lake, MN 5537

June 24, 2013

| Abihe & Svcboda, Inc. s an Equal Oppartunity Emgloyer

Figure 88 - Working Drawing for Permanent Structures

Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic
image of the signer’s signature attached to their digital signature. See Section 5.2. for
instructions on how to create a graphic image.

5.2 Creating Graphic Image of Signhature:

In House CTDOT or Non-Professional Engineering Signature:

The graphic signature will be used by CTDOT employees and signers that are not signing as a
Professional Engineer.

CTDOT graphic signatures shall be created as follows:

Signer must sign a blank piece of paper.

Scan this signature.

Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
Save the images, in PDF to an area on your PC.

12 30—

Figure 89 (Example of CTDOT Graphic Image of Signature — Used with Digital Signature and as a Watermark)

PwnNPE

For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall
accompany their digital signatures and a different one that shall be placed as a watermark on all
the plan sheets the engineer is signing for.
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This section shows an example of a Professional Engineer preparing their graphic image of their
signature; Architect’s shall follow this section when they are preparing their digital signature.
Graphic Appearance Attached to Digital Signature

The graphic signature that accompanies the digital signature only needs to include the
designer’s signature and P.E. Stamp., and shall be created as follows:

Stamp and Sign a blank piece of paper.

Scan this signature.

Crop the image to approximately 250 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the signature set-up procedure.

\}\“Illl[,

\) /,
Nor 2MWecly,

PwnNPE

Figure 90 ((Example of Consultant Engineer Graphic image of Signature — Applied to 15t page only with digital signature)

Graphic Appearance used as a Watermark
In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a

watermark shall also include the designer’s company name and address, and shall be created as
follows:

On blank paper — Print company name and address.

Place P.E. stamp next to company name and address.

Sign P.E. Stamp.

Scan the image created in steps 1 thru 3 above.

Crop the image to approximately 500 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the watermarking procedure.

ok wnNpE

Figure 91 (Example of Consultant Engineer Graphic image of Signature — applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature
appearance preferences must be set as follows:
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5.3 Setting Digital Signature Appearance
Preferences:

Once the graphic signatures are created the digital signature appearance settings must be
defined as follows:
Bluebeam Digital Appearance

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the

Document tab and select Signatures>Digital ID’s:
[
Document  Batch Tools Window Help

% [fi‘f] @ O Markup

Stamp

Measure
Sketch to Scale
) ) Form e T EET -
CTDOT_Highway 08 SFD Plans* {
Signature e Sign Document

Hyperink o ShitteH [ Certify Document...
File Attachmel?
Toolbars 5 Digital IDs...

R Trusted ldentities...
leuse

Figure 92 - Digital Appearance

Next cI|ck on your ID and click Manage Appearances:

“1 5 MR (1) Select ID

M arne Location

A=t d:\Documents and Settingscalkinsmhapp
M athew Calking Windows Certificate Store D@

% (3) Double Click

|
X &6 (4]

|dentity

— ;. Mathew Calking lzgued By -
Organizationaglnit Starts:
= Organization M&me:  AEC Applicat Expires:

. mathew. cgillined@ict. gov

Dijafital Signatures and Dlata Encrpption

= [E:-cport (T_Manage.ﬁ.ppearances
‘-—: (2) Click Manage

E——
Appearance

Figure 93 - Manage Appearances

3. Next follow the figure below:
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Signature Appearance @
== —) 4— Type in Name
Graphic
) Mone
:.._ Nams Browse to graphic
@ File D \Usershcalkinsmj\Desktopmijc pe jpg E]) k_ g p
Posttion: @ Left ) Right () Background appearance
Tt ~
af [ Name »”
v %E:ct:ﬁgoufhed Heme Alignment: @DD / Make Sure these
) Coract o o settings are set
N~ -~ T as shown
Fort Size: |3 Auto \ [ Loge
Preview
<Name>
<Reason> ]
Click OK
<Date>
Co D)

Figure 94 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.

5.4 Watermarking Plans with Graphic Image of
Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a
copy of their graphic signature as a watermark on each sheet of each discipline subset, or
working drawing submittal(Plans and Calculations) that they are responsible for. For
Engineering Reports the preparer and checker of the report shall place a copy of their graphic
signature as a watermark only on the cover of the report.

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant
Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The
following shows an example of a CTDOT signature, but the procedure is the same for a
consultant when they are placing their PE stamp in the border or on the first sheet of an
engineering report.

Watermarking Workflow:

Option 1
1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup

tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not
in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

Issued April 2020 86 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

l pr—

Place stamp in this
area in the border ——

F CONNECTICUT

JF TRANSPORTATION

SLOMATURES
BLOCK

OFFICE OF DNGINEERING

APFROVED OY:

145 Buck Ban,dan

T o 8
b S

PROJECT  TITLE:

Figure 95 - Placing Watermark

3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an
engineering report you do not need to apply to all pages.

I STA.
[LENGTH

Cut Cirl+X
Copy Ctrl+C
Paste Cirl+V
Format Painter  Cirl+Shift+C
Delete Del
Open Pop-Up Note

Change Colors

Layer

Order

Alignment

Edit Action... CtrShift+E
Capture...

Flatten

Lock Crl+5hift+L

Legend

Add to Tool Chest

efault

Apply to All Pages

Properties

04.01.401 (1

Figure 96 - Placing Watermark on All Pages

If more than one group has to watermark this subset, browse to the pages the other group is
responsible for and delete the watermark. Then they can come in a place their watermark on

these sheets.
Flatten Markups

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF
document. Go to Document>Flatten Markups. Use the default settings and click OK.

1. After the watermarks have been placed on the subset, the watermarks must be
“flattened” to the PDF document. Go to Document>Flatten Markups. Use the default
settings and click OK.
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5.5 Digital Signature Fields

Contract Plans

Digital signature fields are form fields created using Bluebeam, and are used to house the digital
signatures. Digital Signature form fields shall be placed within the form field place holders. The
form field place holders are cells that are placed in the MicroStation file on the title sheet and
the subset cover sheets and on any Addendum or Change Order Subset. The figure below
shows a CTDOT designed project with the form field place holders (circled) on the title sheet and
the discipline subset cover sheet.

H’,‘!C CONNECTICUT DEPARTMENT OF TRANSPORTATION o

EDIT FOR -
PROJECT
TITLE

## - SUBSET NAME

nisfc
T Fi

TOWNS AND/OR INDEX OF DRAWINGS
CITIES

000-0000 L

Figure 97 - Digital Signature Fields

The figure below shows a consultant designed project’s title sheet and discipline subset cover
sheet with their form field place holders.

ﬁ CONNECTICUT DEPARTMENT OF TRANSPORTATION @

REPLACEMENT OF ## - SUBSET NAME
BRIDGE NO. 02301, ROUTE 43 INDEX OF DRAWINGS
OVER HOLLENBECK RIVER

CORNWALL

i 0031-0128 [ = = 2;_._

Figure 98 - Consultant Watermarks

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT Digital Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each
discipline subset for each required digital signature.

Note: All signature form fields need to be created for both certifying and signing signatures
before any digital signatures is applied to the document.

Contractor Submittals
Contractor submittals will not be required to have a digital signature place holder.

Engineering Reports
Engineering reports will not be required to have a digital signature place holder.
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Bluebeam - Creating Digital Signature Form Fields

The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed
01-General title sheet, only one digital signature form field needs to be placed.

1. To place signature fields click X.

2. Next place three signature fields in the appropriate location and hit save as shown
below:

THE DESIGN APPCARS TO CONFORM TO APPLICABLE CRITERIA, APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEM PERSONALLY CHECKED BY THE UNDERSIGNED.

SUBMITTED BY TRANSPORTATION PRIMCIPAL ENGINEER P.E.
(>

WPPROVAL RECOMMENDED BY MANAGER OF STATE DESIGH - SCOTT A HILL P.E.
[

APPROVED TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 99 - Placing Signature Fields

5.6 Applying Digital Signatures
This section describes how to apply digital signatures for contract plans, engineering reports,
working drawing plans, and working drawing calculations.

Contract Plans
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic
Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded
into ProjectWise because the Principal Engineer will be looking in ProjectWise to digitally sign
documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of
record, using a single visible certifying signature, applied to the signature form field located on
the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of
Record who is responsible for the most sheets in the subsets. This engineer will apply a visible
certifying signature in the top most form field. The next Engineer of Record shall apply their
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when
applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital signature form fields, previously. See Section 5.5

Engineering Reports
Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying. See
Section 5.7 for instructions on how to apply a certifying signature to an engineering report.
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Applying Digital Signatures to 01 General Subset (FDP and
Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General _A#
subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead
discipline’s Principal Engineer, using a certifying signature. The Principal Engineer should make
sure that all three digital signature form fields (blue boxes in the signature block) are placed
before signing, as these forms cannot be added after the document is digitally certified. After
processing has approved the 01_general subset for Advertising, the Manager, and the
Transportation Engineering Administrator shall digitally sign the same sheet directly below the
principal’s signature, using a signing signature while the plans are in the Manager and Engineer
Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager
and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by
the Manager and Engineering Administrator of the 01_General subset. When both signatures
are applied to the plans, the lead designer shall then notify processing that the 01-General
subset has been signed.

See Section 5.7 Applying Digital Signature Workflows

Note: When digitally signing the 01_General subset all signers shall leave the reason code
blank.

The following image shows a typical project title sheet from the 01_General subset that is
digitally signed:

YV YT RN T TR YTV RIY EYRNZRTNT

iyi CONNECTICUT DEPARTMENT OF TRANSPORTATION @

UPGRADE =

SIDEWALK RAMPS
Tammterrc ot

NEW HAVEN

0092-0655 |-+

THE DESIGN APPEARS TO COMFORM TQ APPLICABLE CRITERIA, APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEN PERSONALLY CHECKED BY THE UNDERSIGNED.

t Leo L. Fontaine Visible Certifying Signature
2012.04.03 11:59:18-04'00'
'SUBMITTED BY: TRANSPORTATION PRINCIPAL ENGINEER - LEO L. FOUNTAINE P.E.
A—T] James A. Fallon ‘i iani f
\ /RN |
Jmeen (Ao 2012.04.04 08:54:35-0400° Visible Signing Signature
APOROVAL RECORWENDED BV FANAGER OF —JAMES A TALLON P
"’ James H. Norman - A .
2012.04.04 09:58:05-04'00' Visible Signing Signature

APPROVED BY: TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 100 - Title Sheet Digital Signatures

CONSULTANT DESIGNED PROJECTS:
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The project title sheet of the 01_General subset shall be digitally signed by the lead consultant,
using a certifying signature.

See Section 5.7 Applying Digital Signature Workflows

CONNECTICUT DEPARTMENT OF TRANSPORTATION @

Plans For
REPLACEMENT OF BRIDGE No. 02973

a2 OVER PATTAGANSETT RIVE
! : Town(s)/City of

EAST LYME

:::::::::
nnnnnnnnnnnnn

LOCATION
OF PROJECT

Teo
oL

044-0148

Figure 101 - Consultant Designed Title Sheet

When more than one consultant works on a CTDOT digital project the project manager (prime
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.
By applying this signature the prime consultant is accepting responsibility for the entire set of
digital contract plans. However the individual subsets shall be signed by the corresponding
firms.

Note: When applying certifying or signing signatures leave the reason code blank.

Applying a Digital Signatures to 02 Revisions Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet
is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed
by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in Section 5.7 Applying
Digital Signature Workflows with the following EXCEPTION; the option “No Changes
Allowed” must be selected to eliminate unauthorized changes after certifying the
document. See the figure below:
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Dvigital 10 [
| |MattEalkins VH Yigm... ][ Mew... ] [

Pazzward:

Signature Type
() Digital Signature

(*) Document Certification

j ermitted changes after certitying:
] | Mo changes allowed v [

.

Optionz

Reazon: | v|

Lacation: | |

Contact Info; | |
| Appearance I
! |StandardTe:-:t VH Edit... H Mew... ] I|
|

~ <Name>
patar p w8 <| ocation>
<Date>

[ 1]8 ][ Carcel ]

Figure 102 Certifying Dialog Box for 02_Revisions.pdf

All Other Discipline Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the
responsible design engineer. As shown below.

See Section 5.7 Applying Digital Signature Workflows

; Wi, .

PEEENSULTANT COMPANY NAME \\}0\\?,: °°“Neg{/,’ William Pratt
SE P i O
ggg@ SZ 2009.01.27
’,0 :40% ;'4‘,,55 10:46:19
7, ‘\/95‘“9. N
Zponesy  -05'00'
/I

Figure 103 CTDOT Certified Plan Subset

Standard Drawing Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.
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Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need
to be digitally signed with a visible certifying signature, by the responsible design engineer that
submits the subset to ProjectWise. For example, in the case where the Traffic unit is submitting
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the
index sheets, not the Highway Principal Engineer.

See Section 5.7 Applying Digital Signature Workflows

All Other Discipline Subsets — Multi-Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same for
CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are
responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall
digitally sign the subset using a certifying signature, and leave the reason code blank. See
Section 5.7 Applying Digital Signature Workflows

Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset
using a signing signature, and complete the reason code with a note stating which pages,
contained in this subset, that they are responsible for. See table 2-1 below:

See Section 5.7 Applying Digital Signature Workflows
Table 1 Reason Codes for Prime and Sub Consultants

Designer Certify or Responsible Reason Code
Sign Sheet
Numbers

Lead Designer Certify
Sub-Designer 1 Sign 03.78 Thru | am Signing for Sheet Nos. 03.78 thru

03.88 03.88
Sub-Designer 2 — Sign 03.88 Thru | am Signing for Sheet Nos. 03.88 thru
etc. 03.98 03.98

Working Drawings

Working drawing submittals shall be digitally certified in accordance with Section 5.7 Visible
Digital Signature using a Certifying signature, of this manual.

Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See
Section 5.7 for instructions on how to apply a certifying signature to an engineering report. If a
report needs to be digitally signed by more than one person, the first person must apply a
certifying signature as shown in Section 5.7 and any subsequent signature will be a signing
signature as shown in Section 5.7.

Bridge Load Ratings

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with
the No Changes Allowed option selected as shown below:
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!

Diigital 10:
hatt Calkins b MNew...
Password:

LI LIl LLLL}
Signature Type
() Digital Signature

(%) Document Certification

‘ermitted changes after certibing:
Mo changes allowed

D

Options
Reason: W
Location:
Contact Info:
Appearance
Standard Test -
- <Name>
Hatar /9 <| ocation>
<Date>

Figure 104 Certifying Load Ratings

5.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature where the document is located in
ProjectWise, but the workflows are the same.

Certifying Signature:

1. Leftclick on the signature field and then update the settings as shown below. Examples
below are for a CTDOT designed project’s title sheet and the first sheet of an

Engineering Report:

Discipline Subsets

Issued April 2020

94

Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

Click on the signature
to certify

"/

THE OLSIGN APPCARS TO .‘;‘m TO APPUICADLE CRITERIA. APPROVAL IS

DECH PERSONALLY CHECKED DY THE UNOERSIGNED. ]

mmvx

(APPSR MECDOTED BT MawaiER (F STATE (SN - SCOTT A WLl FE.

Mathew Calkin

X

GFRTATIN D G TRATOR - S W NP 7. s
%2&:’2011.10.1810:

38:10-04'00

Figure 105 - Certifying Discipline Subsets

Engineering Reports or Documents that Require (1) Digital Signature

FINAL HYDRAULIC REPORT
FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER

(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC
March 8, 2010
Prepared By:

Hidewr - Lokl

Date: 1/21/14

Mathew Calkins Click on the
Ch:cked By: _ Méa' Date:l/n,fy Signature field
an B
to certify

Figure 106 - Certifying Engineering Reports

Select your ID and
> / select as shown

2. Next for document in located in ProjectWise click ProjectWise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list

below:
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ocation

il| ProjectWise Vai ctdot projectwiseonline.com:CTDOT Logged In

Login [ oK ][Cancel]

Figure 107 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for ProjectWise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

Thefile TT_DOC_PUE__Intro to Bluebeam pdf” already exists
A in Project'Wise.

Do you want to overwrite. Select ‘Mo’ to save as a new
filename.

Yes Mo ] [ Cancel ]

Figure 108 - Certifying Signature

4. |If using ProjectWise check the document back into ProjectWise.
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Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be
applied by the sub-consultants as follows:

1. Leftclick on the signature field and then update the settings as shown below:

X
Select your ID, a reason

Ovptal 1D 2
Click on the Mahow Cabors 3 - if necessary and select
- B as shown
signature
e e s el o s o
SEEN PSNALY OROKED b 1 ARSI
' Z s! Mas) Calkins
20)0.10.18 10:40:43-04'00"
f.m: A7 TNATTONATION PR DR -
Mathew Calkin
3
oS VRTINS R T~ 1 K oo V7S 2011.10.18 10:
40:46-04'00'

Figure 109 - Signing Signature Bluebeam

2. Next for document in located in ProjectWise click ProjectWise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list

below:

oCation

ctdot projectwiseonline com:CTDOT

Logged In

il| ProjectWise Vi

Coc ] [owen

Figure 110 - Open from ProjectWise
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3. Then select yes to overwrite existing file as shown below for ProjectWise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

Thefile TT_DOC_PUB__Intro to Blusbeam pdf” already exists
A in ProjectWise.

Do you want to overwrite. Select 'No’ to save as a new

filename.
‘I Mo Cancel

Figure 111 - Overwriting a File

4. If using ProjectWise check the document back into ProjectWise.
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Section 6 Submitting Documents to CTDOT
This section details the procedures for submitting documents to ProjectWise.

6.1 FDP Submittal to Processing

The files required to be submitted to Processing must be added to the set file stored in the
240_Contract Development folder as shown below. The set file creates a link to the document
so documents can be stored in separate folders, but show up together. When files are added to
a set file they are not moved, a link is created.

If there is not a set file in the 240_Contract Development folder in ProjectWise contact
DOT.AECapplications@ct.gov or follow these steps to create a set file in the 240 Contract
Development folder:

1. Right click on the 240 folder, right click in the white area and select properties.

2. Then select Set>New

e e e e mmminen Lopy uut
1. 160_Project Photos
=7 170_ROW and GIS Files Export...
1L 210_Construction Import

-l 220 FHWA Start Studio Session...

-~ 230_Contract_Administration
~{" 240_Contract_Development

xport Dependency Mai

———sstEmraTt —Eomfillential Import Dependency Map(s..
i 310_Review_Documents BI'OWSG Out tO the
7 30% Review Update Server Copy
I €% Revion et o o 240 folder and then
7 0%R g 1 ]
7 S0% Review Purge Local Copy right click in the
{7 320_Permit_Applications N
" 330 Desgn Date P lerees white area, select
I Projectdata @ .
-2 DOT Confidentiel < . properties, Set>New
- Environmental Planning ey —
- Facilities F ste... [
.= Highway_Ops =
I Highuays GENERAL| opy To.. 0051-0269
I Hythulcs GENERA|  Move To...
-7 Landscape GENERAL Rename...
- Maintenance gitixt Delete R 177
- Public_Trans T K oute 177t
& Rights_of Way GENERAL MINOR INTE
T Soils GENERAL Modify.. Waor interse:
[T Structure_Bridge GENERAL Modify Spatial Attriby N
o Traffic GENERAL  Dejete Audit Trail PERW.CN
= Utiies GENERAL 03_Final-Des
= Visualization GENERAL o
L& 300.Pre Design gi:ixt et : e cTDOT
@4 Saved Searches Send To G Toaiy..
2% 00510270 LOCATIO! R . — Famington
[ 00510272 LOCATION opy List o onten 01770004
% 00510273 LOCATION 1| Atmees *|  showReferences 00000000

Figure 112 - Creating a Set File
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After the file is created populate the set file as follows:
1. Open the Set file by double clicking on it.
2. Then browse out the folder where the documents are stored.
3. Then drag and drop the document(s) into the set file wirEqw as shown below:

ot projectwiseonline com: CTDOT\Documents\01.0 - Projects - Active\test\140_Project_Administration = [B* Go

| Label (User Defined)  Description Application File Updated Discipline State Document Date (m... Format
Acrobat PDF 7/28/2017 11945 PM HW 140_Project Admini...

[ | 240_Contract_Development - Documents for Processing = (==
f Lock to Version  Label (User Defined) Description Applicati
=] /[ Set File Place Holder Text
Drag document(s)
57 into the set file
plate_Jan_2011 <
| Document Properiies | Project Propeties | Folde]
= Properties (Project Type - CTDOT Trany

GENERAL - Project Numberis)

GENERAL - Projects Inherited

GENERAL - Contract Number g ] v

GENERAL - Program Number
ns (PDF) GENERAL - Project Title
-uments GENERAL - CTDOT Improvemert Type
ubmittals (PDF) GENERAL - General Description
sring_Reports GENERAL - Federal Proj Oversight
Reports_Confidential GENERAL - Phase Types Included
inistration GENERAL - Project Cument Phase
inistration_Confidentia GENERAL - Project Scope Code
nistration Corresponde GENERAL - TIF/STIF Status

SEMEDAI  Mdeomtinnd B

Figure 113 - Adding Files to the Set File
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6.2 Uploading Documents
ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
ProjectWise, but this procedure can be followed for uploading documents into any folder in
ProjectWise.
1. Once logged into ProjectWise browse out to project and folder you need to upload into.
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.

Correspondance
,O Bridge_Data
Main Category
Folder Docu Oools Hel| Sub Category 1
~ Views 4 Discioline
» I
] Label (User De"in(
|| Refresh .
O - Touwn 'roperties are updated nightly 1
O CTDOT_Project_Information
Label_LooklU
O . P
Misc_PullDown
0 |
CTDOT_Doc_Code_Plus
]
CT_Doc_Xfer
O
CTDOT_Attributes(In Development)
O
Research
U

Research Label

Figure 114 - Selecting the Interface
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2. Next select Document>Upload as shown below:

Advanced search options

&‘- ctdot.projectwiseonline.com:CTDOT
E () Documents

B " 01.0 - Projects - Active

E

a8 0001-0100

(]

" 0001-0999

(| 100_Contract_Plans (PDF)
110_Contract_Specifications_&_Permits (PDF)

o 120_Contractor_Submittals (PDF)

130_Final_Engineering_Reports

121 Engineerina Reports Confidential

@View Tools Help

o Mew...

)

Figure 115 - Uploading Document into ProjectWise (Thin Client)

3. Next browse out to the document you want to upload.

No content available to display.

Upload file X

—

(= Choose File to Upload

-

Cancel

451 Favorites

B Desktop

i Downloads

Browse out to the
file to upload and
click Open

: B Videos

rojectWise Properties

o content available ta display.

uQ ‘. Desktop »

Ex3)
~ [ #3|[ Seorch Desktap o]

New folder =~ 0 @
* Neme e

@& Creative Cloud Files

|
%] Pages from 03-Highways CT_FDP_0043-0128.pdf )
Conndotsppwep. Zip
& Digitel_Project_Develgpment.pdf

/& 76.193 3D Model.dgn
2 projectwise Bridge Pil
&) Paper Plan Order Fon
|#) 2015-2-EC.pdf

| reportleg

Bl AgreementsB.xls

2} 2015-06-19_PW _Impor]
35 . A . _—

docx
CT_Misc_pdf

Rail - Copyads

Filename: Pages from 03-Highways_CT_FOP 0043- + | AllEila -

Cancel

Figure 116 - Uploading a File to ProjectWise
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4. After the file uploads, right click on the file and select Properties:

Folder Document View Tools Help
~

@ (3@ B =

H Label (User Defined) Description

il Pages fron
B View

Right Click on the

K-j' Download...
, file and select
¢ Export..
Properties
More...
Change State »

$ Copy Link(s) ]
_n Delete
v

ProjectWise Properties
No content available to display.

Figure 117 - Select Properties

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If
you cannot assign attributes, the interface was not selected as detailed in step 1 or this

section.
ProjectWise Properties

General Document References Audit Tra*! Z

Select these

Discipline

~
an C attributes
Main Category Main Category Des | -
coN =y | k a
Sub Category Sub Category Description
DR !
Project Number{s) (
D001-0933 -
abel (User Defined) Document Date {(mm/dd/yyyy) *H'--_ Type in these
|04 - Bridge El =
Description ' ! attrl butes
Eridge Plans | x ®
Lol ieser tage \_Select these
Bridge No(s) Building No(s) ) i
ooors B | j asset attributes
Signal Intersections Route_No E .
=] \ if necessary

Sign Structures

Click Save J-—*

Figure 118 - Thin Client Attributes
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Uploading Documents — ProjectWise (Thick Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
ProjectWise, but this procedure can be followed for uploading documents into any folder in
ProjectWise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not
shown go to View>Toolbars and select interface.
2. Dragand Drop files into the correct folder in the Project.
®- B0 T EHE @

@4 - | Search (O g Interface | CTDOT Doc_Code -
Address pw:\ctdot. projectwiseonline.com: CTDOT\Documents\01 - CTDOT Projects0310_00624100_Contrgcl_Flans (PDF)|
= [ ConnDOT (mic-admin) ~ List | @ Geospatial

=" Documents

. Label Defined
& [ 01-CTDOT Projects )

(%% 0015_0335 /ED].DIGEnera\

L_N 0017_0183 ,/ -1 01.02Revisions

(% 0034_0334 A" 01.03-5tation_Plans

[1* o040_0136 A2 01,04Environmental i

(1% 00s6_0309 ZTotosamrak Force (1) Make sure the interface
[ D063_0543 & 0093_0180 /T coT_Hghway SO jg "CTDOT Doc Code"

[ 0083_0872 ") CTDOT Traffic_sTD - -

[ 0079_0230

|/ o0s2_029%

1% 0084_0106

|/ 0083_0178 & 0093_0166
[ 0092_0531-0622-0527
[** 0092_0532

[ 0092_0813

[ 0092_0834

[ 0092_0833

L,: 0107_0158 L (2) Select Project folder and
0108_0178

[ 0110_0129 / then 100_Contract Plans

[ 0138 0221 /7| folder

% 0138_0232
|/ 0150-0126
% 0152_0148
% 0158_0207
L% 0165_0039
1% 0170_2296
[ 0300_0139
[ 0301 _0059 o
(1% 0301_0106 (3) Drag and drop discipline
o]
%% 0301_0125 subsets
[ 0301_0140
|* 0310_0039
| 0310_0056
[ 0310_o057
|/ 0310_0058
1% 0310_0058
" 0310 0060
=7 0310 006
100_Contract_Plans (PDF)
110_Contract_Spedfications (PDF)
120_Contractor_Submittals (PDF)
130_Soil_Archaeological_Misc_Reports (PDF)
210_Construction
220_FHWA
230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Preliminary_Design_Documents{PDF)
320_Permit_Applications £
330_Design_Data

[SAS

=3}

HHHHEHHHEHE

=

Figure 119 - Uploading Into ProjectWise (Thick Client)

3. Select the “Advanced Wizard”

Click “Next” until you reach the figure below:

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If
you cannot assign attributes, the interface was not selected as detailed in step 1 or this
section.

E
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Advanced Document Creation Wizard x|

Define Document Attributes
*t'ou should define enviranment specific document attributes.

< Select these
Main Category Main Category Description attrlbutes

IEDN j IEDnlract Flanz & Specs
Sub Category Sub Category Description

IF'Ians_D2 - Final Design Plans

Project Mumber{s)
IDDDA-DHE_DDM-DHB

Label (User Defined) Type in these
ID‘I -General vl .
Description attrlbutes

Title Sheet and Detailed Estimate Sheets

CT Code {auto Fill In;
|CT_CON_FDP_0004-0116_0004-0118_01-General

CTDOT Asset Tags
Bridges Sign Structures

| 01456; 01654 J [0 0;20156 J

4+ Select the correct
asset tags

Signal Intersections

| [

Click Next

< Back d Mext jl ancel |

Figure 120 - Attributing (Thick Client)

6. Onthe Document Properties page nothing needs to be edited.

7. On the create document page click next and the document will be uploaded into
ProjectWise.

8. Once the document is uploaded the user may need to click F5 (refresh) to see the file
name update.

6.3 PDF Checker — Contract Plans

The Discipline Subset PDF Checker software was developed to check that Contract Plan
Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the
old requirements of attaching the discipline subset checklist to each subset and stamping each
subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to ProjectWise Thick Client and can only be run using ProjectWise
Thick Client. See Section 6.2.2 for the typical workflows for using the PDF Checker. This section
provides details for ProjectWise Thin Client users.

The following details what is checked with this software:
(1) CAD Requirements have been completed correctly:
a. Page Size (see Section 4.2)
b. Searchable Text (see Section 4.2)
c. Levels (see Section 4.2)
(2) PDF post processing steps have been completed correctly:
a. Page labels (see Section 4.14.2)
b. Sheet numbers (see Section 4.14.2)
c. Watermarks and flatten comments(see Section 5.4)
d. Any digital signature fields (see Section 5.5)
e. Digital Signature (see Section 5.6)
(3) The subset was uploaded and attributed correctly in ProjectWise.
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After the PDF checker is run, an Excel report is created detailing what is incorrect on each
subset. Things that are incorrect will show up red and include a note on what is incorrect. Also
an attribute in ProjectWise call Format Compliance will be set to PASS or FAIL when a document
is run through the checker:

o List |e Geospatiall | J—mm—
Label (User Defin;d) Description Document Date (m... Application State f Format_Compliance thto
/Bl o1- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRAMSF. § PASS
/B 02- Revisions Revision Sheet Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 03- Supporting Docume...  Supperting Decuments Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
7 B - Civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF. § PASS
/B 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 08- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 07- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 08- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 09- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
7 Bl10- Electrical Electrical Plan §' S DOCUMENT TRAMSF. § PASS
/11-En\r|ro.nmantal ErT\rlronmem:aIF Format COmpliance :_—M FAIL
/ CTDOT Highway_STD Highway Stand: F DOCUMENT TRAMSF..J PASS
/ Bl CTDOT Traffic_STD Traffic Standard Att ri bute F DOCUMENT TRANSF.. \ PASS

Figure 121 - Format Compliance Attribute

The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which
includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.

Installing the PDF Checker

This is step is for consultants only, DOT staff already have the checker installed.
1. Download the PDF checker executable from this link: Discipline Subset PDF Checker
2. Close ProjectWise if it is open.
3. Run the executable.

Typical Workflow for using the PDF Checker

CTDOT Designed Projects
The following details the typical workflow for a CTDOT designed project.

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into
ProjectWise in accordance with this manual.

2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the
unsigned subsets, any errors can be found before the Principal digitally signs. Note: An
error will be returned that a signature was not found and the ProjectWise attribute will
show FAIL.

3. If there are any other errors, other than the signature error, they shall be fixed. If the
only error in the report is the signature error, then the plans can be digitally signed by
the principal.

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check
the digital signature was applied correctly. If there are no errors then the check is
complete. If there are any errors they shall be fixed and the PDF Checker rerun.

5. The project lead should check in ProjectWise that all subsets have PASS in the Format
Compliance attribute column.

6. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.

Consultant Designed Projects
The following details the typical workflow for a Consultant designed project:
1. Each consultant prepares their subset(s) and uploads their subsets into ProjectWise in
accordance with this manual.
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2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does
not have ProjectWise Thick Client, contact your CTDOT Consultant Liaison or the lead
consultant on the project to run the PDF Checker on those discipline subsets. Any error
shall be fixed and the checker rerun until the report does not have any red errors.

3. The CTDOT Consultant Liaison or the lead consultant should check in ProjectWise that

all subsets have PASS in the Format Compliance attribute column.

4. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.

Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The
following shows how to check multiple discipline subsets, but the procedure is the same for

checking one subset.

1. Loginto ProjectWise.

2. Browse out to your project and open the 100_Contract_Plans folder.

3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF
Check. Hold control or shift to select multiple subsets.

- } E\c’ie‘w[Dm(ument

v] Interface[ CTDOT_Doc_Code

MNDocuments'01.0 - Projects - Active'0077-0234'100_Contract_Plans | « } Go

List |. Geospatiall

Label (User Defined)

Description

Document Date (mm/dd/yyyy) Application

_/ 01-General
_/ 02-Revisions
_/ 03-Supportin

P 107 Electrical

New

Open

Open as Read-Only
Open With...
Markup

View

Check Out
CheckIn

Free

Copy Out

Export...
Import
Start Studio Session...

Export Dependency Map(s)...

Impert Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy
Purge Workspace
Cut

Copy

Paste...

Copy To...

Move To...
Rename...

Delete
—

3 Acrobat PDF
Acrobat PDF|
Acrobat PDF
Acrobat PDF|

Acrobat PDF
Acrobat PDF|
9/14,.'015 12:00:00 AM  Acrebat PDF

DMSconform

3 PDF Check |)

Moﬁ'y...
Modify Spatial Attributes...
Add Comment

Set
Send To
Copy List To

Figure 122 - Selecting the Subsets and Running the Checker

3

3

3

Select all subsets,
right click and select
DMSconform>PDF Check

4. Click OK on the dialog box shown below:
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ContrelCAD Check Drawing & Attributes @

01 -General_CT_FDP_0032-0130.pdf
03-Highways_CT_FDP_0032-0130.pdf

04 Structures_CT_FDP_0032-0130.pdf
05-Traffic_CT_FDP_0032-0130.pdf
06-Tluminatien_CT_FDP_0032-0130. pdf
07-Environmental_CT_FDP_0032-0130.pdf

TOTAL G PDFS

ok | ) cancel |

Figure 123 - PDF Checker

5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The
PDF Checker may take a few minutes to process depending on the size of the files it is
checking.

ControlCAD E3

Report complete. Open in Excel?

Figure 124 - PDF Checker Report

6. Inthe report, errors will show up in red and if you hover over a red piece of text it will
show the details of what is incorrect. If any false errors show up in the report, please
notify DOT.AECApplications@ct.gov with the project and document(s) you are having
issues with. Example of false errors could be the page labels were applied to the subset
but the report details they were not.

611 - £ | incorrect

A | B c 0 E F G H J K L M N [} P Q R s
, CTDOT CONTRACT PLAN QA REPORT
2 01.0 - Projects - Active/0032-0130/100_Contract_Plans (PDF) | | I I | | [ | | | | | 1
3 | POF Format Checks ProjectWise Attribute Checks
4 Label |Document Name Modified Type Description No Pages Sheet Size Signature Searchable Layers _ Flattened lPige Labels [Engineers Stamp |Discipiin [Main Cat |Sub Cat | AssetLabel |Badge No |Signal Int
; 101 -General CT_FDP_0032-0130 pdf _ 71172015 10 37 21 Al pdf _1General Plans FOP OK [Not Found]OK 01, C CON P [none lank blani |
7 [03Fighways_CT FDP 00320130 (673072015 116,59 PM_|pdl JHighway Plans FOP al incompiate THot F T c Con 5 [none fan) biank__|
8 04 Structures CT_FDP_0032-0130 paf 16/25/20° 1921 P pdf |Structural Plans FDP 4 OK O} -04 C CON FDP none lank (blani
9 105-Trafic_CT_FDP_0032-0130 pdf 16/30/20° 5047 PI pdf | Traffic Plans FDP 1 OK N C CON none lank blani
10 ¢ |06-Mlumination_CT_FDP_0032-0130.pdf 16/12/2015 12:17:43 PM |pdf |llumination Plans FDP Cin Sheet Size must be 34°x22" s C CON P [none lank blan
1 [07E I CT_FDP_0032.0130.pdf [4728/2015 124152 PM |pef Plans FOP Inconzct_Olp1 is 36°%24", p2 is 36°x24%, p3 is 36"x24", p is K C Con [none ani [blan
2 |367x24", p5 15 36™24"
13 [Repont created by calkinsm] | I
1 ControICAD version 37 8.4 ] I
15 1
PDF Format Checks
No.Pages Sheet Size Signature Searchable Layers Flattened Page Labels
4 Incorrect  |OK OK Not Found |JOK 01.01-01.04
57 Incorrect  |OK Incomplete |Not Found |Comments ]03.01-03.57
2 14 Incorrect  JOK oK OK Comments ]04.01-04.14
11 Incorrect  |OK OK Not Found |Comments ]05.01-05.11
3 = rrer—— Yy
P18 Incorrect |OFGHGet Size must be 34'x22 p
FDP [5 Incorrect 10\ p1 is 36"x24", p2 is 36"x24", p3 is 36"x24", p4 is

36"x24", p5 is 36"x24"

Figure 125 - PDF Checker Report

The Format Compliance attribute will also be set when the checker is run. It will return a PASS
or FAIL value as shown below:
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a Lst | @ Geospatial|  pr—
Label (User Defined) Description Document Date (m... Application State Format_Compliance tto
/E 01- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 02- Revisions Revisicn Sheet Acrobat PDF DOCUMENT TRANSF..§4 PASS
#[B) 03- Supporting Docume... Supporting Documents Plan Sheets Acrabat PDF DOCUMENT TRANSF.{ PASS
/a 04- Civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/a 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRANSF.§ PASS
/E 06- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 07- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRANSF..§4 PASS
/a 08- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 09- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/a 10- Electrical Electrical Plan S - I DOCUMENT TRANSF.§ PASS
# B 11- Environmental Envirenmental | Format com pllance _—m FALL
# B CTDOT Highway STD  Highway Stand: : DOCUMENT TRANSF.| PASS
/a CTDOT Traffic_STD Traffic Standard Attri bute F DOCUMENT TRANSF..{ PASS

Figure 126 - Format Compliance Attribute

7. If there are no errors in the report and all document have PASS in the Format
Compliance attribute, this process is complete. If there are errors, the errors shall be
fixed and the checker rerun.

Section 7 Contract Plan and Special
Provision Revisions (Addenda and Design
Initiated Change Order)

7.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed
PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall
be digitally signed in a digital signature place holder, that is placed in Microstation as described
in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings sheet. Once
digitally signed, the addendum subsets shall be submitted to CTDOT using ProjectWise, as
described in Section 6 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they
must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into ProjectWise
(See Section 6): The addenda subset shall have the same ProjectWise label as the original final
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda
number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See
example below:

PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

Addenda Discipline Subset: 04-Traffic_A01
2nd Addenda 04-Traffic_A02
6th Addenda 04-Traffic_A06

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by
addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on
the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum
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number. This stamp is placed over digital signatures therefore; removal of the signatures is not
required prior to placing the addenda stamp. For this process see Section 7.4.

WARNING — When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the
project manager for all addenda, and submitted as described in Section 7.3.1. A new subset
must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants)
shall be placed on all added or revised sheets. See Section 5.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent
to all applicable units following Section 3.2.12.

Revised Plans - Addenda

Microstation Processes

A note shall be placed, directly above the bottom right hand corner of the title block, on the
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number. This
note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed somewhere on the line of the cloud. A like numbered triangle shall be placed in the
revision block of the changed sheet, accompanied by a description of the revision itself. The
revision number is specific to a particular sheet, and increases in consecutive order per revision
and per addenda. If a sheet is changed for the first time under Addendum #2 then the sheets
revision number is 1 since this is the first change. If the next time it is changed again is under
Addendum #5 the revision number becomes 2 since this is the second change to the sheet.

Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a
clear manner, do not void out the existing sheet and create a new sheet. In these instances,
the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate
Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General
Plan sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

Original: 02.25
Addenda 1: 02.25.A1
Previous Addenda Sheet;

Original: 02.25.A2
Addenda 4: 02.25.A4
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If a sheet requires further revisions by a subsequent addendum, the addendum shall be
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam
after addendum approval, see Section 7.4.

New Sheets - Addenda

Microstation Processes

Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1.

If the new sheet does not have to be placed in a specific location within the discipline
subset, the new sheet shall be placed last, and numbered sequentially from the last
sheet of the discipline subset. The total number of sheets noted on the project plans
and discipline subsets stays the same. A note shall be placed on the new sheet stating,
"NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.
This note shall be located directly above the right hand corner of the title block. This
note is a level in Microstation that needs to be turned on and edited. The revision block
on the added sheet, shall not be filled out.

If the designer determines that the new sheet must go in a specific location within the
discipline subset, the new sheet number shall be the number of the previous sheet
followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be
02.57-2.A1. The total number of sheets noted on the project plans stays the same. A
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM
NO."Y", where "Y" equals the addendum number. This note shall be located directly
above the right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet
number the drawing number of the new sheet shall be the drawing number of the
previous sheet plus a decimal and the sheet count. For example, if the new drawing
must be placed in the project plans right after drawing number S-5, the drawing number
shall be S-5-1.

Bluebeam Processes

Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-1.A2
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Previous Addenda - Added Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31
Addenda 3: 04.32.A3

Adding New Subset - Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed,
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in
Microstation that needs to be turned on and edited. The label attribute on the new subset shall
contain a “_A##". The first sheet of a new subset to the contract will be a subset cover sheet
and contain an index of drawings. Also the DO NOT update the project title sheet in the
General subset to show the addition of new subsets to the project.

Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted;
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED
BY ADDENDUM NO.”Y"; where "Y" equals the addendum number. See Section 7.4

Addenda Special provisions

Contract Special provisions that are revised or added due to addenda shall be submitted digitally
in accordance with Section 4.5

Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance
with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow Section 4.4 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to ProjectWise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

7.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the
original contract by:

e Arevision to an existing plan sheet(s) or specification(s)

e The addition of a new plan sheet(s) or specification(s)
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e The deletion of an existing plan sheet(s) or specification(s)
The creation and management of DCO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF
discipline subset(s) containing only the added or changed sheets. The sheets being revised or
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset
shall be digitally signed in a digital signature place holder, that is placed in Microstation as
described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO
subset(s) shall be submitted to the CTDOT using COMPASS.

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being
revised by DCO shall NOT be modified except when the Engineer of record places a DCO stamp
on the revised sheets. This digital DCO stamp crosses out the entire sheet with a red X and adds
the following note: “THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. “Y” —
mm/dd/yy” where “Y” equals the Design Initiated Change Order number. This stamp is placed
over digital signatures.

Warning: When placing the stamps, removing the digital signature is not allowed.
For this process see Section 7.4.

The Index of Revision Sheet(s) located in the 02-Revisions subset shall be updated by the project
manager for all DCOs, and submitted as described in Section 7.3

A watermark of the signer’s signature; signature only for CTDOT-designed plans; or PE Stamp for
Consultant-designed plans shall be placed on all DCO sheets.

Paper copies for all change orders will be requested and sent to all applicable units following
Section 3.2.7

Revised Sheets — DCO

MicroStation Processes

A note shall be placed directly above the right-hand corner of the title block of the replacement
sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy,” where “Y” equals the
Design Initiated Change Order number. This note is a level in MicroStation that needs to be
turned on and edited.

The areas on the sheet that are being revised shall encircled by a cloud and a numbered triangle
shall be placed somewhere on the line of the cloud. A like-numbered triangle shall be placed in
the revision block of the changed sheet, accompanied by a description of the revision itself. The
revision number is specific to a particular sheet and is specific to the number of times a sheet is
changed, including addenda changes. It starts with one and increases by one for each revision or
change to the sheet. If a sheet is changed for the first time under DCO #5 then the sheets
revision number is 1 since this is the first change. If the next time it is changed again is under
DCO #7 the revision number becomes 2 since this is the second change to the sheet.

Details shown on the original sheet, but are no longer required, shall not be deleted but shall

only be crossed out with an “X” on the revised sheet. Engineering judgment must be used to
produce clear and concise information for the contractor.
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If the number of changes to the sheet cannot be clouded in a clear and concise manner, the
existing sheet should be voided.

Bluebeam Processes

Sheet numbers for revised plans shall be as follows:

Description Sheet No.
Original Final Plan Sheet 02.25
DCO 1 02.25.C1

Previous Addenda Sheet 02.25.A2

DCO 4 02.25.C4
Previous DCO 2 Sheet 02.25.C2
DCO 4 02.25.C4

Drawing numbers shall not be modified on revised sheets.
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp

(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section
5.

New Sheets — DCO

MicroStation Processes

Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:
1. If the new sheet does not have to be placed in a specific location within a discipline

subset, the new sheet shall just be added to the end and numbered sequentially from
the previous last sheet of the discipline subset. The total number of sheets noted on the
project plans and discipline subsets stays the same. A note shall be placed on the new
sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHAGNE ORDER NO. “Y” —
mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the change order
request was submitted. This note shall be located directly above the title block. This
note is a level in MicroStation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a
discipline subset, the new sheet number shall be the number of the sheet it most closely
relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet
shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE
ORDER NO. “Y” —mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the
change order request was submitted. This note shall be located directly above the
bottom right hand corner of the title block. This note is a level in MicroStation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number
of the new sheet shall be the drawing number of the sheet it most closely relates to
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followed by (-#). For example, if the new drawing must be placed in the project plans
right after drawing number HWY-10, the drawing number shall be HWY-10-1.

Bluebeam Processes

Added sheet numbers shall be as follows:

Description Sheet No.
Original Final Plan Sheet 04.31
DCO 3 04.31-1.C3

Previous Addenda Sheet — Added Sheet 03.24.A1

DCO 4 03.24-1.c4
Previous DCO — Revised Sheet 02.45.C1

DCO 2 02.45.C2

Previous Addenda — Added Sheet 05.14-1A1
DCO 2 05.14-2.C2
Previous DCO — Added Sheet 02.45-1.C1
DCO 2 02.45-2.C2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus C#, where # equals the Design Initiated Change Order Request
number.

Description Sheet No.
Original Final Plan Sheet 04.5
DCO1 04.6.C4

New Subset Required — DCO

New subsets shall be submitted by DCO and prepared the same way as a FDP discipline subset
except with the addition of a C# in the sheet numbers and an note placed, directly above the
right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY
DESIGN INITATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y” equals the Design Initiated
Change Order number. This note is a level in MicroStation that needs to be turned on and
edited. The first sheet of a new subset will be a subset cover sheet containing an index of
drawings contained in that specific subset.

Voiding Sheets

Contract sheets are never deleted. Sheets submitted within final design plan subsets, addenda
subsets, or design initiated change order subsets that are no longer needed shall NOT be
deleted, but shall be voided by the engineer of record, with a DCO stamp. The voided stamp
crosses out the entire sheet with a red X and adds the following note: “VOIDED BY DESIGN
INITATED CHANGE ORDER NO. “Y” — mm/dd/yy,” where “Y” equals the Design Initiated Change
Order number.

DCO Special Provisions

Special provisions shall be created in accordance with the Department's policies and procedures
for Contract Development.
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DCO Memorandum from Design to Construction

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders.
This memorandum shall not include any digitally signed DCO plans and / or DCO specifications.
The digitally signed DCO plans shall be uploaded into the 100_Contract Plans folder in COMPASS
and the DCO special provisions shall be uploaded into the 110_Contract folder in COMPASS. The
memorandum shall include the following:

o A detailed description and justifications of the changes requested.

e |dentify the funding source, if known.

e Alisting of each new, revised, replaced and / or voided plan sheet(s).

e Alisting of each new, revised replaced and / or voided special provision(s).

e Alist of the changes in the estimated quantities for the project (increase, decrease).
The list should also include any item that is new to the project or any item that is
deleted as a result of the revised work. Item numbers of items already in the project
should be provided. Item numbers for items that are not currently in the contract
should be provided if known.

e The estimated increase in cost or credit associated with the change order request.

DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the
following.

The DCO for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow Section 4.4 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to ProjectWise add a “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

7.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded
from these links:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE Subset

Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions
Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP)
and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions
subset starts out as an un-signed blank place holder in the project. The figure below is an
example of a blank 02-Revisions subset:
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Figure 127 - Blank 02-Revisions Subsets

ADDENDA:

When the project requires an Addendum, the Project Manager must record these changes on a
NEW 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets
shall contain all previous Addendum information. For example, Addendum 4 shall include all
changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when
multiple addendums are being submitted to processing for the same project. An example of this
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two
addendum revision sheets must be submitted.

DESIGN INITIATED CHANGE ORDER:
When a project requires a Design Initiated Change Order (DCO), the following process shall be
followed:

For each DCO, the Project Manager shall AMEND the 02-Revisions subset. The 02-Revision
subset shall always contain all previous Addendum information and the new DCO information.
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum
information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to
Addendum #3:
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Figure 128 - Index of Revisions Sheet

Detail A from figure 1 shows the information typed in for a change to the contract plans. The
project designer inputs the Addendum or DCO number, the sheet number, the date, a

description of the change, the person who made the change, and checks the appropriate box
for: new sheet added, revised sheet or deleted sheet.

Detail B from figure 1 shows th
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Figure 129 - Detail A
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02 Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project
Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of ProjectWise to their
local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:

s
PROJECT 1

/ BPCT VT 1T 7 7 =
S Clear Signature [% b
i Validate Signaturs
4

L View Signed Yersion

Compare Signed Ysrsion to Current Yarsion

Show Signature Eroperties. ..

Legal Notice. ..

RB-01.dgn
in €

Figure 131 Clearing the Digital Signature

3. Enter the information into form fields as described in Section 7.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the
title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow Section
7.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 5.6.2
7. Upload the document into ProjectWise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A##

9. Make the document description 02-Revisions_A##.

02 Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset. In this workflow the user edits the subset in COMPASS, they do not have to
export the document out and submit a new subset:

1. Check out the 02-Revisions subset from COMPASS

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:
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Figure 132 Clearing the Digital Signature

3. Enter the information into form fields as described in Section 7.3.4.

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y -
mm/dd/yy”

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy”

6. Resign the 02-Revision subset in accordance with Section 5.6.2

Adding a New Revisions Sheet to the 02 Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 7.3.
2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block
information and update the sheet accordingly.

Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the
Addendum or Design Initiated Change Order. The second column is the revised or new sheet
number. The third column is the date, followed by a brief description that is similar to the
description on the actual sheet being revised. Finally click in the appropriate check box per row
to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is
not required to input changes numerically by Sheet No. If another changed sheet is added to an
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of
Revisions Subset”.

. -
"oV SHEET No. | DATE § G| DESCRIPTION BY |}

Addenda A1\ 02.06.00341 01/01/11 v REMOVED DETAIL Mic
\ AL 03.05.001A1 01/01/11 v | DELETED ShEet MIC
( a2 Joa.05.003a2 oi20/11 | . | v | aBEARING DETAILS MIC
42/] 02.06.003-1a2 o1/20/11 [ V)| _ | “YABUTMENT DETAILS MIC
/TN 04.01.025C1 02/15/11 | k. ({) WINGWALL DETAILS MIC
| 2 Joz.04.055-1c2 03/02/11 ALL 101 DETAILS MIC

g \

k. \

Design Initiated \ Deleted Shaet
Change Order Revised Sheet

New sheet

Figure 133 Modifying the “Index of Revisions Subset”
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7.4 Placing Stamps on Affected Sheets — Revised,
or Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or
in Markup>Stamps as shown below:

Window  Help

MJC_Watermark pdf

01-Addendum_and_Change_Orderpdf

CcTDoT 5 v Tool Chest

Sequences & Actions.

[ (d 40 G o Co Cd (0 0 @ Ca G

> CTDOT Review To
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TRANSPORTATION SPECIFICA”
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VERTICAL DATUM - NGVD29

HORIZONTAL DATUM - NADS3 ‘Sublect et

MARK R. O GALBRAITH
. ol DESIGNED BY: stam

[YOR FUSS & O'NEILL, INC ’

146 HARTFORD RD == Superseded

GARY SCHNEIDER TIMOTHY P. UMRYSZ MANCHESTER, CT 06040

DIRECTOR OF PUBLIC WORKS DIFECTOR OF PUBLIC WORKS

Digital Signature Place Holder
amp

orking Drawing Review Tool

The addendum and change
wrnuseran. st order stamp can be found in VEAR

Comm

=1 Designers Working Drawing Review

PROJECT LENG both places 5 action stamn.
") : ‘Z . & Highlight
%MW”V %' - 4 Hiniont
SEMI-FINAL DESIGN (60%) TS Catout
APRIL 2017 Text Box

(g Cloud Use o Cloud Corrections

/ ine Useto Cross Out

Figure 134 - Addendum and Change Order Stamp

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User
Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see
Appendix A — Bluebeam Stamps

WARNING — When placing the stamps, removing the digital signature is not allowed.
Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and
as built notes. These notes should be used in conjunction with the cross-out stamp.

The following shows how to apply the stamp to the sheet that needs to be crossed out for an
Addendum or Change Order.
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1. Select the stamp from the Tool chest or Markup>Stamps and place it:z

GALBRAITH

GARY SCHNEIDER
DIRECTOR OF PUBLIC WORKS

TIMOTHY P, UMRYSZ
RECTOR OF PUBLIC WORKS

2016 CONNECTICUT DEPARTM
TRANSPORTATION SPECIFICA”
INCLUDING SUPFLEMENTAL S
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VERTICAL DATUM - NGVD29
HORIZONTAL DATUM - NADR3

Comment

Digital Signature Place Hoiger
stamp
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FUSS & ONEILL, INC
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MANCHESTER, CT 06040
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winuseteai. st4 order stamp can be found in
both places

PROJECT LENG'

NOZY

YEAR
F==1 Designars Working Drawing Review
=l

Action Stamg

== Suparserea

n o
j:,,’ﬂl%.- W el

APRIL 2017

SEMI-FINAL DESIGN (60%)
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Use to Cloud Conections

Q oo
s

Use to Cross Out

Figure 135 - Addendum and Change Order Stamp

2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1
below in all caps as shown below:

BRNVRE A BNEE -S5SSR TiaeE

Add. or CO Note

A

Enter Mote:

S

—ﬁ -_l LI‘I: '__-_
( ET REPLACED BY ADDENDUM NO. 1@

| oK || Cancel |

T TILIo® THYCLNT Lorat LINE

SUMVEY BY OISTRICT L

1 SN
E Al FOOT GAID AAAFD CR WAL RIGOST

Figure 136 - Enter Note for Addendum and Change Order Stamp

Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts

Addendum Notes

Description of Use

THIS SHEET REPLACED BY ADDENDUM NO. Y

The revised sheet is considered to replace, in
total, the original sheet.

VOIDED BY ADDENDUM NO. Y

Sheet is voided by Addendum.

Design Initiated Change Order Notes

Description of Use

THIS SHEET REPLACED BY DESIGN INITIATED
CHANGE ORDER NO. Y - mm/dd/yy

Used for revisions to existing sheets. Changes
must be noted only on the revised sheet.

VOIDED BY DESIGN INITIATED CHANGE
ORDER NO. Y - mm/dd/yy

Use this for voiding of existing sheets.

3. The following shows a completed stamp.
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Figure 137 Typical Sheet Replaced by Addendum 1
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Figure 138 Typical Sheet Replaced by DCO

Issued April 2020 123 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

Section 8 As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-314 “As-Built Drawings and Final
Revisions of Plans (As-Builts)”, it is the responsibility of either the Contracting Engineers
(Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions
of Contract Plans. As-Built revisions shall be recorded in accordance with Chapter 1-314 of the
Construction Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed
over the top of the digital signature and its security, therefore, the original content of
the PDF plans can never be altered. Because as-built comments are digital and placed
over the top of the plans they are easily recognizable, searchable, and may be turned off
if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original,
addenda, or construction order plans, located in ProjectWise within the project’s
100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed
on the digitally signed contract plans), these sheets shall be combined by subset number
and uploaded into the 100_Contract Plans folder in ProjectWise.

CAD drawings may be updated, at the discretion of each design office, to reflect any
addenda, change orders, and as-built revisions for use in the future; however the
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set
for permanent records.

8.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following
sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on
their record set (paper copies) during construction. Once construction is completed these
revisions shall then be applied as comments to the digital PDF per the workflow in Section 8.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built
revisions on their record set (paper copies), and shall apply them as comment to the final set of
digital PDF plans on an intermittent bases, during construction. By using this method as-built
information becomes available to all parties that have access to ProjectWise during the
construction process, improving communication and transparency.
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Post Construction As-Built

As-Built Workflow

Step Personnel Task

1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that
As-Builts can be applied to the Contract Plans.

2 Contracting Engineer | Apply As-Built revisions to the Contract Plans in accordance

or District Staff with Section 8.3
3 Contracting Engineer | Notify all applicable personnel list in the Section 8.4.2 that the
or District Staff As-Builts have been completed for this project.

8.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be
available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

ODOOKOHBE: 0o rl= dde

Tool Chest -

~ Sequences & Actions

[a (d /0 o (o Ca Cd (1 @ Ca G o

CTDOT Review Tools [o)]

DERIV + CTDOT As Built Tools @}

-
D29 Comment
;IADRE — Construction Started and End Construction Started and End
: Dates Dates

This Sheet Corrected

m

-~ This sheet Not Corrected
Typical Section Corrected

These Quantities Not Corrected

As-Builts Completed By As-Builts Completed By
As-builts Checked By As-Builts Checked By
/ Line Use to Cross Out
r‘\f PolyLine
7 Ccaliout
Text Box
(A
(o]
/ Arrow
-»>
O  Eiipse
o]
>, Group Cross Out
% Cloud
v A

Figure 139 - As-Built Commenting Tool
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8.3 Applying As-Built Comments to Contract Plans

Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built
revisions. By completing these steps as-built revisions will be standardized across the all
CTDOT users. These steps only need to be completed the first time using Bluebeam or when
the user logs into a new computer.

Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
The user must have a ProjectWise login/password. Contact Julie Annino if you do

not have a ProjectWise Username and Password.

Opening the Contract Plans from ProjectWise

The contract plans are located in the 100_Contract_Plans folder of the project in ProjectWise, as
shown below:

EE @ : # - SearmL;Ea

v| P> Interface| CTDOT_Doc_code

v| ViE‘W‘Dﬂcumant “ Spat\alView:E

Address pw:t\ctdot.projectwiseonline.com:CTDOT\Documents'01.0 - Projects - Active'0085-01414100_Contract_Plans (F ¥ | % Go

- B

™ 0063-0637
" 0063-0633
"% 0063-0641 8 0063-0671
[* 0063-0693 & 0093-0180
" D063-0844
"% n0e3-0670
" Dos3-D872
"% 00630673
[ 0063-0679
(" DD63-0079
"% 0070-0115
™ 0070-0116
" 00730173
" 00730174
[ 0076-0216
{* 0079-0235
[** nos1-0088
{* nos1-0091
{* noaz-0z99

&

onzzooc /

=% 00350141

L 100_Contract_Plans (PDF)

L= 120_Contractor_Submittals (PDF)

L 130_Soil_Archaeclogical_Misc_Reports (FDF
L= 210_Construction
Z2Z0_FHWA
230_Cantrack_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Preliminary_Design_DocumentsiPDF)
320_Permit_Applications
' 330_Design_Data

L 340_Admininstation

L 341_Confidential_administration
' 500_Pre_Design
% saved Searches

HHEYEHY

{* ooss-0142

~

Label {User Defined) Description

_/ 01_General 01_General

_/ 02_Revisions Revisions Subset

_/ 03-Highway 03-Highway

_/ 04_Structures Structual Subset

# B) os_Traffic 05-TRAFFIC

7 B ve_ata1_F10 ATET _Utiity_Plan

# B} cTooT_Highway_sTD CT_COM_STD_008S-0141_CTDOT_Highway_STD
# [B) cToOT_TRAFFIC_STD CTDOT_TRAFFIC_STD

Contract Plans

are located in the
100_Contract Plans
folder of the Project

¢

Main Category  Su

CON
CON
CON
CON
CON
CON
CON
CON

F

[T e e e e

Project Properties | Folder Properties | Dependency Service | &ocess Contral

GEMERAL -
GENERAL -
GEMERAL -
GEMERAL -
GEMNERAL -
GENERAL -
GEMERAL -

Project Mumber(z]

Program Muraber

Project Title

CTDOT Improvement Type
General Description
Federal Proj Dversight
Project Current Phase

Figure 140 - Location of the Contract Plans in ProjectWise
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1. Login into ProjectWise, then browse to the 100_Contract_Plans folder of the project you
are working on.
2. To open a document with Bluebeam right click on the document, and select “Open
With” as shown below:
# | Label (User Defined) Description
Vi n 01_zeneral i £
_/ 02 _Revision
/ 03-Highwway
/a 04 _Skruckur
7 a 05 _Traffic Open With, .,
# Blos_ataT F ”awp -
# Blcoot Hgt £-0141_CTDOT Mighway STD
# Bl cToot_TRe 51D i i
Check Out Right click on the
. plan subset to open
apy Ol
[ 1] H mn
— and select "Open With
Start Studin Session,..
= Refresh Local Copy
Purge Local Copy
(PCF Purge Workspace
Cut
£ Copy
Document Properti to Previews | Dependency Service || Access Control | Compon
::I) = Copy Ta... [
GENER&L-Proj  Move To..
GENERAL - Proi  Rename...
Figure 141 - Open With Bluebeam
3. Select the Bluebeam icon and check “Always use this program” and select OK. The

« Open document with x|

document will now be checked out of ProjectWise and open with Bluebeam:

Select I
Program
MName | Description | Application
lIl:“JF’DF Document PDF Document "C:\Program Files\Bluebeam Software'Blusbeam Revu'Revu'Revu,exe”™ ™01
B sdobe Reader 9.3 Adobe Reader 9.3 C:\PROGRA1\adobe\READER ~2. 0'reader\acrord32. exe "%1"
F.. Adobe Acrobat Document Acrobat "C:\Program Files\Adobe\Acrobat 10.0\Acrobat\Acrobat.exe” " 1”

1| — Check | _;l
I al use this program Select Browse |

Select

[~ Open document as read-only
Click here for a list of suggested document viewers

Figure 142 - Open with Bluebeam

Note: Since we checked “Always use this program”, the next time you open a pdf in
ProjectWise all you need to do is double click on the file.
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then
select “Check In” when a ProjectWise dialog box pops up. If the document is not
checked back into ProjectWise the As-Builts will not be uploaded to ProjectWise.

Applying Digital As-Built Stamps

Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet,
located in the 01_General subset, as stated below:

1. Select the ”“Construction Started and End Dates”: stamp from the “CTDOT As Built
Tools” tool box and place it at a conspicuous location on the title sheet:

2016 CONNECTICUT DEPARTM G @ ZEI C?I Q G @ ékl Q Q Q “H "H

TRANSPORTATION SPECIFICA”

INCLUDING SUPPLEMENTAL S _ KRG AL ©
SURVEY INFORMATION DERIV ~ CTDOT As Built Tools
VERTICAL DATUM - NGVD29 o
HORIZONTAL DATUM - NAD{3 Construction Started and End Construction Started and End
) Dates Dates

RIAN K. GALBRAITH
DESIGNED BY: TS SR Ui eCEy

MAYOR FUSS & O'NEILL, INC.

146 HARTFORD RD

MOTHY P. UMRYSZ MANCHESTER, CT
TOR OF PUBLIC WORKS

This sheet Not Corrected
Typical Section Corrected

These Quantities Not Corrected

As-Builts Completed By As-Builts Completed By
CONSTRUCTION STARTED DATE
CONSTRUCTION END DATE As-builts Checked By As-Builts Checked By
INSPECTOR MONTH YEAR
i+59.35 / Line Use to Cross Out
3 MILES) rTJ PolyLine
7 Callout
Text Box
0 FUSS&O? |/~ 4
0 e
I (60 /IE)) 3 / Arrow
h -
O Ellipse
o

Figure 143 - Construction Started and Completed Date Stamp

2. Enter Start and end and click OK as shown below:

Construction Started and End Dates @
JavaScript Window
Type Construction Started and End Dates

Inspector: calkinsmj|
onstruction Started Date mm./‘dd Aryyy: 12/12/2014
Construction End Date mm./dd Ay 12/13/2015

_ Lok D
Enter Start and End Date
and then click OK

Figure 144 - Entering the Dates for the Stamp

Below is an example of the placed stamp:
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IENT OF TRANSPORTATION

lans For

EHABILITATION CONSTRUCTION STARTED DATE 12/12/20

rE 2’ 207 & 430 CONSTRUCTION END DATE 12§:2§ZD:§
INSPECTOR calkinsmj

n(s)/City of

\, MANSFIELD

RLBOROUGH
AINTEMANCE
SPONSIBILITY LENGTH

STATE 00D FEET

Figure 145 - Placed Stamp

This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail
Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select
that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to
every sheet included in plan set, including the as-built revised sheets, and then go back and
remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that
stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner
of the first sheet in the plan set:
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TRANSPORTATION SPECIFICA”
INCLUDING SUPPLEMENTAL §

SURVEY INFORMATION DERIV

VERTICAL DATUM - NGVD29
HORIZONTAL DATUM - NAD&3

DESIGNED BY:

FUSS & O'NEILL, INC.

146 HARTFORD RD
MANCHESTER. CT 06040

CT. LIC. NO. 20891

MONTH YEAR

THIS SHEET NOT CORRECTED

FUSS &0

TARTFORD

ROAD

R, CONNTETT

. CTDOT Review Tools

~ CTDOT As Built Tools

YN N N

Subject

Construction Started and End
Dates

This Sheet Corrected
This sheet Not Corrected
Typical Section Corrected
These Quantities Not Corrected
As-Builts Completed By
Ag-builts Checked By
Ling

Polyline

Callout

Text Box

Arc

Arrow

Comment Label

Construction Started and End
Dates

As-Builts Completed By
Ag-Builts Checked By

Use to Cross Out

Figure 146 - Placing the "This Sheet Not Corrected Stamp"

Right click on the stamp that was placed and select “Apply to All Pages”:
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Ll LI, INUL ZUaY ]

Cut
Copy

Paste

Format Painter

Delete

Open Pop-Up Note

Change Colors

Layer

Order
Alignment
Edit Action...
Capture...
Flatten

Lock

Legend
Reply

Set Status

Check

Add to Tool Chest

Set asg Defauli

Ctri+X
Cirl+C

Cirl+v

Ctri+Shift+C

Del

&0

TFORD ROAD
ESTER, CEONNITIT
s

Ctri+Shift+E

Ctri+Shift+L

Apply to All Pages

=

Figure 147 - Placing the Stamp on All Pages
This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the

pdf set.

NEE RN

A
4
C
o
X
b

NOTE: You must go back and replace this note on the sheets that contain as-built revisions

with the appropriate stamp.
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This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that
stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every
sheet included in plan set, including sheets that do not contain as-built revisions, and then go
back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp
from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the
first sheet in the plan set:

2. NOTE: You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.

Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built
tool box shown below and apply it to the document that is being as-built.

Tool Chest

~ Sequences & Actions

[a (a2 G Ca (o [d (0 40 G Gan G oom

> CTDOT Review Tools

~ CTDOT As Built Tools

Subject Comment

Construction Started and End Construction Started and End
Dates Dates

This Sheet Corrected

This sheet Not Corrected

Typical Section Corrected

These Quantities Not Corrected

As-Builts Completed By As-Builts Completed By
As-builts Checked By As-Builts Checked By
Line Use to Cross Out

PolyLine

N N

Callout

Text Box

Arc

Arrow

Ellipse

Group Cross Out

Cloud

32 X 00 ¥No

Figure 148 - As-Built Tools

In the following example, the Line tool was used to cross out the existing text and the Text Box
tool was used to add text:
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BITUMINBU
CONCRET
- PARIK-LCURBIN

\ Line Tool
h \Ll P\ Text Tool h <

N

Figure 149 - As-Built Note Example

Do not add a note to a comment by double clicking on the comment. For example, if a line
was placed the user could double click on the line and add notes to it:

N
- g Line X
A Fonald Tellier Supe... 101/20012 12:58 ..

Y A s R

Figure 150 - Incorrect Way to Add Text

If notes are added this way they do not print.

Digital As-Built Stamps and Notes Using ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this
folder:

C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current
user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous
sentence, if version 10 is used replace with 10.

Stamp Files
As-Built stamps.pdf

These stamps are to be placed following Section 8.3 above.

As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe
commenting tools in the following format:
1. Text Font shall be Cambria 16, and the color Red.

2. All line work shall be line width 2 and the color Red.
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Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to
ProjectWise for future use. This information shall be uploaded to ProjectWise in accordance
with the following:

1. Combine the additional As-Built information into (1) PDF for each discipline subset.
For example if the 03-Highway and the 04-Structures set had additional As-Built
information, 2 separate PDFs would need to be uploaded to ProjectWise.

2. After the additional As-Built information is combined into their respective files they
will need to be uploaded and attributed into ProjectWise in accordance with the
following:

a. Loginto ProjectWise Explorer.

b. Make sure the Interface “CTDOT_Doc_Code” is selected.
c. Dragand drop the PDF into the 100 Contract Plans folder in ProjectWise.
d. Select the advanced wizard.
e. Click next until you get to the attributes page shown below and assign the
following attributes:
e Discipline=CT
e Main Category = CON
e Sub-Category = ASB
e Label = Subset No. and name, for example for the 03-Highway set
type 03-Highways.
e Description = Additional As-Built information for....
Advanced Document Creation Wizard =]

Define Document Aftributes
*You should define environment specific document attributes.

Lisi s & Fill these in :

cT -

Main Category ain Category Description
CON - All Cortract Plans & Specs

Sub Category Eub Category Description
As-Built Plans

Project Number(s)
00580329

Label (User Defined) Document Date (mm/dd/yyyy)

03-Highways -
Description

m

Additional As-Buitt Information for Loop Detectors

[Aauto FillInd
03-Highways _CT_ASE_0058-0329

CTDOT Asset Tags
Bridge No(s) Sign Structures

| []

Then Click Next w:)
[ <Back l‘]L Next > 4])[ Cancsl

Figure 151 - Additional As-Built Information

f. Then click next until the document uploads.
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Setting Documents to Final Status in ProjectWise

After the As-Builts are completed it is ready for permanent storage a final status will be applied
to the document as shown below:

Select all the files or one at a time and then right click and select Change State>Set Final Status.

Label (User Defined)

/8

C/- » AT

A= Projebt Schedul

Right Click on the file
and select Change
State>Set Final Status

| —een Propesti

Description

173-464 90% _TR_Review_TR_Final 0173-0464

90% Design Review Request

Open

Open as Read-Only
Open With...
Markup

View

Check Out
CheckIn

= Delete

[Real (Docum

DMScenform

Modify...

Name 4

Modify Spatial Attributes...

Enter filter here

€ ADMINISTR)
€ BRE-Admin
E Bruce.Bourg.
€ CDI-Admin
€ Chuck.Lawso

Add Comment
Set

Send To

Copy List Te

ect Schedule

b =eds Assessment Form

beam end repair bearing replacement

l“FrE? -.__., —naadP™ ’—-\-._L«__’-k e r..—-ab-s

7]

Praview | Dependency Viewsr | Access Ci

3

EEEERE)
EIEIRISIE b
BIRIEIEBIEKE
EEEE S

»

€ cL5-Admin
€EConnDOT I
€ Consultant E...
€ Contractors
€ Copy of IMA...
€ Copy of SVC...
€ CTCodeCha...

. ctdot-pw.co...
€ ctdot-p

Change State

=

:EAEEEe

=

)
)
Previous

=—Batch PrInt
Properties.
Change filename to CT_Code

Edit attributes for multiple documents

Figure 152 - Set Final Status

_/
& Change...

o
( Set Final Status

TETITOVE TTTaT Sats

e

Document Securi

&

T

i o B2 B2 b2 bz e g e |

k2 lea)

This will lock the file so no one can delete it. If a user needs to remove the final status contact

DOT.AECApplications@ct.gov

Construction Completion Project Polygon

If the project limits were changed in construction, the project polygon KML file shall be updated.
The following shows how to do this.
1. Browse out to the 170 Row Files folder under the project in ProjectWise and double

click on the FDP Boundary

Issued April 2020

135

Version 5.01


mailto:DOT.AECApplications@ct.gov

Connecticut Department of Transportation — Digital Project Development Manual

2% 0031-0131 .
% 0032-0130

List | Spatial

LabelilcasDafinad

% 0032-0140
(% 0032-0145
%% 0032-0146
[ 0032-0148
% 0032-0149

_/Q_, DA Boundary
_/m DA Boundary
_/'&g_, FDP Boundary
/m FDP Boundary

Description

|l |

- 0033-0127

% 0033-0128

-7 0033-0129

-[7% 0033-0130

- 0033-0131

{1 0033-0132

100_Contract_Plans (PDF)

110_Contract Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration
141_Project_Administration_Confidential
142_Project Administration Correspondence
150_Quantity Calculations

151 Final Design Calculations

e T B O O B O O O O O O

m

HHYHEEEEEY

170_ROW Files

_Construction
220_FHWA
230_Contract_Administration
240_Contract_Development
241_Contract_Developrment_Confidential
310_Milestone_Submissions
320_Permit_Development
330_Design_Data
500_Survey
600_Project Initation Documents
-3 Saved Searches
% 0034-0305

B

&

Figure 153 - Project Polygons

2. Open the file with Google Earth.

It may say KML like below.

a Open document with

Select

Program

MName Description

[T KML

1| [

Application

"C:\Program Files {x88)\Google\Google Earth Pro'\dient\googlesarth.exe™ %1

[ Always use this program

[] 0pen document as read-only
Click here for a list of suggested document viewers

Browse

=

Figure 154 - Google Earth

3. After the polygon opens, right click on Style 1 and select properties. This will allow
you to edit the polygon.
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= Google Earth Pro

File Edit View Tools Add Help

¥ Search

x: 15213

Get Directions History

v Places
@ My Places
Vs Temporary Places
4 Q polygon

4 VI Levels
4 V& 100! Prelim_Proj_Polygon
o
Add
Cut
Copy
Delete

@ o]

v Layers

Rename
Save to My Places

Save Place As...
Post to Google Earth Community Forum

Email...
Snapshot View

Show Elevation Profile

Properties

B Primary Database

I ¥| @ Thenew Google Earth

> W1 Borders and Labels
Places

¥ = photos

V1= Roads

gﬂ 3D Buildings

4.

£
=99Cware,

Then adjust the polygon as ne

Figure 155 - Editing the Polygon

"G,

Tax

(S
v,:no@“ %
25

Figure 156 - Adjusting the Project Limits

5. Then click OK on the properties box.
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Figure 157 - Adjusting the Project Polygon

6. Then right click on Style 1 and select Save Place As
ile Edit View Tools Add Help

¥ Search

| Search
x: 37 25" 19.1°N, 122 05' 06"W
Get Directions History

r Places

s My Places
Vs Temporary Places
4 V& polygon

4 [V Levels

! T&Ot-Prefirg_Proj_Polygon

VI8 stylel

Add 4

Cut

Copy
Delete

Rename

Save to My Places

L Save Place As...
Post to Google Earth E:mmunity Forum

Email...

Snapshot View
Show Elevation Profile

Properties

Figure 158 - Saving Project Polygon

7. Name the file construction polygon and save it as a KML file:
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s Save file... ==
o
@Uv|- Desktop » P|
Organize v MNew folder = - (7]
S Favorites * MName Size Ttem type Date modified i
. Creative Clol{ﬂzl =| project polygon.kml 5KB KML 10/25/2017 2:27 PM
Bl Desktop =] 17.kml 623,233 KB KML 10/20/2017 815 AM E
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[2] Dacuments - All Documents 1KB Internet Shortcut 2/6/20151:04 PM
4 Libraries @ Mew Projectwise User 1KB Internet Shortcut 1/9/2014 6:59 AM
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J7 Music - . 0137-0158 File folder
[E5] Pictures . DPD Revision History File folder 9/25/2017 T:53 AM
B videos . Signals File folder 9/19/2017 3:00 PM
. Export02.2 - Asset - Signal Intersections File folder
- Computer . MIC File folder
& QSDisk () . Attributes File folder 017 7:23 AM
—a Data (It} . Training Videos File folder 8/28/2017 1:34 PM
&% DVD RW Drive (E: . Railroad crossings File folder 6/20/2017 8:38 AM
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File name:

Construction Polygon.kml

Save as type: [Km\ (*.kml)

* Hide Folders

[

Save
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Figure 159 - Saving a KML

8. Then upload this file into the 170 Row Files folder in ProjectWise and label the file
Construction:

'OJECTVVISE EXPIOTEr

rce | Folder

Search [0 *kml

Document

Export View Tools Window Help

NS

§ '%‘> - lll :Address & | pwihctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0033-0132\170_ROW Files\polyg ~ bGo

Tt

[ 0033-0132

100_Centract_Plans (PDF)

110 Centract_Documents

120 _Centractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration
141_Project_Administration_Cenfidential
142_Project Administration Correspondence
150_Quantity Calculations

151_Final Design Calculations

160_Project s
170_ROW Files i

B ¥ 7 6 N 6 o

84

[

. nnRd-nans

210_Censtruction

220_FHWA
230_Centract_Administration
240_Contract_Development
241_Contract_Development_Cenfidential
310_Milestone_Submissions
320_Permit_Development
330_Design_Data

500_Survey

600_Project Initation Documents
Saved Searches

Figure 160 - Saving Polygon to ProjectWise
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8.4 Notifications

Notifying Department Personnel

After the as-built information has been completed, the person responsible for the as-built

revisions shall notify the appropriate Department personnel (via e-mail):
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Lead Designer

Chief Inspector

Central Surveys

ROW

Central Construction

Bridge Maintenance (if a structure is on the project)

Mathew Calkins and Julie Annino — AEC Applications
DOT.AECApplications@ct.gov
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Section 9 Contractor Submittals

9.1 COMPASS Submittal/Transmittal Application

This section establishes the requirements for, and procedures related to, the submittal and
processing of Contractor Submissions using COMPASS’s Submittal/Transmittal Application (S&T
Application). The business processes for Shop Drawings, Working Drawings, and Product Data
(Catalog Cuts) are defined within this manual. For all other submittal types, please follow
relevant manuals. It is the responsibility of the Engineering Project Manager to generate and
deliver the Contractor Submittal List to the District. The list shall include the expected contractor
submittals, such as but not limited to Shop Drawings, Working Drawings and Product Data. This
list will eliminate confusion and improve contractor submittal turnaround times.

The S&T Application is a custom-built application that enables Contractors to digitally deliver
documents to the Department for processing. Contractors only need internet connectivity, an
internet browser and a free Microsoft Office 365 account.

High level S&T Application Functionality:

e Provides free, cloud-based access for the Contractor

e (Cloud-based storage and access for the Department

e Automatically delivers submittal documents to the appropriate CTDOT staff
e Ball-In-Court (BIC) submittal review tracking and notification controls

e Automatic document version control for modified or replaced documents

e Automatic document storage in correct folders

e Integrated with Bluebeam

The S&T Application automatically tracks what processing phase the contactor submittal is in
and who is currently responsible for reviewing the submittal. Staff are tracked using a BIC
workflow. The processing phase is tracked using the Submittal Review Status. These tracking
functions will be described in detail below.

Once documents are delivered to the Department, the S&T Application allows Department Staff
to establish custom BIC review processes that include one or more reviewers. Reviews that
require multiple staff may be conducted in series or in parallel. Notifications and reminders are
automatically sent to the appropriate staff using email. Notifications include both instructions
and links to the submittal documents.

The S&T also automatically creates versions of replaced or modified documents, providing a
high level of quality control and making finding the latest document easy.

The following fundamental set up is required for each project prior to using the S&T Application:

Action Responsibility
1. Set-up project site, including item number list | Automated / AEC Applications
2. Set-up COMPASS Project Site Permissions Engineering and Construction PMs
3. Complete the Approval Matrix Engineering and Construction PMs

Even though the Submittal/Transmittal Application uses emails to notify staff, staff can also
monitor project submittal activity by directly accessing the S&T table, as information is live and
continuously updated. This is also true for staff that have been assigned to the CC list.
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Basic Navigation of the S&T Application

The following section describes how to get to the Submittals/Transmittals home page for your
project. It also provides a brief description of the homepage layout and navigation functionality.

Getting to the S&T Application:

1. From the Project Landing page, navigate to Project Details page.

Project No. 0173-0468 Temp ID. PP092-0019

CLICK TO NAVIGATE
TO PROJECT DETAILS

7 MS Project Schedule

Figure 161 - Project Details Button

2. Navigate to the Submittals/Transmittals page

Dashboard Details Submittals/Transmittals

CLICK TO NAVIGATE TO THE
SUBMITTALS/TRANSMITTALS PAGE

i MS Project Schedule

Figure 162 - Submittals/Transmittals Page

o Hr G
Project Overview ? Help
Detals  Submittals/Transmittals & Back to Project List
OVERALL SUBMITTAL STATUS
\ 20
15
’ 73
5
[} I I
DEC-2018 AN-2020 FEB-2020
Submnittals / Transmittals Approval Matrix
FILTER
£ Search Submittals Sub Type Status ~ || BallIn Court Due Date Phase Y Allsubmittals
SUB TYPE TEM NO. REVIEW STATUS BALL IN COURT SUBMITTALD... FINAL DUE DATE PHASE
£ 0101126 Disposal of Hazardous Wast  Correspondence 0101126 Complete 1-15-2019 Construction

£ 817 Section 1 10 03 BMP AppendixB_Comespendence Complete 08262019 Construction

Figure 163 - S&T Application Home Page

Submittals are displayed in a table on the S&T Application page. We call this list the S&T table,
see figure above. Submittals may be searched using the search submittal field and filtered using
the drop down filters. Sorting is also available by clicking the column headers.

Issued April 2020 142 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

The Contractor delivers submittals by clicking the New Submittal button. Project Managers click
the Approval Matrix button to launch a user interface that allows them to predefine submittal
distribution including CCs. See Approval Matrix for detailed information and instructions.

Submittal table data may be exported to Excel.

To search, enter key words from submittal names in the search field, or select a filter option
from the various drop-down boxes to filter, or do both. Press the Reset Filters button to clear all
search and filter results.

FILTER SUBMITTALS BY

(,O Search Submittals ) Sub Type Status Ball In Court Due Date

Reset Filters

To sort columns, select the arrow to the right of each column heading. Columns can be sorted
in ascending or descending order.

SUBMITTAL v SUBTYPE V¥ ITEMNO. ¥ REVIEWSTATUS % BALLINCOURT ¥ SUBMITTALDATE “ FINAL DUEDATE v

To open a submittal simply click on a specific submittal name or its review status. For example,
clicking on 0101126 Disposal of Hazardous Waste yields the following details shown in the figure
below. Notice the submittal acts like an envelope for any attached document. Various
attributes and the BIC workflow are also visible. For detailed information regarding the BIC
workflow, see How to Process a Contractor Submittal.

Attributes

/ Attributes /

Attached Submittal Document

BIC Custom Workflow

..... . B / B

& & & &

Figure 164 - Submittal Status Review

How submittals are tracked

The following five Review Statuses/Submittal Phases are used to track submittals.

1. Process Assignment — Applying Custom BIC Workflow
2. In Review — Execution of BIC Review Workflow
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3. Revise and Resubmit — Further Action Needed by the Contactor
4. Complete — No Further action needed — Submittal Fully Processed
5. Draft —Saved Work - Started but need to finish

Review Statuses for each submittal are displayed on the S&T table under the column heading
“REVIEW STATUS.” The fields in this column automatically display and update as the submittal

owner and any additional reviewers complete their reviews. Review Statuses are not to be
confused with the Department’s disposition regarding a specific submittal document.

Submittals / Transmittals Approval Matrix

FILTER SUBMITTALS BY
£ Search Submittals Sub Type v Ball In Court v Due Date Vv Phase v 3¢ All submittals

Reset Filters Export to Excel
SUBMITTAL SUB TYPE TEM NO @ BALL IN COURT SUBMITTAL D... FINAL DUE DATE PHASE
£ 0101126 Disposal of Hazardous Wast  Correspondence 0101126 Comprere 11-15-2019 Construction
# 817 Section 11003 BMP Appendix B Correspondence Complete 08-26-2019 Construction
< 0602000 BR 00480 N Abu W Ftg R Shop Drawing - Bridge 0602000 08-20-2019 Construction
X RFI0037 Access Rd Around Capped L RFI 04-24-2019 Construction
0601201 06947 P1 Col Max Delta 201 Correspandence 0601201 01-06-2020 Construction
060393 1A Struct Steel Br 06000A Spa  Shop Drawing - Bridge 0603931 Process Assignment Andrews, Meredith L 01-06-2020 Construction
1201801 Fnd Des and Comps 015N 0 Working Drawing 1201801 In Review Daniel Hoffman 01-06-2020 01-25-2020 Construction
1of6
1201801 Fnd Des and Comps 015N 0 Working Drawing 1201801 In Review Daniel Hoffman 01-06-2020 01-25-2020 Construction
1of6
1201801 Fnd Des and Comns 0155 01 Workina Drawina 101801 In Review Naniel Hoffman 01-06-2020 01-25-2020 Construction

Figure 165 - S&T Table

vIRY

1201801 Fnd Des and Comps 015N 0 Working Drawing 1201801 In Review 01-06-2020 01-25-2020 Construction

Figure 166 - S&T Table

The above two figures show an example of an S&T table. You will notice that each review status
is associated with a person(s) that are responsible for some action. Meredith is responsible for
establishing the BIC review workflow during the “Process Assignment” phase. Daniel Hoffman is
assigned as the first reviewer of six per the custom BIC workflow during the “In Review” phase.
When the Review Status reaches complete the number count becomes blank.

Approval Matrix

The Approval Matrix is a project-specific matrix that is completed by the PMs to front load
Contractor submittal distribution information into COMPASS. It is a component used by the S&T
application to automatically route contractor submittals the appropriate Department employee.

The Approval Matrix eliminates the need to include submittal delivery information within
specifications and simplifies the Submittal process for the Contractor. Contractors no longer
need to manage distribution data.

IMPORTANT - The Approval Matrix must be set up prior to the Department receiving
submissions.

The Engineering Project Manager and Construction Project Manager are jointly responsible for
preloading the Approval Matrix. They must assign one person to each submittal type listed in
the Matrix. The person they assign to each submittal type is called the submittal owner, who is
responsible for receiving and processing any submission with that submittal type.
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The PMs are also responsible for defining who shall be CC’'d on each submittal type. Staff added
to the CClist have no required action to complete the review. Individuals who are added to a
submittal type CC list are not granted any special privileges or access rights. They will however,
receive an email notification each time the following actions take place on a given submittal
type:

e New submittal created (Process Assignment)

e Submittal marked as Revise and Resubmit
e File(s) replaced in response to a Revise and Resubmit (Process Assignment)
e  Submittal marked Complete

= Close | Approval Matrix

Submittal oy - |
OWNER — CC List

Assigned by PM Defined
LTS by PM

Figure 167 - Approval Matrix

Submittal Owner

The submittal owner is the CTDOT/Consultant employee responsible for assigning any reviewers
(optional), initiating a Bluebeam Studio Session (optional), setting due dates in conformance
with any contractual obligations, and responding to the Contractor with the Department’s
Disposition.

Submittal owners are assigned to a specific submittal type in the Approval Matrix. Depending on
the submittal type, some owners will be Construction staff and some will be Engineering staff.

Because submittal owners are responsible for establishing the BIC custom review workflow, they
must possess a strong understanding of the business processes associated with their submittal
type. They must thoroughly understand who performs each step and how much time shall be
allotted. They must actively check on progress and ensure the submittal review is completed
and returned within the contractual timeframe.

9.2 Setting up the S&T Application

This section provides directions on how to provide access to project staff, how to complete the
Approval Matrix, and how to invite the Contractor.
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Project Access - Site Permissions

All individuals who need to access a project site — including CTDOT staff, consultants and
contractors — must first be granted project-specific access using COMPASS Project Site
Permissions. The Engineering and Construction PMs, or those they delegate, are jointly
responsible for setting up the site permissions at the beginning of a project and maintaining
them throughout the duration of the project.

Approval Matrix
After establishing site permissions, the Engineering and Construction PMs are jointly responsible
for setting up the Approval Matrix. To access the Approval Matrix:

1. Navigate to the project in COMPASS. From the Project Landing page, navigate to Project
Details.

0. 0173-0468 Temp ID. PP092-0019

» Project Dashboard [y Copy Project url

CLICK TO NAVIGATE
TO PROJECT DETAILS

7 MS Project Schedule

Figure 168 - Project Details

2. Navigate to the Submittals/Transmittals page.

Submittals/Transmittals

CLICK TO NAVIGATE TO THE
SUBMITTALS/TRANSMITTALS PAGE

—{ MS Project Schedule

Figure 169 — Submittals/Transmittals tab

3. Open the Approval Matrix by selecting the Approval Matrix button, located next to the
New Submittal button.

@ New Submittal Approval Matrix

Figure 170 - Approval Matrix Button
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4. Click in one of the field boxes for a Submittal Type.

5. Start typing the person’s name in the box under the “To” column and select the correct

name when it appears. For consultants who have a ct.gov email address, select the

user’s company email address, not their ct.gov account.
6. Repeat for other submittal types.
7. Click Save before closing the dialog box.

DOT STAFF
TO
Aresco, Salvatore / Transportation Supervising Engineer x Shop Drawing -
Hussein, Shalal / Transportation Engineer 2 x Shop Drawing -
Iynr| Shop Drawing
Suggested People
Alexander, Lynne M. Shop Drawing -
Lofberg, Lynne / TransportationEngineer2
Luzusky, Lynn /IT Analyst .
Shop Drawing -
Lynn M.. Szkoda / Transportation Engineer 3
lynnelofberg@uconn.edu / lynnelofberg@uconn.edu
Murphy, Lynn D. Shop Drawing -

Warzecha, Lynn L/ TransportationEngineer2|{CE)

Figure 171 - Update Approval Matrix

SUB TYPE UNIT
Highways Highways
Bridge Bridge

- Traffic Traffic
Highway Operations Highway Operations
llumination llumination
Facilities Facilities

In addition to assigning the required submittal owners, PMs may also add staff to the optional
CC list for each submittal type. IMPORTANT - In order for staff to receive submittal notifications
through the use of the CC list the PM must not only add them to the Approval Matrix but must
first grant them access to the project in COMPASS, as described in COMPASS Project Site

Permissions.

To add a user to the CC list:

1. First use the same instructions listed directly above to navigate to the Approval Matrix.
2. Click on the box under the CC column and start typing a name. Select the name. Click

the Save button at the bottom or top of the dialog box.
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TO SUB TYPE UNIT cc

Transportat Supervising Enginee p Drawing - Highways Highwa: judg

Figure 172 - CC List

Invite the Contractor to COMPASS

The CTDOT Construction Project Manager (Project Engineer or Chief Inspector) is responsible for
inviting the Contractor to join the project in COMPASS. Contractors need to be sent a separate
invitation for each project.

To invite a Contractor to a specific project in COMPASS, follow the steps described in Setting up
Site Permissions Groups. Invite the Contractor to the xxxx-xxxx Contractors permissions group.
The Contractor should accept the invitation following the instructions provided in Accepting an
Invitation (External Users).

9.3 How to Process a Contractor Submittal

Once the Contractor delivers a submittal, the submittal Owner is then responsible for
establishing and starting the Department’s BIC internal review workflow. Submittal Owners
establish who needs to review the Submittal, initiate a Bluebeam Studio Session (optional), set
due dates in conformance with any contractual obligations, and respond to the Contractor with
the Department’s Disposition.

Shop & Working Drawings and Product Data Submittals

The three types of Contractor submittals identified below are covered in this manual. Although
they are covered in this manual they are each being precisely defined in your project Contract
specifications. The following ‘short hand’ descriptions are provided for instructional purposes
but are not the controlling definitions.

Shop Drawings supplement the information in the contract documents (e.g., plans and
specifications) and include details, diagrams, etc.

Working Drawings portray the design of an engineered feature required by the Contract that
was not designed by the Department’s Designer. Working Drawings and supporting information
are prepared and stamped by a Professional Engineer serving as the Contractor’s designer.

Product Data (Catalog Cut) is product information developed and made available by
manufacturers, such as product specifications, diagrams, installation instructions, etc.

IMPORTANT - Although, contractors submit other types of submittals to the Department for
review, only the workflows for the three submittal types are covered by this manual. Please see
other office manuals and directives as necessary.

Summary of Processes and Roles

This section summarizes key points related to processing Shop & Working Drawings and Product
Data Contractor submissions, with a focus on Department responsibilities and coordination.
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This summary is an overview of the Contractor submittal and internal review processes and is
intended to be an instructional overview. It is important to understand that the contract
documents (i.e., including special provisions), not this summary, control the actual requirements
between the Contractor and the Department, and should be referenced for all project decisions.

Timely, coordinated and effective communication is essential to the successful and equitable
completion of the Contract. Generally, the Department is required to respond to a Contractor
submittal within 30 calendar days of its receipt, with 20 additional days allowed to process any
necessary resubmissions. Special provisions may alter this typical timeline.

Shop Drawings/Product Data along with supporting information shall be submitted by the
Contractor to the Department and shall be processed by the Department’s submittal owner
using COMPASS.

Once received it is the owner’s responsibility to ensure that the shop drawing is reviewed, that
appropriate comments have been made and the Department’s disposition is clearly defined by
stamping each shop drawing sheet and, at a minimum, the cover sheet of any multi-page
support documents with the appropriate Department (digital) Action stamp.

Working Drawings along with any supporting information, transmittal, calculations, and
certificates of insurance, shall be submitted by the Contractor to the Department and shall be
processed by the Department’s submittal owner using COMPASS.

Once received, it is the Construction District’s responsibility to ensure that the working drawing
is reviewed, that appropriate comments have been made and the Department’s disposition is
clearly defined by stamping each working drawing sheet and, at a minimum, the cover sheet of
any multi-page support documents with the appropriate Departments’ (digital) Action stamp.

It the discretion of the District to decide if they need assistance from the Office of Engineering
during the review process. Typically, the District will ask the Design Engineer(s) to perform a
review on Working Drawing submissions involving structures and complex engineering. All
requests for additional reviews shall be completed in COMPASS. See the Construction Manual
for guidance for additional reviewers.

When requested by the Construction District, the Department’s Designer(s) from the
appropriate discipline(s) (e.g., Bridge, Highway Design, and Traffic Engineering) shall review the
Working Drawing documents, and stamp (with a Review stamp) each Working Drawing sheet
and, at a minimum, the cover sheet of any multi-page supporting documents.

Each time a reviewer applies a, “Reviewed with Comments” stamp they must also provide a
comment note that clearly describes the reviewer’s recommended disposition, i.e. exceptions as
noted, revise and resubmit, or reject.

The Construction District should evaluate the Designer’s comments and recommendations and
meet with the Designer and/or Contractor to resolve any conflicts.

After considering the Department’s Designer’s review comments and other pertinent
information, the Construction District will make appropriate adjustments to the comments and
clearly define the Department’s disposition by stamping each Working Drawing sheet and the
cover of associated support documents with the appropriate action stamp.

All communications between the Contractor and Construction District and between the
Construction District and Department Designer shall take place in COMPASS.
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The submittal type the Contractor selects determines which submittal Owner will receive the
submittal and what internal business process review will be implemented. Some submittals will
be processed by Construction, some by Engineering, and some by both. COMPASS'’s flexibility
allows submittal Owners to establish a variety of review workflows. Review workflows for all
submittal types must adhere to all standard business processes as defined in the Contract,
issued as directives and defined in office manuals.

IMPORTANT - In order for employees to participate in a review they must first be given access
to the project in accordance with section 2.6 COMPASS Project Site Permissions.

Contractor Submittals are tracked using the following Review Statuses:
1. Process Assignment

In Review

Revise and Resubmit

Complete

Draft

vk wn

Process Assignment

When the Contractor creates a new submittal in COMPASS, the initial review status is “Process
Assignment.”

In this phase the submittal Owner first reviews the submittal for completeness. If complete,
submittal owners establish the BIC review workflow by adding the correct staff; setting due
dates; setting the review order; and, launching a Bluebeam Studio Session, if needed. Once the
submittal Owner presses the Start button the review status changes from Process Assignment to
“In Review.”

Submittals may be reviewed by a single reviewer (the Submittal Owner only) or by multiple staff,
including the submittal Owner. Either option always requires the owner to be the last reviewer.
Being the last reviewer allows the Owner to complete the workflow.

If any upper management need to be part of the review, simply add them during this phase in
the correct review spot based on the submittal type needs.

Is the Submittal Complete? - Initial Assessment

The submittal Owner will perform an initial cursory assessment of the submittal before
beginning the review cycle. The initial assessment shall validate if the correct documents are
attached, the documents are complete, are signed, are in the correct file format, etc.

Complete Submittals

If the submittal Owner deems the assessment satisfactory, the submittal Owner will establish
the review process to be used for the specific submittal documents from the following list
provided below. If the assessment is deemed unsatisfactory, see Incomplete Submittals.

One of the following review options may be used:

1. Single Reviewer — The submittal Owner is the only person to review the submittal
documents.

2. Single Reviewer — The submittal Owner performs an expedited review by pressing the
Bypass Approval & Complete button. This is relevant for submittals that only require
acknowledgement of receipt and will not need to undergo a Revise and Resubmit
process.
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3. Multiple Reviewers — The submittal Owner will review the submittal documents along
with additional reviewers, including any reviewers that need to approve the submittal.

Single Reviewer

1. The Submittal Owner will open the submittal by clicking the submittal name or review
status in the S&T table.

FILTER SUBMITTALS BY
)3 Search Submittals Sub Type Status Ball In Court ™~ Due Date ~ Phase
Reset Filters Export to Excel

SUBMITTAL SUB TYPE ITEM NO REVIEW STATUS BALL IN COURT
#  Bridge Deck Rebar — Stage 1 Shop Drawing - Bridge 1234567 Complete

98765432

Coordination Drawing 1234567

Figure 173 - S&T Table

Beaulieu, Shawn W

2. Enter the appropriate due date by clicking on the calendar.
Start a Bluebeam Studio Session if needed.
4. Press the Start button at the bottom of the Submittal Process Assignment window.

Figure 174 - Process Assignment

w

5. Once the Start button is clicked, the submittal owner will receive an email notification
and the submittal review status will automatically advance to “In Review” in the S&T
table.

Single Reviewer — Expedited Approval

An expedited approval option is available to an individual reviewer if all of the following
conditions are met:
e No other reviewers are needed

e No Bluebeam Studio Session or document mark-ups are needed
e The submittal can be accepted and completed as-is with no need for a Revise and
Resubmit process.

If such conditions are met, from the Submittal Process Assignment page, the submittal Owner
may push the Bypass Approval & Complete button.
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SELECT FOR EXPEDITED

APPROVAL PROCESS
Save Revise and Resubmit

Bypass Approval & Complete

When the Bypass Approval & Complete button is selected, the Review Status automatically
updates to Complete and the appropriate notification is sent to the Contractor.

Multiple Reviewers

A submittal Owner will take the following actions when setting up a review workflow with
multiple reviewers:

Start Bluebeam Studio Session

Submittal owners may choose to set up a Bluebeam Studio Session when requesting additional
staff to perform a review. If multiple reviewers are required, it is strongly recommended that a
Bluebeam Studio Session be used to facilitate a collaborative review. See Starting a Bluebeam
Studio Session for details.

Add Submittal Reviewers

The following steps show the Submittal Owner how to add additional reviewers and how to
perform a collaborative review on submittal documents:

1. Click on the submittal name in the S&T table to open the Submittal Process Assignment
dialog box.

2. Click the Add Reviewer button. In the NAME field, type the user’s name you wish to
add. A list of potential reviewers will automatically generate.

3. Click on the name you want to select. Repeat as required.

4. IMPORTANT: In order for added reviewers to participate they must first be given access
to the project in accordance with COMPASS Project Site Permissions.

——— PRESS ADD REVIEWER TO ADD
@Y <—  NEW REVIEWER NAME ROW(S)

Figure 175 - Assigning Reviewers

Set Reviewer’s Due Dates

The Submittal Owner is responsible for assigning Due Dates to all added reviewers (including
oneself). Selected dates must ensure the submittal review process is complete within the
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required timeframes as set by the contract documents. Due Date(s) are displayed in the S&T
table along with warning icons that warn staff of approaching deadlines (e.g., Due within 7 days,
Urgent, Past Due, etc.)

Establish Order of Review

COMPASS'’s flexibility allows Submittal Owners to establish a variety of review workflows. This is
accomplished by providing Submittal Owners the ability to add additional reviewers and to
customize the review order accordingly. Submittal Owners are responsible for establishing the
workflows for each Contractor Submittal. The review workflow established by the submittal
Owner must adhere to all standard business processes as defined in the Contract, issued as
directives and defined in office manuals.

The Submittal Owner can assign reviewers to review the Submittal documents in series or in
parallel, and in any order. To assign reviewers in parallel, set the users’ Order of Review to the
same number. To assign reviewers in series, set the order of review as desired. Any
combination of review order can be established.

Reviewers may be removed by the Owner by clicking on the trash can icon to the right side of
the Order of Review column. By default, the Submittal Owner is always the final reviewer.

HAME DUE DATE ORDER OF REVIEW

LML )

SET THE ORDER OF REVIEW fu"'l
Z TO THE SAME MUMEER TO —
3 Add Reviewes REVIEW IN PARALLEL

Figure 176 - Order of Submittal Reviewer(s)

Once all elements of the review workflow are established, the submittal Owner will press the
Start button. At this point the first assigned reviewer(s) will receive an email notification, the
BIC column will update in the S&T table, and the review status will update in the S&T table to In
Review.

Incomplete Submittals

If the Submittal Owner deems a submittal incomplete or unacceptable because not all the
required documents were attached, documents are incomplete, or are in the incorrect format
the Owner will send the submittal back to the Contractor before beginning a review session.

In such a case, the Owner should push the Revise and Resubmit button and should not hit the
Start button (see figure below). A submittal only truly begins its content review when the
submittal owner clicks the Start button. When a submittal is sent back as incomplete, the
submittal has not been entered into the review phase; the review process and any associated
timeframe requirements have not begun.
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Reasons for returning an incomplete submittal before beginning a review session may include,

but are not limited to:
e Required digital signatures / contractual obligations are missing

e Document Submittal form incorrectly filled out (e.g., incorrect Submittal Type or ltem
Number is selected)

e Document Submittal Type incorrectly selected, causing the submittal to route to the
incorrect approving party. Note: An individual who incorrectly receives a submittal
should respond to the Submitter / Contractor promptly with instructions to select the
correct Submittal Type when resubmitting.

TO SEND BACK AN INCOMPLETE Vv
SUBMITTAL, DO NOT PRESS START.
PRESS REVISE AND RESUBMIT.

v
@
®

It is the submittal owner’s responsibility to explicitly define to the Contractor why the submittal
was deemed incomplete. The Revise and Resubmit button launches the comment box below.

PROVIDE COMMENTS TO SUBMITTER

Pleaze enter any comments you have / CONTRACTOR IN THE RESUBMIT
/ COMMENTS POP-UP WINDOW.

Comments

his submittal is incomplete, >

m 'Agr»%

Figure 177 - Revise and Resubmit

Below is a sample email notification back to the Submitter / Contractor. Comments typed in the
Resubmit Comments window will populate in the email notification.
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The submittal titled Test for incomplete needs to be revised and resubmitted for the following reasons:

his'  submittal is incomplete.
COMMENTS TYPED IN POP-UP WINDOW
ARE SENT TO SUBMITTER / CONTRACTOR

VIA EMAIL.

Please take corrective action identified in the Comments and resubmit.
Click the link below to view the submittal:

https://ctgovdot.sharepoint.com/sites/dev/Projects/0171-0417/Pages/Submittals aspx?routeid=304

Submittal details

Submittal Name: Test for incomplete
Project: '0171-0417"

Purpose: Revise and Resubmit

Content: 0 Shop Drawing - Bridge

When Submitted: 1/24/2019 12:00:00 AM

Figure 178 - Incomplete Submittal

In Review

In this phase submittals are reviewed, approved and tracked using the BIC workflow. In order to
maintain traceability and a high level of quality control all reviews must be completed within
COMPASS. Reviewers must complete their review within their allotted time.

Each reviewer is responsible for applying the appropriate stamps and comments in accordance
with Department Directives and manuals. It is the submittal owner’s responsibility to resolve all
internal comments/disputes and prepare the final documents for the Contractor with the
appropriate mark-ups and stamps.

Tracking who has completed their review is done in COMPASS. In order to provide this
information to the Project Managers each reviewer must perform the following steps when they

have completed their review:

1. Navigate to the submittal through the COMPASS S&T table.

SUBMITTAL

ITEM NO. REVIEW STATUS

SUB TYPE
VIEW THE SUBMITTAL BY CLICKING THE

SUBMITTAL OR REVIEW STATUS LINK
Shop Drawing - Highways

Figure 179 - Review Complete

2. The Submittal Status Review window will open. The current reviewer’s name will be
highlighted in blue in the Submittal Reviewer(s) table. The eye icon identifies ball-in
court.
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- Close | Submittal Status Review

Details Comments/Log

Project No Sub
Testing potential CC bug 0310-0059 404
item Number:- not required
Date Submitted
mittal Type 03-14-2019

Shop Drawing - Highways

- _ , THE REVIEWER'S NAME WILL SHOW IN THE BLUE
) Testing CC bug pdf HIGHLIGHTED ROW. THE EYE ICON TO THE LEFT
INDICATES THE BALL-IN-COURT.

SUBMITTAL REVIEWER(S

NAME DUE DATE STATUS COMPLETE DAT|

o
ol
wn
N
(o]
]

Not Complete NA

w
B |
n

-2019 Not Complete NA

Figure 180 - Ball In Court Reviewer

3. Click the gray Complete button to finish the review and advance to the next reviewer.
The button will turn green and COMPASS will automatically advance to the next person
in the BIC/assigned reviewer(s).

PRESS THE COMPLETE BUTTON TO FINISH THE REVIEW.
COMPASS WILL AUTOMATICALLY ADVANCE THE
SUBMITTAL BIC TO THE NEXT ASSIGNED REVIEWER(S).

STATUS COMPLETE DATE ORDER
Not Complete NA 1 O
Not Complete NA 2

Performing a Digital Review

The Bureau of Engineering and Construction has standardized the use of Bluebeam for all PDF
workflows. As such, this manual only provides instructions for using Bluebeam for PDF review
and commenting.
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PDF reviews will be completed using Bluebeam (Single Reviewer) or a Bluebeam Studio Session
(Multiple Reviewers). Reviewers routed/invited to a Studio Session must place all comments
within the session.

IMPORTANT - All comments must be digital and must be applied directly onto the submittal
documents. The Contractor shall be able to review and clearly understand the Department’s
comments and disposition directly from the submittal documents. Prior to commenting you
must set up Bluebeam by importing the CTDOT Bluebeam Profile, See Appendix A. Once
completed you are ready to comment. It is the submittal owner’s responsibility to resolve all
internal comments/disputes and prepare the final documents for the Contractor.

Document links provided in a Contractor Submission automatically route you to the document in
one of two ways. If the document is in a Bluebeam Studio Session the document link will
automatically route you to the Studio Session.

If the document is not in a Studio Session the link will simply open the document (non-Studio
Session). To open the document as a single reviewer without a Studio Session you must first
integrate your Bluebeam desktop client with O365. To set-up this integration, follow the
instructions provided in Checking Out Documents to Bluebeam.

Integrating Bluebeam with 0365 is a recommended when:
e The Owner is the sole reviewer and a Bluebeam Studio Session is not needed.

e Before returning a submittal to the Contractor, the Owner needs to scrub or modify
review comments applied during a Bluebeam Studio Session.

Digital Review using Bluebeam:
1. Access the S&T Application page
2. Click on the submittal name to open the submittal and view the documents. The
Submittal Status Review dialog box will open.
3. Click on any document name link to open that document
a. Ifthe document is set to a Bluebeam Studio Session the document link will
automatically route you to the Studio Session.
i. Theicon shown below indicates that a document is linked to a
Bluebeam Studio Session.
b. If the document is not linked to a Studio Session you will still use regular
Bluebeam to open. See first link below.

- == ICON INDICATES FILE IS
= LINKED TO A BLUEBEAM
) computations. ’ STUDIO SESSION

Figure 181 - Working in Bluebeam Studio

Once a Bluebeam Studio Session starts for a given document, when reviewers (including the
submittal Owner) click on the document link, they will automatically be routed to the associated
Bluebeam Studio Session. Reviewers are not required to have a Bluebeam Studio account in
order to participate in a Session. Submittal Owners are required to have a Bluebeam Studio
Prime Account in order to start a Bluebeam Studio Session.
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Bluebeam Studio

Figure 182 - Logging into Bluebeam Studio

If the below message pops up, click Open URL: Bluebeam Protocol.

Open URL:Bluebeam Protocol?

Remember my choice for URL:Bluebeam Protocol links

Open URL:Bluebeam Protocol

Figure 183 - Open URL Bluebeam Protocol

In the Bluebeam Studio Session, select the document to be reviewed.

Studio v H g
0310-0059 EB-2016-6 - 659-807-642 [E—> I_—l

My Status:

v Attendees |
{} Lynne Lofberg

» Documents

EB-2016-6.pdf

R B © T 6 D @ B @

Figure 184 - Studio Document

Review, stamp, comment or insert attachments as needed. The digital review process should be
conducted in a manner consistent with current business practices and as described below.

Commenting

IMPORTANT - All comments and stamps must be digital and must be applied directly onto the
submittal documents. Prior to commenting you must import the CTDOT Bluebeam Profile, See
Appendix A. Once completed you are ready to comment. The user shall also ensure that
standard Department settings are made. Consultant stamps can be found in Appendix D.

Reviewers may print the digital review documents to paper and mark them up, however, when
done, all paper markups must be transferred from paper to the digital documents. See
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Reviewing. If a unit cannot print their own paper copies they should contact MaryAnn Cass by
emailing Jackie.Rivera@ct.gov. In the email include the project number and attached documents
that need to be printed, and include the address of where they are to be mailed.

All comments associated with a review must be applied to the digital documents, such as
telephone or email comments.

The ultimate goal is to provide clarity and to eliminate confusion. Be sure to use engineering
judgment to determine the most appropriate location for placing comments in a document.

General comments may be placed on the first sheet of the document using the note markup
tool in Bluebeam. This process is detailed in Reviewing.

If a reviewer refuses to participate in the digital review please contact AEC Applications.

Best Practice - Applying Comments

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow,
cloud, rectangle, etc.).

Text/notes can be attached to each type. Text tools already have a note attached; all you need
to do is start typing.

Non-text tools also have a note attached to them, but you need to double click on it to launch
the attached note box. The text note box must be closed after the comment is made by clicking
on the X in the top right corner of the note. The example below shows a note being attached to
the cloud tool the correct way:

1. Place Cloud 2. Left click on the 3. Double click

cloud so the on the cloud
yellow circles and type text

show /

Update Road List E
LITY LENGTH

ROUTE 77 N/A
ROUTE 80 N/A
ROUTE 146 N/A
ROUTE 33 N/A
ROUTE 106 N/A
ROUTE 123 N/A
ROUTE 124 STATE N/A

aNVIISI

MAINTENANCE
F.A.P. # RESPONSIBILITY PROJECT #
00OR(825) STATE 173-440

Figure 185 - Correct Way to Add Text to a Non Text Commenting Tool

Review Stamps

Review stamps are used for intra-Department (including Department consultant Designers)
coordination. They are applied by the reviewer to communicate information to the submittal
Owner and the Department.

An example of use is that each Department Designer(s) must apply a review stamp when
requested by a Construction District to review Working Drawings.

Review stamps have the following meanings:
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DESIGNER'S REVIEW
Lt 2
-

This Stamp Shall Only be Applied to
Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

urgoinbe

Date: 5/18/2017

e Reviewed, No Comments means the Department’s Designer has reviewed the submittal
and takes no exception.

o Reviewed with Comments means the Department’s Designer has reviewed the
submittal and has provided comments. When used on Working Drawings the reviewer
shall provide a Bluebeam note that identifies the reviewer’s recommended disposition,
i.e. Exceptions as Noted, Revise and Resubmit or Reject.

Action Stamps

The Department uses action stamps (and if appropriate, comments) to notify the Contractor of
the Department’s disposition.

Action stamps must be placed on each sheet of all working drawing, shop drawing and Product
Data submittals. They shall also be placed on the cover of any other supporting, multi-page PDF
documents such as computations.

The precise meanings of action stamps are defined by the contact control of work specifications.
The following are paraphrased definitions:

ACTION STAMP

- |[DO0R

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

By bourgoinbr Date

e No Exceptions Noted means the Department’s reviewer has not observed anything in
the submittal different from what is called for by the Contract requirements and the
Contractor may proceed, provided that any manufacturer’s warranty called for by the
Contract can be fulfilled.

e Exceptions as Noted means the considerations or changes noted by the Department’s
reviewer are required and, after reviewing required changes, the Contractor notifies the
Department’s reviewer if the changes violate a Contract provision or lessen any
warranties. The Contractor may proceed with the work covered in in the submittal.

e Revise and Resubmit means the Department’s reviewer has identified and noted
statements or features that appear different from what the Contract requires. The
Contractor is required to revise the submittal(s), based on the reviewer’s comments,
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and resubmit for another review. The Department may take such additional time
(typically 20 days) to review resubmissions.

e Rejected means the Department’s reviewer has identified and noted one or more
statements or features that are different from what the Contract requires. The
Contractor is required to revise the submittal, based on the reviewer’s comments, and
resubmit for another review. The Department may take such additional time (typically
20 days) to review resubmissions.

Applying Review Stamps
Submittal Review Stamp
1. For CTDOT employees the submittal review stamp is located in the tool chest in
Bluebeam and should be placed on an open area of the drawing. For Consultants
Appendix D must be followed before their stamp is located in the tool chest.
2. To place the stamp, left click on the stamp in the tool chest and then place it. All shop
drawing sheets must be stamped with the action stamp. Product data sheets only need
to have the first sheet stamped.

Left click on
the stamp
and place.

ACTION STAMP
: =]

Designer's Warking Drawing
=== R

| |Action Stamp

=]
=1

N ST D G == [Superseded
TOWN OF NEW BRTAIN, CT STATE PROUECT NO.
e ERECTION DRAWING Highlight
| RO GONTRACTING cO. e, |50/t
R, W, |EHECKEDJEY: o = Highlight
C1372 _[Bnu 8/10/17 G
PRINT RECORD
NG mu:ln 70/ FOR ; Callout
Text Box
o Use to Cloud
1 a | L) 1 — 4 ; {t;} Cloud Cse o5
— Tl - et s

Figure 186 - Placing Submittal Stamp

3. Next select the appropriate option from the java script window and click OK.
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-

Submittal Review [me3m]
1 JavaScript Window
Action
@ Mo Exceptions Noted
) Exceptions as Maoted
] 7) Revise and Resubmit

) Rejected

Date of Review

Date: 12/14/2017

Figure 187 - Submittal Review Stamp

4. |If the stamp is too big and is covering part of the drawing, resize the stamp by dragging

a corner as shown below:

- - L -
- Eaarrags [ D%
— LOCATION f— BEARING CAMENSIONS
] B AAUTIPIER SRR BEA[SY TVPE ﬁ L W T A
ERAL D I PER 2 3 B10E & BT £, " L3 v 1.5 La
EB2-O 4 mEs 2 3 12 o, ™ T t Ly w
FRAY-O 1 PIER 2 B (] 3 ¥ L Tag" L
TEST-O 1 [ ACTION STAMP 3 ™ r LTAY Mk
_wa S B
ST H [ . =
=
P vt R 7 —
[ 4] 2 |"-'.:-.:" a
| Lol W
v Ta
ald g ! mTTLSE .
|‘?.5a I S | 1
; koo | i 1 |&
g / i T HH
1 | .
e it .. TO T@SiZe the stamp,
i v first click on the middle
e . Of the stamp so the
o oD e ettt yellow circles appear,
LB | 1. T then click on a corner and
| — i ® a
g I N —- l drag it to the size
P REERREEEAL L. thatfits,

Figure 188 - Submittal Review Stamp

The stamp is now resized as shown below:
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now resized

CT_CON_SDR_0004-0133_0153468-Bearings.pdf* D-1* »
BEARING LOCATION BEARING ‘
Qry. TYPE '
MARK ABUT/PIER SPAN BEAM(S) ‘
EBA1-D 2 PIER 2 3 B-11E & B-11W EXP
 EBA2D 4 PIER 2 3 B-12 EXP
EBA3-D 1 PIER 2 3 B-12 EXP
TEST-D 1 N/A N/A NIA B
AS2 A2
MSor PL S0 Pl ACTION STAM
=
L/2 L/2 | | 3
LAM. PAD | LAM, PAD //
7
| BEARING ////
. || SR ¥ Iy — = I / o
o 1‘3 .r~ ]
oz o V FANNNNANY
! |
i -
The stamp is | gl B NSNS

|
1

|
|
L

i
I

|
|
|
|
|
|

-4

[

SHIM /

11GA ((1196" NOM.) INTERNAL
{3) REQUIRED

Figure 189 - Resized Stamp

5. After the review is completed, close the file and click yes to save.

Figure 190 - Saving the Shop Drawing

6. Repeat the review process for the each drawing/document in the submittal.
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7. Close Bluebeam when complete. If the document is in a Bluebeam Studio Session, the

stamps will save automatically. If the document is being modified by using the check-

out to SharePoint feature, ensure the document is properly checked back in to

COMPASS.

Designer’s Review Stamp

The designer shall place a Designer’s Review stamp on the working drawing submittal. The

action stamp will be placed by District Construction.

1. To place the Reviewed stamp, left click on the stamp in the tool chest and then place it.

All working drawing plan sheets shall be stamped with the reviewed stamp. Calculations

and supporting documents only need to have the first sheet stamped with the reviewed

stamp.

New Britain 88-187 - Submittal 18 Rev A - Temp Support of Utilities*

DESIGNER'S REVIEW

Reviewed, No Comments
Reviewed With Comments

[
[

| ﬁll&gg[{:l

This Stamp Shall Only be Applied to

Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

NY: T2 Al B THap L

[ o050 x O R

2 ANLD T ]
To pegpe~] Helied
RLcE A 2507 Losp

O 4<LINT Pz TUE
22 A Dep1s = L&
CF 207 |e — CoNSER

2. Then select the appropriate option.

Left click on
the stamp and

= |Siamp Digtal Signature Place Holder Stamp

Superseded
7|
i I
<t M Ao Tl .
Figure 191 - Reviewed Stamp
Lo | 1

1= 1A I1L=b]]

VIR

-

Submittal Review
JavaScript Window

Action
@ Reviewed, No Comments - Onby For Working Drawings
™) Reviewed with Comments - Only For Working Drawings

Date of Review
Date:

[a)

1/23/2018
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3. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging
a corner as shown below:

bv A - Temp Support of Utilities™ =

DESIGNER'S REVIEW

Reviewed, No Comments
Reviewed With Comments

P This Stamp Shall Only be Applied to | &
Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

LN B ATLS%ZQMOB
0 : .

To resize the stamp, first click on
the middle of the stamp so the
yellow circles appear, then click
on a corner and drag it to the size
that fits.

Figure 193 - Resizing the Stamp
The stamp is now resized as shown below:

‘emp Support of Utilities™ =

[+

° 2
DESIGNER'S REVIEW
Reviewsd, Mo Comments EI
Reviewed With Comments [:l
of This Stamp Shall Only be Applied to I

Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

M. Calkins Bridge
By: Diesign Date: 1/23/2018

"/ Pl HE DoTENTIKL
OlUE-TE <5 ol SLELD
w2 Ul geos-

Figure 194 - Resized Stamp
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4.

Close Bluebeam when complete. If the document is in a Bluebeam Studio Session, the
stamps will save automatically. If the document is being modified by using the check-
out to SharePoint feature, ensure the document is properly checked back in to
COMPASS.

District Construction Review

After the designer has reviewed the working drawing submittal, District Construction should do
the following:

1.

E

Review the designer’s comments and update the comments on the
drawings/documents as necessary. District has the final say on what comments the
Contractor should be able to see.

Stamp each working drawing sheet with the action stamp; stamp the first page of any
calculations or supporting documents with the action stamp.

Prepare the documents to provide CTDOT’s response back to the Contractor.

Open the file from COMPASS.

To place the action stamp, left click on the stamp in the tool chest and then place it.
Each plan sheet in a working drawing submittal shall be stamped. For calculations and
supporting documents in a working drawing submittal, only the first sheet of those files

needs to be stamped.

Cloud

B IG5

Polygon

Highlight

« CTDOT Miscellaneous Stamps
Subject Comment

Digital Signature
Stamp Place Holder Star

X Spec. Stamp
>

Flan Stamp

Left click on
the stamp
and place.

Fe

Subject
Designer's Working Drawing
FEVIEW

ACTION STAMP

o
=]

| |Action Stamp

Superseded

TMLE

ERECTION DRAWING Highlight

CONTRACTOR [OATE
ROTHA CONTRACTING CO, INC. 5/10/1
o0, M0, CHECKED BY- TRAWIN
C1372 | BH 8/1017 G
FRINT_RECORD
HD. ISEUED 10 / FOR

Highlight

Callout

Text Box

||
| = | ,, | —J (J [ooud Sl

Line Use to Cross Out

Figure 195 - Placing Submittal Stamp

6. Next select the appropriate option from the java script window and click OK.
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Submittal Review [
] JavaScript Window
Action
@ Mo Exceptions Moted
) Exceptions as Moted
b (71 Revise and Resubmit

) Rejected

Date of Review
Date: 12/14/2017

Figure 196 - Submittal Review Stamp
7. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging

a corner as shown below:

— . R
=L ey O-1% =
LOCATION TOTAL BEARING DIMENSIONS
Hm . ARUTPIER SPAN BEAM[SY ‘E#;’I:G m L W T A
ERALD I FER 2 3 BE R BT £ L] L3 L 175" L
EBQ-D 4 mEm 2 a 812 e ™ T L LTy L
IRAY-O 1 =ER D L] ™ 3 i iLTag L
PEST-O 1 [y ACTION STAMP " EE) 5 " (¥ 15 [y
o s H
SO P ™ [y a
D.
b Vs
| 1 Yy
le To
_-'- nla . : R IiD LY AL RIS ARE TR Rt P : -
e _ _ Sy 1
o e I /x 55— iog|%
¥l3 ] , ! | r =
4 I .
— ! ws e, 10 Fesize the stamp,
g first click on the middle
e e Of the stamp so the
o D e meertt yellow circles appear,
i 'I‘ then click on a corner and
“ I drag it to the size
i « . that fits.
Figure 197 - Submittal Review Stamp
The stamp is now resized as shown below:
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CT_CON_SDR_0004-0133_0153468-Bearings.pdf* D-1* &

BEARING | LOCATION BEARING |
MARK ) ABUT/PIER SPAN BEAM(S) TYPE ‘
EBA1-D 2 PIER 2 3 B-1ME&B-11W EXP
EBA2-D 4 PIER 2 3 B-12 EXP
EBA3-D 1 PIER 2 3 812 EXP
TEST-D 1 N/A NA NIA EXP

AS2 A2
SOLE PL | SOLE PL | | ACTION STAMP
L/2 v2 | g
[TAM. PAD | LAM, PAD 1 /)
7, 7
} BEARING | | //////
I ,f',____i__¥_1' e~ i
EIR | ’
ale. 12 | V EANNNNNY
| |‘
- | | L
The stamp is | gl B NSNS
now resized | ||
NN\,
Sly *|12 | ‘ a
2 B | N/
11 L.
! | A 11GA (1196 NOM.) INTERNAL SHIM/

(3) REQUIRED

Figure 198 - Resized Stamp

8. Close Bluebeam when complete. If the document is in a Bluebeam Studio Session, the
stamps will save automatically. If the document is being modified by using the check-
out to SharePoint feature, ensure the document is properly checked back in to
COMPASS.

9. Repeat the review process for the each document in the submittal.

Closing a Bluebeam Studio Session

When reviewers are complete with a Bluebeam Studio Session review, the Bluebeam window
can be closed. Submittal owners will finalize the Studio Session at the appropriate time.
Submittal owners are to finalize a Bluebeam Studio Session at the appropriate time. Note:
Owners should NEVER press the Finalize button from within Bluebeam. COMPASS Studio
Sessions should be finalized via COMPASS. See Bluebeam Studio Session Finalization Process
for details.

Completing the Review — Advancing the Submittal

Once the review is complete there are two options available to move forward.

1. Further action is required by the Contractor

a. One or more pages of the submittal documents have received a Revise and
Resubmit Action Stamp or Rejected Action Stamp.

b. During this process, the submittal Owner should provide supplemental
comments in the comment pop-up window. These comments should
correspond with the actual comments applied to the documents during the
review process.

Once the reviewers have all completed the review and it has been identified that further action
is required by the Contractor the Owner must click the Revise and Resubmit button. This will
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change the review status displayed in the S&T table from “In Review” to “Revise and Resubmit.”
It is the submittal owner’s responsibility to resolve all internal comments, disputes and prepare
the final documents for the Contractor with only final mark-ups and appropriate stamps.

2. No further action is required by the Contractor
a. All Action Stamps are either No Exceptions, or Exceptions as Noted

Once the reviewers have all completed the review and it has been identified that no further
action is required by the Contractor, the submittal owner shall click the Complete button.
This will change the review status from, “In Review” to “Complete.”

Revise and Resubmit

If a submittal enters into the “Revise and Resubmit” review status, the Contractor will be
notified via email and the BIC displayed in the S&T table will update accordingly. This is the
phase where the Contractor makes all the necessary adjustments and resubmits to the
Department.

Further action may include, but is not limited to, revising a document, adding a document or
deleting a document.

The Contractor is responsible for reviewing all comments and addressing as needed. For
documents that need amending, the Contractor shall resubmit the document(s) in COMPASS by
replacing the existing document with a new conformed document. COMPASS has automated
Version History, so when the Contractor replaces the document COMPASS automatically creates
a new version. Versions are stored within the document and are saved in the same location.

Conformed files shall include; all unchanged sheets that received No Exceptions as Noted or
Exceptions as Noted Action Stamps, and any revised sheets that need to be reviewed.

See Revising and Replacing a File for details.

Complete

A submittal enters the “Complete” phase when the Owner clicks the Complete button.

The Submittal Owner must click the complete button to finalize the processing of submittal
documents. The Complete review status indicates that all documents have been processed and
that no further action is necessary. A submittal cannot be complete if the Action Stamps Revise
and Resubmit or Rejected are used.

The Department’s disposition shall be clearly marked by Action Stamps placed on each sheet of
all working drawing, shop drawing and product data submittals. It shall also be placed on the
cover of any other supporting multipage PDF documents, such as computations.

The Contractor is responsible for opening and reviewing the final submittal documents to
determine the Department’s disposition. The Department’s disposition is not shown as a status
in the Submittal / Transmittal tool; it shall be communicated using action stamps in accordance
with this manual and current business processes.

Once a submittal is marked Complete, the action cannot be undone and no further action can
take place in the submittal workflow.
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COMPLETE DATE ORDER

NA 1

PRESS COMPLETE WHEN SUBMITTAL IS
FINALIZED AND NO FURTHER ACTION IS
REQUIRED BY THE SUBMITTER / CONTRACTOR

e

Send Back to Owner Revise and Resubmit ‘ Complete ’

Figure 199 - Complete Review Workflow

Draft

The submittal Owner, Reviewers and Contractor have the option to save their work as a draft
without advancing the workflow. In the Process Assignment and Document Submittal windows,
if the Save button is selected the user’s work will be saved as a draft. In the
Submittals/Transmittals table, the Review Status will show as Draft. The Ball-In-Court will
remain with the user who selected save.

SAVE WORK AS A DRAFT
WITHOUT ADVANCING

THE WORKFLOW.

Figure 200 - Save as Draft

Send Back to Owner

If the submittal Owner incorrectly assigns a reviewer, the assignee should click the Send Back to
Owner button to return the submittal to the Owner. A comment should be included explaining
the reason for sending back the submittal. Any individual who believes a submittal to have
been incorrectly assigned is responsible for sending back the document immediately to avoid

any delays to the processing period.
Revise and Resubmit Complete

PRESS TO SEND SUBMITTAL BACK TO
OWNER WITHOUT PERFORMING A REVIEW

Send Back to Owner

Figure 201 - Send Back to Owner

Adding Attachments to a Submittal

When using COMPASS, submittal Owners and Reviewers may choose to respond to the
Submitter / Contractor with a letter or memo. Such a response can be transmitted via
COMPASS using Bluebeam Revu’s Attachment Tool.

To attach a file inside of a COMPASS document:
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1. Open the submittal document from COMPASS using a Bluebeam Studio Session or by
Checking Out Documents to Bluebeam.
2. Once the document is opened in Bluebeam Revu, go to Tools = File Attachment.

An Open Dialog box appears.

g

Type | Location | Status |
ProjectWise V10 ctdat projectwiseonline.com:CTDOT Ready
SharePoint https://ctgovdot sharepoint .com/projec...  Ready

My Computer From Disk:

Login | '_-:;:':'.l oK I Cancel

Figure 202 - Bluebeam Attachment Tool

28

4. Browse to and select the desired file to send to the Contractor. Then click Open. Note:
Attachments are made individually, so only one file can be selected at a time. If multiple
files need to be attached to a submittal document, then a separate attachment can be
created for each file.

5. Click on the submittal PDF to place the Attachment icon, a paper clip. Attachment icons
can be moved after they have been placed. Click and drag the icon to move it. The
name of the attachment file is revealed when hovered over with a mouse.

ATTACHMENT ICON

Figure 203 - Bluebeam Attachment Icon

6. When finished inserting attachment(s), finalize the Bluebeam Studio Session or check-in
the PDF per the applicable instructions for Using Bluebeam to Review Submittals.

7. If no further action is required by the Contractor, press Complete. If the Contractor has
further action or correspondence, press Revise and Resubmit. The Contractor will be

able to view and download the original submittal with the response attachment. This
response attachment will also automatically save in the Internal Documents version
controlled folder in COMPASS. Note: If using the Attachment Tool, the submittal
Owner should include a note to the Contractor in the Comments box, notifying the
recipient that an attachment containing additional information is embedded in the
document.

If the review has identified a document(s) that the Contractor must revise and resubmit, the
Submittal Owner shall respond to the Contractor in COMPASS by clicking the Revise and
Resubmit button located on the Submittal status review dialog box. COMPASS will automatically
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notify the Contactor that reviewed documents are ready for consumption and that some portion
of the original submittal needs to be amended and replaced.

If no portion of the Submittal needs to be revised and resubmitted then the Submittal Owner
may click the Complete Button, this will automatically notify the Contractor.

Delete a Submittal

Members of the project Site Owners permission group have the ability to delete a submittal.
When this function is exercised, all elements of the submittal are deleted, including:
e Llineitem in the S&T table

e Back-up document(s) in the Internal Documents folder

e Comments and comment log

Submittals can be deleted when they are in the following workflow stages:
e Process Assignment

e In Review
e Send Back

Submittals cannot be deleted if they are the Revise and Resubmit or Complete workflow status.
To delete a submittal:
1. Select the submittal from the S&T table.

2. If the submittal is in Process Assignment or Send Back status, select the Delete Submittal
button located in the lower left-hand corner of the page. If the submittal is In Review,
select Edit to see the Delete Submittal option.

m

Q
<
14
.

1
¢
=
i
51
1

f
1
7
T

A
| 4
v}
1

SELECT TO DELETE A SUBMITTAL,
INCLUDING ALL ASSOCIATED
FILES AND COMMENTS

3. A Delete Submittal confirmation window will appear. Select Delete to confirm the
deletion. Select Cancel to abort the process. Once the Delete button is selected all
documents and data for the submittal will be permanently deleted. This process
cannot be undone once the Delete button is selected.
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Delete Submittal

SELECT DELETE TO CONFIRM
PERMANENT DELETION.

SELECT CANCEL
TO ABORT

9.4 Bluebeam
Checking Out Documents to Bluebeam

Bluebeam has built-in integration with SharePoint. Since COMPASS is a SharePoint site, this
integration can be used in COMPASS for a single-reviewer who prefers not to start a new
Bluebeam Studio Session or who needs to scrub a document before it is sent to the Submitter /
Contractor. This functionality is a recommended option when:

e The Owner is the sole reviewer and prefers not to launch a Bluebeam Studio

Session.
e Before returning a submittal to the Submitter / Contractor, the Owner needs to
scrub or modify review comments applied during a Bluebeam Studio Session.

This process only works when using Internet Explorer as a browser. The process outlined below
applies specifically to Bluebeam 2018. The checking out process should not be attempted while
a Bluebeam Studio Session is open.

Set-up Bluebeam Administrator Settings

To set-up the Bluebeam / SharePoint integration:
1. From the Start menu, open Bluebeam Administrator 2018. (See Appendix E: Bluebeam

2016 Integration for instructions applicable to Bluebeam 2016.)
2. On the Plugins tab, click Internet Explorer - Revu 2018 and Checkout SharePoint Files
on Open. Press Apply. Press OK to close the window.
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Bluebeam Administrator i =

Plugins INet Conﬂq| Pﬂntor| Revu |

Plug into Applications:

v Microsof Office - Revu 2018
¥ Microsoft Qutiook - Revu 2018

v! ProjectWise Explorer - Revu 2018
@) Internet Explorer - Revu 2018

1. CHECK BOXES

2. PRESS APPLY

[

|=]
BLUEBEAM

Chedcking this selection will load the
plugin into Migosoft Office 2007 -
2018 - Revu 2018

Integhet Explorer 3. PRESS OK
Checkout SharePoint Files on Open
NOTE: Applications need to be restarted for plugin to activated/deactivated
Apply oK Cancel |

Checking Out Documents

After setting up the Bluebeam Administrator 2018 settings, perform the following steps to
check-out a COMPASS document and open it directly in Bluebeam without starting a Studio

Session:

1. Using Internet Explorer, navigate to the correct submittal in the Submittals/Transmittals

table.

2. From the S&T table or Internal Documents folder, select the preferred PDF submittal

document.

3. The document will open in Bluebeam. The SharePoint check-out symbol will appear on

the document tab. The user can then edit, mark-up or scrub the document as needed.

Previous versions of the document are preserved by COMPASS'’s Version History

feature.

E“ externaltest X

When complete, press Save in Bluebeam.

5. Close the document by closing the individual Bluebeam tab or closing the entire

Bluebeam program.

6. The Close SharePoint Document window will appear. Either the Check In or Release

Checkout button must be pressed to return the document to COMPASS.

e Press Check In to save any mark-ups or edits and return the document to

COMPASS.

e Press Release Checkout if no changes or edits need to be saved to the

document. This option does not save any changes or make a new version.
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Note: Comments inputted in this window will not be provided to the Submitter /
Contractor. Comments intended for the Submitter / Contractor must be added to the
PDF document itself or inputted in the COMPASS Comment Pop-Up Windows.

Close SharePoint Document

X

Document Path: |https://ctgovdot sharepoint.com/projects/0083-0264/Intemal Dc
~ Checkin Comments (optional). PRESS RELEASE

| PRESS CHECK IN CHECKOUT IF NO
— 1O SAVE CHANGES  CHANGES ARE MADE

: ol l
Check In LbdateServerCopyl( Release Checkout } Cancel |

7. Bluebeam will communicate with SharePoint based on the option selected. If the Check
In button was selected, a new version saves in COMPASS. The previous version(s) are

preserved through COMPASS’s Version History feature.

8. Once the submittal Owner’s review is complete, the submittal Owner needs to take final
action to communicate with the Submitter / Contractor. If no further is action required
by the Submitter / Contractor, the Owner should press Complete in COMPASS to end
the submittal workflow and a notification email will be sent automatically. If further
action is required, the Owner should press Revise and Resubmit and provide comments

to the Submitter / Contractor.

Multiple Users Checking Out to SharePoint

Only one user can check a file out to SharePoint at a time. If a document is checked out and
another individual attempts to check out the same document concurrently, Bluebeam will open

and provide the following message:

Open file read-onhy

Yes

The file hitps://ctgovdot sharepoint .com.projects/0310
0055/ Intemal Documents/ 120 Contractor_Submittals
(FOFWEFI no cc TEST pdf'is cumenthy checked out by
another user. Would you like to open this file read-onh?

Mo

X

To identify the user who has a document checked out via the SharePoint feature, users can
navigate to the file in the Internal Documents folder. For Contractor Submittals this location is
Internal Documents = 120_Contractor_Submittals (PDF). The name of the user who has a
document checked out will be listed in document’s row under the Checked Out To column:

Checked Qut To
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Starting a Bluebeam Studio Session

Bluebeam Studio Sessions allow multiple individuals to collaboratively review, comment, and
place stamps on submittal documents, all in real time.

Bluebeam has been integrated into COMPASS, therefore submittal owners can start a Bluebeam
Studio Session directly in COMPASS. In order to initiate a Bluebeam Studio Session, the
submittal owner must have a Bluebeam Studio account. To acquire an account please contact
AEC Applications.

It is the submittal Owner’s responsibility to start and close a Bluebeam Studio Session. However,
if the submittal Owner is unavailable, others users in the project Site Owners Group may also
start and close a Session. A Studio Session can be started during the Process Assignment or In
Review workflow status.

e  Process Assignment
On the Submittal Process Assignment page (before starting a review processes) the
Owner can click on the Start Bluebeam Studio Session button located under the
preferred document. Clicking the file name prior to launching a Bluebeam Studio
Session will open the document in the user’s default PDF viewer. If a Studio Session
is started the same document link will automatically route reviewers to the
Bluebeam Studio Session. Once the Studio Session is closed the link will revert back
to opening with the user’s default PDF viewer.

= Close | Submittal Process Assignment

Details Comments/Log

Payrolls v

Click bottom link to launch

Bluebeam studio session
DOCUMENT|(S)

&) Hartland 20191019 REV Payroll.pdf
aunch Bluebeam Studio Session

Figure 204 - Start Studio Session

e In Review
To start a Bluebeam Studio Session when a submittal is In Review:
1. Open the submittal by clicking its name.
2. Inthe Submittal Status Review dialog box click the Edit button.
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- Close | Submittal Status Review

etails Comments/l ¢ J

“— SELECT EDIT

Figure 205 - Edit Button

3. Select the Start Bluebeam Studio Session button for the relevant document(s).

A separate Bluebeam Studio Session must be started for each individual submittal document, if

needed.

IF NEEDED, START A SEPARATE
BLUEBEAM STUDIO SESSION
FOR EACH DOCUMENT
CONTAINED IN A SUBMITTAL

Figure 206 - Start Multiple Studio Sessions

Finalize Bluebeam Studio Session

The submittal Owner is responsible for finalizing all Bluebeam Studio Sessions at the appropriate
time. When the submittal Owner determines that a Bluebeam Studio Session is complete, the
Owner should push the Finalize Bluebeam Studio Session button in COMPASS. This button
needs to be pushed for each individual document opened in a Bluebeam Studio Session. If the
submittal Owner is unavailable, any person in the site Owners group can finalize the Session via
the Edit page. When a Bluebeam Studio Session is finalized, the new document version is
automatically saved in COMPASS. Previous versions are preserved through the COMPASS
Version History feature. IMPORTANT: Users should not finalize the Bluebeam Studio Session
directly within Bluebeam. The Studio Session should be finalized via COMPASS as described in
this section. For more details see Bluebeam Studio Sessions.

FINALIZE BLUEBEAM

SESSION VIA COMPASS

-—v = — -~ '\E‘

Reconcile Bluebeam Studio Session Comments

During a Bluebeam Studio Session, comments may be added to the submittal documents that
are confidential to CTDOT personnel or Consultants and not appropriate to send to the
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Submitter / Contractor. After a Bluebeam Studio Session is finalized, the Owner is responsible
for reviewing the document and determining whether any mark-ups need to be removed before
responding to the Submitter / Contractor. If necessary, the Owner may open Bluebeam without
starting a new Studio Session by Checking Out Documents to Bluebeam. This technique can be
used to reconcile comments and scrub the document as needed before it is returned to the
Submitter / Contractor.

Once all Bluebeam Studio Sessions for a given submittal are complete, the Owner needs to take
final action to communicate with the Submitter / Contractor. If no further is action required by
the Submitter / Contractor, the Owner should press Complete in COMPASS to end the submittal
workflow; a notification email will be sent to the Submitter / Contractor automatically. If
further action is required, the Owner should press Revise and Resubmit and provide comments
to the Submitter / Contractor. These two processes cannot proceed if any Bluebeam Studio
Sessions are still open. In such a case, COMPASS will block the process and provide a
notification message: “A Bluebeam Studio Session is still open. Please make sure the
documents are ready for review by the Submitter / Contractor and close the session before
proceeding.”

9.5 Revising and Replacing a File
When a submittal is returned to the Contractor as Revise and Resubmit, the Contractor is

responsible for opening the document, reviewing all email comments and mark-ups, and
responding according to current business processes as described in this manual.

Opening and Downloading a File

To open a file, navigate to the appropriate submittal from the Submittals / Transmittals table.
Select the hyperlink in either the Submittal or Review Status column. The Review Status will be
listed as Revise and Resubmit; the Ball-In-Court will list the Submitter / Contractor’s user name.

REVIEW
STATUS

SUBMITTAIL SUB TYPE ITEM NO

SELECT SUBMITTAL NAME OR
REVIEW STATUS (REVISE AND
RESUBMIT) TO VIEW DOCUMENT

When the hyperlink is selected, the Document Submittal window will appear. This window will
appear similar to the original window used to create a New Submittal. The two key differences
are that the submittal document(s) will appear and there will be a Replace File link under each
document listed. To view the submittal document(s), select the file name.
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» Close | Document Submittal

0090693 - SPARE PARTS, 0101050 - ENVIRONMENTAL LAND\.

Submittal Type: @

Shop Drawing - Highways

SELECT THE NAME OF
THE DOCUMENT TO VIEW

If the document is a PDF, it will appear in a PDF viewer. From the PDF viewer, the document can
be downloaded and saved to the preferred location (e.g., desktop, server, drive, etc.) Examples
of how to save from the PDF viewer are shown below. The exact appearance and function vary
by device and browser type.

SAVE BUTTON IN INTERNET EXPLORER

DOWNLOAD
BUTTON IN
CHROME

Revising a File

Once the comments provided via email and/or in the document mark-ups are reviewed, the
Submitter / Contractor is responsible for revising the submittal document(s). The Submitter /
Contractor should not revise any portion of any documents that have been accepted by the
Department.

Shop Drawings and Working Drawings

If the Owner returns a shop or working drawing submittal with different dispositions stamped
on each sheet, the Submitter / Contractor shall revise individual sheets as needed. Consistent
with current business processes, the Submitter / Contractor shall only make modifications to
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sheets stamped Revise and Resubmit or Rejected; the Submitter / Contractor shall not make any
modifications to sheets that have been accepted by the Department. When the replacement

document is ready to submit, the Submitter / Contractor shall combine the approved sheets and
replacement sheets in the appropriate order in one file.

To combine approved and replacement sheets using Bluebeam Revu, open the document that
was downloaded from COMPASS. Then go to Document > Replace Pages, or press CTRL +

SHIFT +Y.

Apply Stamp...

Insert Blank Page...  Ctrl+Shift+N
Insert Pages... Ctrl+Shift+]
Insert Layered Page...

Insert from Scanner...

Extract Pages... Ctrl+Shift+X
Split Document...

Replace Pages... Ctrl+Shift+Y

Rotate Pages... Ctrl+Shift+R

Crop Pages... Shift+Alt+0

Number Pages...

An Open From dialog window will appear. Navigate to and select the file that contains the

replacement pages.

x
Type l Location ] Status l
ProjectWise V10 ctdot projectwiseonline. com:CTDOT Ready
My Computer From Disk

(== e

v

WHEN THE OPEN FROM DIALOG WINDOW APPEARS,
NAVIGATE TO AND OPEN THE FILE CONTAINING THE
REPLACEMENT PAGES.

If the replacement pages are contained in separate files, the above process can be repeated
until the new document is compiled. Note: Documents that have been certified or digitally
signed cannot have pages replaced.

Replace File

When the replacement document is prepared, the Submitter / Contractor should:
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1. Navigate to the appropriate submittal page and click the Replace File button. Note: The
Submitter / Contractor should not respond to a Revise and Resubmit by attaching a
new document in the Attach File(s) window:

'\ Do not replace by attaching a new

file marked as Rev 1, Rev 2, etc.

2. A document file window will appear. Select the correct document to upload, then press
the Open button. The replacement document does not have to match the original file
name; it can have any name necessary based on the Submitter / Contractor’s naming
conventions (e.g., Rev. 1, etc.).

I Name - IDat:modﬁed IType Size

B Replace R and R Example Rev 1 5/6/2019 12:45PM  PDF File

name: [Replace R and R Example Rev 1 3 I

3. The File Ready to Replace prompt appears. The file name in COMPASS remains the
same, regardless of the name of the replacement file itself.

COMPASS INDICATES WHEN THE NEW
FILE HAS BEEN SUCCESSFULLY ADDED.

name.pa
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4. If more than one file in a given submittal is to be replaced, press Replace File under each
document and repeat the process described above. Ensure that the correct
replacement file is uploaded to replace the corresponding original document in
COMPASS.

5. Press Submit to complete the R&R process. COMPASS automatically saves the
replacement file in the original document’s Version History. The Ball In Court will return
to the submittal Owner.

"" m

9.6 Comments

The COMPASS Document Submittal / Transmittal Application contains two mechanisms for
providing comments.

Comment Log

The comment log is accessible to all individuals in the project Site Owners or Site Members
groups and can be used for any submittal-related communication. The log can be accessed
through any of the Submittal / Transmittal windows (e.g., Submittal Status Review, Submittal
Process Assignment, Send Back, Complete, etc.) Click the Comments/Log tab to view all
comments provided on a given submittal and write new comments. After a new comment is
typed, press Post to log it. All comments are automatically date and time stamped and identify
the entrant. The comment log is searchable, and a record of the log saves in each COMPASS
project page.

- Close | Submittal Status Review
CLICK TO WRITE AND
VIEW COMMENTS
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~ ‘ SEARCH FOR COMMENTS
Details ¢ POl USING KEY WORDS

ADD COMMENTS TO COMMUNICATE
ABOUT A SUBMITTAL WITH INTERNAL

PROJECT STAFF

~—— POST OR CANCEL (DELETE) A COMMENT

Comment Pop-Up Windows

Optional comment windows pop-up when the Ball-In-Court is returning to the Submitter /
Contractor or when the Send Back button is pushed. The Owner or Reviewer completing a given
process can use the comment field to communicate with the recipient. Once the comment is
typed in the pop-up, press Submit to log it. These comments will populate in the email
notification sent to the recipient and be saved in the Comment Log to maintain a record of
project communication.

Resubmit Comments
PROVIDE COMMENTS TO SUBMITTER
Pleaze enter any comments you have / CONTRACTOR IN THE RESUBMIT
/_ COMMENTS POP-UP WINDOW.

Comments

< This submittal is incomplete >

A imeinthefield be

m S

9.7 Document Storage

The Internal Documents section is a SharePoint library attached to each project. To access the
Internal Documents library, navigate to the Project Dashboard, Details or
Submittals/Transmittals page of the selected project.
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Project No. 0173-0468
Temp ID. PP092-0019
Schedule Phase: Contract-Processing

Project Overview

Contacts
Internal Documents
Documents

Project Emails

Report of Meetings

By default, all Contractor submittals are saved to the Internal Documents library, in the file
named 120_Contractor_Submittals (PDF).

INnternal DocumentS CONTRACTOR SUBMITTALS (INCLUDING ALL VERSIONS)
AUTOMATICALLY SAVED TO THIS FOLDER.
[ Name Modified Modified By + Add colu
i 100_Contract_Plans (PDF) October 26, 2018 Brad Wilcox
B 110_Contract _Documents October 26, 2018 Brad Wilcox
@ Contractor_Submittals (PDF) October 26, 2018 Brad Wilcox
B® 130_Final _Engineering_Reports October 26, 2018 Brad Wilcox

Document Storage Securities

All users included in the project Site Owners Group and Site Members Group can view the
document folders and document versions. Users in the Site Contractors Group are blocked from
viewing the document folders.

Version History

COMPASS includes automated Version History. Every version of each individual document is
automatically saved in COMPASS. This includes the original document as submitted, versions
saved from Bluebeam Studio Sessions, versions saved from checking out to SharePoint and
replacement files submitted in response to a Revise and Resubmit.

To access all document versions of a Submitter / Contractor’s submittal:

1. Navigate to the project site.
2. Go to the Project Dashboard, Project Details or Submittals/Transmittals page.
3. Select the Internal Documents library on the left-hand side of the page.
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Project No. 0173-0468
Temp ID. PP092-0019

Schedule Phase: Final-Design

Project Overview

Contacts

Internal Documents

Documents

Project Emails

Report of Meetings

4. Select folder 120_Contractor_Submittals (PDF)

D Name

B8 100_Contract_Plans (PDF)

B8 110 Contract _Documents

® & 120 _Contractor_Submittals (PDF)

B8 130_Final _Engineering_Reports

AUTOMATICALLY SAVED TO THIS FOLDER.

Modified

October 26, 2018

October 26, 2018

October 26, 2018

October 26, 2018

Modified By

Brad Wilcox

Brad Wilcox

Brad Wilcox

Brad Wilcox

Internal Documents CONTRACTOR SUBMITTALS (INCLUDING ALL VERSIONS)

+ Add co

5. Navigate to the document. Columns can be sorted by Name, Modified (date) or
Modified By. Click the ellipses (three dots) to show the drop-down menu associated
with the preferred document, then click Version history.
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(v .g} Working drawing.pdf 3 days ago
,Ea multi-page working drawing2.pdf Open
1. SELECT THE DROP-DOWN Preview

MENU ASSOCIATED WITH

THE DOCUMENT Share

Copy link
Download
Delete

Pin to top

Move to

2. SELECT VERSION HISTORY

Copy to

Rename

Alert me

6. The document Version history shows in a new window. All versions of the document
are listed with their associated version number, date and author. Click on any version’s
hyperlink to view the version. When a file has been saved back from a finalized
Bluebeam Studio Session, it presents as Modified By CTDOT Admin.

Version history

Delete All Versions

Mo. 4 Modified Modified By Size Comments
30 10/30/2019 1:00 AM Peter Parker  80.7 KB
20  10/30/201910:59 AM CTDOT Admin 119 KB
1.0 10/30/2019 10:58 AM Peter Parker 3 KB
Folder 120 Contractor Submittals (PDF)
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Section 10 Digital Review and Commenting
(Non-COMPASS Workflows)

This section details the digital review process using Bluebeam’s collaborative online review tool
called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2)
Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and
6) Respond to comments made in the session. Also, directions for locking the documents after
the review process to create a read-only final record copy to be stored for future use are also
provided.

The following link in to a Bluebeam Resources website. On this website are videos for the Digital
Review process: Bluebeam Resources These videos show an overview, but specific details are
found in this document

10.1Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of
the original paper document. Any required markups are placed directly on the document using
a computer with software designed for managing digital reviews. The documents can also be
printed from the review session and the paper copy marked up; however, those markups must
get transferred back to the digital copy.
Advantages of a Digital Review Compared to Conventional Paper Review

1. Higher Transparency — Increased Collaboration.

2. Digital markups are searchable and sortable, by comment, author, etc.

3. Real time collaboration review process improves turnaround time and quality of the
review.
Real time feedback allows easier handling of large amounts of data.
Reduces the time required to compile and resolve comments.
Eliminates document mailing time.
Reduces document printing.
Eliminates shipping cost.
. Easily store a permanent digital record on the cloud.
10. Overall reduction in review time.

LN UM

Types of Reviews:
This manual may be used as a guide to perform a digital document review on any digital
document. Below is a list of examples of the types of documents that may be reviewed:
e Preliminary Design Plans
e Structure Type Studies
e Semi-Final Plans
e Final Plans for Review
e Special provisions
e Engineering Reports
Review Process:
To help participants of a digital review more easily track the digital review process it has been
split up into six Phases as listed below:
e Phase 1 — Preparation of the Digital Documents
e Phase 2 — Set Up Digital Review
e Phase 3 — Invite Attendees to Review
e Phase 4 — Digital Review
e Phase 5 — Ending the Digital Review
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e Phase 6 — Resolve Comments
Each phase and its required steps will be discussed later in detail.
Digital Comments:
In this review process, all comments must be applied to the documents in the review session.
Reviewers have the ability to print the digital review documents to paper and mark them up,
however, when done, all must be transferred from paper to the digital documents, see Section
10.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email
Jackie.Rivera@ct.gov. Inthe email include the project number and list documents that need to
be printed, and include the address of where they are to be mailed. In the case of preliminary
contract plan reviews, the original digital documents, with comments, will become the final
record.

All comments associated with a design submission should be applied to the digital documents.
Telephone of email comments must be applied to the correct digital document by the staff
member who received them. Be sure to use engineering judgment to determine the most
appropriate location for the comments in the document. General project comments can be
placed on the first sheet of the document using the note markup tool in Bluebeam. This process
is detailed in Section 10.7.3. If any outside entities (railroads or utilities) will not participate in
the digital review, their comments with your responses should be attached to the final record
copy in accordance with Section 10.7.3. Itis not necessary to transpose these comments
individually as all comments can be attached at one time.

FOI Requests
Contract Document Digital Reviews - After a digital review session has been completed and all

the comments have been resolved, a read-only copy of the review documents with the
comments and resolutions will be stored in the 310_Milestone_Submissions folder under the
project.

10.2Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and
the software Bluebeam. This software was chosen for the following reasons:

a. Includes a collaborative live review feature (STUDIO) with real time feedback,
enabling all reviewers to comment on the same document at the same time out
on the cloud.

b. Alicense for Bluebeam is more cost effective than competitive software like
Adobe Acrobat. Thus it is much less expensive to purchase and maintain.

c. Only the Organizer of the review is required to have a licensed copy of
Bluebeam. All other attendees can participate in the digital review using
Bluebeam’s free version, Bluebeam VU.

d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the
original review documents as well as saves the final reviewed copies and their
comments.

2. The following table lists the software required to organize and/or participate in a CTDOT
digital review. Note: It is recommended that the latest version of the software be used.

Role Software

Organizer — Manages review Bluebeam Extreme or Revu Standard and ProjectWise Explorer

Author — Produces documents ProjectWise Explorer

Reviewer — Reviews documents | Bluebeam Extreme or Revu Standard or Bluebeam VU*

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the
invitation. Note: An IT administrator may have to install this software on the computer.
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3. All CTDOT digital review participants are required to complete the steps provided in
Appendix A prior to organizing or joining a review session. Completing these steps will
standardize the Bluebeam format across all CTDOT digital reviews.

10.3Digital Review Workflow

F
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PHASE 1 PHASE 2 PHASE 3 PHASE 4 PHASE 5 PHASE 6

Figure 207

All CTDOT digital review participants are required to complete the steps provided in Appendix
A prior to organizing or joining a review session. Completing these steps will standardize the
Bluebeam format across all CTDOT digital reviews.

Roles

Organizer — The organizer sets up and coordinates the review session. For in-house projects this
would be the project lead and for consultant jobs this will be the Consultant Liaison.

Author - Group that produces a document(s) for the review.

Reviewer — Group that participates in the review session to review documents.

Step ‘ Role ‘ Task ‘ Section
Phase 1 - Preparation and Delivery of the Digital Documents
11 Organizer Coordinate the organization and preparation of the review Section 10.4

documents. Request all Authors to upload their review
documents into ProjectWise.

1.2 Author Prepare and upload review documents into ProjectWise. Section 10.4
Notify the Organizer that this step has been completed.
13 Organizer Check that all review documents have been prepared and Section 10.4

uploaded correctly into ProjectWise.

Phase 2 — Set up Digital Review

2.1 Organizer Start a Bluebeam review session and then change the state Section 10.5
of the review documents in ProjectWise to “Reviewing”.

Phase 3 — Invitation to Review

3.1 Organizer Create a Digital Review memo, which includes a link to the Section 10.6
digital review session, and send it to all Reviewers.

Phase 4 — Digital Review

4.1 Reviewer Join the review session by clicking on the link provided in the | Section 10.7.1
review memo. Become familiar with the review session and Section
layout. 10.7.2

4.2 Reviewer Set Status to “Reviewing” Section 10.7.3

4.3 Reviewer Review the documents in the Bluebeam review session and Section 10.7.3

place comments on documents as necessary. Documents
can be printed, marked up, and then comments transferred
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the PDFs. If the documents cannot be printed out, send a
request to engineering records.

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to Section 10.7.3
“Finished”
4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 10.7.3
Phase 5- Closing the Digital Review
5.1 Organizer Close the Bluebeam review session and check the Section 10.8

documents back into ProjectWise.

Phase 6 — Resolve Comments

6.1 Organizer Notify the Authors that they can review the markups on Section 10.9.1
their review documents in ProjectWise. Provide them with a
link to the folder in ProjectWise.

6.2 Author Open the specific document(s) from ProjectWise. Section 10.9.2
6.3 Author For each comment on your document, type a final Section 10.9.2
resolution.
6.4 Author After all resolutions are applied to comments, Notify the
Organizer that you applied your resolutions.
6.5 Organizer Change the state of the review documents to “Review Section 10.10

Complete” to make all review documents read only after the
resolutions have been applied.

6.6 Organizer Send out a Completion of Review Session Memo to all the Section 10.10
personnel associated with the review session that the all
comments have been resolved on the documents located in
ProjectWise.

10.4Phase 1 - Digital Document Preparation

Organization

Below are the guidelines by which the review documents should be organized:

Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans - Must be in discipline subsets. The review Organizer is responsible for assighing
each Author a subset number in accordance with Section 4.1 Note: CTDOT Standard
Subsets cannot be added to a review session because they are combined in a PDF
Package (Portfolio).

2. Special provisions — Each discipline shall combine all of their special provisions into one
(1) PDF document. Each discipline’s special provisions will remain separate throughout
the review session; they will not be combined with the other discipline’s special
provisions.

3. Other Documents — Shall be individual PDF documents.

4. All Authors must upload their documents into the 310_Milestone_Submissions folder
under the project in ProjectWise.

Other Reviews

1. The only requirement for the organization of other types of reviews is that the
documents must be in PDF format.

Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:
Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans:
a. Must be in PDF format
b. Plans must be in discipline subsets
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c. Plans must be sized 34” x 22”

d. Do not need watermarks, sheet numbers or to be digitally signed.

2. Special provisions:

a. Each discipline shall combine all of their special provisions for review into one
(1) PDF document.

b. Sized 8.5” x 11”
3. Other Documents:

a. Must be in PDF Format

Other Reviews

1. Documents:

a. Must be in PDF Format

Uploading Digital Documents

Authors shall upload their digital documents into ProjectWise in accordance with the following:

For Preliminary Contract Docum

ent Reviews — PD, SF, FPFR, etc.

1. Launch ProjectWise and

log in.

2. Browse out to the project this review is for and open up the
310_Milestone_Submissions folder and the specific review folder: If the three

subfolders are not in the project contact Mathew.Calkins@ct.gov

= ..]__'_?f CT

HUHEHTHEHT

DOT_Project_Temnplate_Jan_2011
100_Contract_Plans (PDF)
110_Contract_Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports

131 Engineering_Reports_Confidential
140 _Project_Administration

141 Project_Adrministration_Cenfidential
150_GIS

151_Project Photos

160_Property Maps

210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development

241=Cnntra ct=D evelopment_Confidential

8 SLLL

K

310_Milestone_Submissions

{1 30% Review
[ 60% Review

[ 90% Review

a0_Fermit_Uevelopment

330_Design_Data

iy 01 - Final Design Calculations

Figure 208 - Projectwise Project

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a

time into ProjectWise as

shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then

you will be able to select the
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2§ ProjectWise Explorer V8i (SELECTseries 4]

Document

Tools Window Help

Detf=" - & @ : @k - search (O

If the Interface

{ Address [ pwt\ctdot.projectwiseanline.com:CTDOT\Documents\01.0 - Projects - Active\000L

- b@nterface CTDOT_Doc_Code v)iew Docum:

10_Review_Docume > [o° GO

dl'opdown is not xplorer Datasources

nje-admin)

BEF 1

ments

.0 - Projects - Active

£ 0001-0100

£ 0001-0999

-+ 100_Contract_Plans (PDF)
-7 110_Contract_Specifications, is selected
- 120_Contractor_Submittals

[ 130_Final_Enginesring_Repo

[ 131_Engineering_Reports_Confidential
[ 140_Project_Administration

1= 141_Project_Administration_Confidential
1= 150_GIS

([ 151_Project Photos

(o 210_Construction

{07 220_FHWA

1 230_Contract_Administration
|_Contract_Development

there, go to View>
Toolbar>and make
sure Interface is
checked

(1) Make sure

o 240
-+ 241_Contract_Development_Confidential
-+ 310_Review_Documents

L7 30% Review

[ 60% Review
LI 90% Review
{I’ 320_Permit_Development
(' 330_Design Data
(I 500_Pre Design
84 Saved Searches
{28 0004-0116
17 non4-n118

stion File Updated File Upda

CTDOT Doc Code

(2) Drag and Drop file
into this area in
Projectwise

Figure 209 - Uploading Documents into ProjectWise

4, Select Advanced Wizard

# Select a Wizard
Document %WM‘\

x| B

Mo Wizard Advanced
Wizard
—
[ Make this wizard the default.

&3

Cancel

Figure 210 - Advanced Wizard

5. Click next until the attributes screen appears as shown below. Enter the correct
attributes and then click next until the document uploads.
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Advanced Document Creation Wizard

Define Document Altributes [
*ou should define environment specific document attributes. £ Al

Discipline / (1) SE'ECt q
°r & appropriate
Main Category Main Category Descri

con v| | [Cortract Plane 8 Specs '

Sub Category Sub Category Descgp (2) Type

|PRE w | | Plans_01 - Preliminany Pﬁs

Project Number(s) / appropriate
| |

00040116 D0040118

Label (User Defined)

30% -01-General v

Description

[1-General Preliminary Dasign Plans

CT Code {Auto Fill In)
|cT_coN_PRE_0004-0116_0004-0118_30% -01-General

\sset Tags

(3) Click Next ] Signal Intersections
. \

w

|~

|

P —
[ < Back q_ Meod > 11 Cancel ]

Figure 211 - Attributing a Document

For Other Reviews

1. Launch ProjectWise and log in.

2. Browse to the folder where the digital documents are to be stored.

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into ProjectWise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

<< ProjectWise Explorer V8i (SELECTseries 3)

Datasource Folder Document| Tools  Window Help

AN e AT =AY @ 8 - |search| D v‘(Interla(ElGDOT_Du(_Code | i vijw| Document v

4 - o B agdress [ puictdat projectwiseonline. com:CTDOT\Documents\0L.0 - Projects - Active\0004-0116 &gmusxjm,prelﬂbﬁo

Select View> Explorer Datasources A | El Lst | @ Geospatil
(mjc-admin) Label (User Defined) Description Main Category | Sub Category
01.0 - Projects - Active

Toolbars>Interface
of the Interface box %57 e (1) Select

is not displayed i comac e, CTDOT_Doc_Code

120_Contractor_Submittals (PDF)
130_s0i_archaeological_Misc Reperts 0F) 1§ the Interface
210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential

B

310_Preliminary_Design_Documents(PDF)

320_Permit_Applications
330_Design_Data
340_Administration b
341_Administration_Confidential
[ 500_Pre_Design
4 saved Searches
{* ooog-0094
{* po11-0151

% 0014-0177 (2) Dl'ag al‘ld dl'Op

{* 0014-0133

=]
L SACACARARASASARARARLARAGAGAS

0¥ tossaass file into this area
- 00170183 - - -
@ oo in Projectwise

{*% 0025-0118

o (M mnn mann

Figure 212 - Uploading Documents into ProjectWise

4. Select Advanced Wizard
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# Select a Wizard fz|
Document Crezjef VWizards
=
x| B
No Wizard Advanced
Wizard
[ Make this wizard the defautt.

Figure 213 - Advanced Wizard

5. Click Next until the attribute screen appears shown below. Enter the correct attributes

for the review documents and then click next until the document uploads. Make sure a
good label and description are entered.

dvanced Documen reation Wizard

Define Document Altributes
*You should define environment specific document attributes.

Discipline

o W | e— (1) Select

|

Main Category Main Category these

CON v |Cont|7—.|ct Plans & Specs |
Sub Category Sub Category C ( ) H
|SDR v‘ |Apprcved Shopﬁa\ 2 Type In
Project Number(s) / these
[0004-0116_0004-0118 ‘ |

Label (User Defined)

tems 0605252 v

Description

Structural Steel Shop Drawing Review

CT Code (Auto Fill In)

| CT_CON_SDR_0004-0116_0004-0118_ttemd# 0605252

——

H DOT Asset Tags
(3) CIICk \ Signal Intersections -

| INU | O

=

< Back @ Cancel |

Figure 214 - Uploading Documents

|~

6. Notify the Organizer that the documents have been uploaded into ProjectWise.

10.5Phase 2 - Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: Note: The

example below is for initiating a Semi-Final review but can be followed for other types of
reviews.

1. Launch ProjectWise Explorer from the shortcut on your desktop or the start menu.

2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews
browse out to the folder in ProjectWise where the documents are located. Note: The
document does not need to be in ProjectWise to use Bluebeam’s Studio feature.)
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E'L-R cT

UYL

DOT_Project_Template_lan_2011
100_Contract_Plans (FDF)
110_Contract_Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration

141 Project_Administration_Cenfidential
150_GISs

151 _Project Photos

160_Property Maps

210_Construction

220_FHWA,

230_Contract_Administration
240_Contract_Development

241 Contra ct=D evelopment_Confidential

310:Milestu:| ne_Submissions
| 30% Review

1" 60% Review

1= 90% Review

240_Fermit_Lrevelopment
330_Design_Data

1= 01 - Final Design Calculations

Figure 215 - Preliminary Design Documents Folder

3. Next select all the documents that are to be included in the studio session, right click,
and select Start Studio Session:
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ey 3 e Rt T s e e

line.com: CTDOT Documentsi08.0 - ProjectWise Administration'01 - Administrators\h % | p Ga
2 List | & Geospatial

Label Description

_/ E 30% - 01-General 01-General Preliminary Design Plans
_/ 30% - 03-Highways 03-Highway Preliminary Design Plans
_/ E 30% - 04-Traffic 04-Traffic Preliminary Design Plans

_/ 30% - 05-Structures 05-5tructures Preliminary Desian Plans

_/ 30% - PD Statement Project 120-036 PD Statement
e n 60% - 01-General 01-General Semi Final Plans
_/ n 60% - 03-Highways 03-Highway Semi Final Plans
7 n 505 - 0T = z

nal Flans

mi Final Plans
New Cost Estimate
semi Final Specs.

/

Right Click on the
documents and select
"Start Studio Session”

Chedk Out

“0r)
:_Reports (PDF)

Start Studio Session. ..

Confidential Refresh Local Copy
aments{PDF) Purge Local Copy
Cut
itial Copy
Paste...
4

Figure 216 - Start Studio Session

4. Using the naming guidelines from the table below, type in the applicable review session
name in the box entitled “Session Name”.

Review Review Name
Preliminary Design (30%) Project #XXXX-XXXX PD Review
Structure Type Study Project #XXXX-XXXX Structure Type Study Review
Semi-Final (60%) Project #XXXX-XXXX SF Review
Final Plans for Review (90%) | Project #XXXX-XXXX FPFR Review
Other Include Project number if necessary and give a good description
of the review

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting
the Session Expires date is optional. If set, this date can always be changed after the session is
created.
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Start Studio Session

=

*
Session Name:  Project #0123-0123 PD Review _)

Uocuments

File name Path
(4] | CT_CON_PRE_30%-04-T.. PW:ctdot projectwiseonin...
CT_CON_PRE__30%-03-H... PW:ctdot projectwiseonlin...

r Y

v

Options

Pemission

Save As
Prirt
Markcup
Marup Alert
] Add Documegia

Restnct Mtendees by E-mail Address

Session Expires

May 22,2015 @~ || 500PM k2 )

Dt

(1) Type in the
session name

_. (2) Uncheck

(3) Optional - Set if
/ necessary

- (4) Click OK

Figure 217 — Initiating a Review Session

5. Inthe next dialog box click copy invitation as shown below. The invitation will be copied
to the clipboard of the computer and then can be pasted into an email or memo.

Session Invitation
Session Information

Session Name:  Session

Invitees

Session ID:  068-578-012

==

Copy Invitation

E-mail Address

)

o

Message (Optional)

@m| Click to copy

invitation to
__clipb d
Ec ipboar

Note: A Session is limited to 500 Attendees.

Figure 218 - Adding Email Address to Studio Session

Next paste the invitation into a blank Word Document or email. The following is an invitation
that has been pasted into an email. Note how the session URL appears in blue. Then you can

copy the URL from the blank document or email into a formal memo.
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BAEHYO + = ¥ = Untitled - Message (HTML) - @ =

File. Message | Insert  Options  FormatTedt  Review  Developer  Adobe PDF s @

B (‘_‘._ CalibriBody- 11 - AT o7 D -4 & ﬁ @l @ = Qf ;TI] ¥ Follow Up - ':%

¥ HighImportance
Address Check = Attach Attach Signature | Assign Zoom
Book MNames  File Itemw poliy - & LowImportance

Clipboard = Basic Text = Names Include Tags | Zoom

Subject | ‘

&

You have been invited by M. Calkins AEC Applications (mathew.calkins@ct.gov) to join a Bluebeam Studio Session:

Session

Session ID: 0 12
Session UR(. ttps://studio.bluebeam.com 'Din.htmI?ID=UEB-578-012) 1 - !f needed copy URL
Mathew Calkins, P.E. into formal memo.

Transportation Engineer 3

AEC Applications

Connecticut Department of Transportation
2800 Berlin Turnpike

P.O. Box 317546

Newington, CT 06131-7546

860-594-2988

Mathew.calkins@ct.gov

4 i 3

Click on 5 photo to see social network updates and email messages from this persan. A v

Figure 219 - Session URL

6. After the session has been created go back to ProjectWise, Select all the documents that
are included in the session.

- search| (3 ~| P> interface sub Category 1 | i view Dacument v/

seonline.com:CTDOT\Documents'06.0 - ProjectWise Administration\01 - Administratorsih Vl > Go
& Ust | @ Geospatial |

Label Description Main_Cat Sub_Cat Cat_Description
# Bl 30% - 01-General 01-General Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
# Bl 30% - 03-Highways 03-Highway Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
/ 0% - 04-Traffic 04-Traffic Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
# B 30% - 05-Structures 05-5tructures Preliminary Design Plans fate] PRE Plans & Specs_01 - Preliminary
5 E 30% - PD Statement Project 120-086 PD Statement DOC MDO Misc Documentation
60% - 01-General 01-General Semi Final Plans CON PRE Plans & Specs_01 - Prefiminary
03-Highway Semi Final Plans CON PRE Plans & Specs_01 - Preliminary
04-Traffic Semi Final Plans CON PRE Plans & Specs_01 - Preliminary

tructures Semi Final Plans CON PRE Plans & Specs_01 - Preliminary

# Bl 60% - HwY-Specs Highway Semi Firy

Select all documents es-Lp2-Premnay
to be included in the
review session

Figure 220 - Select Documents to be Included in Bluebeam Review Session

7. Then change the state of the documents to “REVIEWING” as shown below:
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mi W - Frojeavise - W e

A | E Lst @ Geospatial

Desaription

o - 01-General 01-General Prelminary Design Plans
e - D3Highways 03-+ighway Prelminary Design Fians
" - 04-Traffic 04-Traffic Prelminary Design Plans

o - 05-Structures 05-5tructures Preiminary Design Plans
e - PD Statement Froject 120-086 PD Statement
01-General Semi Final Plans

03-Highway Semi Final Plans
04-Traffic Semi Final Plans
5-Structures Semi Final Plans

i Final Cost Estimate

Hig way Semi Final Specs.

New

(1) Right click on the
documents and select
coprout "Change State>Next"

rts (PDF) Export...

Check Qut

Start Studio Session. ..

lential
“(PDF)
Refresh Local Copy
Purge Local Copy

cut
< Copy
Paste...

Docum jeties | Photo Preew | Dependency Senvice | Accest

(=]
GEN

irts (PDF) GEN
GEN  Delete
GEN  Modify...
GEN Modfy Linear Atbutes...
Gen Modfy Spatial Attrbutes.

lential
i e Add Comment

ASS|  Set »
ASS SendTo »
455 CopyListTo »
N
»
¥

L Z
e

ASS’
o e )
Dreviou:

Desi “~gzramemmT
Desi

Desif Set Final Status
Desil  Change fiename to CT_Code

Desi|

Desi{

Desi{  Oid Audit Tral Report
Desigr - Digtaly Sire:
Moo - ROV 81 TH

Editattributes for multiple documents

Figure 221 - Changing the State to Reviewing

Then click OK next on the box that pops up. The documents will now be in the
Reviewing state.

List | @ Geospatial | P

Label (User Defined) Description o Document Date (mm/... Application State

P @ Inspection Report Condition Assessment/Inspection Report Arrigoni Brid £/10/201512:00:00 AM  Acrobat PDF | REVIEWING
7 a RSR_Original RSR for Project Mo, 82-312 Arrigoni Bridge Mo, 00524 _ 8/7/201512:00:00 AM  Acrobat PDF | REVIEWING
7 a RSR_Updated RSR for Project Mo, 82-312 Arrigoni Bridge Mo, 00524 3/22/201612:00:00 AM  Acrobat PDF | REVIEWING
7 @ RSR_Updated RSR for Project Mo, 82-312 Arrigoni Bridge Mo, 00524 J 3/22/201612:00:00 AM  Acrobat PDF | REVIEWING
/E GPR Report GPR Condition Evaluation of Arrigoni Bridge-Project Sum 3/28/201612:00:00 AM  Acrobat PDF | REVIEWING
7 a GPR Report_Arrigoni Bridg GPR Evaluation of the Arrigoni Bridge Deck f 3/29/201612:00:00 AM  Acrobat PDF § REVIEWING

Figure 222 - State of Documents

10.6Phase 3 - Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:
For Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes
the following:

1. Atable of all documents that are in the review session.

2. Links to relevant documents that are not included in the review session but still need to
be referenced. These documents shall be located in ProjectWise and ProjectWise links
shall be included. (Not shown in the example below)

3. Alink to this manual (Digital Project Development Manual)

4. Alink to the Review session. To do this, paste the invitation that was copied when you
created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the
Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s

Issued April 2020 199 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

responsibility to compile a complete distribution list so the review invitation gets sent to the
applicable personnel. Below is an example of a memorandum for a preliminary design review:

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modem Roundabout,
guutde 188 at Route 334 and Holbrook
oa

Town of Seymour

menmorandum date: December 11, 2012
10: THOSE LISTED BELOW from: Wiliam W. Britnell List all documents
Transportation Principal Engineer
Bureau of Engineering and Construcnon/ i“ the review and
Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment fs#your
ot e relminay desin redon To s proec - Plese review nd a5 vour cypere and who authored them
recommendations to the following Preliminary Design Documents included in the digital ge#few referenced

below, by Tuesday, lanusry 8, 2013-
(| | )
Document Document Auther -
[01-Genersl [ Highway Design ) Include a link

Comments and recommendations shall be spplied to the documents in accordance wi allowing to the Dlgltal PI'Ojth
document
‘ Digital Project Development Manual ’

Development Manual

The following is & link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session.

( Invitation to live Review of the Preliminary Design of this nmieM
Units that receive paper plans con review the Sovuments an paper, but must ransfer their comments to the Include the link

digitsl pdf documents in the above review session

to the review session

A Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 st 1:30pm in Room 3130 of
the Department's Administration Building, 2800 Berlin Turnpike, Newingten.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594-
3342 should you have any questions or require additional information.

DISTRIBUTION;
Thomas J. O'Hala Leo L. Fontaine - Michael F. McDonnell
John DeCastro Gregory M. Dorosh
Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi
Delois L. Barnes Donald Ward - Mary Baler - Hard Copy to Follow
WMark W. Alexander - Kimberly Lesay Colleen A. Kissane

Leo L. Fontaine - EdgardoD. Block
Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Capy to Follow

Attachments
Stephen Hall/sh

Figure 223 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to
the end of the review session.

For Other Reviews
Invitations for less formal reviews may not require a memo. It is recommended that an email be
sent which includes the links to this manual and the review session.

10.7Phase 4 - Digital Review

Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a
preliminary design review, or for less formal reviews, click on the link in the email. Below is an
example of an email for a preliminary design review (semi-final). Remember the link to the
review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.
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U0 @) From

Subject

4 Date: Today

.4 ) Bourgoin, Bruce R Project 120-086 Semi Final Review

Received Size
Mon 10/1/2012 7:36 AM 51 KB
Mon 10/1/2012 1:40 AM 95 KB

4 Date: Last Week

L4 DOTWebmaster
-4 DOTWebmaster

1es DPD Manual

Bloomberg Public Finance Conferen
RE: AEC Applications Database

ConnDOT eAlert: Construction News
ConnDOT edlert: Construction News

[~ Savader Asset Advisors LLC

(1) Open the email

ConnDOT eAlert: News from the Con|
. Message
ConnDOT edlert: Construction News

=]y

4+ ¥ |5

Bluebeam

Projectiise

_ﬁ _$ EMeeting

= New e-mail to:

Project 120-086 Semi Final Review - Message

N3 S Rulesw [ Mark Unrez

from the Review
Organizer

[ Bentley Technical Support How did we do?
‘Ip, DOT '—\é Molly Watts@bentley.com RE: ST Mumber: {ticketno:[300146157¢
=4 Pratt, William 5 FW: 10:30
{4 Richard, Elaine H RE: [GWGA] CT DOT DDE question
[~ Rinaldi, John s RE: [GWGA] CT DOT DDE guestion
[~ Rabert Brickley RE: Projectwise
4 Rinaldi John s VAC 09/28/2012

(2) Open the Review

Memorandum

RESHQ3 Conf Room 3130, DOT  Accepted: Smart Board

Chhabra, Greg M
Maolly Watts@bentley.com
Ul Hanley, Richard C

€1IDBADT@REMTI EV AR

-
{4 PiePro
=
=]
2

Click on the link to the Review Session.

STATE OF CONNECTICUT
DEPARTMENT OF TRANSPORTATION

memorandum

Before it's too late

RE: proj 25-138: Pilot projectwise Chi
RE: Code Changer

FW: Bluebeam PDF problem

sinar: Next Gen Imag
20T DDE question
ceipe-e —....Board

Webinar Oct 2: Designing Combined
Using the 8'%4" interactive board in §
RE: ST Mumber: {ticketno:[300146157¢
Bluebeam PDF problem

ST Miimbar firlabnn RANTAST ETATL

;@ Reply All - - ‘,E OneNote '3 Categorize
« Delete | Reply Reply Forward & - Move
& Junk A 2 More (23 test - [ Adions - | ¥ Follow Up
Delete Respond Quick Steps - Move Tags
From: Bourgoin, Bruce R
To: Calkins, Mathew J
Co
Subject: Project 120-086 Semi Final Review

Please read the attached Digital Review Memorandum for State Project 120-086

Project 120-086
Semi Final Rev...

Bruce R Bourgoin, P.E.

Transportation Supervising Engineer

Division of Design Services

Architecture, Engineering & Construction Applications

Connecticut Department of Transportation

860-594-2760

Bruce.bourgoin@ct.goyv

Figure 224 - Review Memorandum

ubject:PRELIMINARY DESIGN REVIEW

Project No. 0124-0162

Rotary Upgrade to Modemn Roundabout,
Route 188 at Route 334 and Holbrook

Road
Town of Seymour

date: December 11, 2012

10: THOSE LISTED BELOW from: William W. Britnell
Transportation Principal Engineer

Bureau of Engineering and Construction

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment for your
use in the preliminary design review for this project. Please review and apply your comments and
recommendations to the following Preliminary Design Documents included in the digital review referenced
below, by Tuesday, January 8. 2013:

[Document

[ Document Author |
[ 01-General

| Highway Design

Comments and recommendations shall be applied to the documents in accordance with the following
document,
Digital Project Development Manual

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session

t Invitation to live Review of the Preliminary Design of this mmemf

Units that receive paper plans can review the documents on paper, but must transfer their comments to the
digital pdf documents in the above review session.

A Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 at 1:30pm in Room 3130 of
the Department's Administration Building, 2800 Berlin Turnpike, Newinzton.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vall, Project Engineer, at (860) 594~

Click on the link

to the review session

3342 chould you have any questions or require additional information

DISTRIBUTION:
Thomas ). O'Hala
John DeCastro
Charles S. Harlow - Mark F. Makuch
Delois L. Barnes
Mark W. Alexander - Kimberly Lesay
Leo L. Fontaine - Edgardo D. Block

Leo L Fontaine - Michael F. McDonnell

Gregary M. Dorash
Sohrab Afrazi

Donald Ward - Mary Baier - Hard Copy to Follow

Colleen A Kissane

Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Copy to Follow

Attachments
Stephen Hall/sh.
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3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the

webpage as shown below:

| @ itps/studic bluebeam... 0~ @ ¢ | @ Bluebeam Studio ‘ ‘

===

5k [ Transmittals - All tems .« Installing SharePoint 2013 ... F% Sean Keene's Blog - Peer... [ Documents - All Docume... [[7] Sign in to Office 365 £ eB

oining Bluebeam Studio Session...
Session: 600-702-866

Unable to determine if a compatible version of Bluebeam Revu or Vu is installed. If the meeting does not open click here to download Bluebeam Revu or Vu. ]

\ Ignore this text

To join a session click
Allow
AN

Internet Explorer

i . ) Allowing web content to open a program can be useful, but it can
a potentially ham your computer. Do not allow it unless you trust
- the source of the content. What's the risk ?

Figure 226 - Accessing the Review Session

4, Bluebeam will now launch. If this is the first time in a review session, a Studio Account
must be created. To do so click on Create Account and then enter in a State email
address and a password. In the Name box type in the First Initial then Last name and

unit. See below for an example.

Login

Studio Server:  studio bluebeam.com

If you do not

Domain / E-mail:

have an

Password: |

account click e —

Lost Password

create account

[ Use Windows Authentication

Figure 227 - Creating a Studio Account

Create Studio Account

&
&

/

E-mail: mathew calkins@ct.gov

Password:
Corfirm:

q?:

Login with Existing Account

I Remember password

Select

M. Calkins AEC Applications

@)

Click OK

Figure 228 - Studio Session Account
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If this is not the first time in a review session, enter the studio login information as shown

below: If you forgot your password click lost password and an email will be sent to you.

Please review and apply your commenis and recommendations to the Semi Final dmuments in

the review session referenced below by September 28, 2012, C

and rec

shall be applied fo the documenis in accordance with the following document, This ducumeni
contalng instructions for steps that need to be completed before joining the review session above.

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the
fallowing link to join the review session.

Ivitation to live Review of the Preliminary Desian of this praject

The Semi Final Design M
Department's Administrs

Please contact Project B

DISTRIBUTION:
Highway Design
Hydraulics

Construction

Attachments

.
E3

E-mail:
‘assword:

mathew calkins @ct gov

[] Remember password

Create Accourt

Lost Password

ok ) Yoo |

Malhew Calkins/co
ce: James H Nnrman

Enter your studlo
session email and
password and click
OK

Figure 229 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam
Profile, See Appendix A

Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for
commenting, the attendees of the session, and the documents in the session. On the bottom,
there are the list of comments.

Icon next to

document
showing this file
is in a session

Studio Icon

[ List of Attendees ]

Documents in the

session

CT.LIC NO. 20891

MONTH YEAR

MARK R_¢ GALBRAITH
TOWN M. AYOR
GARY SCHNEIDER TIMOTHY P UMRYSZ
DIRECTOR OF PUBLIC WORKS DIRECTOR OF PUBLIC WORKS
MULTI-USE TRAIL - STA 622179 t0 STA.33+50.35
FET (0.63 MILES)

Markup list

s

SIGN (60%) |

17

EET KT ComRECTID

MANCHISTEE, CT 06040

o FUSS&O'NEILL

Figure 230 - Review Session Layout

All comments that are made get saved instantly to the Bluebeam review session; these do not
need to be manually saved. Each user can only delete their own comments and can leave and
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rejoin as many times as they want as long as the review session has not been closed. The review
session will be closed by the Organizer in accordance with the date on the review memo.

Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital
review. Reviewers may print digital review documents to paper by going to File>Print and mark
them up; however, they must transfer these comments onto the digital review documents in
accordance with this section. If a unit cannot print their own paper copies they should contact
MaryAnn Cass by email Jackie.Rivera@ct.gov . In the email include the project number and list
documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments,
will become the final record.

All comments associated with a design submission should be applied to the digital documents,
including any email or phone call comments. These types of comments must be applied, by the
staff member who received the email or phone call, to the correct digital document, use
engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note
markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text
from any source such as an email or a Word document. This allows larger project wide
comments to be applied to the plans.

Tools Window Help

Batch
2 Q

Markup

Stamp

Measure

Sketch to Scale
Form

Signature

Hyperlink  Shift+H

File Attachment F
Toolbars

Reuse

MULTI-U

DDATEAT T ERTLT

Text Box
Typewriter

Note

Pen
Highlight

Eraser

Line

Arrow

Arc Shift+C
Polyline Shifi+N

Dimension  Shift+L

Rectangle R MARIAN K, €

Ellipse E MAY

Polygon Shift+P

TIMOTHY |
Cloud C D]RE(1TUR OF P

Cloud+ K
Image
Flag Shift+F

PDF Content

T IR TWETET /N 22 RATT T

Figure 231 - Note Markup Tool
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Note about Commenting in a Review Session and Supervisor Approvals

In most cases, the unit that reviews a document has an internal approval process whereby the
supervisor finalizes the comments from staff members. The workflow described in this Chapter
does not specify or dictate an approval process within each unit; rather, it outlines the review
procedures once the review comments have been compiled from each unit. Therefore, it is
important that only the reviewing unit’s final comments be added to the review session. Once
the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review
process is flexible for any procedure a reviewing unit develops. The only restriction is the final
comments must be placed on the digital documents located in the review session before the
reviews session ends:

1. Alower level employee can join the session and comment on the documents in the
review session. Then the supervisor can join the session and filter out their
subordinates comments for their review. If there is an issue with a comment the
supervisor will have to direct the lower level employee to fix that comment. If there are
not any issues with the lower level employee’s comments then nothing has to be fixed.
After the supervisor review, a lower level employee will join the session and fix the
applicable comments. In section 10.1 of this manual there is a list of advantages to
using this digital review process. With this option, all of these advantages are realized.

2. Alower level employee can join the review session and save a copy of the review
documents to their computer. Then they can markup the documents offline and have
their supervisor approve those comments. After the supervisor approves the
comments, those comments can then be imported into the documents in the review
session. In section 10.1 of this manual there are a number of advantages to this digital
review process. With this option, advantages 3 and 4 are eliminated due to the
comments made offline.

3. Alower level employee can join the session and print the documents in that review
session. Then they can markup the prints and have their supervisor approve the
comments. After the approval, a lower level employee can transfer the comments to
the digital documents in the review session. In section 10.1 of this manual there is a list
of advantages to this digital review process. With this option, advantages 3 and 4 are
eliminated due to the comments made offline.

Notes about Outside Entities that will not Participate in a Digital Review

If an outside entity such as a railroad or utility company will not participate in a digital review it
is still important to add their comments to the final record document in ProjectWise. It is
encouraged to have these entities participate in the digital review and AEC Applications is
available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to
those comments shall be attached to the final record document in ProjectWise:
1. Create a PDF document that includes the non-participating outside entity’s comments
and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in
ProjectWise in accordance with section 10.9.1.
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Reviewer

1. First set your review status to Reviewing by clicking on the drop down shown below:

Note: If you leave the session and return your status will stay as Reviewing.

Studio v H

0173-0468 ProjectWise_New_User Form-327- [[» [ [M

D

‘ My Status: | Reviewing

« Attendees {;

Q
Attendee Access

) M. Calkins AEC ... —

{‘? dudzinskijc Offline

- Documents

@ ProjectWise_Mew_User_Form.pdf

Figure 232 - Set Status to Reviewing
2. Next select a document to review from the studio session tab. The document will open
up and can be reviewed.
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Studio v H 3
0173-0468 ProjectWise New_User Form - 327! [+ [
My Status: | Reviewing

~  Attendees

M. Calkins AEC ...

dudzinskijc Offline

¢
¢

~ Documents

I @ ProjectWise_New_User_Form.pdf

4 (7 M. Calkins AEC Appli

Session

Figure 233 - Selecting a Document to Comment On

3. Select a commenting tool from the tool chest and mark up the plans. If you do not have
the CTDOT Review Tools show below, follow Appendix A to have them imported in the
Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to
them in Bluebeam.
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Recent Tools

Sequences & Actions

CTDOT Review Tools

‘Subject ‘Comment
T Inserted Text
Text Box
with the L
ELLl following: |~

~7 callout

: Spelling

Sp Spelling Error =
Highlight

|§ Polygon o

meme - Praliminary Stamp
./ Line

Mote

Cloud

ﬁ Length Measurement
[

Area Measurement

CTDOT As Built Tools

Figure 234 - Bluebeam Commenting Tools

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool
development.

MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow,
cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have
a note when you type text, but the non-text tools can also have a note attached to them. To
attach a text note to a non-text tool place the comment and then double click on that markup.
Then you can type in your note. The text note box must be closed after the comment is made
by clicking on the X in the top right corner of the note. The example below shows a note being
attached to the cloud tool the correct way:
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1.Place Cloud 2. Left click on the > Double click

cloud so the on the cloud
yellow circles and type text

show /

Update Road Lisﬁ

ANV 1SI

E
LITY LENGTH

ROUTE 77 N/A
ROUTE 80 N/A
ROUTE 146 N/A
ROUTE 33 N/A
ROUTE 106 N/A
ROUTE 123 N/A
ROUTE 124 STATE N/A
MAINTENANCE

F.A.P. # RESPONSIBILITY  PROJECT #
00DOR(825) STATE 173-440

Figure 235 — Correct Way to Add Text to a Non Text Commenting Tool

General Project wide comments can be placed on the first sheet of the document using the note
markup tool located in the tool chest. Text can be copied and pasted into the note tool as
necessary.

4. After you have completed your set your status to Finished.

Note: You can still enter the session if your status is set to Finished. You can also change your
status back to Reviewing if necessary. This status is for the Organizer so they know which
Reviewers have completed their reviews.

Studio v K

0173-0468 ProjectWise New_User Form-327-! [[» [ [
My Status: | Reviewing Ej
~ Attendees # @]

Attendee Access

) M. Calkins AEC ...
§) dudzinskijc Offtine

~ Documents

@ ProjectWise_Mew_User_Form.pdf

Figure 236 - Set Review Status

5. Create a review comment report of your comments. First filter out the comments so
only your comments are displayed as shown below:

Issued April 2020 209 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

o0 B

Markups List Y | @ Q Ssearch

= Subject Y  Measurement Y  Sequence Y Author Comments

v 04.01.A01 (2) 2 Count Al

L, stamp 1 Count [Customl (3) Then
Saltbon) select your
name

L This sheet Not Corrected 1 Count

m

Figure 237 - Filtering Comments

6. Now that the comments are filtered by your name create a comment report as shown
below:

=
Q_ Search

Measurement

2 Count XML Summary

Stamp 1 Count PDF Summary

L, This sheet Not Corrected 1 Count

Figure 238 - Creating a Comment Report

Next type in a title for the comment report that includes Project No, What review it is plus the
word “Comments”, and what document this comment report is for. See below for an example:

Project #iti#-#### Semi Final Review Comments 03-Highways

Make sure all the settings are set as shown below and click OK:
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Markup Summary

Files

Name

58-308 SFD Plans.pdf

Export as:

Export to

Template:

Style:

Thumbnail

% Padding

/| Open File After Creation

Columns Filter and Sort Output

PDF
Append and Hyperlink to Current PDF
D\Users\calkinsmj\Desktop
Owerwrite Existing File
SFD Plans.pdf Markup Summary
Create Multiple Reports Per Page Label
Append Date to Title
None

Insert page Break per

Flow
Medium
+ Include Page Content

25

Options

Figure 239 - Comment Report

Save Config

Pages

All Pages (1-21)

Save.. Load...

Load Config

Cancel

7. The comment report will now be created and opened in Bluebeam, leave the comment
report open in Bluebeam. We will be copying this report into the comment report

memo.

8. Next save the following review comment memo to your computer: Review Comment

Memo.

9. Open the memo and fill in the correct information.
10. Then copy all the pages from the comment report as shown below:
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Revu File Edit View Document Batch Tools Window Help

fleg By B Q v I O

FD Plans Summary Pages:1 | [

s - ITI D Plans* Q ProjectWise_New_User_Form : SFD Plans_Summary 3

SFD Plans.pdf Markup Summary

Copy Pages

Copy Page to Snapshot  Ciri+Alt+C

)
ent: 2 Count

Apply Stamp...
SaswrerToey  Subject: Stamp
Measurement: 1 Count

Sequence:
) (b Author: calkinsmj
Ctrsnitey | — Label:
DESIGN | status:

1L 2017 Date: 3/8/2019 8:36:28 AM
Page Label: 04.01.A01
Page Index: 1

Lock: Unlocked
Checkmark: Unchecked

Depth:

Ctri+Shift+R

Figure 240 - Copying the Comment Report Memo

11. Then paste the pages into the memo as shown below:

Revu File Edit View Document  Batch Tools Window Help

G ® B He a2 Qv &0

FD Plans* [ Projectwise_Mew_User_Form 58-308 SFD Plans_Summary X

Page Setup

Copy Page:

Copy Page to Snapshot  Cirl+Alt+C

;ount

Paste Pages

ossn  Subject: Stamp
Measurement: 1 Count
i - Sequence:
e Faces culshiftel [N Author: calkinsmj

Ctri+Shift+N

Figure 241 - Pasting the Comment Report Pages

12. Save the memo and process this memo as your unit requires.
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10.8Phase 5 - Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per
the date on the review memorandum.

1. Loginto ProjectWise and browse out to the review documents folder.

2. Then select the documents that are in the session that is to be closed, right click on the
documents, select Change State>Next: If this step is not performed the session cannot
be closed. This will place the documents in the CLOSE REVIEW state.

Label (User Defined) Description File Updated File Updated By ~ Document Date (mm/... Application  State
7 Condition Assessment/Inspection Report Arrigoni Bridge No. 00524 3/23/201611:22:34 A... BBrako-Frempo...  6/10/201512:00:00 AM Acrobat PDF
WA rse original RSR for Project No. 82-312 Arrigoni Bridge No. 00524, Original 4/14/2016 236:58 PM _ Gregg Hendricks..  8/7/201512:00.00 AM  Acrobat PDF
P4 | RsR Updoted RSR for Project No. 82-312 Arrigoni Bridge No. 00524 Mew Acrobat PDF
P4 | sk Updoted RSR for Project No. 82-312 Arrigoni Bridge No. 00524 Acrobat PDF
GPR Condition Evaluation of Arriger ( dridge-Project Summary Report Open Acrobat PDF
P4 | PR Report Arigoni Bridg GPR Evaluation of the Arigoni B ige Deck Open as Read-Only Acrobat PDF
Open With...

Markup
View
Check Out
CheckIn

Free

Select the documents that are in the

session that is to be closed, right click Copy Out

¢ ,and select Change State>Next PP 0t R 00 0 P s Psssss
S D
Send To V
Copy List To b
C Change State b Mot
Batch Print N Previous
Change...
Properties...

Set Final Status

Change filename to CT_Code P -

Figure 242 - CLOSE Review State

3. Then open up Bluebeam and join your session.
4. Then Click Finish to close a Bluebeam Review Session as shown below:

Studio - H

0173-0468 ProjectWise_New_User_Form - 327-! [E—: l_—i [T

Wy Status: | Reviewing _S—
Finish Session

Attendees #:
) M. Calkins AEC ...

¢} dudzinskijc Offline

Documents

@ ProjectWise_New_User_Form pdf

Figure 243 - Terminating a Session
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5. Make sure all the reviewers in the list below are selected (they will be by default) and
the Save (Overwrite Existing) button is checked and click OK.

Figure 244 - Terminating a Session

6. Click OKin the figure below.

Bluebeam Revu xb4... 100% X0

Finished...

01 - Administrators . Mathew Calkins"Digital Review Examples*.124- -
162_Session 14.310_Review_Documents"CT_CON_PRE__30% - 04 -
Traffic.pdf. 102693.1...

CT_CON_PRE, s pdf checked outto

P‘.‘\iTctdot.prnjeu = DOT 6.0 - ProjectWise Administration

01 - Administrz CI 1c k “Digital Review Examples'124-
162_Session 1' nts\CT_CON_PRE__30%- 03 - E
Highways pdf.1

| OK .

Figure 245 - Overwriting Existing Documents

7. Close Bluebeam Revu and check in each document to ProjectWise. Note: A check in box
will pop up for each document in the review session.

General

Documents

MName Label (User Defined) Description Main

{a CT_DOC... PD Statement Project 120-086 PD Statement DocC

< >
Folder: 06.0 - Projectise Administration\01 - Administrators\Mathew

Calkins\0123-0145\310_Preliminar

[ create new version during Check In S e I ect C h ec k I n

Version:

ﬂ Check In u Update Server Copy ] [ Free ] [ Cancel
i —

Figure 246 - Checking a Document Into ProjectWise

8. Notify the Document Authors that the session has been closed so they can resolve the
comments on their documents.

10.9Phase 6 — Resolve Comments

This section shows how the comments from the review session will be resolved by the
Document Authors. After the comments have been resolved in the PDF documents located in
ProjectWise the Document Author shall notify the Organizer that they have finished applying
their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review
Organizer will notify the Document Authors when the session has been finished. If the
document authors go into the documents located in ProjectWise before the session is finished
there will be no comments on the documents.
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Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on
the digital PDF review documents using Bluebeam. The following shows the steps for resolving
comments.

1. Open your document(s) from ProjectWise.
2. Next select a comment in the comment list and right click. The select Reply.

Copy ‘Stamp’

Layer
Lock Cirl+Shift+L

Legend

04.01.A01 (2)

S stamp

S, This she X

_u} Properties

Figure 247 - Comment Resolutions
3. Inthe box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.
Resolution — Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document
Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:
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/’\
” GG =
-
LIMIT OF CON!
53442
-~

Type in a resolution
in the box

Y Filter § . o Summary -
Author
Teat Bax st c ing si st path m: rattankd

L) Re: Text Bax 3 Resolution: Included - This _* Hallsd
correction will be made on [

Hallsd
5 Callout i aking tt : ing rattankd
W R : G 3 st : i : Hallsd

._ Callout i ; [ in gz ¢ tre: 5Lz rattankd

| | 'V Fiter §
Subject
~ CMarie District Drainage Eng ___

~  HendricksonGWautilities (1)

e first 1 i

Figure 249 - Resolutions

4. Next attach a PDF document that includes any non-participating entities comments with
your responses to the review document. This should be done by adding that PDF
document to the end of the review document as shown below:
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|
File Edit Views Document  Hatch Tools Window Help

) r‘——1 El] E] (¢) DocumentProperties  Ctri+D I\

Page Setup...

Rotate Pagaes Cirl+Shiff+R
~
00% | lcon: [37
W | 100% Icon: [;I Ins Ctrl+Shift+N

umbnails +~ = l—'

Cirl+Shift+Y

e

Shift+Alt+0
MNumber Pages...
Create Page Labels...

Headers & Footers

i ARK R. OEFINGER MARIAN K. GALBRAI1
NS TOWN MANAGER MAYOR

GARY SCHNEIDER TIMOTHY P. UMRYS:
Ctrl+Shift+0 “TOR OF PUBLIC WORKS DIRECTOR OF PUBLIC Wt

5B DD LB N

Color Processing...
Reduce File Size... MULTI-USE TRAIL.  STA. 0+21.79 to STA. 33+59.35

PROJECT LENGTH = 3,338 FEET (0.63 MILES)

atten... Cirl+Shift+M

Unflatten Ctri+Shift+U M _ "7_ Qjéﬁm,
low f

CENMI_EINIAT MEQIN FAN0LA

R PRy [ < oy

Figure 250 - Attaching Comments

5. Browse out to the PDF document you want to add and then select to insert after the last
page:
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-

Insert Pages 22|
Insert Files
File Path Fages
(4] | 20152-EC pof D\Users\calkinem.. Al(1-2 of 3)
F Y
v
Options

[ Include Bookmarks [ Use Filename as Page Label

- i Select After
and Last Page
"and then click
) Fis Page

OK

™) Page: |12 of 38 ¥

o)

After

Figure 251 - Adding Comments

6. When all the resolutions have been applied, make sure to save the documents and
check them back into ProjectWise.

7. Notify the Review Organizer that you have completed your resolutions.

8. Send out Completion of Review Memo to all the personnel associated with the review
session indicating that the review session is over and all comments have been resolved
on the documents in ProjectWise. Link to: Completion of Design Review Memo

10.10 Locking the Review Documents after the
Review

The Organizer shall change the state of the documents to make them document read-only after
the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in ProjectWise to
“Review Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed”
as shown below:
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qutney -

W oy

Ust | @ Geospatial |
Label (User Defined)

Description

Select View

Hew

Check Out

Copy Out

Export.

Start Studio Session. ..

Refresh Local Copy
Purge Local Copy

Main Category

Version
File Revisinn

Cut
Copy
Delete
Modify.
Modify Linear Attributes. ..
Modify Spatial Attributes. ..
Add Comment
Set »
_ SendTo » L
Documet Properties | Copy List To » PrevieW | Dependency Service | Accsss Cortr
i
Ve
— Batch Print o Propel
cT_cc
m SetFinal Status 0.
CTDOT
POE Change flename to CT_Code a.cc
Digital
| Ecit attributes for multile documents R
01d Audit Trail Repart e
Status Checke

(1) Right click on the
documents and select
"Change State>Next"

Figure 252 - Changing the State to Review

AWNE.COM:LIVUNUBCUMENTS 6. - FIOJECWISE AOMINISTIATIONIWL - AQMINISTAtors\ ¥ | = L0

List | @ Geospatial |

bel (User Defined) Description Main Category
'B) o1-General Ccon

con

con

con

Sub Category

PRE-PD
PRE-PD
PRE-PD
PRE-PD

o mossrosmenen NOTICE State column,

Sub Category Description
DOC_01 - Preliminary Docs
DOC_D1 - Preliminary Docs
DOC_01 - Preliminary Docs
DOC_D1 - Preliminary Docs

the documents are
now in the Review
Complete state.

Figure 253 - Review Complete State

Application

Adrobat PDF
Adobat PDF
Adrobat PDF
Adobat POF

0C_D1 - Preliminary Docs
J0C_01 Acobat PDF
0E 01 -Preliminary Docs ~ Acrobat PDF

State

REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE

REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE

2. Thenright click on all the documents again and select Change State > Set Final Status.

This will lock the documents.
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Ljj F—

|Docwner1tProperties|

Real (Docum - L

MName

L

Enter filter here

§
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MNew

Open
Open as Read-Only

Open With...
Markup
View

Check Out
Check In
Free

Copy Out

Export...
Import
Start Studio Session...

Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy
Purge Workspace

Cut

Copy
Paste...

Copy To...

Move To...

Rename...

Delete

DMSconform

Modify...

Modify Spatial Attributes...
Delete Audit Trail

Add Comment

Submission

Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF

Viewer | Access Control | Components

7

Document Security

<[ %[x[@[~s

| @]

Set

Send To

Copy List To

Change State ' Mext

Batch Print Previous
Change...

Properties...

Change filename to CT_Code

Edit attributes for multiple documents

Set Final Status

EMOoveE Fina

us

Figure 254 - Setting Final Status
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Section 11 Design Phase Project Scheduling

An Engineering working group evaluated several scheduling software options to support the
mission statement. Microsoft Project 2010 was selected because it offers the following features
and advantages:

e Accommodates any number of milestones and tasks (i.e., easily scalable),

e Graphically displays series and parallel tasks,

e Provides baseline and tracking Gantt charts,

e Displays the critical path,

e Ability to link notes and documents, and

e Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following
minimum requirements:
1. Includes all the activities identified by the Minimum Requirement Schedule
Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
Task Indicator columns are used to link applicable instructional and reference
documents,
Explanations for changes in task durations are added as task notes,
Tracking View/Gantt chart functions are used,
Task-level progress is tracked regularly,
Files are stored in COMPASS as indicated by the Digital Project Development

w

A

Manual, and
8. Microsoft Project files are maintained and current, with projected schedules in
accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs
are as follows:

e Bridge Design — Kevin Blasi and David Gruttadauria

e Consultant Bridge Design — Derick Lessard and Marc Byrnes

e Highway Design — Scott Bushee, Jordan Pike, and Vitalij Staroverov

e Consultant Design State Roads — Nilesh Patel and Meredith Andrews

e Trdffic Projects Design — Barry Schilling and Michael Chachakis

e Trdffic Studies & Safety — Erika Lindeberg, Daniel Veronesi and Colin Baummer

e Facilities Design — Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding
discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov ) or John Dudzinski
(john.dudzinski@ct.gov)
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The table below details the minimum tasks included in the template:

Table 2 - List of Minimum Tasks

Task Name

Project XXXX-XXXX

Project Initiation

e Prepare and Submit PPI

e Prepare and Approve RPM

e Secure Funding/Authorization

Preliminary Design

e Survey

NEPA/CEPA

Develop PD through Design Approval

e Design Approval

Final Design

e Prepare Semi-Final Design Submission

e Prepare Final Design Submission

ROW Coordination

e Prepare and Submit Final Accepted Property Maps

e Acquire Properties

Permit Acquisition Process

e PermitA

O

Prepare and Submit Permits to Regulatory Authority

@)

Regulatory Authority Review and Issuance of Permit

e PermitB

O

Prepare and Submit Permits to Regulatory Authority

O

Regulatory Authority Review and Issuance of Permit

e PermitC

o Prepare and Submit Permits to Regulatory Authority
o Regulatory Authority Review and Issuance of Permit
FDP
DCD
ADV
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11.1MS Project Schedules in COMPASS

All Microsoft Project schedules managed in-house are now stored in COMPASS rather than
ProjectWise.

AEC Applications is coordinating with individual Project Managers (PMs) to migrate all active,
existing MS Project schedules from ProjectWise to COMPASS. For questions on the migration
process, contact Chris Smith in AEC Applications.

COMPASS Software License Requirements

Project Managers and any individuals who will be actively maintaining an MS Project schedule

must have a Microsoft Project Professional desktop application license and a Microsoft Project
Online Professional license. Individuals who will be viewing schedules or implementing minor

edits in COMPASS require the Microsoft Project Online Essentials license only.

Configuring MS Project COMPASS Profile

In order to interact directly with schedules stored in COMPASS via the MS Project Professional
Desktop Application, set-up the configuration as follows:

1. Open the Microsoft Project Professional desktop application.

2. Click the File tab at the top of the screen.

3. Press Info 2 Manage Accounts

1) Click here
2) Click here
Project1 - Project Professional
Info
E roject Web App Accounts Project Information -
You're not connected to Project Web App Start Date Tz
Manage
Accoun ts Finish Date Today
Schedule from Start
Current Date Today
;| Organize Global Template Status Date Today
- Move views, reports, and other elements between project files and the global template. Project Calendar ~ Standard
Organizer Priority 500

Figure 255 - Configuring MS Project
4. Click Add.
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5.

In the Account Properties window, enter the information provided below, then click OK.

2) Enter this

Project Web App Accounts

Ayailable accounts:

Default

Computer

1) Click
here

Account Properties

Account Name:
Compass| |

Project Server URL:
https://ctgovdot.sharepoint.com/sites/pwa

Set as default account

Cancel

Current account:  Ci
To switch accounts,

When starting

(O) Use my default account 3) CliCk here

(® Choose an account

Help Cancel

4) Click here

Figure 256 - Configuring MS Project

New MS Project Schedules

The following steps show how to set-up a Microsoft Project file.

1.
ProjectWise Explorer.
2. Double-click on CTDOT and sign in to ProjectWise.

infarmation

A ProjectWise Fxplorer V&i (SELECTseries 4)
Datasource View Tools Window Help

of G | O Ss e EEEE @ : 3% v |search

i dp - & - B i address [

EHJ] Praisstiiiice Explorer Datasources Name

| ProjectWise Explorer Log in
Datasource: | CTDOT
User Mame: PWOMLINE \Nicholas.Langer

Password: sessssss|

Figure 257 - Logging into ProjectWise
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3. Browse to Documents = 04.00 Engineering Libraries = Scheduling Directive. Select the
applicable Scheduling Documents folder. The minimum requirement schedule template
is stored in the AEC Scheduling Documents (Minimum Req) folder.

jectWise Explorer V81 (SELECTseries 4)
urce Folder Document View Tools Window Help

b | = -@EﬁvSearchéﬁz

&  Bn ®p

II|'> - ul EAddreis =" NnDocuments'\04.00 - Engineering Libraries\Scheduling Directive'\AEC Scheduling Documents (Minimum Reg)\, + b Go

v > Interface[ CTDOT_Doc_Code x|y

031 - Traffic Counts

|~ 04.00 - Engineering Libraries

-4 04.02 - Asset Management

-4 04.03 - Research Administration 1
[#-{_" 04.06 - Project Management
E
E
e
[E:

i AEC Applications

i-{_ Bridge Structures

v Censtruction

f-{_" CTDOT Standard Drawings
1 Directives 8 Bulletins

-4 Engineering Administration

-1 Engineering Templates

-4 Environmental Planning

- Facilities

E-{2 Highway

-4 Hydraulics & Drainage

-4 OSTA

-4 Permit_Documentation

-1 Proprictary Product Approvals 2
L Rails
2|7 Scheduling Directive 9

L Bridge Division Scheduling Documents

.~ Highway Divisicn Scheduling Documents
{_ Traffic Division Scheduling Documents

1 AEC Scheduling Documents (Minimum Req)

. Facilities & Transit Division Scheduling Decuments

>

List |. Geospatial

Name

Description

lf?.‘ Minimum Requirement Schedule Template )

Minimum Requirement Sc

m

# | AEC Schedule Task Library

- 3 - Click specific division's
Scheduling folder

AEC ScheduleTask Library

- Traffic

4| m

Figure 258 - Schedule Template

4. Right click on the desired schedule and select Export, then select Send to Folder, and
click next. Then save the file locally and prepare MS Project schedule.

7 L AEL SUIIEUUIE 13K LIDIdTy

/| AEC Initiation Phase Scheduling
= 2

R A Process v2.0

ﬁﬁ Minimum Requ epbSchadule
[l TR o New

S ey quire

Z@ms Projec@ecember

pe Open
/= NEPA-CEPRrocess v

Open as Read-Only
Open With...
Markup

View

Check Out

Check In

‘MMS Free

Copy Out

ACL SLHEUUIE 1a3K
Temporay Schedul
Minimum Require

Minimum Require

Minimum Require!
MS Project Decem
Supplemental NEP.

Document Export Wizard

Export...

N
Import by
Create Renditions...

Export to Excel

Export Dependency Map(s)...

Import Dependency Map(s)

Update Server Copy
Refresh Local Copy

<
—_—— Purge Local Copy
Document Properties  Folder | Purge WorkSpace
Document v
© Ll Cut
Name + | Desc
Copy

Enter filter here 7| Enter Paste...
| CEADMINISTR.. Adm

Copy To...

Welcome to the Document Export
Wizard

Choose an action to perform
(O Export - Locks file, changes can be re-imported

| (® Send to Folder - Creates unmanaged local copy

The Send to Folder option will d
selected documents so they can

load unmanaged local copies of the
nt out for review.

e e i e [ e e e M e M e i

Figure 259 - Schedule Template
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5. Next open the project file.
6. Then click on the File menu, select Info, select the Project Information dropdown and
then Advanced Properties as shown below:

Pl | (Gantt Chart Tools Projectl - Microsoft Projec

Task Resource Project View Acrobat Format

Information About Projectl

Organize Global Template
g Move project elements such as views, reports, and tables between two local files,
or between a local file and the global template file.

Organizer

Project Information ~

New ~4igl] Advanced Properties
B View advanced and custom
properties of this project.
Print . -
See key statistics related to
Save & Send your project.
Help f’lﬂjed Calendar ftrarndald

Figure 260 - Setting Advanced Project Properties

7. Inthe dialogue box that pops up, fill out the information as shown below:
NAL -Minimurm Requirement Schedule Template Prop... |I||E|

General | Summary |Statistics I Contents | Cusboml

f Title: Project ¥00-x0000 \
Subject: Write the type of Project/short description
Author: Mick Langer
Manager: Project Manager Name

Qompany: State of Connecticut Dept of Transpartation J
Category:
Keywords: 1. Some information
Comments: must be provided after

Proj. Initiation, such as

Hyperlink Proj. No. & PM Name
base:
|:| Save preview picture 2

‘ OK b Cancel

Figure 261 - Project Information

8. Next set the project start date by selecting the File menu > select Info, then select the
date as shown below:

Issued April 2020 226 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

Gantt Chiart Tools Project] - Microsoft Project

Projet  View  Acrobat Format

Information About Projectl =

Organize Global Template
Q Move project elements such as views, reports, and tables between two local files,
or between a local file and the global template file.

@ Select a Start Date

Recent Project Information =
e 1unjzu150
Print Finish Date 4 October, 2015 3
. Schedule from Su Mo Tu We Th Fr sa
Current Date 7 8 2 W 1 2 3
Save & Send
Status Date 4568 7 8 9D
11 12 13[4 15 6 17
Help Project Calendar 18 19 20 21 22 23 24
Friority 25 26 27 28 29 30 31
|1 Options 1 3 4 5 &
Toda!
& e

Figure 262 - Setting the Start Date

9. When the new MS Project schedule is ready to be added to COMPASS, upload it to the
appropriate Internal Documents = 140_Project_Administration folder in COMPASS.

/O Search ‘+‘ New 1 Upload ™ a Sync m Export to Exce f Quick edit

Canignrs Internal Documents

Internal Documents

7 ts D Created Modified Name

o
o
)

100_Contract_Plans (PDF)

June 27, 2018 June 27

Project Emails

Report of Meetings June 27, 2018 June 27, 2018 110_Contract _Documents
Edit June 27, 2018 June 10 120_Contractor_Submittals (PDF)
June 27, 2018 June 27,2018 130_Final _Engineering_Reports
June 27, 2018 June 27, 2018 131_Engineering_Reports_Confidential

June 27, 2018 140_Project_Administration

Figure 263 - Saving the MS Project File to COMPASS
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Internal Documents

J

Created Modified Name

Press the Upload button or Drag
and drop MS Project file to save
to COMPASS Internal Documents

140_Project_Administration

Drag files here

Figure 264 - Uploading MS Project File to COMPASS

Once the schedule is prepared and saved in the 140_folder, contact Chris Smith in AEC

Applications to have the file linked to the COMPASS pages.

Working with MS Project in COMPASS

Editing and Opening a MS Project from Desktop Application

Schedules stored in COMPASS can be opened to view or edit via the MS Project Professional

Desktop Application:
1. Open the Microsoft Project Professional desktop application.

2. Select the COMPASS profile; click OK.

Legin

Profile: | Compass el

I__cuad Summary Resource Assignments

Cancel

Figure 265 - Opening an MS Project Schedule

Wark Offline

3. Select Open Other Projects.
4. Under Project Web App, select COMPASS.
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Open

Project Web App
) Compass g

7 LY
& Recent

Figure 266 - Opening an MS Project Schedule

5. Click Browse and select the desired project schedule from the list. Note: If the Project
schedule is not listed, click “Show me the list of all projects.”

Mame Cache Status Last Access Time

I%Shﬂw me the list of all projects

_F' roject Schedule_HW_Waorking_0036-0195 32119 1057 AM
_F' roject Schedule HW_Working_0139-0191 3119 2:31 PM
_F' roject Schedule_TR_Waorking_0013-0365 329719 12:02 PM
B3 Proiect Schedule TR Workina 0132-0133 47119 242 PM

Figure 267 - Show me List of Schedules

Then click Open.

After the edits are completed, save the file.

Then publish the MS Project file back to COMPASS by clicking on File =2 Info.
Then Click the Publish button.

Lo N

Info

CTDOT - TPMS

Connecticut Department of Transportation » sites

F Publish Project Progress
©Q Last published: 11/9/18 9:29 AM.

Publish Publish your project to share more recent updates with your team.

SharePoint site: https://ctgovdot.sharepoint.com/sites/

Figure 268 - Publish MS Project File to COMPASS

Editing and Opening an MS Project Schedule from a
COMPASS Project Site

To open a schedule via COMPASS, navigate to that project’s COMPASS site and click on the MS
Project Schedule button on the landing page or on the Project details page.
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i 0059-0164 TempID. PP059-0004
US1/CT22 Roundabout, Guilford

FDP: 12/25/2019
arboe, Erik A. e

Praject No. 0059-0164 Temp ID. PP059-0004

l» Project Dashboard [ Copy Project Url

7 MS Project Schedule ‘

Click to Open From the
Project Landing Page

PROJECT DESCRIPTION

Townl(s). Guilford, Morth Branford

Modern roundabout at the intersection of US I& CT 22 in Guilford, with approaches in North Branford. C
controlled at the 3-leg intersection. Modifications also include removing a bypass spur to the west & recon:

Figure 269 - Opening an MS Project file from COMPASS

Project Overview

Project No. 0058-0164 )
yashboart u tals/Transmittals
TempID. PPOS9-0004 Dashboard Details Submittals/Transmittals

Schedule Phase: Final-Design

Project Overview i MS Project Schedule

Contacts

\nternal Docurments PROJECT DESCRIPTION

Town(s): Guilford, Nerth Branford
Documents

Modern roundabout at the intersection of US 1 & CT 22 in Guilford, with approaches in North Branford.:

Project Emails intersection. Modifications also include removing a bypass spur to the west & reconfiguring a driveway.

Report of Meetings

DETAILS

Tasks: 253 Health . Schedule Phase: Final-Design

Figure 270 - Opening an MS Project file from COMPASS

To edit the schedule in the Microsoft Project desktop application, navigate to the task tab, click
the down arrow on the Edit button, and select In Microsoft Project. The schedule will then open
in the Microsoft Project desktop application.

BROWSE  PROJECT  PAGE | TASK | OPTION

%

.
o
"
[a]
1
»
"
a
3
U

In Browser coitng asks

In Microsoft Project 1

- mbusas Chasliad in lass Modified: 4/30/2018 4:55 PM Version: Published
e_HW_Work In Microsoft Project

Check out the project in Project

Schedule Professional so that you can make
roiect Deta changes to it.
i \ P -

Figure 271 - Open MS Project File

Opening and Editing an MS Project Schedule in the 0365
Web App

The following shows how to open an MS Project schedule in the Office 365 (0365) Web App
(PWA).

1. Log-in to COMPASS and navigate to the project site.

2. From the project page.
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3. Then select the MS Project button to access the schedule via the PWA.
4. Click the edit button in the project group on the project tab or the task tab.
Incorporate edits as needed.

Status: Checked-in Last Modified: 4/3(

Figure 272 - Editing the MS Project Schedule in the Web App

5. Once edits are complete, click the close button on the Project tab.

x I = e
S o
o 5] e _)
ose o ect £
Ste e 2 Delverable
s
Close

ed-out 1o you since 10/3

Schex

Figure 273 - Closing the MS Project Schedule

6. Then click Check it in and press OK.

1005 oh U =
|  —
88 " Close - 0059-0164 X
1 Checkin
Do you want to check your project in?
B 1 ® Checkitin Keep it checked out
1 CK Cancel
; =3
| 10U [un I n

Figure 274 - Checking IN an MS Project

7. Press close on the Project tab.
8. Theon the Task Tab click Publish. This saves and publishes the changes.
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BROWSE  PROJECT  PAGE] | TASK | OPTIONS
;g Cut - =)
; =2 [*%, Oz 257 S0x 7S« M0 [—d
& Copy b —
Paste £d Save Pubtish * oo s Set Manually  Aute
€ Undo . e Baseline . Schedule Schedule
pboard Projec Editing
Publish
i @ 118 2:08 PM
hedule | publish the project schedule to make
059-0164 B the latest updates public.

Figure 275 - Publishing MS Project

Open MS Project from COMPASS PWA Site

Users can also manage MS Project schedules directly through the Project Web App (PWA),
rather than navigating through specific project site. This can be particularly useful for users who

are maintaining schedules for multiple projects.

To open an MS Project file directly via the PWA site:
1. Signin to Office 365.

2. Click on the Project application button.

» @& @&

SharePoint

Teams Delve

Project Flow

Click here

Figure 276 - MS Project App
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3. Locate and select the relevant schedule by project number in the Project Name column.
[ F m B outine- - 8 view: Summary T HE OB F Ly [ subprojects (‘) "
“‘V‘ "B @l a % || Rollups Y Filter: Mo Filter - 1.- l'-.- ﬂ;ﬂ ) _?
remians CFraset” | ZT TB e O Gantt chart B Group By D ek fG RS P O Tmewmbate  Change
- 2 BY: | Mo Group
Navigate Zoom Data Timeline Share ShowiHide Praject Type
1) Click to sort on Project Name
July 18 Ji y 26 ugust 5 August 15
5}“| Add tasks with dates to the timeline
iz
Project ID @ | Project Name t Cwner Start Finish % Complete Work Duration
‘ 100352 = [oon2-0128 ool Natwick: Brian J. 9/21/2017 8/21/2019 19% oh 500d
100232 E 0005-0114 ==+ | Bushes; Scott 322016 12/2/2020 17% oh 1,240.05d
100186 E 0007-0189 =+« | Schilling; Barry A 1/2/2018 8/7/2019 53% 4a8h 417d
100393 = |oo11-0156 | Reed;: Bryan H 10/3/2017 3/20/2022 6% 2,408h 1,164d
100371 B |oo11-0157 s« | Bushes: Scott 4/5/2017 1071172022 % oh 1,440d
100354 E 0011-0158 =++| Reed; Bryan H 57472018 4/30/2022 5% 3,356h 1,041d
100255 = |oo14-0174 | Aresco; Salvatore 7/21/1998 10/25/2017 70% oh 5,025.4d
100278 B |oo14-0128 s« | Aresco; Salvatare 1/23/2015 7/12/2020 40% oh 1,425d
100398 E 0015-0248 =++| Reed; Bryan H 11/16/2012 9/9/2019 25% 36,240h 1,777d
100417 = |oo15-0312 « | Pfaffinger; Jeffrey 3/3/2016 10/31/2018 47% oh 695d
100199 E 0015-0365 ==+ | Conroy; Lisa N. 71572013 10/4/2017 92% oh 1,102d
100408 E 0015-0368 ===\ Pfaffinger; Jeffrey 9/2/2013 6/30/2021 34% oh 1,520.5d
100421 = |oo1s-03m1 | Roberts; Scott A. 6/2/2014 9/23/2020 75% oh 1,648d
100297 E 0015-0374 =} Cannamela; Sebastian A 2/17/2018 4/15/2020 93% oh 1,086d
100409 E 0015-0376 ===\ Pfaffinger; Jeffrey 3/9/2016 127272020 55% oh 1,193d
100345 = |oo15-0378 «o| Cutler; David A 5/24/2016 1/12/2021 1% 18,672h 1,211d
100218 E 0o17-0182 =+« | Cherpak; Michael 5 4/8/2014 10/16/2019 0% oh 1,439.38d
100219 E 0o17-0187 =+=| Cherpak; Michzel 5 9/28/2015 10/31/2022 20% 924h 1,849.53d
100291 &= |oo1e-0124 «++| Cardinali; Andrew J 3/31/2016 9/26/2018 99% 3,552h 650d
100236 E 0018-0135 =+« | Bushee; Scott 11/16/2016 5/6/2021 62% oh 1,165.7d
100350 E 0018-0136 ===} Matwick; Brian J. 3/30/2017 4/8/2019 99% oh 484d
100356 & |oozs-0147 «++| Palmer; Gregory 14172017 9/11/2019 45% oh 703d
1ANIED =T NN _NNT wesfl Blndicls Drimn | D41 INAE 11 M990 INOL Nk 1 AEEA
2) Locate and select relevant
project schedule from list

Figure 277 - MS Project List

4. To view and edit the MS Project schedule, ensure that the “Schedule” tab is selected.

Ensure that Schedule tab is selected
Schedule: 0002-0128

COMPASS

CONNECTICUT DOT

&

0002-0128 (1) Status: Checked-in Last Modified: 6/6/2019 8:16 AM Version: Published
Schedule
Project Details ® |iDt | Mode | Task Name Start Fin
Project Site 1| + Project Initiation Phase 9/21/2017 11/,
2 -l:b Prepare and Submit PPI 9/21/2017 | 10/4
Figure 278 - Project Schedule
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Reassigning MS Project Schedule Ownership

To edit an MS Project Schedule baseline (0-5), the user must be assigned as the “Owner” of the
schedule. AEC assigns the correct Project Manager when a schedule is added to COMPASS. The
current owner has the ability to reassign ownership if needed. If the current schedule owner is

unable to perform this task, contact Chris Smith in AEC Applications.

To reassign ownership of an MS Project schedule in COMPASS, the current owner can:
1. Open the relevant MS Project schedule as described in Section 11.1.4.

2. Enter the Edit Project Details page.

BROWSE PROJECT PAGE

= Documents I, Risks D
*®
) Issues <«

Previous  Next

Deliverables

Page
0002-0128 ed-in Last Modified: 6/6/2019 8:16 AM
Schedule
Project Details

asic

Matwick; Brian J.

2) Select PROJECT tab

Project Site

MName * 0002-0128
Projects Specify a name for the

terprise Project
Approvals
Tasks 100352 . .
. 3) Click Edit

Resources
Reports 442612017
# EDIT LINKS Finish Date 8/21/2019

1) Ensure Project Details
tab is selected

Figure 279 - Reassigning Ownership of an MS Project File

3. Next to the Owner field, click Browse. Select the new schedule owner, then press OK.

Blasi; Kevin
blasik@DOT.CT.GOV
Blume; Matthew
BlumeM@DOT.CT.GOV
Bordonaro: Joseph §
BordonaroJS@DOT.CT.GOV
Bourgoin; Bruce R
Bruce.Bourgoin@ct.gov

| l:l Brad Wilcox

Brad Wilcox@ctgovdot.onmicrosoft.com

inish Date 8/21/2019

Pwner

Browse...

Details

roject Departments |

Brazaitis: Peter
Peter.Brazaitis@ct.gov
1 ) Cllek Erewse Bushee: Scott

LR Scott.Bushee@ct.gov
Byrnes; Marc P
Marc.Byrnes@ct.gov

/ Calabrese; Michael N
Michael Calabrese@ct.gov
Calkins; Mathew J

2) Selaet deslrad schadule ewner CalkinsMJ@DOT.CT.GOV

3) Select OK
Figure 280 - Selecting New Owner
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4. Click close and check-in the MS Project schedule.

BROWSE  PROJECT = PAGE
E B ‘%' E = Documents 1. Risks D
l.l; Issues €«
Edit Save  Close  Project  Build Previous  Mext
Ste Team [ Deliverabies
Project Mavigate Page
0002-0128 (i) status: Checked-out to you since 7/26/201% 3:07 PM Last Modified: 6/6/2019 8:16 AM
Schedule
Project Def )
o Basic Info
Project Site
. lame 0002-0128
Projects
Approvals Project ID 100352
Tasks I
Resources o
Reports
# EDIT LINKS
Start Date * 4/26/2017 ]
Finish Date 8/21/2019
Owne Browse.,
Close the project schedule and check-in

Figure 281 - Closing MS Project Schedule

11.2Basic MS Project Function

This section presents the following schedule basic terminology and functions:
e Scheduling Terminology
e Task Relationships (Predecessors and Successors)
e Adding, Renaming, Indenting and Deleting a Task
e Adding/Adjusting Durations
e Lead and Lag Times
e Adding Hyperlinks
e Combining Multiple Projects

Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule
using task names, durations, start and finish dates on the left, and bar charts presenting these

dates and durations to the right.
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E

- |= Gantt Chart Tools

Task  Resource | Project | View  ProjectWise Format
= e [ 'ﬁ Status Date: (3] 3/23/15 = =
= q == = : 3 H =%
W B E L E B B L il B 53 ¥

=| Update Project
Subproject Project  Custom Links Between WES Change Calculate  Set Moave visual Reports Compare = Spelling
Information Fields Braiarts *  Warkinn Tima | Praiert Raceline ~ Project Reports Prajects

Minimum Requirement Schedule Template - Microsoft Project

Insert

P I Stat R | Grey Bar - Parent Task
Task Indicator Column = coots v B
‘ @ a5k Name M [une1 [October 11 [February2i  [Julyl 4  [November 11 [March 21 [August 1

s/24 | 7/26 | 9/27 [11/28] 1/31 | 4/3 | 6/5 | g7 [ 10/9 [12/11] 2/12 | 4/16 | 6/18 | 8/20 [10/

o ~ Project XXXX-XXXX 38.65 mons Project XXXX-KXXX 7 .8.

= 1Project Initiation 17 mons Project Initiation @ v
2 B 1.1 Prepare and Submit PPI 10 mons ‘rEmrw—
R N 1.2 Prepare and Approve RP . Prepare and Approve RPM Milestone
a 1.3 Secire Fundin;;Authori: Red - Critical Path W
E = 2 Preliminary Design 6 mons Preliminary Design )
6 2.15urvey 3 mons / Survey E;
7 2.2 NEPA/CEPA 6 mons Blue - Non Critical Task NEPAICEPAE;

= Develop PD through Design Approval 6 mons
Hyper"nk Design ippmval ¢ e 0 mons Design Approval 9/7

10 = 3 Final Design 13 mons Final Design 'r

Figure 282 - Basic Terms

Task Indicator Column - Present task Notes and Hyperlinks.
Milestone - A major schedule date, such as an FDP.

Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the
Child Tasks.

Critical Path - Shown in Red, signifies the task relationships that control major milestone dates.
Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

Task Relationships (Predecessor and Successors)

Predecessor is a task which has a start or finish date that affects the start or finish of another
task.

Successor is a task which has a start or finish date that is affected by another task.

There are different ways of defining task relationships, these are

o Finish-to-Start: This is the default dependency in Microsoft Project in which the successor
cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by
FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

@ Tk . TaskName - |Duration ., |Start + Finish + |Predecessors ., | [Mar6,'16 [Mar 13,16 [Mar 20, 16 [Mar 27,16
Mode SIM[TIW[T[F[s[SIM[TIW[T[F[S[S[M[TW[T[F[s[S[M[TIW[T[F[S
1
2
3 =S Predecessor 10 days Mon 3/7/16  Fri3/18/16 K ‘ﬁ
& =S Successor 10 days Mon 3/21/16  Fria/1/16 3
Figure 283 - Finish to Start relation

e  Start-to-Start: The successor cannot begin until the predecessor begins. The successor task

can start at any time after predecessor begins. Start-to-Start relationship is designated by

SS.

(i Task  [Task Name - |Duration . |Start « |Finish - |Predecessors || [Mar 6, '16 [Mar 13, 16 [t

Mode s[M[TIw[T[F[s[sM[T[w[T[F[s]
1 3
2
3 2 Predecessor 10 days Mon 3/7/16  Fri3/18/16 [:r
= 2 Successor 10 days Mon 3/7/16  Fri3/18/16 355 ¥
; l

Figure 284 - Finish to Finish relation
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o  Finish-to-Finish: the successor cannot be completed until the predecessor is completed.
The successor can be completed at any time after the predecessor is completed. Finish-to-
Finish task relation is denoted by FF.

[ Task  |Task Name - |Duration  |Start + |Finish - |Predecessors | [Mar6,'16 [Mar13,'16 |
Mode SM[TIW[TF[s[sIM[TIW[TTF]s]|

Predecessor 10 days Mon 3/7/16  Fri3/18/16

( C
Successor 6 days Fri 3/11/16 Fri 3/18/16 ‘BFF } | ‘J

H W -
ol gl

Figure 285 - Start to Finish relation

e  Start-to-Finish: the successor cannot be completed until the predecessor begins. The
successor can be completed at any time after the predecessor has started. The Start-to-
Finish task relation is denoted by SF.

Predecessor 10 days Mon 3/7/16  Fri 3/18/16 L
Successor 6 days Fri2/26/16  Mon3/7/16  3SF G n

ol gl

Figure 286 - Start to Finish relation

The schedule should have a Predecessors column where task relationships can be defined. To
define a task relation, enter the Task ID and the Task Relationship in the associated task’s
Predecessor Cell. For example, in the Figure below the PPl is a predecessor and the RPM is a
successor task. The PPl must Finish before the RPM can Start. This relationship is denoted in the
RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the
Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is
a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is
not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.

@9 I= |v‘_-u.L'J"_\;Um‘ Microsoft Project

Task | Resource  Project  View  ProjectWise Format

o i
= 2 4 cut - g [~ u> n\'ﬁ - o] Notes
=] Calibri 12 - ORSsSR Mark on Track = 2 (] B
E 2 o - TEEER 7 - = H Predecessor ] petails
Gantt | Paste (Blr u - A- 0 | €8 | ©0 5 =2 Respect Links Auto || Inspect Move Mode | Tas rmation .
o ormat Fainter = - Schedule] -~ o s 3 Column T Add to Timelir
, Task ID Font Schedule Tasks ya Praperties
= & 7
Minimum *ulrament Schedule Template {
@ TeskName - Duration |Start + |Finish - |Predeced®hrs [October 11 [February 21
7/26 | 9/27 [11/29[ 1/31 | 4/3
o ~ Project XXXX-XXXX 34.65 mons Fri 12/4/15 Wed 8/1/18 ‘ L OOOKI000K T
= 1 Project Initiation 13 mons Fri 12/4/15 Thu 12/1/16 vject Initiation e
EAL N 1.1 Prepare and Submit PPI 6 mons Fri 12/4/15 Thu 5/19/16 and Submit PPI [
s @ 1.2 Prepare and Approve RPM 4 mons Fri 5/20/16 Thu 9/8/16 2 Prepare and Approve RPM
LN 1.3 Secure Funding/Authorization 3 mons Fri 9/9/16 Thu12/1/16 3 \ Secure Funding/Autk
= B - . . .
2 preliminary Design 6 mons Fri 12/2/16 Thu 5/18/17 FS relation
6 2.1 Survey 3 mons Fri 12/2/16 Thu 2/23/17
7 2.2 NEPA/CEPA 6 mons Fri 12/2/16 Thu5/18/17 4
8 2.3 Develop PD through Design Approval 6 mons Fri 12/2/16 Thu 5/18/17 755
9 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/18/17 8
10 = 3 Final Design 13 mons Fri 5/18/17 Thu5/17/18

Figure 287 - Linking tasks
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If the Predecessors column is not shown in the template, double click in the “Add New Column”
cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the
current columns. If Add New Column is not shown right click on any column label and select
Insert Column and then start typing in Predecessors, as presented below:

] —
Format

Task Resource Project View Developer

% @ :_ﬁ Ligl [%% = é & Critical Tasks [y -= Ty ey ey ey ey e
‘e u @Column Segngs' S [ sl = - 21 gl gl gl - ==
sTt:igs Gndv\mes Layout Clgls:l;tn ] Custom Fields Forvmat ] Late Tasks Basslme Shpeage P & P & P &
Format Columns Bar Styles
b’:‘l o Task Name - |Duration _ Start + |Finish - I
i 0 = Project 44.85 mon: Mon 8/3/15 Wed 1/9/1%
1 = Project Initiation & mons Mon 8/3/15  Fri 1/15/16
2 aR PRI 2 mons Mon 8/3/15  Fri9/25/15
3 @ RPM Process 4 mons Mon 9/28/15  Fri1/15/16
4 = Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
5 Project Start up(Survey,NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16
5 Develop PD through Design Approval 6 mons Wed 11/30/16 Tue5/16/17
7 ROW OBL 0 mons Tue 6/13/17  Tue6/13/17
8 = Final Design 19 mons Wed 5/17/17 Tue 10/30/18

Figure 288 - Add new column

——————T T

Resource

Project
= L
- M

Format Columns Bar Styles

View Developer Format

ETEJ o Task Name + |Duration . |Start + Finish

N a = Project 44.85 mon: Mon 8/3/15 Fredecess -
1 = Project Initiation 6 mons [ Fri 1/ preleveled Start
ERE T el 2 o Mon §/3/15  Fris/ [T @
ERNL N RPM Process Click hereamons Mon 9/28/15  Fri 1/ Project Engineer (Text2)
q = Preliminary Design 12 mons Wed 6/15/16 Tue Sﬂgﬁttmnager (Text1) =
5 Project Start up{Survey, NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 1
3 Develop PD through Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 Start t}-pmg
7 ROW OBL 0 mons Tue 5/13/17  Tue 6/13/17 "Predecessors”
8 - Final Design 19 mons Wed 5/17/17 Tue 10/30/18
8 =/ ROW acquisition Process 18 mons Wed 6/14/17 Tue 10/30/18
10 (& Prepare and submit maps to ROW 6 mons Wed 6/14/17 Tue 11/28/17

Figure 289 - Adding predecessor column

Adding, Renaming, Indenting and Deleting a Task
Adding a Task

To add a task, right click on the task which will follow the new task and select Insert Task. For
example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select
Insert Task, as shown below:
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1016-03-09_Project Schedule_ HW_Draft_0001-0100

o Task Name + |Duration . |Start + Finish ~ |Predecessors
0 ~ Project 0001-0100 38.r° ik P dmadan
1 = 1 Project Initiation 17r .1 ng ht cllck an
2 @ 1.1 Prepare and Submit PPI u
ERRL 1.2 Prepare and Approve RPM 4m exist'ng task to |nsert a
4 @ 1.3 Sepupp s st tn s ssnntine im
E - 2prcliminai 0T e sm NEW task dlrectly above
6 21survel B £ 97 A e &5 F - am..._ et [
7| & 2.2 NEPA/CEDA Y lsmons Fri 3;’24!1? Thu 9/?!1? 4
& 2.3 Devel T roval 6mons Fri3/24/17 Thu 9/7/17 755
B 2.4 Desigl ~2  Lopy Cell 0 mons Thu9/7/17 Thu9/7/17 g
0 - 3 Final Desig b Paste 13 mons Frio/8f17 Thu9/6/18
11 3.1Prepa Paste special... nission 7 mons Fri9/8/17 Thu 3/22/18 9
iz 27Preng T seroll to Task 5mons Fri3/23/18 Thu 8/9/18 11
i3 2 m 9mons Fri9/8/17 Thu 5/17/18
14 Bt oo ccepted Property Maps 3mons Frig/s/17 Thu 11/30/17 9
15 3.3.2A 6 mons Fri12/1/17 Thu5/17/18 14
16 = 3.4Permi i Manually Schedule 13 mons Frio/8/17 Thu 9/6/18
17 -3.4p| > AuteSchedule 7 mons Friof8f17 Thu 3/22/18
5 @ 3.4 8 Assign Resources.., rmits to Regulatory Authority 3 mons Frig/f8/17 Thu 11/30/17 7
10 3.4.] Fill Down eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 18
20 ='3.4.2p Clear Contents 7 mons Frio/8f17 Thu 3/22/18
21 3.4.] 1 Iformation.. rmits to Regulatory Authority 3 mons Fri9/fa/17 Thu 11/30/17 1855
22 3.4.] o] Netes.. eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 21
23 -'3.43P %@ addto Tmeine &mons Fri1/26/18 Thu 9/6/18
24 3.4.° rmits to Regulatory Authority 2 mons Fri1/26/18 Thu 3/22/18 22FF,19FF
25 3,41 % Hperink. eview and Issuance of Permit 6mons Fri 3/23/18 Thu9/6/18 22,19
26 ([ 1n

Figure 290 - Adding a Task

Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)

Task Inforninatio n

= =
: Genera }Predecessors] Resources] .ﬁ.dvanced] Motes ] Custom Fields]

Mame: PFI ’ 2 Duration: 2 mons : |:| Estimated

Percent complete: 0%o : Priority: 500 :

Schedule Mode: () Manually Scheduled

@) Auto Scheduled
Dates
Start: Mon 8/3/15 ~  Finish: Fri 9/25/15 -

[~ Digplay on Timeline

[ Hide Bar

[T Rollup Then Click

C o 1) o )

Figure 291 - Renaming a task

Outdenting & Indenting
Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left
of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of
the preceding, outdented ‘Parent’ task. Parent task durations are populated by their
accumulative child task durations, therefore, parent task durations should not be manually
entered. To set your task as a child or “sub-task”, select the row you would like to modify and
click the Indent Button in the main toolbar area shown:
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®lEd@9- |= ;r_\'.i_l'J'_]'_'C'J_i.'U.;H;A_i|
Task Resource Project View ProjectWise Format
=2 B & Cut Calibri 11 - WEME WS &)k Track
Gantt | Past LR A =
- A~ 2| ey S5 BE i
Chzr:-tv a's e jFormat Painter B I O Ly = g{.u =2 E2 s Respect Links
View Clipboard Font Schedule
1
o Task Name Outdent & - |Duration
Indent Buttons ————
0 = Project XOOOK-XXXX 34.65 mor
1 = 1 Project Initiation 13 mons?
2 % 6 mons
s ||
s %
5 % 1.4 Secure Funding/Authorization 3 mons
Figure 292 - Outdent and indent
Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By
entering zero for the duration the MS Project will view the task as a milestone, if a report is
generated the report will present all zero duration tasks as milestones. This may confuse report
reviewers. A small duration may push back critical milestone dates. It is therefore
recommended that project managers manually delete and revise predecessor and successor
relations, as described below. To delete a task right click on it and select delete task. (Do Not
Delete the Base Template Tasks in Bold)

@ |[reskname . |puration  |start . |Finish . |Predecessors | [ July 21 |May 1 | February 11 | November 21 |Se;
7/7_[11/24] 4/13 [ 8/31 | 1/18 | 6/7 [10/25] 3/13 [ 7/3.
o = Project P a e 44.85 mons Mon 8/3/15 Wed 1/9/19 e
alibri - P :
1 = Project Initial <« 6 mons? Mon 8/3/15  Fri1/15/16 =y 0%
A - e sl B 5 :
2 2@ PPl B IO A =sF 2mons  Mon8/3/15  Frig/25/15 =o%
3 | [ Demo Jamons?  Mons/3/15  Frigj2s/15 =|o%
. @ RPM Proce # SUECEl 2mons Mong/28/15 Fri1/15/16 2 :
5 = Preliminaryp =4 Lopy Cel 12mons  Wed 6/15/16 Tue 5/16/17
6 Project Sta "= 1 Data) 6 mons Wed 6/15/16 Tue 11/29/16 4F5+5.35 mons
7 Develop PI I 6 mons Wed 11/30/16 Tue5/16/17 6
8 ROW OBL T Scroll to Task 0 mons Tue 6/13/17 Tue 6/13/17 7FS+4wks
9 = Final Design Insert Task 19 mons Wed 5/17/17 Tue 10/30/18
10 = ROW acqui 18 mons Wed 6/14/17 Tue 10/30/18 8
1 @ prepare - & mons Wed 6/14/17 Tue 11/28/17
2 (@ Acquire ¥ Manualy schedule 12mons  Wed11/29/17 Tue10/30/18 11
13 = Permit Acg = “Ute schedule 12mons  Wed5/17/17 Tue 4/17/18
14 Prepare @ Assign Resources... llatory Agencie 4 mons Wed 5/17/17 Tue9/5/17 7
15 |@ Acquire Fill Down 8 mons Wed9/6/17 Tue4/17/18 14
16 Prepare Fit Clear Contents 18 mons Wed 5/17/17 Tue 10/2/18 7
17 i
% =1 tormation.. 1min Wed 10/31/18 Wed 10/31/18 9
B & FDP ol et 0 mons Wed 10/31/18 Wed 10/31/18 17
otes...
19 DCD el B 0 mons Wed 12/12/18 Wed 12/12/18 18F5+6 ewks
b2 Addto Timeline
20 ADV 0 mons Wed 1/9/19  Wed 1/9/19  19FS+4 ewks
& Hyperlink...

Figure 293 - Deleting a task

When a schedule is started the user should remove tasks that do not relate and estimate all
other pertinent task durations. It is critical to note if the task being deleted is a predecessor.
You can determine this by following the lines stemming from a task in the Gantt chart. If a task is
erroneous and must be deleted, but is also a predecessor for other tasks that should not be
deleted, the successor task must be corrected. Failing to update a new predecessor will likely
disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be
deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the

Issued April 2020 240 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be

the new predecessor. See the task relationship and Gantt chart prior to task deletion:

-——rs

jantt | Past B My A~ %o | 88 | e &5 €2 i Manually| Aut Inspect M Mod
antt | Pt g et vt | 7 U | 2~ A | T | 46| oo 98 Drespectinis | Meruaty Y| wspect Move Mode
fiew Clipboard Font . Schedule Tasks
Task Name - |Duratior _ |Start  _ |Finisk _ |Predecessors - % + Du
Com
1.2.3.5 Preliminary Hydraulic Analysis 51days Tue Tue 16 O%>
11/24/15 2/2/16
1.2.3.6 Hyw/Traffic/Landsc oordination 1day Tue Tue 16 0%
11/24/15 11/24/1
1.2.3.7 Utility Coordination ~ Delete 15days Tue Mon 16 Change 0%
11/24/15 12/14/1 to 19
1.2.3.8 Kick-Off Meeting 1day Wed Wed 18 days 0%
| New predecessor ID 12/9/15  12/9/1
21 2@ 1.2.3.9 ABC Analysis 10days Wed Tue 0%
, 2/3/16  2/16/1
2 Gl 119 1ANCA ArOTR Tiinn Ravinalanmann - AL Amuer Teim Tin ac nos
Figure 294 — Before task deletion table
|October November December January February
B [ M | E B | M | E B [ M | E B [ M | E B [ M [ E
Preliminary Hydraulic Analysis
Hyw/Traffic/Landscape Coordination EV—O%—-
Utility Coordination & > 0%
v
Kick-Off Meeting Y 0%
v
ABC Analysis [mmr@] 0%
Figure 295 — Before task deletion Gantt chart
See Task relationship and Gantt chart after task deletion:
o Task Name . |Duratior _ |Start  _ |Finisk _ |Predecessors - |% - Du
Comp
16 &8 1.2.3.4 Survey 64days Wed Mon 15 0%
8/26/15 11/23/1
17 1.2.3.5 Hyw/Traffic/Landscape Coordination 1day Tue Tue 16 0%
11/24/15 11/24/1
18 & 1.2.3.6 Utility Coordination 15days Tue Mon 16 0%
11/24/15 12/14/1
19 1.2.3.7 Kick-Off Meeting 1day Wed Wed  17FS+10 days 0%
12/9/15  12/9/
20 @@ 1.2.3.8 ABC Analysis 10days Tue Mon 0%
12/15/15 12/28
21 2@ 1.2.3.9 RSR or STR. Type Development 46days Tue Tue 16 0%
11/24/15 1/26/16|
Figure 296 — Post task deletion and predecessor update table
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| October | November | December [January

|F

0 T 7 T S Y = - " [ =~ Y |

E

0%

4
Hyw/Traffic/Landscape Coordination E'"O%—

>
Utility Coordination g =2 0%

. A Kick-O Meeting—E 0%
Notice the critical

path has changed ABC Analysis (< 0%

RSR or STR. Type Development |

Figure 297 - Post task deletion and predecessor update Gantt chart

lO‘)e

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS
Project automatically reconfigures the schedule to show the new critical path. The critical path is
shown in red and highlights the task relationships that determine a projects finish date.

Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click
the Duration Cell to the right of the task and enter the task’s estimated period and the

applicable unit, as presented below:
e Mons: for months
e  Wks: for weeks
e Days: fordays
e Hrs: forhours
e Mins: for minutes

Task Name Duration Start Finish Predecessors
1. Rename the Task

o = Project 44.85 mon: Mon 8/3/15 Wed 1/3/19
1 = Project Initiation 6 mons Mon 8/3/15  Fri 1/15/16 2. Type in the
2 28 PRI 2 mons Mon 8/3/15  Fri9/2s bl Duration
3 ( Demo ) ( 2mons ,m?_j'ls Fri 9/25/15
a @ RPM Process 4 mons Mon 9/28/15  Fri 1/15/16 2
= = Nerallmlmame Nl A manne war~Ad clarfac Towmn rlaciaz

Figure 298 - Adding durations

Jul

1/18 6/7

If the duration unit is already entered, then the duration value may directly entered, without
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations

are automatically calculated by their subtask durations.

If a parent duration is manually entered, select the parent task and re-select Auto Schedule.
This will recalculate the appropriate parent duration, based on its child tasks. See below:
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B H2- s Ganttchart Tools
Resource Project View ProjectWise Farmat
E * Cut Calibri Fit - D EMES S varkonTad - |_D—| ﬁ
Gantt P_aste e (B]lz U &-A-|uos | b el 52 i Ifspect Move Mod'e
Chart~ + < Format Painter = - @ o | @8 | = gp T Respectlink ° = >
View Clipboard
Make sure Auto
$-03-09_Project Schedule_HW _Drz
o Task Name SChed ule is selected -~ » |Finish - |Predecessors | é';;:l |
0 ~ Project 0001-0100 38.65 mons Fri 12/4/15 Wed 11/21/18 Project 0(
1 = 1 Project Initiation 17 mons Fri 12/4f15 Thu 3/23/17 Project
2 @ 1.1 Prepare and Submit PPI 10 mons Fri 12/4/15 Thu 9/8/16 'repare and ¢
3 @ 1.2 Prepare and Approve RPM 4 mons Frig/9/16 Thu 12/29/16 2
4 @ 1.3 Secure Funding/Authorization 3 mons Fri 12/30/16 Thu 3/23/17 3
5 | =2 Preliminary Design Fri 3f2af17 Thu 12/28/17
6 2.15urvey 3 mans Fri 3/24/17 Thu 6/15/17 4
7 2.2 NEPA/CEPA 6 mons Fri 3/24/17 Thu 9/7/17 4

Figure 299 - Auto Schedule

Lead and Lag Times

In defining a task relation, a task may have to be delayed or started early.

The Lead time will tend to push your duration and a plus sign is used.
The Lag time will tend to shorten your duration and a minus sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a
plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

Gantt Chart Tools
Farmat

roject xoooc_ 00

Task Resource Project View Developer
% @ = uu (= =E &y E otiaiTasks 2, _e ey ey ey gy ey pe—p
W8 W coumnseings | S [ sisck - o. e = === s
ST';(:S Grldvllnes Layout CI:Isuer:‘tn _d_| e T Forvmat D T s Bassllne Sllpeage & & & P P &
Format Columns Bar Styles
E;] o Task Name - |Duration _ |Start « |Finish « |Predecessors - ]E
- 7/7
= Project 44.85 mon: Mon 8/3/15 Wed 1/9/19
-/ Project Initiation 6 mons Mon 8/3/15  Fri 1/15/16
=t N PPI 2 mons Mon 8/3/15 Fri 9/25/15
a RPM Process 4 mons Mon 9/28/15  Fri 1/15/16 2
=/ Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
Project Start up{Survey,NEPA,Design Data) 6 mons wed 6/15/16 Tue 11/29/16 3F5+5.35 mons
Develop PD through Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 5
ROW OBL 0 mans Tue 6/13/17 Tue 6/13/17  6FS+4 wks
=/ Final Design 19 mons Wed 5/17/17 Tue 10/30/18
= ROW acquisition Process 18 mons Wed 6/14/17 Tue 10/30/18 7
& Prepare and submit maps to ROW 6 mons Wwed 6/14/17 Tue 11/28/17
& Acquire Properties 12 mons Wwed 11/29/17 Tue 10/30/18 10
= Permit Acquisition Process 12 mons Wwed 5/17/17 Tue 4f17/18 Task
Prepare & Submit Permits to Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 (3] -
(= Acquire Permits 8 mons wed 9/6/17  Tue 4/17/18 13 relation
Prepare Final Design Submission 18 mons Wed 5/17/17 Tue 10/2/18 6 ““it}l lead
=) 1 min Wed 10/31/18 Wed 10/31/18 8 i/ tHime
e | FDP Ioynons Wed 10/31/18 Wed 10/31/18 16
DCD ans wed 12/12/18 wed 12{12}’18(17FS+5 ewks ,
ADV 0 maons wed 1/9/19 wed 1/9/19 1 ewks

Figure 300 - Task relation

This can also be set by right clicking on a task and selecting Information. Then go to the
Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship
type and then a positive duration for a lead time or a negative duration for a lag time in the Lag

column.
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Task Information e |
General Predecessors l Resources ] Advanced ] Motes ] Custom Fields ]
Mame: DCD Duration: 0 mons : Estimated
Predecessors:
FOP -

e Task Mame Type Lag

17 FDP | = AFinish-to-Start (FS) Sew

Help [ Ok ] | Cancel

Figure 301 - Task relation in Project Information

Adding Notes and Hyperlinks to a Task
Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.”
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the
baseline. The note should be placed in the respective task’s indicator column. The note should
state:

e The date of the entry,

The person writing the note,

Justification for the task duration adjustment and
e Recommended: Recipient Notification.

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to
outline a step where project team members who may be interested or are directly impacted by
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is
recommended that a notification email be sent to the relevant recipients and that the
correspondence is saved to the subject project’s 140_Project Administration folder in
ProjectWise. The recipients may typically include:

e AEC’s Project Management Unit —Bruce.Bourgoin@ct.gov or John.Dudzinski@ct.gov

e Finance, such as the Office of Capitol Planning.

e Design Engineers within the Project Manager’s division.

e The group involved with the duration change or the group affected by the change, if
applicable. For example, if the 6 month estimated duration for a project survey needs to
be pushed back, the respective survey supervisor who is involved with the task should
be included as a recipient in the notification email.

The purpose of the recipient list is to improve communication between units and to harvest
project data. Meaning, AEC will collect a repository of duration change notes in order to
continuously reevaluate and improve schedule templates.

To add a note right click on a task and select Notes... as shown below:
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0 ~ Project 44.85 mon: Mon 8/3/15 Wed 1/9/19
1 = Project Initiation 6 mons Mon 8/3f15  Fri1/15/16
2 @% [z1=]] 2 mons Mon 8/3/15 Fri9/25/15
3 % Calibri -1 - % E>:_ 4 mons Mon 9/28/15 Fri 1/15/16 2
4 o 12 mons Wed 6/15/16 Tue 5/16/17
B 7T M-A-e0cs - i
5 ey e e Y, NEPA, Design Data) 6 mons wed 6/15/16 Tue 11/29/16 3F5+5.3%
6 d; cut Cen = "rough Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 5
7 2 Eopy(ell 0 mons Tue 6/13/17 Tue 6/13/17 6FS+w
8 B ;aste 19 mons Wed 5/17/17 Tue 10/30/18
S - on Process 18 mons Wed 6/14/17 Tue 10/320/18 7
10 & Faste spedial. submit maps ta ROW & mons Wed 6/14/17 Tue 11/28/17
11 (@ T SeoltoTask perties 12 mons Wwed 11/29/17 Tue 10/30/18 10
12 Insert Task tion Process 12 mons Wed5/17/17 Tue 4f17/18
13 Delete Task ubmit Permits to Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 6
14 @& # Manually Schedule mits 2 mons Wed 9/6/17 Tue4/17/18 13
15 = Auto scnedute Jesign Submission 18 mons Wed 5/17/17 Tue 10/2/18 6
16 % 1min Wed 10/31/18 Wed 10/31/18 8
17 @ B AssionResources. 0 mons wed 10/31/18 Wed 10/31/18 16
18 Eill Down 0 mons wed 12/12/18 Wed 12/12/18 17FS+6¢
19 Clear Contents 0 mons Wed 1/9/19  Wed1/9/19  18FS+de
E Information...
o] Motes..

2 Add to Timeline

53’.,) Hyperlink...

Figure 302 - Adding Notes
Then type/insert your notes in the popup window.

The other option to access the notes window is to double click on the task and in the Task
Information window and click on the Notes tab.

Adding Hyperlinks to a Task

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and
reference documents.” For all templates, hyperlinks shall be used to link a task to a division
specific Schedule Task Library folder located in the Scheduling Directive folder. Contact your
SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that
contains the permit’s regulatory document, suggested points of contact or experts, pre-written
memorandums, etc... These documents must be added, actively maintained and updated.
Division SME’s and AEC shall be the active maintainers of the division library modifications.
When a document is incorrect or has been superseded it is critical that users report this to a
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users
go through their SMEs to hyperlink documents, but the procedure is explained below.

To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink

- RPMI g 7 oo s A - oew o5 52 - 4mons Mon 9/28/15  Fri 1/15/16 2
= pPreliminary weogm = 12 mons wed 6/15/16  Tue 5/16/17
Proje % cutcen esign Data) I mons wed 6/15/16 Tue 11/29/16 3FS+5.35 mons
Devel ol oo e broval 6 mons Wed 11/30/16 Tue 5/16/17 5
ROWOE o . 0mons Tue 6/13/17  Tue 6/13/17  6FS+4 wks
=~ Final De| ;am speciat.. 19 mons wed 5/17/17 Tue 10/30/18
9 - ROW| = 18 mons Wed 6/14/17 Tue 10/30/18 7
10 & prg = ScrolltoTask ROW 6 mons Wed 6/14/17 Tue 11/28/17
11 |& Ac Insert Task 12 mons wed 11/29/17 Tue 10/30/18 10
12 -~ Perm Delete Task 12 mons Wed 5/17/17 Tue 4f/17/18
13 Pre & manually schedule Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 [3
14 & AN (]  aute Schedule 8 mons Wed 9/6/17  Tue4/17/18 13
15 Preps n 18 mons wed 5/17/17 Tue10/2/18 6
15 By & Assion Resources.. 1 min wed 10/31/18 wed 10/31/18 8
17 | FDP Eill Down 0 mons Wed 10/31/18 Wed 10/31/18 16
18 Dco Clear Contents Omons Wed 12/12/18 'Wed 12/12/18 17FS+6 ewks
15 ADV =0 information... 0 mons wed 1/9/19 wed 1/9/19 18FS+4 ewks

o] Motes..
ZE Addto Timeline

Figure 303 - Adding Hyperlink

Then in the following window, insert web address\navigate to a file.

Issued April 2020 245 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

Insert Hyperlink X
Link to: Text to displayi{ Demol ,
Look in: ‘ :| My Documents h ; =
Existing File or | - ]
Web Page | ArcGIS - Bookmark. ..
Current | 1) Bridge Final.zip L
Foider | 7 Camtasi Studio You may L el
Place in This . FME .
Document Browsed | |i GIS DataBase point to| a file
Pages My Data Sources
, My FME Workspaces
CreateNew | | Recent |(=3 My Shapes Web link Then
Document Files , OneNote Notebooks .
| pp / - chck
Address: th::ffu\"i\"a\'.ct.gov,‘dotsi,‘sitefdefault.asp )’ OK
E-mail Address | —
([ OK ]) Cancel l
LS

Figure 304 - Add link/browse to a file

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link

Edit Hyperlink

T |-

Lirk o Text to display: pw:\\ctdot. projectwiseonline. com: CTDOT \Documents Y04, 0% 20-%620Engi
Look in: | My Documents IE‘
Existing File or
Web Page | ArcGIS - Bookmark...
Current i i i
et 1, Bridge l.:II‘IELZID. |E|
. Camftasia Studio |
Place in This . FME
Document Browsed . GIS DataBase
Pages My Data Sources
. My FME Workspaces
Create New Recent 5 My Shapes
Document Files . OneMote Motebooks 1
. pp S
"
Address: pw:W:bdot.projer:tv\-iseonline.com:CTDOT\.Documents\,D‘}.D‘}‘nZD—‘}'nzDEnE "
E-mail Address .
Then click here = ([ ok |} cancel |

Figure 305 -

Removing a link

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator

column.

Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several
schedules from the same file. MS Project provides this ability through the Subproject combine
function. As outlined in Section 8, schedules must be stored in the project container:
140_Project Administration folder. However, to use the combine function, MS Project schedules
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive.
Schedules located in a local network can then be combined using the subproject tool. Exporting
is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1.

Browse to the ProjectWise Project container’s 140 _Project Administration folder.

Right click the Project Schedule and select Export, as shown below:
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B8 ProjectWise Explorer V8i (SELECTseries 4)

Datasource Folder Document View Tools Window Help
= ! @ : @4 - Search [
da - b - | [P i Address (= trint nrnia

T T shuorees 2. Right Clic

=-[* 0001-0100
100_Cor

& Dot

&

120_Contracter_Submittals (PDF)

110_Contract_Specifications_&_Permits (PDF)

~ [ | Interface| CTDOT_Doc_Code malliaiiy

TTNOT\Documentsy01.0 - Projects - Active\0001-01004140_Project_Administ ~ D Go

- Lst | @ Geospatial |

Label (User Defin... File Name

"y
g
¥

_7 140_Project_Administration

=
=
= 210 Xonstruction
{7 220 Figva
&
1.

230_Corkract_Administration

Browse to Project
Admin Folder

1 330_Design_Data
[&-L27 500_Pre_Design
- Saved Searches

-t 0001-0999

" 0004-0116
% 0004-0118

- 0004-0133
-7 0006-0122
-[* 0007-0182

"8 0007-0182 & 0170-3155
" 0007-0183

- 0009-0094

Document Export Wizard

130_Final Engineering Reports_and Information
incasiagRopod fidential

Ramimistration_Confidential

3. Click Export

<

Document Properties | Project Py

—

Figure 306 - Schedule Export

Highlight Export and Click Next as shown below:

_

New
Open

Open as Read-Only
Open With...
Markup

View

Check Out
CheckIn
Free

Copy Out

Export..
Import
Start Studio Session...

Export Dependency Map(s)...
Import Dependency Mapi(s)...
Update Server Copy

Refresh Local Copy

Purge Local Copy

Purge Workspace

Welcome to the Document Export

Wizard

Choose an action to perform

(@) Export - Locks file, changes can be re-imported ,

(7) Send to Folder - Crea

The Export option will lock an
selected documents so they
later imported using DOCUMEN . « i

nmanaged local copy

1. Click Export .

2. Click Next

=

< Ba

ack [ Mext = ]

Cancel

]

Figure 307 - Export Option

NOTE: DO NOT DELETE THE EXPORTED FILE

T E AEC Example Proi OO 000 mpp.

3

Browse to the network folder where you will keep the schedule file image. This
network file will likely be in the division specific X-Drive>all_data-folder.

The floppy disk means that the file has been exported so the schedule is now read only. A user
can still access the Project file by double clicking it and opening the file as Read Only.
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Jocuments\01.0 - Projects - Active'0001-0100%140_Project_Administ + .‘ Go

Label (User Defin... File Mame

Description

AEC Example Proj JoO0- X000 mpp The ﬂﬂppy disk means AEC Example Proj J000-3000

the file is exported

o List | @ Geospatial

Figure 308 - Exported File

4. Create a new “Master” MS Project file that will be used as the container for the
combined Subprojects. This Master Schedule file can be stored in the local network
drive (such as the X-Drive) or on ProjectWise. Browse to the local network schedule
(the one stored in the X-Drive) and click Insert as shown below:

Ganttc

Toos | S G Sl ToniiEls ol |
Format

= status Date: (8 10,5715 -

= B oo i = =2 ¥

= Update Froject

Calculate Set Move Visual Reports Compare Spelling

Project Baseline - Project Reports Projects
Schedule Reports

View Developer

=
B
Custom Links Between WBS Change

Fields Projects Working Time
Properties

Pr:
Information

status Proafing

The schedule has been inserted into the Master Schedule, where it can be actively updated and
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s

outline symbol.

Sl

Figure 309 - Subproject

o Task Name - |puration _ [start - |Finish - |Predecessors _ |ResourceNames . |  Add New Column . Sep 27, '15
Mode T s
I
Insert Project =]
& )=[[H » Libreries » Documents » ~ [ €3 | [ Search Documents 2|
Organize + Mew folder == - @
&> (B] Microsoft Project Documents library Arrange by:  Folder ~
Includes: 2 locations
“ ¥ Favorites MName Date modified Type Size
B Desktop
B Downloads 1 ArcGIS 3/16/20153:38 PM  File folder
%3] Recent Places |\ Camtasia Studia 9/18/201511:50 AM  File folder
= 1) FME 9/22/201412:38 PM  File folder
a | GIS DataBase 3/20/201510:39 AM  File folder
- Libraries
| & [E Decuments My Data Sources 8/5/2015 2:06 PM File folder
& @l Music L0 My FME Workspaces 10/24/2014 1:20 PM File folder
&> [ Pictures My Shapes 7/25/2014 1:04 P File folder
> B Videos |\ OneNote Notebooks 2/26/201511:19 AM  File folder
I e 1/20/2015 317 PM File folder
28 Computer | Project resources 6/5/201512:49 PM  File folder
> @y OSDisk (C:) I Snagit 5/27/201511:57 AM  File folder
b = Data (D:) (EH] Highway Templats2__.mpp 8/10/2015 10:45 AM  Microsoft Project ... 439 K
& & GIS Data (L)
I E@ ERANDS N SRCNaGEM (S adll| < | it v
ODBC... Link to project
File name: Browse to vour file ~  [Microgbft Project Files (“.mpp;* ~
Tools  ~ Insert |+ Cancel

Gantt Chart Tools 1cn
File Task Resource Project View Developer Format
g B Status Date: 10/6/15 & =
i 2 [9 = =2 = Doens g = gF A
L glUpdate Project
Subproject Project  Custom Links Between WBEBS Change Calculate Set Move Visual Reports Compare | Spelling
Information Fields Projects = ‘Working Time Project Baseline ~ Project Reports Projects
Insert Properties Schedule Status Reports Proofing
- Thu 9/24/15 Sat 11/14/15
=
=
=
=
o Task . Task Name ~ |Duration . |Start - |Finish ~ |Predecessors _ |Resource Names Add New Column
Mode T !
1 898 days  Fri 9/18/15 Wed 2/27/19
2 —

897 days

| = 8rojent 1- signing
L] Q roject 2-signinig
Click the plus signs to expand

Mon 8/3/15 Wed 1/9/19

Figure 310 - Added Subprojects
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A user can view the most updated schedule via the ProjectWise file by right clicking the schedule
file and selecting Update Server Copy as shown below:

List |. Geospatia||

Li Llllecr Dafio, Bl blacoc

A
1. Right click i

n as Read-Only
exported schedule ...

Markup

View
Check Out
CheckIn
Free

Copy Out

2. Click Update Export...
Server Copy Import

Start Studio Session...
Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy ’
Refresh Local Copy

Purge Local Copy —

[ s .| DPrriact Dranariz

Figure 311 - Update server copy

5. This step updates the ProjectWise schedule from the local network image file that is
maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.

6. To Import a project schedule back into ProjectWise the user must right click on the
ProjectWise schedule and click Import. As shown below:

List |. Geospatial|

| 3kl llatio, Eile Bloooc
é[f%‘ AEC Example Proj Xx(K-Xaoal aons

B

\ ‘ Open
Open as Read-Only

1. Right click A
exported schedule Markup

View

Check Qut
CheckIn

2. Click Import Free

Copy Out

Export...
Import
Start Studio Session...

Figure 312- Import

7. If you look back to the local server where the project image file had been saved,
you will notice that it is no longer there, this is because the file has been imported
back into ProjectWise. Now the file can once again be managed directly from
ProjectWise. If a user wishes to maintain their schedule continuously from their
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master schedule, they should avoid importing the schedule. Once a file is imported
the user must re-export and re-add the schedule to their master schedule.

11.3Tracking the Project

Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not
be re-baselined unless there is a major scope change. Re-baselining requires Engineering
Administrator approval.

1. To set the baseline, under the Project tab select set baseline and select Set

Baseline from the dropdown as shown below

ntt Chart Tools ighway AEC__.mpp ict
Task Resource 1Jlew Developer
L. 1 = =2 oy . 8 323/, F4 "
L‘i}—l ] éj @ﬂ = b Status Date: _ﬁ:. 23/15 “ gr_:l 33 Ag
- o Update Project
Subproject Project  Custom Links Between WBS Change Calcula¥g V Visual Reports Compare | Spelling
Information Fields Projects o Working Time Project Edalios Project 3 Reports Projects
Insert Properties {_.:) Set Baseline... ‘ Status Reports Proofing
= \_‘ o] ’ —
o Task iTask Name &t Clear Baseline ation  |Start + |Finish + |Predecessors 11
Mode y | €
- = 3
0 =3 Project XXXX-XXXX 38.7 mons Thu 10/1/15 Wed 9/19/18 )
1 2 = 1 Proiect Initiation 11 mons Thu 10/1/15 Wed 8/3/16 lec

Figure 313 - Set Baseline Dropdown

2. Inthe dialog box that pops ups, keep the default values and click OK.

Set Baseline =

@ﬂ baseline

Baseline

Set irnterim plan
Schaduled Start/Finish
Start 1 /Firish 1

Fegs
@ Eptire project
Selected tasks

Foll up baselines:
Ta gll summary tasks

Erom subtasks into selected surmmary taskis)

Click OK

[ ben |

Figure 314 - Setting a baseline

Re-Baselining

If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be

set in accordance with the following:

1. Go to Projects > Set Baseline > Set Baseline.

2. Then select Set Interim plan, select Baseline from the copy drop down button, then

select Baseline 10 for the Into dropdown list.
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Set Baseline @
(1) Select the "Set © setbaseine
~

Baseline
Interim Plan”™

Copy: {Baseline

For:

_
(4) Make sure this is e
Roll up baselines:
selected To gl summary tasks
From subtasks into selected summary task(s) (5) Se I ect O K
( OK ) Cancel

Figure 315 - Re-Baselining

3. Next, go to Project > Set Baseline> set Baseline.
4. Then in the dialog box that pops up just click OK to save a new Baseline.

Set Baseline £3

@ Set baseline

Baseline -

) setterm gan Keep the default
::13 values and select
o OK

(@) Entire project
() Selected tasks

Roll up baselines:

To all summary tasks

From subtasks into selected summary

Sedf=s Default

Ce e

Figure 316 - Re-Baselining

5. When a pop up window asks you if you want to overwrite click yes

Microsoft Project 2%

Baseline has already been used on Thu 2/11/15. Are you sure you want to overwrite the data in this baseline?

L D[ ]

Figure 317 - Re-Baselining

6. After the project has been re-baselined add a note to the top left Identifier cell
located in the Project No. row. The note should include the details outlined in the
Adding Notes and Hyperlinks to a Task section. The recipient list should include all
parties affected by the base-line adjustment.
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® o R B eSS il = o= Y

Format

Resource View

Project

Subproject Project  Custom Links Between WES Change Calculate Set Move Update Visual Reports Compare | Spelling
Information Fields Projects - ‘Working Time Project Baseline = Project Project Prot uals | Reports Projects
Insert Properties Schedule Status Reports Proofing
@ Task - Task Name - Duration - Start - Finish - Predecessors - Add
y Mod
o = - P RTATATA'RTATAS i
O? Put a note here 44.65mons  Fri12/4/15  Wed 5/8/19
1 = = 1Project Initiation 21 mons Fri 12/a/15 Thu 7/13/17
: ol = 1.1 Prepare and Submit PRI 10 mons Fri 12/4/15 Thu9/8/16
: & = 1.2 Prepare and Approve RPM 8mons Fri 9/9/16 Thu 4/20/17 2
4 e T 1.3 Secure Funding/Autharization 3 mons Fria/21/17 Thu 7/13/17 3

Figure 318 - Re-Baselining Note

After the project has been re-baselined change the view to a Tracking Gantt view.
1. Inthe left dark grey bar shown below, right click and select Tracking Gantt.

| = R R \Gantt Chart Tools. _Mew Minimum Requiremnts__ - Microsoft Proje

Task Resource Project View Format

E E Metwork Diagram = ,_=-3 Resource Usage = Al ‘ 2 Highlight: [No Highlight] ~ Timescale: C_\ @ i
: H calendar ~ : [ Resource Sheet - Z = P Filter: [Mo Filter] T [18] Weeks - \
Gantt | Task Team = Sort  Outline Tables Zoom Entire Sele
Usage ~ ﬂ Other Views Planner ~ [ Other Views = - - - Group by: [No Group] - - Project Ta
Task Views Resource Views Data Zoom
o Task _ Task Name . |Duration . |Start - |Finish
Mod
=l = Project XXXX-XXXX 34.65 mons  Fri12/4/15 Wed 8/
= = 1Project Initiation 13 mons Fri 12/4/15 Thu 12/1
2l S 1.1 Prepare and Submit PPI 6mons Fri 12/4/15 Thu 5/1¢
_ = 1.2 Prepare and Approve RPM 4 mons Fri5/20/16 Thu 9/8/
=S < 1.3 Secure Funding/Authorization 3 mons Frigf9/16 Thu 12/1
2 =2 Preliminary Design Right click on this porl:ion of 6 mons Fr! 12/2{16 Thu 5/18
= 2.1 Survey 3 mons Fri12/2/16 Thu 2/213
=, 2.2 NEPALGEPT the window 6 mons Fri12/2/16 Thu 5/16
=2 .3 Develop PD through Design Approval 6 mons Fri12/2/16 Thu 5/1§&
= 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/18
=S =3 Final Design 13 mons Fri5/19/17 Thu 5/17
2 3.1 Prepare Semi-Final Design Submission 7 mons Fri5/f13/17 Thu 11/3
2 3.2 Prepare Final Design Submission 5mons Fri12/1/17 Thu 4/1¢
2 = 3.3 ROW Coordination 9 mons Fri 5/19/17 Thu 1/25
= 3.3.1 Prepare and Submit Final Accepted Property Maps 3 mons Fri5/13/17 Thu 8/1C
= 3.3.2 Acquire Properties 6 mons Fri8f11/17 Thu 1/25
= = 3.4 Permit Acquisition Process 13 mons Fri5f19/17 Thu 5/17
= = 3.4.1 Permit A 7 mons Fri5/19/17 Thu 11/1
2 3.4.1.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/19/17 Thu 8/1C
= 3.4.1.2 Regulatory Authority Review and Issuance of Permit 4 mons Fri 8/11/17 Thu 11/32
2 = 3.4.2 PermitB 7 mons Fri 5/19/17 Thu 1141
= 3.4.2.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/13/17 Thu 8/1C
= 3.4.2.2 Regulatory Authority Review and Issuance of Permit 4 mans Fri8f11/17 Thu 11/
= = 3.4.3 Permit C 8 mons Fri 10/6/17 Thu 5/17
=2 3.4.3.1 Prepare and Submit Permits to Regulatory Authority 2 mons Fri 10/6/17 Thu 11/3
= 3.4.3.2 Regulatory Authority Review and Issuance of Permit 6 mons Fri12/1/17 Thu 5/17
=
2 5FDP 0 mons Wed 5/23/18 Wed 5/2
2 6 DCD 0 mons Wed 7/4/18 Wed 7/4
= 7 ADV 0 mons Wed 8/1/18 Wed 8/1

Figure 319 - Changing to a Tracking Gantt

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the
one on top is the actual duration. If there is a slip in a task schedule it will be shown as an
offset.
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QOfr 3, 2015 [atr 4, 2015 [atr1,2016 [atr2,2016 [atr3,2016 [atr 4, 2016 [atr1,2017 [atr2,2017 [atr3,2017 [atr4,2017
Jul [Aug [Sep | oct [Nov | Dec [ Jan [Feb [ Mar | Apr [May [ Jun [ Jul [Aug [Sep | Oct [Nov | Dec [ Jan [Feb[Mar [ Apr [May[ Jun | Jul [ Aug [ sep [ Oct | Nov [ Dec
&
Project Initiation G — 17/1
P d Submit PPI §
repare and Submit PRI (\ Current (Actual)

0%

Prepare and Approve RPM

Secure Fanding/Authorization

Preliminary Design P 0%
0%
NEPA{CEPAL—: 0%
g 0%
Design Approval o 5/18
Final Design :
Prepare Semi-Final Design Submission 5" g

Figure 320 - Tracking Gantt view

2. Next to change the table of tasks to the tracking mode, click on the left upper corner
cell to select the entire schedule, then right click and select tracking.

Tory REE L ry e sl

Project XXXX-XXXX Thu 10/1/15 %
olect nitiation P——— §/3
itest/schedule e 0%
e
Prepare and Approve REM B 0%
Sccure Funding/Authoriation & 8/3

Project Initiation Thu 10/1/15

Reauest survey po 8/3
Develop PD Submissior] S 0%

ROW Activities Y 0% |

8 Design Approval-30% & 1/18

19 3 Final Design OF
. - Prepare Semi-Final Design Submission § e 0%

11 mon: Permit Acquisition Process o
4
OFP Review ) 0%
OEEP Review ¢ & 3 0%

Authorize ROW £ 3 o%
Generate Property Maps & o
Last Final Property Maps Delivered to ROW ¢ 10/25

Conduct Evaluations/Negotiations ) 0%

Acquire Properties E
- 3 0%
Dumeny Tesk 10%
e
e
o 919

Figure 321 - Changing to tracking table

The table of tasks will now be in the tracking mode,

3. Then click save.

Recording Task Progress

The project manager will be required to record the project progress by keeping an up to date
record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:
1. Click on a task.
2. Then in the task menu select the appropriate % complete as shown below:
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Gantt Chart Tools

ighway_AEC__.mpp icroso

Project View Developer Format 3
=== i #
.; == K cut X Q - % |:|—| 3 y
E Calibri |11 - ?Mark onTrack = o [aa! ; e
0 53 copy - . = = :
Gantt Paste B J U | &~ A~ T w | =2 cWMERespect Links Manually| Auto Inspect Move Mode Task Summary Milestone | I
Chart~ ~ < Format Painter = - Sthedule |Schedule - - - -
View Clipboard Font Fl Schedule Tasks Insert
Task Name - |Act.Start  _ |Act.Finish  |% Comp. - Rem. Dur. Add New Colun| |1 September 1
1
0 |~ Project XXXX-XXXX Thu 10/1/15 NA 4% 1.71 mons 3 ons - |
1 - Project Initiation Thu 10/1/15 NA 25% 2.89 mons 8.66 mo! Then select the &
2 Define scope/cost est./schedule Thu 10/1/15 MNA 25% 1.75 mons 5.25 mons ]
P % to update
3 PPI MA MNA 0% 0 mons 0 mons
L « Prepare and Approve RPM i Fri4/29/16 NA 25% 1 mon 3 mons ti
=&
5 Secure Funding/Authorizati MA MNA 0% 0 maons 0 mons
2] = Preliminary Design NA NA 2% 0 mons 6 mons
7 . . e - - .
Make sure the task to be updated is
& Develop PD Submission
s ROW Activities

clicked on (Selected)

Fimcicn Aeenaeal A0S nin a nos [ — [ —

2

Figure 322 - task update tools

Important Note: When the task is completed, do not select 100% complete. You will need
to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will

calculate the actual finish date instead of recording the physical date the task was completed.

In the tracking Gantt, the task will show the percent complete of the task as shown below:

3%

024

Figure 323 - Updated task view

Coémpleted

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the

following figure.
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Preliminary Design [ 53
=

B 25%
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0%
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Design Approval ‘:|-57’-1»S—
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Final Design

Prepare Semi-Final Design Submission
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—
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0%
N v
125%
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Figure 324 - Tracking View

11.4 Generating Reports and Summaries
Microsoft Project provides different forms of reports and visual summaries. MS Project has

three reporting options:
1. Standard Reports

2. Custom Reports

3. Visual Reports

Standard Reports
Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs,

assignments and workload.

Under Overview the following is reported:

e Project Summary
e Top-Level Tasks
e  Critical Tasks

e Milestones

e  Working days
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Under Current the following is reported:

e Un started Tasks
e Tasks Starting Soon
e Tasks In-Progress
e Completed Tasks
e Should have Started Tasks
e Slipping Tasks
Under Cost the following is reported:

e Cash Flow
e Budget
e QOverbudget Tasks
e Overbudget Resources
e Earned Value
Under Assignments the following is reported:

e Who does what

e Who does what when

e To-do List

e Over allocated Resources
[ ]

Under Workload the following is reported:

e Task usage
e Resource Usage

To access these report options go to Project > Reports

LR 3 “.:J_L;.-_._--L[M| Highway AtC_mpp - Microsaft Project -~

GO Task  Resource \ew Developer Format
E . g = Status Date: 25 3/2315 i = ¥
g EJ L!él i) = ﬁ

| Update Project
Subproject Project  Custom Links Between WBS Change Calculate  Set Mave Visual\Reports Gbmpare  Spelling
Information Fields Projects *  WorkingTime ~ Project Baseline * Project Reports Projects
Insert Properties Schedule Status Reports Proofing
Task Name L Actstrt _ ActFinish _ %Comp _ ActDur , RemDur | AddNew Colum | [July1 [November 21 [April 11 [September1 [ianuary21 [lunell  [Novemberl [March2l [August1l
6/7 | 8/16 [10/25] 1/3 [3/13 [5/22 [ 7/31 [ 10/9 [12/18] 2/26 | 57 [7/16 [9j2a [12/3 [ 211422 7/1 [ 9fe [1
~ Project XXXX-XXXX Thu 10/1/15 NA 6% 233 mons  36.87 mons — T 6%
= Project Initiation Thu10/1/15 NA 31%  3.94mons 7.61mons Initiation (EE——==mp /18
Define scope/cost est.fschedule Thu10/1/15 NA 25% 1.75mons 5.25mons | f 25%
] NA| Reports 2 4113
Prepare and Approve RPM Frid/29/16 repaie and Approve RPM 50%
Secure Funding/Autharization NA e Secure Funding/Authorization (- 8/18
ﬁ 1= - .
= Preliminary Design NA = - Preliminary Desigr| pr——y 3,
NA . 8/18
Develop PD Submission NA Develop PD Submissiur% 0%
Qverview... Current. Costs... .
ROW Activities NA ROW Activities?=== 0%
Design Approval-30% NA| 19 Design Approval-30%4r 2/2
= Final Design NA ; “.‘— =8 Final Design ¥ 0%
o 38_& 1] Ly L
Prepare Semi-Final Design NA| - Prepare Semi-Final Design 0%
Submission
. s Assignments. .. Workload... Custom... X o
= Permit Acquisition Process NA Permit Acquisition Process iy 0%
OFP Review NA NA 0% Omons 3mons [ OFP RE\'WEW:E’J,W-
DEEP Review NA NA 0% 0mons 8mons DEEP Revi 0%
= RNW Arnuricitinn Prarass NA NA % nmans 1amnnc 0%

Figure 325 - Report options
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Custom Reports

A custom report has the ability to customize the report based on templates in the following
categories:

e Task

e Resource

e Monthly Calendar
Crosstab

To access custom report tool, go to Project > Reports > and double click on Custom

Gantt Chart Tools

icrosoft Project I

ighway_AEC_.mp|

2
) v

Resource iew Developer Format

d 3 - = Status Date: [ 3/23/15
: =a = = & : = B i
_\E il =18 - | =r S| Update Project
Subproject Project  Custom Links Between WES Change Calculate  Set Mave visual {Reports Fompare | Spelling
Information Fields Projects -~ Working Time | Project Baseline ~ Project Reports Projects
Insert Properties Schedule Status REports Proofing
Task Name + |Act.Start  _ |Act Finish _ % Comp.  |Act.Dur. . |Rem.Dur. « | Add New colum | [July 1 November 21 [A
6/7 | 8/16 [10/25] 1/3 [ 3/1
o = Project XOO00-XX00X Thu 10/1/15 NA 6% 2.33 mons 36.87 mons _—
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2 Define scope/cost est./schedule — = iﬁ
p o ﬁ : &
4 Prepare and Approve RPM | { - = Prepa:reand Approve RPM =
5 Secure Funding/Authorization = : Secure Funding/Auth
& = Preliminary Design Preliming
5 Qverview... Current Costs...
g Develop PD Submission Develop PD £
2 ROW Activities . J ‘D ROV
10 Design Approval-30% %—J% il
11 = Final Design
. . Assignments. .. Workload. .. Custom...
1z Prepare Semi-Final Design Prepare !
Submission l
13 = Darmit Arauicitinn Dracace nA nA nos N mane 11 mane
Figure 326 - Custom Reports
Then the report to be edited is first selected from the list of available custom report. Next, click
. . . ) . .
the Edit button. The dialog will show the current report’s setting and all the available report
settings.
~ Project Initiati onamdet = 34%  3.94mons 7.61 mons Initiation ey &/18
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PPI Reports: 0% 0mons 0 mons H 4/13
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N Resource Usage (material) H : A
Secure Funding/A Resource Usage (work) ‘ JD% 0 mons 0 mons ] Secure Funding/Authorization 8/18
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Slipping Tasks
Coy 0% 0 8/18
Develop PD Sub E 0% of i) vers| sort | e 0%
Tasks In Progress £ | organize )
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: To Do List . y >
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Figure 327 - Customizing a report template

Other than the Definitions tab you may utilize details and sort tabs for further customization.
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Visual Reports

Unlike the standard/customized reports which are text based, visual reports present the report

graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio

pivot-diagrams.

To access go to Projects tab > Visual Reports
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Section 12 Electronic Engineering Data
(EED)

12.1Introduction
Purpose

The intent of this section is to provide standards and guidelines to promote consistent, uniform,
and useable deliverables for CTDOT construction projects. It is not the intent of this section to
add unnecessary additional responsibilities to the designer, but rather to have the projects
delivered in a consistent manner following best practices and industry standards used in the
today's CAD environment.

Definition of EED

Electronic Engineering Data (EED) refers to the Computer Aided Design (CAD) files and the
Digital Civil Engineering data files (from applications like OpenRoads and InRoads) that were
used to create the pdf contact plans. These files include:

e Geospatially correct 2D project location polygon
e 2D and 3D geospatially located CAD files

o MicroStation (DGN) Design Models
e InRoads Data

o Coordinate geometry - Horizontal and Vertical alignments (ALG) files
o Roadway Surfaces - InRoads digital terrain models (DTM) files
e OpenRoads Infrastructure Consensus Models (ICM) & i-Models
o Coordinate geometry
o Digital Terrain Models
o Storm Drainage, Structure and Pipe Data — Subsurface Utility Engineering (SUE)

In the future, EED may contain additional information such as asset data (signs, signals,
guiderail, etc.).

In conjunction with an emerging project delivery method or technology initiative, the
Department may provide bidders and contractors with:

e CAD files of the Base Technical Concepts in conjunction with alternative
contracting methods (e.g., Design-Build, Construction Manager/General Contractor
and Construction Manager at Risk).

Implementation Phases

The requirements for EED will be implemented in three phases. A phased structure was
developed to facilitate the transition of the Department into the 2D/3D modeling arena. This
guide has been divided to detail the files submittal types for all phases. The following sections
outline the data requirements based on the Project type for each phase of implementation.

Phase 1

Phase 1 will focus on the practice of submitting proposed MicroStation 2D CAD, InRoads
geometry files and a 2D project location polygon. These files are to be free of any extraneous

Issued April 2020 259 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

data and match the contract plans. All projects designed using InRoads SS2 will follow the data
requirement in Section 12.4.

Phase 1A

R/

% Note: The original Phase 2 requirements have been replaced by Phase 1A goals.
Phase 1 requirements remain in place.

Phase 1A will add the goals of submitting curb to curb 3D roadway top surfaces using the
Department’s current modeling software, InRoads SS2. These 3D surfaces will not be required
submissions; the designers are encouraged to develop the models which can be utilized not only
during the construction phase but the design phase as well. These projects are designed in-
house on the internal network or by consultants on an external network. All projects designed
using InRoads SS2 should follow the data requirements in Section 12.5. If there are design
submissions in this phase they should have the 2D models to be complete from curb to curb for
the entire project, along with the Phase 1 requirements.

Phase 3

Phase 3 will change the data delivery files type using OpenRoads technology (OpenRoads
Designer and beyond). In the upcoming years all new roadway projects designed at CTDOT will
require the use of OpenRoads Technology. All projects designed using this technology will
follow the data requirement in Section 12.6. For these future projects 3D models will include
finished (or “top”) design surface and any subgrade excavation surfaces within the grading limits
for the entire project. Phase 3 will also include Phase 1 requirements.

Why and When Should a 2D/3D Model be Developed?

Nationally the civil industry is quickly recognizing business improvements and lower costs by
changing field operations to incorporate the use of EED. One of these practices is the utilization
of 2D/3D modeling for the development of model based digital design data.
The concept of model centric design, and the generation of digital design data for use in
construction, involves the following key steps:

1. Collection and development of geospatially located survey data for an accurate

existing conditions model to be used for design, and also to be delivered for use
in bidding on the project.

2. Utilization of the survey model in design, with design software capable of 3D
model output.

3. Proposed output from design of critical digital deliverables for use in bidding,
construction and inspection purposes on the project.

4. Utilization of digital deliverables in constructing the project in an automated
fashion.

5. Field collection of as-constructed and inspection measurements and
observations using modern positioning technology, relative to the engineered
model data.

6. Archiving and preservation of digital model data for future use, including asset
management.
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FHWA has promoted the adoption of this technology through their Every Day Counts 2 and 3
initiatives. According to FHWA, “Three-dimensional (3D) modeling in transportation
construction is a mature technology that serves as the building block for the modern-day
digital jobsite. The technology allows for faster, more accurate and more efficient planning
and construction.”

For more information on please visit the U.S. Department of Transportation, Federal Highway
Administration, EDC2 Website titled 3D Engineered Models website at:

https://www.fhwa.dot.gov/construction/3d/about.cfm

Digital 3D models of a highway project can convey a greater level of design intent than a 2D
model; therefore, design projects should be developed in 3D when it is practical to do so.
Essentially, if the designer is using surfaces (existing and proposed) to develop contract plans,
then a 3D model shall be delivered. The following are guidelines to help determine projects in
which 3D models may be beneficial:

e Cross sections will be included in the final plan set.

e Reconstruction is proposed within the project limits. If the reconstruction is only a
component of the overall project (e.g., mill and overlay scope of work with a section of
reconstruction) only the reconstruction area should be designed in 3D unless an
accurate surface was obtained of the entire project.

e Major roadway rehabilitation (structural enhancements that both extend the service life
of an existing pavement and/or improve its load-carrying capability).

e Complex storm water and drainage in order to check for clearances under roadway
subbase and clash detection (i.e. utility conflicts).

e Intersections

e Subsurface utility information that is field located.

12.2Project Types and Phases

This section defines the types of projects that EED will be delivered, along with the contract
plans, at FDP. To determine what requirements are to be delivered in each phase, classify the
type of project from Table 3 — EED Project Types and then use Table 4 — Project Deliverables to
identify the deliverables.

Project Type 1 — No Earth Work Project Type 2 - Site Earth Project Type 3 -

2D Projects Work Roadway Earth Work

3D Site Projects 3D Roadway Projects
Bridge Deck/Superstructure Bicycle/Pedestrian Facility Grade Crossing - Major
Replacement (Multiuse Trails) Improvement
Bridge Bridge Replacement Intersection
Restoration/Rehabilitation W/Realignment Of Approaches Improvement - Minor
Bridge Drainage - Major Intersection Realighment
Substructure/Superstructure
Repairs
Concrete Barrier Rail Facility Construction (Site New Interchange
Work)

Drainage - Minor Hazardous Waste Removal Operational Lane
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Facility Rehabilitation Retaining Walls/Slope Realighment
Stabilization
Fixed Objects Modification Wetland Widening - Major (4r
Replacement/Restoration Projects)
Grade Crossing - Minor Widening (3r Projects) -
Improvement Minor
Guiderail Improvements
lllumination
Intelligent Trans Systems
Landscaping
Maintenance
Noise Barriers
Resurfacing By Contract
Roadside Safety Improvements
Traffic - Paint & Epoxy
Pavement Markings
Traffic - Signal Installation
Traffic - Signal System
Improvement
Traffic - Signing
Transit
Utility Projects
Table 3 - EED Project Types
Project Type 1 Project Type 2 Project Type 3
No Earth Work Site Earth Work Roadway Earth Work
Phase | Phase | Phase | Phase | Phase | Phase | Phase | Phase | Phase
1 1A 3 1 1A 3 1 1A 3
Proposed
MicroStation File R R R R R R R R R
(%]
Q .
T | bxisting Ground D D D D D D R R R
< MicroStation File
O
Project Polygon R R R R R R R R R
" Geometry ALG File D D D D D R R
(]
E
2 Top Surface Curb to G G
s Curb DTM File
[a'4
S | Existi
= xisting Stfrface DTM R R
File
[%)
B Geometry Data D D R
e g
S i
g Top Surfac-e Data R R
o Terrain
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S
ubsurfac? Data R R
Terrain
OpenRoads Terrain R R
Existi
xisting Surfface Data D R
Terrain
Storm Drainage Data
SUE b R
Table 4 — EED Project Deliverables
R = Required

D = Discretionary (Required if used during design)
G = Phase 1A Goals (Submission is at the discretion of the designer)

12.3 Contract Plans and EED Conflicts

In all cases the EED will be issued as “For Information Only” purposes and the contract plans
shall govern. An EED Notice to Contractor will be issued with each contract informing the
potential users of this information as such.

12.4Phase 1 Requirements
Note: Also see Section 12.8 EED Phase 1 Quick Start

Phase 1 will require the delivery of MicroStation 2D CAD models, InRoads alighments and
existing ground surfaces. CTDOT uses Bentley software products for all their computer aided
design needs, with MicroStation (.dgn format) being the foundation to all computer modeling.
Therefore it is critical that MicroStation EED files be submitted to the CTDOT and conforms to
the criteria outlined in this section.

InRoads | PHASE 1 DELIVERABLES
Existing DTM .
| InRoads ALG ﬁl

MicroStation el Perform

Files e ‘ = ‘ | -~

—
:- Check List
: Fill out Submit Files

Submittal to
Create EED Manifest ProjectWise

Figure 329 - Phase 1 EED Deliverables
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Existing Survey

3D Ground Model(s) (.dgn)

o All elements shall be placed using CTDOT’s customized MicroStation Task Manager or
be generated by InRoads Survey Tools. This will ensure that all CAD graphics have the
correct attributes (color, weight, line style, level).

e Must be compatible with CTDOT’s current SELECTSeries DDE.

e Elements must be placed in real world modified state plane coordinates (see Section
3.0 of CTDOT’s Location Survey Manual, June 1997) and be geospatially correct

e Only one design model per dgn file; no drawing or sheet models are to be used

All elements representing existing topography features shall be drawn according to the current
CTDOT Survey standards; CTDOT’s Location Survey Manual, June 1997. These MicroStation
file(s) shall contain a single 3D design model including both 3D and 2D elements of the existing
survey. 2D elements included but are not limited to ROW lines and control lines. 3D element
includes tangible elements such as edges of pavement, shoulders, curbs, gutters, sidewalks and
retaining walls.

Existing Survey Surface File (.dtm)

Existing Digital Terrain Models represent existing ground conditions at the time that surveying
data was collected. This original ground DTM represents the undisturbed ground surface prior
to construction. There may be several existing DTM’s depending on the length of the project
and the number of project site locations. The existing surface dtm will adhere to the
specifications outlined in CTDOT’s Location Survey Manual, June 1997.

See Section 12.5.4 for more information.

Proposed Master Design Models (.dgn)
CTDOT uses Bentley software products for all their computer aided design needs, with
MicroStation (.dgn format) being the foundation to all computer modeling. Therefore it is
critical that MicroStation EED files be submitted to the CTDOT and conforms to the following
criteria:
e All elements shall be placed using CTDOT’s customized MicroStation Task Manager or

be generated by InRoads using the CTDOT preference files (CT_civil.XIN). This will
ensure that all CAD graphics have the correct attributes (color, weight, line style, level)
and follow CTDOT's CAD standards.

e  Must be compatible with CTDOT's current SELECTSeries DDE.

e Elements must be placed in real world modified state plane coordinates and be

geospatially correct

e If a 3D model is developed during design, it should be exported to a 2D model. Any 2D
files generated from a 3D file must be in direct correlation to the 3D parent file.

e Only one design model per dgn file; no drawing or sheet models are to be used

Proposed Master Highway Models

This 2D Design Model DGN will include geometric line work such as centerlines, and proposed
right of way lines. This file will also include right of way dimensions, roadway dimensions and
centerline annotation. All features that are to be quantified shall be included in this file (i.e.
guide rail, fences, etc.).
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Level of Detail ‘

Patterned Riprap Channels
Patterned Riprap Slopes

Patterned Pavement Removal
Patterned Milling

Erosion control Matting for Channels
Erosion control Matting for Slopes
Processed Aggregate

Pavement for Railing

Sodding

Turf Establishment

Planting Details (may be in a separate model)
Project Polygon

Figure 330 LOD Prosed Master Highway Model for Areas

Level of Detail \

Sedimentation Control Fences

Cut limit

Fill limit

Fence

Front face of landscape wall

Single PCBC

Double PCPC

Temporary PCBC

Cut Pavement

Parking lot

Driveway

ROW - graphical representation of an InRoads alighment.

Centerline and Baseline — graphical representation of an InRoads alighment.
Guide Rail =The end anchor should be placed in the correct location. The
smart line is to be offset from EOR so it can be graphically seen (Connecticut
Standard Details for placement will supersede plan placement).

Figure 331 - LOD Proposed Master Highway Model for 2D Smartlines

Proposed Master Structure/Bridge Models

The lead structural designer shall submit to the CTDOT a single 2D design model, per site and
project, in a single 2D DGN file for every project that contains a new footing (including new box
culverts). Each 2D design model shall include all components associated to the particular site

and project.
The single 2D DGN file and its corresponding model shall conform to the following formats and

include the following components:

e All components must be referenced into a single model

e Elements shall be placed using CTDOT'’s customized MicroStation Task Manager.
e Components modeled in MicroStation shall be Feature Model Elements.

e All elements shall be geospatially correct.

o All elements shall be placed at 1:1 scale.
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The master structural model shall include but not be limited to the following components:

Level of Detail

Structure excavation earth and rock
Pervious structure back fill
Granular fill

Figure 332 - LOD Structure Elements Earth

Proposed Master Environmental Compliance Models

The master environmental compliance model shall include a single DGN file with one 2D design
model per file, per location, per project. All features that are to be quantified shall be included
in this model.

Proposed Master Traffic Models

The master traffic model shall include one 2D design model per site. This model shall include all
items that are to be quantified.

Proposed Master Miscellaneous Models

These models could be (but not limited to staging plans and or other disciplines not listed above
that have items to quantify.

Project Polygon (Geo-Spatial Boundary)

** Note: This is the only EED file that is required before FDP.

A Project Polygon (geo-spatial boundary) shall be submitted at the completion of Design
Approval. This will replace a cursory project polygon created at design development by the
project sponsor. Any changes to that boundary during final design or construction warrant a
resubmission of the Project Polygon after Design Approval, at DCD or Construction Completion.

See section 13 for more information.

Coordinate Geometry Files (LALG)
If used, an InRoads (.alg) file shall be submitted per discipline. Submit only final alignments. Do

not include preliminary or alternates information). The .ALG files shall:
e All centerline and baseline horizontals with a maximum of one vertical geometry

alignment per horizontal alignment (including structures).

e All geometry contained in these file shall have names representative of the designed
alignments and features found in the plans (Centerline = Route_84_ Eastbound).

e All coordinate geometry information must be provided in the native InRoads (*.alg)
format.

e Engineering discretion shall be used in determining which geometry elements shall be
displayed in the master highway model.

e Alignments shall follow the specifications outlined in CTDOT’s Location Survey Manual,
June 1997.
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| Horizontal alignments for all roadway centerlines/baselines

Type 2 Projects only - Vertical alignments for all roadway centerlines/baselines

| Horizontal alighments for all proposed ROW

Special alignments used for drainage purposes, skewed driveways or stage construction

| Alignments used for design features such as edge of roads, sidewalks & retaining walls

Structure centerlines of bearings

| Structure centerlines of girders

Figure 333 - LOD ALG Files

12.5Phase 1A Goals

InRoads DTM PH.#.SE 1.& DELI\E"ERABLES
| InRoads ALG
‘|“|E° i ‘-___._ Perform 1E 11 .
T emamm— Y 1" =1
133 . Check List
'3 Fill out Submit Files
Submittal to
Create EED Manifest ProjectWise

Figure 334 - Phase 1A EED Deliverables

Existing Survey Ground File(s) (.dgn)

See Section 12.4.1

Proposed Master Design Files (.dgn)

See Section 12.4.2

Coordinate Geometry Files (LALG)
See Section 12.4.3

Digital Terrain Models (DTM)

A Digital Terrain Model (DTM) is a three-dimensional topographic model which mathematically
and graphically represents the existing and proposed surfaces. It consists of a triangulated
surface with features. A feature is a named set of points in a Digital Terrain Model (DTM). There
are five feature types which define the structure of the feature and controls how it affects the
triangulated model. Each of these feature types has a feature style or styles, which controls how
they are displayed.

e Random - “spot” points which have no direct relationship with other points

e Breakline - groups of points with a direct linear relationship

e Exterior - Surface boundary extent; closed and only one per surface

e Interior - defines undefined areas; closed and no limit to number

e Contour - groups of points with a direct linear relationship and same elevation
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Any DTM used to generate final contract plans must be submitted. For Phase 1 Type 2 projects
this will include all surfaces curb to curb for the entire project. These projects would also be the
type which in most situations will require the inclusion of Item 9.80 Construction Staking. Files
must meet the following criteria to be submitted with the EDD for CTDOT projects:
e |nRoads uses DTM data to produce contours, display the existing and proposed ground
lines in profile and cross section grids, and in the calculation of cut and fill quantities.

Supplied surface files must be in the native InRoads .dtm format.

e Project model deliverables shall include at a minimum, two proposed DTMs and an
existing DTM. One proposed surface shall be a finished grade DTM, and the other shall
be a top of subgrade DTM. It is important to note that the subgrade data is available
with the top surface DTM but when the top surface gets exported using LAND XML for
use with AMG technology the subgrade data gets automatically dropped. For this
reason a separate subgrade surface needs to be delivered.

3D design has no overlaps of breaklines or visual inconsistencies of features.

Surface features are continuous over their entire length, not broken into multiple pieces.

2D contract plans match the surface models.

No vertical faces are present (all vertical surfaces are to be offset a minimum of 1/12 in—1/8 in
to be accepted into the AMG software).

Accuracy clash detection, spot check x, y and z coordinates.

In critical areas (i.e. intersections), contours should be displayed at construction equipment
tolerance intervals (typically 1” or less) to insure smooth surfaces for automated machine
control/guidance purposes.

Figure 335 - LOD DTM Files

Existing

Existing Digital Terrain Models represent existing ground conditions at the time that surveying
data was collected. This original ground DTM represents the undisturbed ground surface prior to
construction. There may be several existing DTM’s depending on the length of the project and
the number of project site locations.

Design

Proposed Digital Terrain Models represent the project design as generated by InRoads using the
horizontal alignments, vertical alignments, templates, roadway definitions and surfaced editing
tools.

A top surface for each corridor will need to be created representing at minimum the proposed
finished grade curb to curb as part of the design data deliverables. All proposed DTM surfaces
shall be defined by a breakline density interval (frequency of cutting templates) of no more than
five feet, and at every event location. In tightly constrained or critical drainage areas, or on the
outside of sharp horizontal curves, the break line interval may need to be reduced to two feet or
less.

Substratum

All files created to represent the approximate Substratum surfaces will also need to be supplied.
Substratum surfaces are used to represent assumed existing subsurface layers, such as rock,
sand, clay etc.
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Subgrade (Structure)

If underground structures are involved multiple subgrade surfaces will need to be generated to
include all bottoms of footings, granular fill, box culverts, piers, walls, abutments, sign supports
and bottom of excavation.

Proposed Master Storm Drainage Models

The Storm Drainage Model DGN file will be either 3D using InRoads Storm and Sanitary or 2D
using StormCAD. The master Storm Drainage Models shall include but not be limited to the
following:

Level of Detail

Pipes — Double line representing the inside Diameter at invert elevations
Culvert ends — 2D cell placed at invert elevations

Endwalls, Riprap Splash Pads and Scour Holes — 2D shape at invert elevation
Catch Basins — 2D cell placed at top of grate elevation

Paved Apron— 2D shape at grate elevation

Manhole - 2D cell placed at top of frame elevation

Figure 336 - LOD Storm Drainage Using Storm and Sanitary

Level of Detail

Pipes — Double line representing the inside Diameter at elevation 0
Culvert ends — 2D cell placed at elevation 0

Endwalls, Riprap Splash Pads and Scour Holes — 2D shape at elevation 0
Catch Basins & Structures — 2D cell placed at elevation 0

Paved Apron— 2D shape at elevation 0

Manhole — 2D cell placed at top of elevation 0

Figure 337 - LOD Storm Drainage Using StormCAD
12.6Phase 3 Requirements

Overview of Phase 3

Phase 3 will consist of delivering a full 3D model of the entire project, slope limit to slope limit.

This will be accomplished using Bentley’s OpenRoads Designer (ORD). This software allows the
designer to create a 3D model much more easily than the current production software, InRoads
Select Series 2.

The deliverables for Phase 3 will just be the MicroStation dgn file itself. All of the engineering
data is written to the dgn including the coordinate geometry, surfaces, and CAD line work. The
dgn is simply saved as an i-Model which can be consumed by the GPS field equipment directly
with no conversions necessary.

Bentley is currently developing the production version. After the release of ORD and testing,
CTDOT will be adopting ORD as the production software sometime later this year.

Existing Survey Ground File

Details coming soon
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Proposed Master Design Files
Details coming soon

Coordinate Geometry Files

Details coming soon

Integrated Civil Models

Details coming soon
12.7Submission Procedures

Submission Dates

All required EED documents shall be delivered:
e AtFDP
e At award of Contract (includes all addenda)
e After design initiated change orders, that the lead desigh deems necessary to supply to
the contractor.

EED Delivery Manifest

The EED delivery manifest must be delivered to the CTDOT with every EED submittal. A blank
copy can be found by clicking on the following link: EED File Manifest. This form will include
general project information; the datum used for the ground survey; file names and specific
information about each EED file being submitted. The contact information for the lead designer
and lead surveyor must also be provided.

ProjectWise File Location

Each discipline will upload their EED files in a zip folder into the 01.0 - Projects - Active\XXXX-
XXXX\240_Contract_Development\ folder where XXXX-XXXX is the project number. For
uploading documents to ProjectWise see Section 6.

EED Notice to Contractor (NTC)

The Notice to Contractor (EED Notice to Contractor) must be filled out by the lead designer with
the correct project number in the last line of the notice. This NTC informs the Office of

Construction and the contractors that the EED will be available, along with the contract plans, at
advertisement. The NTC also states that all EED files are for information only. This will be

submitted along with the specifications at FDP.

For uploading documents to ProjectWise see Section 6.

Converted Data

AEC will convert MicroStation CAD files (dgn) into a dxf format, InRoads alighment files (alg) into
xml, and InRoads surface files (dtm) into xml. These conversions are necessary to be utilized in
the GPS field equipment and automated machine guidance/control equipment. It will be AECs
responsibility to zip all files, both native and converted, and upload to the 100_Contract_Plans
(PDF) folder in ProjectWise. Contracts will be notified so that the EED zip file can be posted
along with the contract plans, specifications, and estimates on the State’s contracting portal at
advertisement.
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The converted data is being provided by CTDOT to insure that inspectors and contractors are
utilizing the same set of data.

Addendum and Design Initiated Change Orders

Changes to the EED that require edits to the CAD models, surfaces or alignments shall be

submitted along with submission of the revised contract plans.

For uploading documents to ProjectWise see Section 6.

A new zip file will be created containing the renamed updated files and uploaded to
ProjectWise. AEC will then be notified that the amended files are complete.

12.8 EED Phase 1 Quick Start

Note: EED is due with the FDP plans at FDP. The only exception is the project polygon. This is
required to be submitted at Design Approval, DCD, and when any Change Order that affects
project polygon. See section 13 for more information on project polygon locations.

1. Ensure that the MicroStation Design Models meet the requirements of Section 12.4.2 for your
discipline. 3D CAD models will be exported to 2D CAD models.
a. All graphical elements are at the correct geospatial location and are on the correct level.
b. Models are free of all cross sections, profiles, construction lines for design purposes.
c. Models are free of annotation that should reside in the cut sheets.
d. Models have clean reference attachments, only needed reference files & no redundant
references.
e. Models are a 2D design model, not a sheet or drawing model
f.  Files contain only one model
2. Ensure that the InRoads Coordinate Geometry file(s) meets the requirements of Section 12.4.3.
a. Only final alignments included (do not include preliminary or alternates information).
b. Alignments names and descriptions are intuitive.
c. Each horizontal alignment has only one child vertical alignment.
3. AtFDP:
a. Check that the EED Checklist criteria is met.
b. Fill out EED File Manifest for all files (native data only).
c. Upload the MicroStation dgn and InRoads alg (if applicable) in a zip folder into the
ProjectWise folder 01.0\Projects - Active\XXXX-XXXX\240_Contract_Development\ where
XXXX-XXXX is the project number. For uploading documents to ProjectWise see Section 6.

4. Send a link to AEC Applications at ronald.tellier@ct.gov that the files are ready.
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12.9EED Checklist

Check List

MicroStation Design Models

All graphical elements are at the correct geospatial location.

All graphical elements are placed on the correct CT DOT Level.

Files are free of all cross sections, profiles, construction lines for design purposes.

Files are free of annotation that should reside in the cut sheets.

Files have clean reference attachments, only needed reference files & no redundant
references.

All 3D files have lines and elements at the proper elevation (no spikes).

Files are a 2D or 3D design model, not a sheet or drawing model

Oog) O ojooo

Files contain only one model

Coordinate Geometry

0 Only final alignments are included (preliminary and alternate information has been
removed).

] | Alignments names and descriptions are intuitive.

0 | Each horizontal alignment has only one child vertical alignment.

Surface Models

0 Visualized breakline features and they appear to be consistent and match the 2D
MicroStation file.

Visualized breakline features, no vertical faces are present; breaklines appear to be
horizontally offset.

Visualized both the contours and triangles in a 3D file. Looked at it from the top and front,
side, and isometric view. No irregular dips, spikes or voids in the surface are apparent.

Triangles were viewed on top of the proposed design file. The triangles do not cross
obvious breaklines such as centerlines, edges of pavement, edges of shoulders, etc.

0 N 0 I A

Contours were viewed to ensure the low points line up with the proposed drainage
structures and structure flowlines match the proposed surface.

If automated machine control/ guidance will be used during construction, at intersections
or other critical areas, contours should be viewed at a 0.1 foot interval to ensure the
model is accurate enough for automated machine control/ guidance use.

O
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12.10 Electronic Data Definitions

3D Model — Models includes all engineering data which is geospatially positioned and graphically
displayed on project related datums and are used to describe the existing conditions or
proposed design of a capital project. This can include multiple DTM surfaces and related
Graphics Information. The “Model” is what is generally what is referred to as the deliverable for
projects which anticipate using AMG.

Automated Construction and Inspection — Automated Construction & Inspection include all
technologies used for the construction and inspection of capital projects, and require the input
of reliable EED to operate effectively. Examples of this may include Automated Machine
Guidance, Automated Stakeout & Inspection, and Intelligent Compaction operations.

Automated Machine Guidance (AMG) — AMG uses computers and survey technology on
construction equipment to automate the calculation and interpolation between a proposed
digital terrain surface (or a control alignment with templates) and survey geospatial positioning.
This interpolation provides visual horizontal and vertical guidance to the operator of the
construction equipment. AMG is also referred to as Machine Control or Automated Machine
Operations.

Automated Stakeout & Inspection — Use of computers and survey technology to automate the
calculation and interpolation between a proposed digital terrain surface (or a control alignment
with templates) and survey geospatial positioning. This interpolation provides horizontal and
vertical guidance to the operator of the equipment, for the stakeout of proposed work or
positional verification or measurement of completed work.

CAD Model (design) — Master Design CAD dgn file. The model usually consists of one dgn file (for
large projects there may be more than one) that contains all of the proposed design work. There
are separate models for each discipline that is doing design for the project (Highways, Traffic,
Bridge, etc.) This model is referenced into the individual cut sheets and clipped to the correct
size.

CAD Model (existing) - Master existing CAD dgn file. The model usually consists of one dgn file
(for large projects there may be more than one) that contains all of the existing survey. This
model will also contain other information such as the datum used and control tie box
information.

CAD files — refers to any CAD files that are not defined as a CAD model (see above). Examples of
these files would be the title sheet, miscellaneous details, detailed estimate sheet, plan sheets,
etc. Plan sheets would have CAD models referenced into them but would not contain any
design work in the file itself.

Digital Terrain Model (DTM) — A DTM is a digital map representation of a three dimensional
topographic surface. (Also referred to as Digital Elevation Model DEM, or a Triangulated
Irregular Network TIN). DTMs are visualized electronically by draping a surface over
triangulated points which are generally determined along breaklines where changes occur in the
slope of the surface. The points are defined geospatially by coordinates and elevation values. In
the civil engineering industry, DTMs can represent existing natural terrain of the earth’s surface,
or proposed terrain intended to represent a completed surface. DTMs can portray triangulated
and/or non-triangulated features, shapes and solids.

Documents & Publications — Includes reports, manuals, contract proposals, specifications or
other publications which record or document decisions, standards, policies, procedures or other
legal requirements related to capital projects.

Electronic Engineering Data (EED) — Includes all types of design project related engineering data
which is used for the defining, developing, designing, documenting, spatially locating,
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constructing, and historical recording on a CTDOT Project. This includes Documents and
Publications, Geospatial Data, Digital Terrain Models, and Graphics Information.

Elements — Elements are points or lines which are described geospatially in two or three
dimensions.

Features — Features consist of points and lines which may be connected to form geospatial
objects, and can be used to form the ground surface displayed in a DTM. Features can be either
3D triangulated (including elevations) or 2D non-triangulated (without elevation). Features
store attribute information about the symbology, level, and text.

Finished Grade DTM — FG DTM shall include the entire proposed project surface area which will
be disturbed by construction operations out to all limits of work. The FG DTM shall be a true
representation of the entire finished surface that the Designer intends to be built. The outer
limits of a project’s DTM shall include all disturbed/modified terrain surfaces that require
excavation or fill of greater than 6” from the existing ground surface over a 1,000 sqft area.

Geospatial Data — This information identifies the geographic position and characteristics of
natural or proposed constructed elements, features and boundaries and how they are
positioned related to the earth’s surface.

Graphics Information — Graphical representations of project information portrayed either by
raster or vector images. Files include graphical representations of points, lines or shapes, text
annotation, and images. CAD files are generally in MicroStation DGN formats, and include all
associated reference files. Graphics are generally published in PDF format.

GPS — Global positioning system, the Global Positioning System (GPS) is a space-based satellite
navigation system that provides location and time information in all weather, anywhere on or
near the Earth, where there is an unobstructed line of sight to four or more GPS satellites. It is
maintained by the United States government and is freely accessible to anyone with a GPS
receiver.

GPS Rover — GPS device that collects the data in the field. Typically consists of a receiver
(antenna), a fixed rod and a data collector. The receiver can also be mounted to a vehicle.

LOD — Level of detail.

RTK — Real Time Kinematics, Real Time Kinematic (RTK) satellite navigation is a technique used in
land survey and in hydrographic survey based on the use of carrier phase measurements of the
GPS, GLONASS and/or Galileo signals where a single reference station provides the real-time
corrections, providing up to centimeter-level accuracy.

RTN — Real Time Network is similar to RTK yet it uses a network of base stations located on
maintenance garages, the internet, satellites and host server software. Though fairly new to the
U.S., these types of networks have been very successful in Europe and Asia where networks
span entire countries where utilization is spreading beyond surveying to mapping, utilities,
emergency response, agriculture, forestry, public safety, transportation, machine control for
construction, environmental, and scientific research.

RTS — Robotic Total Station. This equipment utilizes the same software as the GPS rovers but
does not rely on satellites for locations. RTS equipment localizes to a project area by calibrating
using control points set by traditional survey techniques.
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12.11 Benefits

Construction operations which may produce the greatest productivity gains by the use of EED

are for material excavation or placement. Construction items which optimize the efficiency and
accuracy of AMG are earth excavation, fill and subbase courses. These items are all volume
measured and their quantities can directly be calculated from the terrain models for the existing
surface, the finished grade surface, and the top of subgrade surface.
Other construction installations which would benefit most from providing EED for stakeout and
inspection verification are bridge substructures, public and private utilities, curbing, sidewalks,
commercial driveways, signs, lighting & signal posts, and pile driving. Bridge superstructure and
substructure layout could be modernized to provide contractors with 2D or 3D spatial
descriptions (features) of all structural elements and critical control lines. This information
could be used by AMG for the excavation of the footings, backfills up to finished grades, by pile
drivers to position proposed pile locations, by carpenters to automate the layout and building of
concrete forms, by steel workers to automate the positioning of steel supports and for installing
of reinforcement, and by DOT Inspectors to verify the correct spatial locations.
Projects which do not contain 3D DTMs can also benefit from using supplied EED. Sign or
guiderail replacements, or pavement striping contracts could benefit from locations derived by
GIS approximated or GPS field measured 2D coordinates for positional locations. Using
geospatially described locations (coordinates) or station-offsets provided by alignment files
instead of record plan scaled stations and offsets will provide more clearly defined designer
intent as to the location of the items.
General:

e Greater ease of design implementation at time of construction.

e Enhanced quality of constructed facilities.

e Greatly reduces the need for construction staking which in turn reduces survey costs

e Contractor and agency labor savings when measuring and documenting as-built

guantities and pay-quantity management.

e Increased accuracy and data intelligence going into design.

e Enhanced visualization capabilities during the design process.

e Identify clashes and constructability issues prior to construction.

e Greater accuracy for quantity computations

Construction:

e Points or alignments of features can be used by Contractors to locate items in the field
by using Total Stations or GPS/RTK survey equipment (available in CT).

e Breaklines, features and other alignments included with digital terrain models (DTMs)
are used by Contractors for Automated Machine Guidance (AMG) operations. Use of
GPS for AMG allows for the most efficient operation of earthwork machinery, less
operator time is required for construction, idle time and rework.

e Uniform compaction

e Check constructability

e Track stage construction

o Improved Safety for the inspectors and contractor personnel

e Equipment resource savings

Issued April 2020 275 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

- Machine idle time can be reduced when there is less waiting for excavation and
embankment staking and clarifications.

- Finish grading iterations are lessened or nullified because of GPS accuracy,
therefore resulting in a reduction of machine hours.

Earthwork construction tasks are shortened because:

- Contractors can mobilize to the site and begin work without waiting for
surveyors to position grade stakes for the initial lifts.

- Checking grades and rechecking spot locations immediately versus calling and
scheduling a survey crew.

- Time saved in layout and grade checking can be devoted to machine movement
and cycle time efficiency.

- Reduction in rework - Jobsite grade and location errors are more easily spotted
and corrected with GPS technology than with reliance upon 2 dimensional
drawings and surveyor‘s grade stakes.

- Construction field managers can make decisions more quickly and accurately
because position and grade information is provided in real time.

Construction Inspection:

Accurate quantity take off for pay-items (point locations, areas, volumes)
Pay-items are easily tracked

A single person can locate and document exact x,y,z positions providing real-time
verification of an item being inspected or a point location being disputed.
Reduction of conflict resolution time.

Electronic as-built data can be produced and easily incorporated on the electronic
contract plans either during construction (“live” as-builts) or post construction.
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Section 13 Project Location (Geo-Spatial
Boundary or Route ID and Mileage)

A Project Polygon (geo-spatial boundary) shall be submitted to ProjectWise at project
milestones of DA (Design Approval) and DCD (Design Completion Date) by the lead designer and
at Construction Completion by the Inspector. The Design Approval submission will replace a
cursory project polygon created at project development by the project sponsor. The DCD
submission will replace the Design Approval submission at DCD. The construction Completion
submission is required if the DCD polygon does not reflect the project’s completed limits. The
inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if
required at construction completion.

The Project Polygons will be used in the Department’s Project Web-GIS feature layer to identify
spatial location, each section of State and Local Roads contained within the boundary for FHWA
FMIS reporting, and future CIM (Civil Integrated Management) of roadway assets. The Project
Polygon will also aid in the ROW (Right of Way) Web-GIS mapping process. The Design Approval
Polygon shall not be public facing on any CTDOT Web-GIS mapping.

13.1Project Polygon Requirements

Capital Projects that include Location Survey

Note: If a project has multiple sites, a project polygon file shall be created for each site.

Project Polygon Milestone Deliveries:

e DA (Design Approval):
o The Project Polygon shall include the entire project extents per site and include

all existing and proposed ROW boundaries and portions of local affected roads.
The polygon shall be drawn up to and following the ROW lines, then it shall
cross the roads at the project limits. The following figure shows a Design
Approval Polygon. Note: The Polygon does not include slope limits.

\\ @ L

DA Polygon drawn:to
Existing ROW.Line or

)
]

13'- CUT B
17'- CUT B
BITUMINOU
372'- CUT |
APPROXIMA
5 CONCRET.
SIDEWALK

BITUMINOU

proposed ROW Lines Eﬁ\
Bt

*+Ire

Figure 338 - Design Approval Project Polygon
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e DCD (Design Completion Date):

o The Project Polygon shall include the entire project extents per site and include
all ROW boundaries and portions of local affected roads. The polygon shall be
drawn up to and following the right of way lines. When Rights and/or Defined
Easements extend beyond the ROW, these lines shall be followed. The polygon
shall cross the roads at the project limits.

| [ Swrewnen nmne 'f/ [ [
/ I ,///‘ /
[

| Project Limits | ,/ / Include Temporary
on Local Roads | / Work Areas
r/ /J // /
f /+/ l/
T e A B
EaENEANanEnl
e
------- | 52400 53
50400

Slope limits inside of ‘ Slope limits outside of
the ROW, draw to the the ROW, draw to the
ROW line slope limits

Figure 339 - DCD Project Polygon

e Construction Completion:
o The inspector shall obtain the DCD polygon and modify the limits to represent
as-built conditions if required at construction completion. See Section 8.3.7 for
more detail.

Capital Projects without Location Survey
This type of project could involve, but not limited to the following:
e Guard rail replacement

e Rumble Strips

e Barrier replacement

e Pavement rehabilitation
e lllumination

e Signing

The project limits will be identified By Route ID and Mileage. AEC Applications will get the route
and mileage from the project’s Design Report. Note: An option to get authoritative mileages for
the Design Report can be to reference in a WMS (web mapping service) into Microstation. See
section 13.4 for instructions.
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13.2Creating a Project Polygon for Projects with
Location Survey

The following steps explain how to create and submit the Project Polygon file(s). If the project
consists of multiple “sites,” a separate file shall be created for each polygon.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be
referenced. This can usually be found within the ground survey file title block. If there
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. InHouse CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT
seed file located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

Note: If your project is NAD 27 FT still use the 83FT seed.

@ Select Seed File - \\sh3dgs18\CTDOT V8 Warkspaces\Workspace\Standards\seed\G guspatram)

Lock in: Geospatial o mr
- Name Date modified Type Size
e 52D _Poly 27FT.dgn T/17/20141253 P Bentley MicroStati... 31 kB
Recentblece: 7/17/20141:10PM  Bentley MicroStati... 3L KB

?)
!

/2D Poly 27M.dan
= /42D _Poly 83FT dgn /26/20141250 PM  Bentley MicroStati... 87KB
730 _Poly 83M.agn T/AT/20141:03PM  Bentley MicroStati... B
Desktop
="
Libraries
LY
Computer
.
A

Network

Fie name: CT_Design_30_V&i.dgn -

Fies of type: MicroStation DGN Fies " don) <) [ Cenedl |

Figure 340 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D _Poly 83FT Seed File
3. Reference the Highway Design file into the newly created file using true scale off and

1:1 )
] References (1 of 1 unique, 1 displayed) o] @ |3
Tools  Settings
= - ] s o] D] B20[R0] 83 2] B38| @ ol ede] (Bowndres <)
Slst ¥ |4 File Name Model Description Logical QOrientation Presentatior
1 HW_HWY_012... Design Desian Design Coincident Wireframe
Il [ 3

Scale | 1.000000 : | 1.0D0000 Rotation §00°00°00" Offeet X | 0.000 Y | 0L

Elle '_:.l 1‘|EJJ’EE’_J|EQJ Mested Mtachments: Display Ovenides: | Allow

-

Figure 341 — MicroStation reference file settings
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4. Verify that the tentative coordinates of this file match the referenced design (using
stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match and
you can proceed to step 5. If they do not match check that the scale of the reference is
1:1.

If the coordinates still do not match, the project is probably in NAD 27 FT and the
reference files will have to be moved so the coordinates are correct. To move the
reference file do the following:

a. Select Reference File.

b. Select Move Reference:

1| References (1 of 1 unique, 1 displayed) E\ (=] @

Tools  Settings
.E - ¢ﬁ| 134 Y‘ \)|( | [ |ﬁ _’Q| J|jj l\j‘ x'j|H|Ine Mode: [Boundaries
St ¥ [ File Name Model 1\'-1----"'Descnpmn Logical Qrientation Presentatior
1 HW_HWY_012... Design Design Design Coincident Wireframe
1 m b
Scale | 1.000000 © | 1.000000 Rotation | 00°0D0°00" Offset X | 0.000 Y 0C

’_rr?-'t' 11 IIJJFJFJ’_JJ Mested Attachmerts: Mo Mesting ™ Nesting Display Ovemides: | Alloy
MNew Level Display: Corrhg Variable ¥ | Georsferenced: |No

Figure 342 - Move Reference

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box
key in XY=0,0 and click Enter.

e |

Highway

't Key-in — Ref s (1 of 1 unique, 1 display:
F— Key_ln XY_0,0 and @ [Ey erencTe (1 of 1 unique, 1 display
[or =004 Izl Tools Settings
= hit enter = | i ad e | g«
Property '5 = St ¥ [y File Name Mad
Structurd. [+ i ‘ 1 HW_HWY 012 Desi
Location| |accldaw
accfznap & Al -
Traffic
“J Drawing
& Drawing
& Terrain 1
Scale | 1.000000 2| 1.00
BRIy @i < [ e
New Level Display: |Config Viariable ~
-I—'ITasks ” % Projgct Explorer I
3 - © ~| ' ~[& naD83FT views ~] 1|2]3]|slsl7]el i X[ 215722 Y|[1582427
@e Reference > Enter point to move from j Reference attached

Figure 343 - Key In
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| ALIIUSS v

d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the
Key-In Box key in DL=400124.9,500038.9.

-

“! Highway Operations v
High“?"a?’ g kerin &2 O} References (1 of 1 unique, 1 dit
Landscay EE ~ ﬁi‘ el y‘ I
Property IS * : I I = |4 File Name
structurg [ ) KGY'I n HW_HWY_012...
e et | DL=400124.9,500038.9
Traffi -
= Then Hit Enter
4 Drawing '
4 Drawing
An Terrain ‘
Scale | 1.000000 :
7= bal g |
Mew Level Display: Config Variable
—l_"lTask5 " % Project Expforer J A
|\~ ~[=Y NAD 83 FT Views ~ y 1|2)2]4]5le]7]8l i X[ 2157263 Y[ 1582233

@ve Reference > Enter point to move to ) Reference attached

Figure 344 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing,

grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”")

6. Then place a closed polygon(s) using the shape tool or the smart line tool.

7. Then turn on the fill on the polygon.

8. After the polygon has been placed, turn off all reference displays and fit the polygon to
the view.

9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml
file to Google Earth.
Do this by choosing: File> Export> Google Earth.

10. Google Earth should then automatically open and zoom to the Project Polygon(s)

vicinity.
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13.3 Project Polygon File(s) Submission

The Project Polygon file(s) shall then be uploaded into ProjectWise in accordance with the
following:
Note: If a project has multiple sites, a project polygon file shall be created for each site.
1.
2.

Log into ProjectWise

Browse to your project’s 170_ROW and GIS Files folder. If this folder does not exist

under the project email DOT.AECApplications@ct.gov

Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface
Drag and drop the file into ProjectWise and use the Advanced Wizard.

Continue to click Next in the Advance Wizard until you get to the Attributes screen and

assign the attributes.

Click Next until the file uploads.

After the files have been uploaded into ProjectWise email

DOT.AECApplications@ct.gov

0010131

+ [ 00320148
o 0% 00320149

o ¥ 3327
[ o033-0128
1% 00332
0 230130
I 0330131

% 0330132

100_Contract_Plans (POF)
110_Contract_Documents

130 Contracter_Submittals (PDF)
130_Finald_Engineering_Reports
13_Engineerng_Reports_Confidentasl
140_Project_Administration
141_Project_Administration_Confidential
142_Project Adminstration Cormespondence
150 Quantity Calculstions

151_Finad Design Caleulations

170_RMW andd GIS Files

TR YT EET

=

U _Censtructen

M) FHWA

13 Contract_Administration
240_Contract_Development
M1_Contract_Derelapment_Confidential
310_Milestane_Subrassiond
320_Perenat_Developrent

330 Desagn_Data

500 _Siarvey

500 _Piaject Initatson Documents

o Y Seved Searches
i (226 0034-0305

&

£ L=t [ Spotal)

il -J-.n.IJIL].uu Dk J;

# | DA Boundary
#TRDA Boundary
o & | FOP Boundary
AIBIFor Boundery

Description

Figure 345 — ProjectWise project polygon folder example
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13.4Project Route ID and Mileage for Projects
without Location Survey

The following steps show how to get the route ID and Mileage for a project from within.
1. InHouse CTDOT Users: Create a new MicroStation design file using the 2D_Poly_ 83FT
seed file located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

@ Select Seed File - \\sh3dgs18\CTDOT V8 Warkspaces\Workspace\Stan dards\se:d\G:ospaﬁaV\)

Lockin: || Geospatial © ¥ @
- Name Date modified Type Size
=P B20_Poly 27FT dgn 7/17/2014 1259 P Bentley MicroStati... 31 kB
RecentPlace-lY 3 J 7/17/20141:10PM  Bentley MicroStati... 31 KB

2120 Poly 27M.dgn
! 2D_Poly _83FT.dgn 8/26/2014 1251 PM  Bentley MicroStati... 87 KB

2D_Poly_82M.dgn 7/17/2014 1:03 PM Bentley MicroStati... 31KB

: g

%

Desktop
=l
Libraries
LY
Computer
g
79

MNetwork

File name: CT_Design_30_V&i.dgn -

Files of type: MicroStation DGN Files (*.dan) - [ Cancel |

Figure 346 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D Poly 83FT Seed File

2. Next go the raster manager and navigate to File>Attach>WMS

“| Raster Manager : 0 of 0 listed

File | Edit View Display Seftings Utilities
New ol ] 8 0] 3] a0 B
Attach » ‘& Raster o ;. B Model
Detach 5[ wWMs.. escription odel ‘I
Detach All 3 FromImage Server...
Reload % ECWP Image Server..
Save As & Bing Maps.
Import 3
Batch Convert
PR v | 1]2]3]4]s|e|7]s] 2l @l &&= Tne O transparency: W

Figure 347 - Attaching the WMS
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3. The attach file dialogue should appear. In-House Designers Browse to W:\XWMS and
select the Interstate Milepoints and the Non-Interstate Milepoints layer. Note this will
have to be done one at a time. Then click Attach in the Raster Attachment Options
Dialogue. Consultant Designers the WMS files can be found here: XWMS Files

Look in: XWMS - O F @~ 5]
: Name - Date madified T, Preview Attachment

-~ Bing Aerialxswms 12/28/2016 2:47 PM X PESET FIETEL

Recent Places Bing Road.xwms 12/28/2016 2:47 PM X
! Interstate Milepointsxwms 12/28/2016 3:47 PM X
Interstates & State Routesxwms 12/28/2016 3:47 PM X
Desktop Non-Interstate Milepointsxwms 12/28/2016 3:47 PM X
LiI;ra.r!ies
A
Computer
£ 16384 X 11850, RGB Alpha
m Origin X: 729443.706
¥: 558544.268
Metwork
4 1L 3
File name: Interstate Milepaints xwms -
Files oftype Web Map Server [ *xwms ] v] [ Cancel J

.
I Raster Attachment Option i=h

S Atachments|

Lo WAXWMS\Bing Roadxwms

Figure 348 - Attaching WMS

General

Level
Color
Line Style
Weight
Class
Priority

Image

Logical Name
Description

Geometry

Geo Priority
Inherit GeoCS from Model
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Brightness
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Do Not Invert Display
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Figure 349 - Attaching WMS
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4. You will need to zoom in to see the Route Numbers and Milepoints.

e
Caﬁ\to\ P

Figure 350 - Route and Mileage
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Section 14 Project Information Management
— Under Development

This section details how project locations, project assets, project asset work codes, and other
project information is managed throughout the life cycle of the project. The project location
and the assignment of assets to a project are managed in ATLAS. The project asset work codes
and other project information is in managed in the Composite Project Database (CPD).

The first section goes over the Proposed Project Information process (PPI), which includes
locating the proposed project, filling out the PPl form, and how a proposed project container in
ProjectWise is created.

The second section goes over how to manage the project location and project information after
the proposed project receives is recommended project number.

14.1 Digital Proposed Project Information Process

PPI Project Location and Asset Selection

The following details how to locate a proposed project and select the applicable assets on the
project using ATLAS.
1. Go tothe ATLAS webpage - http://ec2-54-175-159-39.compute-
1.amazonaws.com/atlas/
2. Then at the top right of the screen click Login and enter your email and password. If
this is your first time logging in, select “Click here to sign up”.

=8 R |
T 2 e

Build 1.1.6730.10610 6/5/2018 [3628]
WIN-JDLKBR2HNJS (local) Atlas

Login

Not registered? Cli€k here to sign up.

"\A
®)

Password lnoooooooooo ol
[] Remember Me ' Cancel

Email | mathew.calkins@ct.gov |

iy o N <3 L RN : .
4 . A-.“" e ‘ g ?.' j 81+ S

Figure 351 - Logging into ATLAS

3. Next navigate to the area on the map where the proposed project is located.

Issued April 2020 286 Version 5.01


http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/
http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/

Connecticut Department of Transportation — Digital Project Development Manual

4. Then click on Asset Maintenance and select Add/Edit Construction Project Work Area.

-ompute-1.amazonaws.com/atlas/ P~ || & cTatas

Figure 352 - Locating a Proposed Project

5. Thenin the Town dropdown, select Use Work Area and click next.

< ;e\ @ http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/ pL-c H ]
File Edit View Favorites Tools Help

3 & Prudential Retirement (5} CTDOT ROW Map Viewer [ Project Documents - Al D... &] hitp--www.ctgov-dot-lib... &) https--ctdot-a

- Statewide
gl it S - District 1
——————{172 - District 2
Jump To: 173 - District 3
174 - District 4

Catalog | [Btart[Use Work Area

= Back to Sett{ Angover
| Ansonia
projAshiord
New PP: Specify t AVON 2
new proposed projd Barkhamsted i be
assigned when the| Beacon Falls
Town |Berlin
Existing PP: If aad BEtNANY a
previously-defined | Bethel 9
proposed project n§ Bethiehem
P Number | Bloomfield

Bolton

Bozrah
New Project: To ¢{ Bridgeport

aciive, identiy exis| Bridgewater
supply project num|

Bristol
Project Number

Existing Project: I| Brooklyn an
active project, seled Burlington v
Project Numper |Canaan

Figure 353 - Locating a Proposed Project
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6. Next pick how to locate the project in accordance with the following and click Next:

e By Administrative Area — District or Statewide Projects. Stop Sign
replacements, warning sign replacements, etc.

e Related to bridge(s) and/or signal(s) — Bridge joint or bearing projects affecting
multiple bridges or traffic signal head upgrades affecting multiple signal
locations, etc.

e ['ll draw a polygon — Intersection improvement projects, bridge replacement
projects, roadway improvement projects, etc. These projects could be at
multiple locations.

In the example below a polygon is going to be drawn for the proposed project.

U T

-

Cataleg  Define Project Work Area
= Back to Settings

Mext Proposed Project Number (PP) will be assigned
for town 093 when area is saved.

How do you want to specify the location?

:_ By Administrative area

':::' Hy Town(s)

[ P' iCk the :_,' Helated to bridge(s) and/or signal(s)
approprlate ® draw a polygon
select and
) I upload a KML file
click Next

\, ':;:' III specify a route and milepoints

Figure 354 - Locating a Proposed Project
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7. Then draw a polygon for the proposed project by left clicking. To close the polygon
double click when you are on your last point. If the polygon needs to be adjusted you
can redraw the polygon before you click GO.

This polygon should be drawn close to the State ROW line. Use engineering judgement
for where you think the ROW line is. Future enhancements to ATLAS will have all the
state ROW lines on a layer.

Figure 355 - Locating a Proposed Project
8. Then click Go.

le =2 U 0 QAR =L30¢v AL»~&0
Jump To:
| =]

Available Tools:

(") Navigate

(® Draw Polygon
(") Select a Drawing

Click and draw to define a new work area. Double-

click to complete the poly
| X Close |

Figure 356 - Locating a Proposed Project
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9. When the polygon is drawn ATLAS will return any road segments and any assets that
are located within that polygon. On the next screen deselect or select the applicable
road segments and assets, then click next. By default the local roads are not selected.

E 3 19 - '

Jump To: b ; AN .' - :‘

! E3

| Catalog  Define Project Work Area @ .
' «=Back to Seftings

Select Roads to Include

I'US / Interstate Roadway Sections

oute Starting Ending
5N 74794 74956
5-S 74795 T74.964
76-N 0.000 0076
N 27.204 27.366

Local Roadway Sections
Road Name Starting Ending

B83) GRISWOLDVILLE AV 0000 0.060
83) LOUIS ST 0476 0510
Select Signals to Include
'93-229
Caned |

Figure 357 - Locating a Proposed Project

10. Then on the next screen click Go.
Jump To:

| =] j
Catalog | Define Project Work Area &

| = Back 1o Settings |

Review and Save

Mext Prop Project will be assigned for
town 082 when area is saved.

& work area pelygon will be defined for the polygon
you drew.

Selected Route and Road sections will be saved as
project road segments.

Route/Road Name Starting  Ending
15-M 74754 74.956
15-3 74785 T4.564
176-M 0.000 0.076
5-N 27.204 27.366
{93) GRISWOLDVILLE AV 0.000 0.0&0
{83) LOUIS 5T 0476 0.510

Selected signals will be saved as project assets.
093-229

The project "Signal Mumbers" attribute will be
updated with this list of signals.

Figure 358 - Locating a Proposed Project
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11. On the next screen you will see the proposed project number that ATLAS assigned to
the project and list of assets and road segments included in this project. Then click

Done.
Jump To:
| 2
Catalog = Define Project Work Area &
= Back to Settings
I Proposed project number PP0OS3-0011 assignedl
Work ares palygon saved for your drawn section.
Signal Control Area list zet for Project:
Proposed e
. Route/Road Name Starting Ending
P rOJ ect num be r (93) GRISWOLDVILLE &Y 0.000  D0.06D
(93)LOUIS 5T 0.476 0.510
15-M 74784 74858
15-5 74785 74884
1TE-M 0.000 0.076
S-M 27.204  27.385

Saved 4 route and 2 local road sections for project
PPOS93-0011.

Figure 359 - Locating a Proposed Project

Editing PPI Project Location and Assets
The following details how to edit the location or Assets of a Proposed Project.
1. Go tothe ATLAS webpage - http://ec2-54-175-159-39.compute-
1.amazonaws.com/atlas/
2. Then at the top right of the screen click Login and enter your email and password.

Build 1.1.6730.10610 6/5/2
WIN-JDLK3R2HNJS
Login

Not registered? here to sign up.
Email |maﬂ1ew.calldns@ctgov

.rdl

Figure 360 - Logging into ATLAS
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3. Then turn on the Proposed Project Local Work Area layer as shown below.
A/ Interstate
A7 Route
Local Roads
e
A/ Local Road
[ Route Milepoints
| Local Road Milepoints
|| Roadway Assets
Bridges
Traffic Signal Control Areas
| Rumble Strips
|- Project Information
=] &%Prgjecis_

Local Work Areas (Polygons)

(]

eee ee

(]

In for Signature
B3 Submitted to Capital Programming
=2 Undefined
|| State/District Work Areas (Polygons) (@
[ Active Capital Projects
[ TLRS Road Sections
| I Local Work Areas (Polygons) ®
|| State/District Work Areas (Polygons) (i)
[ /VIP (Maintenance Resurfacing)
[ ROW
|- Investigations
|- Administrative Areas

Figure 361 - Proposed Project Layer

4. Next navigate to the area on the map where the proposed project is located.
5. Then select the Identify tool.

CT Atlas

The Connecticut Asset Tracking & Location System

1mp To:

Zatalog
7 Drawing and Markup
)oiBEEOU

1 Road Network
CT/US/ Interstate Routes
@
A/ Interstate
A7 Route
Local Roads

)
A7 Local Road
[ Route Milepoints

Figure 362 - Proposed Project Location

6. Then draw a rectangle that includes part of the project.
[T B M\ Wi

Figure 363 - Proposed Project Location

7. On the next screen choose the applicable option.
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e To add or remove a road segment or asset select “Roads and Assets”

Catalog  Identify
= Back to Settings

Detailed information for the area you clicked on the
map..

Project PP093-0011 (ID 8153)
Work Area: 3312
Phase: Undefined
Title:

Lead
Engineer:

Project
Manager:

Bridges:
Signal
Intersections:
Sign
Structures:

Buildings:

Roads and Assets IZoom-To Area} Redraw Area

KML Edit Area Delete Area CPD

State/U S/interstate Roadway Sections

Route Starting Ending /
18-N 74807 74829
5-N 27.217 27.239

Figure 364 - Editing a Proposed Project Location

If the polygon needs to be extended or shortened select “Redraw Area”
Jump To:

8. Based on what was selected in step 7, either select or deselect the assets or redraw the
polygon. Then click through the screens until the project location is updated.

Proposed Project Information Form

After a proposed project has been located a Proposed Project Information Form (PPI) will
automatically be created in CPD. This section shows how to fill out this form and submit for
review and approval. If you do not know the proposed project number follow section 14.1.2
and when you get to step 7 click on the CPD link. This will automatically get you to that project

in the CPD.

1. Go tothe CPD Website: http://dot-sdcdts303v/PW CompositeData/MainMenu.aspx
2. Then click on Proposed Project Information.
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PYUSILY L LVjVLL L AU, LVEKLLL VAV,

Version: Production

Your Windows Username: CalkinsMJ

‘ Data View Form

\
‘ Project Asset Form ‘
‘ Manage My Projects Lists ‘
\ \

Export to XML or CSV

Environmental Site Tracking

| ‘ Proposed Project Information ‘ |

‘ Data Import Log ‘

‘ Edit Users ‘

‘ TED Interface Adminisiration ‘

‘ Developers’ Form ‘

Figure 365 - Proposed Project Information
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3. Select the PPl number that needs to be updated.

System Status: |

Instructions; Enter proposed project attribute Information in the areas Indicated beiow. ThiS Information will be used for prelminary SCOpe re!
Administrator for consideration priar to preparing the Recommended Project Memorandum (RPM) for formal approval. If you have questions i

Non-Promoted PPI's v/

Select Proposed Project 1D:

Refresh Filter:

Figure 366 - Updating a PPl Form

4. Nextfill in any of the fields in the form and click the save project data button.

Proposed Project Information

Update PPI Location and Assets from ATLAS |

| Save Project Data

ATLAS Main Menu

ition will be used for preliminary scope review and priority determination as well as completing a funding eligibility determination. This completed form should be submitted

norandum (RPM) for formal approval. If you have questions about completing this form, please contact Jennifer Trio (x2901) or Bob Barrio (x2983)

n-Promoted PPI's v

:d Project Number: (none)

_ v
M

Figure 367 - Saving Project Data

When this button is clicked a ProjectWise project container will be created under the 01.2 —

Projects — Proposed area in ProjectWise. This will take about 5 minutes to show up in

ProjectWise. This folder will be used to store any document during the proposed project phase
of the project. This folder is also where the completed PPl form will uploaded for signature.

ProjectWise Explorer Datasources
2y CTDOT (mathew.calkins@ct.gov)
E|1__ Documents

- 010 - Projects - Active
-, 011 - Projects - Legacy
o
[ PP0O0L-0011

(- PPO0L-0012
[-{7* PPD02-0004
[-{" PP0O07-0002
- PP0O10-0001
[ PP0O11-0004
[-{% PP0O11-0005
- PP0O11-0006
[-{" PP0O11-0008
- PP0O11-0009
([ PP0O11-0010
- PP0O12-0001
&-{% PP0O12-0003
[-{" PP0O15-0017
- PP020-0003
[-{ PP0O27-0009
- PP0O28-0002
[ PP0O28-0004
[-{ PP0O34-0003
- PPO34-0004

IE

m

List | @ Spatial

MName

/1% PP0O01-0012
% pP001-0011
/1% PP164-0005
/1% PP164-0004
% pp146-0011
/1% PP0a2-0030
/(1% PP158-0007
% PP037-0003
/1% pp148-0006
/1% PP164-0003
% PP011-0010
/1% pp0a2-0031
/1™ PP0&3-0010
[ pp151-0012
/% pp151-0011
1% Pp015-0017
o/ [[¥PP1a5-0010
/1™ PP035-0003
/1% pp131-0010
o [[* PP094-0006

71" ppo76-0006
< |

Figure 368 - Proposed Project Area in ProjectWise

5. The following steps show how to complete the PPl form for capital planning. Note: If
an asset needs to be added or removed this must be done in ATLAS. Go to ATLAS by

clicking on the ATLAS Link.
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Update PPI Location and Asseis from ATLAS Save Project Data | |ATLAS |Mam Menu

minary scope review and priority determination as well as completing a funding eligibility determination. This completed form should be submitted to the Engineering
have questions about completing this form, please contact Jennifer Trio (x2901) or Bob Barrio (x2983).

]

none)

Lead Engineer:

l:l Email | ‘ Employee ID ’7
l:l Email | ‘ Employee ID ’7
] Emai: | | EmployesD: [
1
Figure 369 - Updating Assets for a PPIF
6.  Firstfill out the General Information.
Select Proposed Project ID: Refresh Filter. Updale PRI L ocafian and Assq
PPI Current Phase: \Development V\ Recommended Project Number: (none)
General Info:
DOT Improvement Type* I v]
FHWA Improvement Type™ ‘ V\
Transportation Mode™
Adds Capacity™
Project Dev Manager* I v Phone: | | Email [ |
Project Dev Engineer* I v Phone: | | Email [ |
Project Manager I v Phone: | | Email [ |
\ \ |
\

Title™

Description™

Justification™

Figure 370 - PPl Form General Area

7. Then fill out the Environmental Classification, Cost Estimate Information, Schedule
Information, and add any comments.

Environmental:

Environmental Classification® \ Unknown/Undetermined hd |

Cost Estimate:

PE(PD) - Preliminary

Phase: Design PE(FD) - Final Design Right-of-Way Cost Construction Cost Total
Estimate: | | [ | [ | \ | \ 0.00
Schedule:
PE(PD) - Begin PE(FD) - Begin Final Begin Right-of Way Anticipated # of
Phase: PreliminaryDesign Design Phase Anticipated FDP Construction Seasons
Date: | | | |

*Wednesdays Only
Comments: (Notes to Capital Programming)

Figure 371 - PPl Form

8. Then verify the proposed road section information. If information needs to be edited,
click on Select and edit the information.
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Proposed Road Sections:

Route/Road  StatefLocal s':': . :::1 Miles ADT Interstate :I‘::; NHS Towns MPO coG Urban Area
Select gﬁ'SWOLDV'LLE Local 0 006 |006 [6700 |N 5 N |Newington |Capital Region |Capital Region :ferg‘"d’ CT Urbanized
Select |LOUIS ST Local 0476 (051 0.034 N 7 N |Newington |Capital Region |Capital Region :ferg‘"d’ CT Urbanized
Select [15-N State 74794 |74.956 [0.162 |35100|N 3 Y  |Newington |Capital Region |Capital Region :ferg‘"d’ CT Urbanized
Select [15-5 State 74795 |74.984 |0.169 |16800|N 3 Y |Newington  Capital Region |Capital Region :f’erg‘"d’ CT Urbanized

]
Select 176-N

Hartford, CT Urbanized

Newington Area

Capital Region

Select |5-N ‘State ‘27.204 ‘27.366 ‘0.162‘ ‘N ‘ ‘N Capital Region

Figure 372 - PPl Form Road Section Area

9. Then fill out the Asset information. Select if there is a pavement treatment and enter
any bridge work codes if there is a bridge on the project by clicking on Select next to
the bridge.

Assets
Pavement Treatment:

Bridge Assets:

Capital Project History

Completed Active

Bridge Length| Suff. |Struct. Func. Work | Work Wk. - ECC Wk. Wk
No. | MBI Cubvert = . Rtg. | Def. |Obsol. Type | Codes = EELED o mr - Date Type Codes

Select|05309 |Yes [No | 127 937[No  |No | \ \ \ \ \

Traffic Signal Assets:
No Signals were found.

Sign Structures:
No Signs were found.
Figure 373 - PPl Form Asset Area

10. After the form is completed print the form to PDF. First click on the printer and then
print.

4 =8 =R
a@\@ hittp://dot-sdedts303v/PW_CompositeDsta/PPL/ProposedPro) : o-T oA
File Edit View Favorites Tools Help L 4
Ny " T — 7 »
5 (6] CTDOT ROW Map Viewer &7 Development Composite .. £ eB [ How to Build an Advance.. &' a Benefit Soluti ( [ IR v [ | v||Page v Safety v Toolsv @+
£ \L &= Pprint... ] "
B Print preview...
| b
p |4 Pagesetup..
€
System Status: ’
y ate PPI Location and Assets from ATLAS ‘ | Save Project Data ATLAS Main Menu
Instructions: Enter proposed project attribute information in the areas indicated below. This mfnnv? *q eligibility determination. This completed form should be submitted to the Engineering Administrator for
consideration prior to preparing the Recommended Project Memorandum (RPM) for formal appr
Select Proposed Project ID: PP054-0002 ~v| Refresh Fitter:
PPI Current Phase: \ Development V\ Recomme:
General Info:
DQT Improvement Type: \ 104 - MAJOR INTERSECTION Ly

Figure 374 - Printing to PDF

11. Then select the Bluebeam Printer and click Print.

Issued April 2020 296 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

E%A Print @
General | Options
Select Printer
% Add Printer Z5DOT-MH

Adohe DOE OT-MH
| =0 Bluebeam PDF '@FOT-MH

1 0 +

Status: [ Prirt ta file
Location:
Comment:
Page Range
@ Al Number of copies: 1 =

Selection Curent Page
() Pages: 1 Collate
Erter either a single page number or a single lll 212 313
page range. For example, 5-12

[ P |} cancel |[ ety |

Figure 375 - Printing to PDF

12. Then save the file to your computer.
13. Next open the file and add the following four signature fields for approvals.

Comments:
T
PPI developed by: r | Manager Approval: [- | @I
Division Chief: r | Engineering Administrator: [- |
User ID Of Creator: |Washburn|'\.n'| Creation Date: |1 0/25/2017 4:45:00 PM
User ID Of Modifier: |WashburnM Last Modification Date: [11/1/2017 9:52:45 AM

Figure 376 - PPl Form Approval Area

14. Then upload the PPl form into the corresponding proposed project folder in
ProjectWise. Fill in the label and description attribute fields with PPl Form for the
label and a project description in the description field.

Q;‘ - q) - I_L < Address L_" pwih\ctdot projectwiseanline com: CTDOT\Documents\01.2 - Projects - Proposed\PPO12-0001% - DGU -
Lt PPO01-0012 4 Lst | @ Soatial|
" - G
LF PP0O02-0004 Label (User Defined) Description State

-[% PPO07-0002

-[1% PPOL0-0001

-[% PPO11-0004

-[% PPO11-0005

-[* PPOL1-0006 3
-{* PPOL1-0008

1% PRO11-0009 s

[ PPO11-0010

[ P

[ % PPO12-0003

,/ PPIForm Rotory Cenversion te Modern Reundabout

-[*% PPO15-0017
- 1% PP020-0003
- % PP027-0009
-[* PP028-0002
-[* PP028-0004
%% PPO34-0003
%% PPO34-0004
% PPO35-0003
7% ppna7-nnng

Figure 377 - PPl Form Upload

15. Next have the form digitally signed by the submitter, Principal Engineer, Manger, and
Engineering Administrator by sending a ProjectWise link to the PPI form.

Proposed Project Document Storage

All documents created during the proposed project stage shall be stored under that proposed
project’s container in ProjectWise in the 01.02 — Projects — Proposed area.
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L

Q:I - E:> - L’j - Address | pw:\\ctdot.projectwiseonline.com:CTDOT\Documents\01.2 - Projects - Prog

S-{)J ProjectWise Explorer Datasources - List

5-80@' C_TDDOD'EU(:Z;PL:W.CEIklns@ct.go\r] Name
"L; 01.0 - Projects - Active _/L_RPPU(]l -0012
e 11 Droiecke o 1eoo #1%pPo01-0011
IB‘: 012 - Peo |75 PP164-0005
T PPI0L /[ pp164-0004
J"L-R PPO0L-0012 /L.R PP146-0011
o[ PP002-0004 A5 PP092-0030
5-[1% PPOOT-0002 75 PP158-0007
H-[7% PPO10-0001 =| | % PP037-0003
o-[[% PPO11-0004 % PP148-0006
5-[[% PPO11-0005 [ pp164-0003
5-[[% PPO11-0006 % pPO11-0010
-2 PPO11-0008 A pp0gz-0031
o-{%% PPO11-0009 /[ PP083-0010
:|--1__?t PP011-0010 ./L.-H PP151-0012
3"1-: PPO12-0001 /[PP151-0011
(% PP012-0003 A2EppRo15-0017
| % pp165-0010

H-[™ PP020-0003

o-[[%% PP027-0009 1% pP035-0003

0.7 PPO28-0002 A% pP131-0010
0.[1% PP028-0004 /17 PP094-0006
0-[*F PP034-0003 % pPO76-0006
o-[[% PP034-0004 5 pp127-0002
5[ PP035-0003 /[ pP006-0006
- PPO37-0002 [ ppa79-0007
H-% PPO37-0003 15 PP028-0004
-7 PPO40-0003 #*pp0a3-0013
-7 PPO40-0004 [ pp0a3-0009

7" PP042-0012 [ pP0s3-0009
0 TR pPNAT-nnnT FrH nna T Aannn

[
[
[
[
=
=
=
=
=
[
[
[
- PPO15-0017
=
=
=
=
E
E
E
=
=
[
[
[
-

Figure 378 - Proposed Project Area in ProjectWise

After the proposed project moves through the Recommended Project Memorandum (RPM)
process and an official project number is assigned to that project, all the documents in the
proposed project area shall be moved to the 600_Project Initiation Documents folder under the

project container in the 01.0 — Projects — Active area in ProjectWise.
-7 0010-0088
=12 0010-0089
g ontract_Plans (PDF)
110_Contract_Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration
141_Project_Administration_Cenfidential
142 _Project Administration Correspondence
150_Quantity Calculations

151_Final Design Calculations

160_Project Photos

170_ROW and GIS Files

210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Milestone_Submissions

320_Permit_Development

330_Design_Data
500 Sun

600_Project Initation Documents |

aved >ea rcF es

AT

Figure 379 - Project Initiation Documents in ProjectWise

14.2 Project Asset Form (PAF) — Under Development

The project asset form (PAF) is used to manage project information after the RPM process
through construction. This form manages the following information:
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e Project Assets through the use of ATLAS

e Project Asset Work Codes

At RPM the Project Assets and Asset work codes will be transferred to the PAF from the

Proposed Project Information Form (PPIF).

The PAF is required to be continuously updated as changes happen through the duration of the

project.

The following details how to update the PAF.

1. Go tothe CPD Website: http://dot-sdcdts303v/PW CompositeData/MainMenu.aspx

2. Then click on the Project Asset Form Button:

PUDJLU e lUJ\.«UL A FClLCl. IVICLLLL IVINW

Version: Production

Your Windows Username: CalkinsMT

‘ Data View Form

Project Asset Form

‘ Manage My Projects Lisis
\ Export to XML or CSV

Environmental Site Tracking

Proposed Project Information

Data Import Log

TED Interface Administration

|
|
‘ Edit Users
|
|

Developers' Form

Figure 380 - Project Asset Form

3. Next pick the project that needs to be updated:

Update Project Location and Assets from A

V| | ‘Number 0fpr0jects:| EE |GU to Projec-t‘ \_

0077-0215
D077-0217

0l

0077-0223
0077-0224
0077-0225
0orr-0227
0077-0228
0077-0234
0077-0236

0077-0241
no7e noso

0078-0090

O075-0061
0078-0092
0078-0093
0078-0094
0078-0095
0079-0202
0079-0206
0079-0209
0079-0210
0079-0212

Figure 381 - Project Asset Form

4. Then update the Project Asset Area in accordance with the following:

e Updating Asset Works Codes: Click on Select next to the appropriate asset and

then fill in the work codes.
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Project Asset 1] ment (Selected Assels by Project 1] r):

Instructions for managing Asseits,
lork d 'S

Pavement Treatment:. Yes ¥
Bridge Assets:

Bridge Length Suff. Rg. ‘Struct. Func. | Work

No. | () Dt |Obsol | Tepa | VK Codes

Select 01155 280 668 Yes No RHB DF.G.QU.VNN
Select 01156 227 626 Yes No RHB DJFEGQUVNN

Traffic Signal Assets:
No Signals were found.
Sign Structures:

No Signs were found.

Figure 382 - Asset Work Codes

e Adding or Removing an Asset from the Project: Send an email to
DOT.AECApplications@ct.gov detailing the asset and if it is added or removed.

5. After the PAF has been updated click on the Save Project Data button at the top right
of the form.
orm
| Update Project Location and Assets from ATLAS | Save Project Data
ser of projects: @{Go to Project:il 0130-0180 ~
Figure 383 - Project Asset Form
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Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam

These steps only need to be completed the first time using Bluebeam or when the user logs into

a new computer.

R

Bluebeam

1. Open Bluebeam by selecting the desktop icon: e

2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on REVU in the top left hand corner and click Preferences as shown below. If you
cannot find the settings icon in the top right, go to the Edit menu and select

Preferences.

Revu ile Edit View Document Batch

About = % [:=-:=] @ 9]
Preferences  Ctri+K £

View Mode
Markup Mode
Profiles 3 l—' : SFD Plans*

Keyboard Shortcuts

Unreqgister

Exit

04.01.AM

FLANE
NI PROFILES

Figure 384 - Bluebeam Preferences
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4. Set the General options first.

General Options
Interface
User: | M.
Tools
Language:
Studio
Theme:
Window
Tab Truncation:
Sets

Import/Export

Advanced

Startup Mode:

Document

Navigation

Calkins AEC Applications

English (|
Dark

Start

Show Full-Screen Crosshair

Last Used

| Toggle Full Screen with View Mode

Grid & Snap

Spelling

Type in
Name
and Unit

Reopen Files from Last Session on Startup

Open Home Paae in Web Tab on Startup

/| Show Recent Files on Startup

Import Export

Help Bl
auto U

Reset Hidden Messages

Cancel

Figure 385 - General Options

5. Click on Interface and then File Access and make sure the box is checked as shown below: If
ProjectWise is not listed click the plus sign, click Load, enter your ProjectWise Username and

password and click OK.

General

Interface

e Items in Rel int
Studio
Window Recent history lir
Sets

Import/Export

Advanced

DMS Type
ProjectWise V10
SharePoint
SharePoint
SharePoint

SharePpip

Import Export

Ta |4244%

Markups List

/| Enable Recent Files
20
+| Show preview of PDF

90 Days Clear

Open and save files to DMS from toolbar only

+| Always Show S Dialog

/| Enable Batch Check-in when closi

SharePoint Options.

Location
ctdot.projectwiseonline. com:CTD(
https://ctgovdot.sharepoint.com/:
hitps://ctgovdot.sharepoint.com/|
hitps://ctgovdot-my.sharepoint.ca
https://ctgovdot.sharepoint.com/i

04.01.A01 (1 of 31)

Layers

ument Managemen

Type: | ProjectWise V10
Status
loggedin

ready

DataSource: | ctdotprojectwiseonline.com:CTDOT

Login Name: | PWONLINE\Mathew.Calkins

Password: | ses -e

ready

loggedin

ready Checkout on Open from Hy

links

Cancel

Cancel

@ 8-~ Q@

Figure 386 - ProjectWise Integration
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6. Next go to the Window option and select WebTab. Then uncheck the box below.
Preferences

General ¢ Tablet Presentation WebTab

Interface =lnr . o
/ 2r'U Acceleration

Tools .| Automatically Switch to New WebTabs upon Creation
Studio Open PDF Hyperlinks in WebTabs
Window tpen Web PDFs in

Show Script Errors

Use Standardized Favorites:

Import/Export U nc h ec k
this box

Advanced Edit Web Favorites...

Import Export Cancel

Figure 387 - Bluebeam Preferences

Downloading the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile

2. Double click on the profile in the zipped folder on your desktop.

(9 FER
$35.Q FER S 8

New Open Favoiites Add Extact  Delete Wiew CheckOut

Name, | Modified [ Size | Ratio | Packed | Path
;_i‘f‘ CTOOT As-Buiks Profile by ) T/B20129186M  BEFEE3  BEY  ZG0EI7

\

Double click on
this file

+ - Selected 1 file, 555 kB Total 1 file. 555 kB [245 kE] @@

Figure 388 - Importing the Bluebeam Tools

Bluebeam Stamps

The following steps are for CTDOT Engineering only.
1. Select Markup>Stamp>Change Stamp folder as shown below:
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Batch Tools

5 Q

window Help

Markun

o & <
Stamp > MJC_Watermark.pdf

! re
01-Addendum_and_Change_Order pdf
ch to Scale
i - Form 02-CTDOT Review Stamp.pdf
D Plans*

e s 02-CTDOT Submittal_Review.pdf

Hyperlink  Shift+H Greg Dorosh.pdf

File Attachment F
Toolbars

Reuse Superseded Stamp.pdf

Create Stamp...
Import Stamp...

LBRAITH
Change Stamp Folder...

GARY SCHNEIDER
DIRECTOR OF PUBLIC WORKS

TIMOTHY P. UMRYSZ
DIRECTOR OF PUBLIC WORKS

Figure 389 - Changing the Stamp Folder

2. Next browse out to this folder on the X: Drive and select your discipline
X:\V8_Admin\Bluebeam Resources

'?‘ Select Folder
@C/Q _ ) Browse out to this folderon
the X: Drive and select your _

Mew folder g== - (7]

Organize »

TR_BUS_C2_URS2_2007
TR_BUS_C2_URS3_2007
TR_BUS_C3_BAKER_2007
TR_BUS_C3_LOCH_2007
TR_BUS_C3_SEA_2007
TR_BUS_C3_URS_2007
TR_BUS_C4_LOCH_2007
TRAFFIC_NONPROJECTS
TRAFFIC_SIGNAL_PLANS
VE_Admin
J 999_TE1-2_Test
. 2008_AASHTO
. AASHTO
. Accident_Data
Airport
Archive_for_V8_Admin
Assignments
AutoCad
barmenu
BE_Awards
Bentley Conference
Bentley_Map
Bentley_Master_Agreement
BentleyTraining
Bidding Documents
Bluebeam Resources
Budget
Ruiraans Chisf

Folder: Bridges

Name

As-Built

Construction gfamps
. CTDOT Stamps

. Document Templatgs

. Facilities

. Highway Operations
. Highways

. Hydraulics

. Other Watermarks

. presentation

. Settings

. Traffic

. Watermarks-Initials

= discipline and then click

Select Folder

6/19/2015 8:58 AM  File folder
3/1/2016 2:58 PM File folder
10/20/201511:40 ... File folder
2/11/2014 8:01 AM  File folder
10/21/201511:46 ... File folder
11/4/2015 3:14 PM File folder
2/27/2015 2:47 PM File folder
3/12/2014 10:39 AM  File folder
3/16/2016 8:08 AM  File folder
1/23/2015 211 PM File folder
2/1/2016 1:03 PM File folder
2/27/2015 2:47 PM File folder
11/24/2014 810 AM  File folder

[ Select Folder I Cancel

Figure 390 - Changing the Stamp Folder

3. Now your unit’s stamps will be available for use when Markup>Stamps is selected:
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knt  Batch Tools window Help

i:j Ef O Markun 8:‘3 l—_lj E‘B ,69
Stamp > MJC_Watermark.pdf

IMeasure
01-Addendum_and_Change_Order pdf
Sketch to Scale
. . e 02-CTDOT Review Stamp.pdf
D Plans*

e 02-CTDOT Submittal_Review.pdf

Hyperlink  Shift+H Greg Dorosh.pdf

File Attachment F Legacy Project No.pdf

Toolbars Matt Vail pdf

—
[EUFERSEDE]

Reuse Superseded Stamp.pdf

Create Stamp...

Import Stamp...

e GALBRAITH
Change Stamp Folder... YOR
GARY SCHNEIDER TIMOTHY P. UMRYSZ
DIRECTOR OF PUBLIC WORKS DIRECTOR OF PUBLIC WORKS

Figure 391 - Changing the Stamp Folder
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Appendix B - Usability of PDF Documents

Usability of PDF Documents

This section contains information about viewing digital contract documents.

Structure of Digital Plans

Final Design Plans, Addendums, and Design Initiated Change Orders

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents
digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline
subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge
Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in ProjectWise. Below is an example
of a project’s discipline subsets in ProjectWise:

5 List | @ Genspatial

Label {User Defined) Description Main Category | Sub Category Sub Category Description Application

ra @ 01_General 01_General_revision.pdf CON FFL Plans_04 - Final Plans {adv) Acrobat FDF
7 @ 0Z_Revisions 02 _revisions _ce.pdf COM FPL Plans_04 - Final Plans (Adv) Acrobat PDF
ra @ 02 _Revisions_A0L 02 _Revisions_a01 CON ADF Plans_05 - Addenda Acrobat PDF
# B 03_Highway COM FPL Plans_04 - Final Plans {adv) Acrobat PDF
v @ 03_Highway_a01 03 _Highway _a01 rev COoN ADP Plans_05 - Addenda Acrobat PDF
ra @ 04_Traffic 04 _Traffic,pdf CON FFL Plans_04 - Final Plans {Adv) Acrobat FDF
7 @ 05-Landscape 05_Landscape revl.pdf COM FPL Plans_04 - Final Plans (Adv) Acrobat PDF
ra @ 06-Structures Bridge 02695 Structure Plans CON FFL Plans_04 - Final Plans {adv) Acrobat FDF
/' B CTDOT_HIGHWAY_STD ckdot_highway_std.pdf COM STD Plans_10 - Skandard Drawings Acrobat PDF
ra @ CTDOT_TRAFFIC_STD ctdat_traffic_std,pdf COoN STD Plans_10 - Standard Drawings Acrobat PDF

Figure 392 - Discipline Subsets in ProjectWise

As-Built’s
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

The PDF digital plans have the following functions when the digital contract plans are created in
accordance with this manual:

Turn levels on and off

Search for all text on the documents.

PDF plans are measurable
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Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier
viewing of the contract sheets. See below for turning levels on and off:

Revu File Edit View Document Batch Tools

@ B 3 B0 B Q ©

100% | lcon: [5] v
|:°1 - || Default

L—

] b B (3 [m

B

Il

[
=4
=y

®

FLANE
NI PROFI

[ SIGNIM

Figure 393 - Turning Levels On and Off
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Searching Digital Plans
The plans can be searched for any text located on them. This can be useful if searching for a
certain pay item.

See below for searching the PDF Plans for text.

Options

~|Search Pages
Search Filenames
ch File Properties
arch Form Fields
Search Markups
Case Sensitive

Whole Words Only

Figure 394 - Searching for Text in PDF Plans
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Measuring on the Digital Plans
The plans have the ability to be measured in PDF. This is helpful because a paper set does not
need to be created for on desk measuring.

See below for measuring in PDF.

Measurements

-« Scale

Calibrate

Recalculate

~  Measurements
Subject:
Label:
Depth:
Width:

Height:

er Tin=41t

Current
Length:

Perimefer

Figure 395 - Measuring Tool
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Digital Specification
The FDP specification package will be one PDF document and located in the

110_Contract_Special provisions folder. This package includes all special provisions, Notice to
Contractors, Wage information, etc.

The Addendum special provisions prepared in the same way as the FDP specification package
and will also be located in the 110_Contract Special provisions folder.

The Design Initiated Change Order special provisions will be contained in one PDF document
located in the 110_Contract Special provisions folder when they are released to the Contractor.

Some useful features on the digital specification package are:
e Search for any text in the document, see Searching Digital Plans
e Bookmarks for each section in the specification package
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R Row Fie  Eit Teaunent Forr B

B - q . 7.

Mewy Open Frint E-mail &l ] el Fen Line:

‘REwEES Bookmarks tab

an ‘ . CT_CON_FSL_0026-0118_Final Spes

TABLE OF CONTI

] Note: This Table of Co
] contract with the sole

herein; and no claims st
of Contents shall not be

B-4$ - !Tr s Summary -

Figure 396 - Bookmarks in the Spec. Package

Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay
Pages. Compare Documents will compare two documents and create a third document that
clouds all the changes. Overlay pages will create a third document where the pages of
document A will become one color and the pages of document be will become another color.
When the pages are overlaid you will be able to see the changes from the difference in these
two colors. Both of these tools can be used for single and multipage PDF documents. The
following shows how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to
compare from ProjectWise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

Issued April 2020 311 Version 5.01



Connecticut Department of Transportation — Digital Project Development Manual

Q {Covs  File Edit R Document Form Markup

vikw @-om- 4

Mews Open Frint E-mail Studio atures ages - ; _ ] OCR Script

RN wE S-SR ey ‘e on . EOKS™

a e
E..|E 5 4 - U.|.|.|.|1.|.I.|.E|.I.|.B.|.I|I

~ Hecents
| _CON_FDP__01-General pdf
@ _CON_DCD__ 01-General pdf
|7 R

Completion
it

By submitting thes farm it sgnifies 1
@ Portfoliol. pdf contract plans.
Figure 397 - Compare Documents

3. Inthe window that pops up you will notice the two documents that were just opened.
Click OK to run the document compare as shown below:

X]

Compare Documents

D |

Document; |d:\pw_working\pwonline\mic-admin\dmsEB v|[j

BllPages(1-36  w|of 3 Documents
File[10f1]: CT_CON_FPL 0170-3085 VOID 04-. that were
Page: Bange [1-36
opened

Docurment B

Document: |d:\pw_wDrking\pwnnline\mic-admin'\dmsBS le]

|AII Pages [1-35) v | of 36

M anual Aligrment;

Select Window l[ Pick Points l

Summary Fepart:

Other Ophions:
Split-gcreen view [spnchronize) [ Tum on Dimmer

Comparizon type: | Printed Dacuments (zame printer]* v | — C I ic k O- K
| advanced.. || AddFies | (| ok [) Cancel |

Figure 398 - document Compare

Overlay Pages

1. Open the Revised document first and then open the original document that you want to
compare from ProjectWise or your computer.

2. Next go to Document>Comparison>0verlay pages as shown below:
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[

New

File

Edit

Form Measure W

“
Studio

Document Markup

® v B

L

%

= %

(2N

< B

kel

{ %

‘ Overlay Pages...

EswEESE

® m B
Select Document>
Comparison> Overlay
Pages

B E we - I s

] H

Figure 399 - Overlay Pages

In the window that pops up you will need to select which pages of each document you
want to overlay. To do this double click on a file, then in the window that pops up type
the pages you want to overlay. The example below shows pages 1-28. Once you select
the pages you want to overlay click OK.

SIALF FRUPLIFE 1 NUD, FI-NEL

Overlay Pages...

==l

Lo To set which pages

Document Color Layer Pages

o | f<Gdendum No. 3pdf B Addendum No. 3 1;W/ to Overlay double
Addendum No. 4.pdf (] Addendum Mo. 4 10of 28 = =

T click on a file

Figure 400 - Overlay Pages
Add Layer [=]
Layer
Source:  Addendum Mo. 3.pdf - D [

@es 1-28

T

-of@*_

Layer: @ Create New:

Appearance [Base Layer]
Caolor: E]
Background:
COpacity:
Blend:

100 %
MNomal {none)

L=
IALY

1.00

Absolute

Inches

IRLY

") Use Source Layers

Addendum No. 3 -

L ] [l
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Appendix C - Using the Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Opening the Set File
Double click on the set file from ProjectWise and open as shown below: This may take a while
please be patient. Note: The first time opening a set file will take longer than any subsequent
times.

Deseription Main Categary |~ Sub Category Sub Category Description Application File Updated
coM NS d 5[23/2013 11,0212 AW §/2¢
oM FRL Acrobat PDF 5[2220135:24:27 BN 520
oM FRL lans_04 - (Adv) Acrobat PDF 5[22/20135:10:41 PN 520
con FRL Plans_0¢ - Final lans (ad) Acrcbat POF Sl22/2013 23909 PH 520
oM FRL Plans_0¢ - Final Plans (Adv) Acrobat POF 5/22j20132:37:03PM - 5j2(
# Blos-supporting becs con FRL Plans_04 - Final lans (Ad) Acrobat FOF 5/21/2013 112901 AM 520
# Bl 0z-revisions com FRL Plans_0+ - Final Plans (Adv) ‘Acrobat POF S{20/2013 1:01:14PM S
7 Bl os-uchitectural com FRL Flans_04 - Final Plans (Adv) Acrobat POF 5{20/2013 1:00:16PM /20
/B 10-Enwironmentsl Environmental com FRL Flans_04 - Final Plans (Adv) Acrobat POF S{20{2013 12:58:47 PR S{2(

Plans_04 - Final Plans (Adv) Acrobat POF 5/20/2013 12:58:46 P 520

= e 58146 PM 520
T Open d i 158140 PM 520
P S747PM 520
i | et Double click on STO1PM 52
e ( the set file and

ame Description . Ene
(&% Bluebeam Revu Set beam Rewvt. CI ICk o K vare\Bluebeam RevulRevuifevuexe'"...  No

<

Dacument Propties | Project Propertes

Praperty name
\ g
Name:
Folder Name:
Envirorment:
Fie Name
Warkiiow <)

Created By
Updated By frowz
File Updated By

Status (] open document a5 read-only

persien Click here for 3 st of sunqested document: viswers

Local File Revision

LocalFe Oneton ) o ]
Shareable:

Figure 402 - Opening a Set File

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screenin a
thumbnail view. To view a sheet, simply click on that sheet and it will open up.

® Rw Fie  Eat B L eyl Maesue ow  Help

TR EE-omae O < § % Rk

Open Frint E-mall

B wEES®E-SE e
al F kR wm® R
BT

|CT_CON_FPL 00010001 01-General pdf 8 Co N N ECTIC UT [

M 45 5 4 CHUSETTS

DISTRICT 1 BISTRICT 2
- - e s

Click on a thumbnail
_and the sheet will
-open on the right

; J’{ml:‘ 3 hitie

STATE OF CONNECTICUT

NOTES:
FRONCT NG,
108 e

Figure 403 - Viewing a Plan Sheet from a Set File
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Marking Up a Set File
1. Open up the set file. You will notice on the left hand side of the screen will be
thumbnails of all the sheets in the set file.

iR

- . - -
(= - ﬂ [
Print E-mai abs Rulers Interface

@ CT_CON_ADP_0102-0278_01-04_TYP_AD2

SNALE THEATMENT MLESS OTMERVISE SHECIFIED In-
THP-£.TAP=1. (SEE WISCELLANEOUS OETAIL S<EETS
FOR SWALE DETATLS |

sex ceTatL B

All the sheets in the project
will be shown in the thumbnail
view -

SWALE TREATMENT UNLESS OTWERNISE SPECHFIED T
TIPS, TTR-T, GIDE MISCELLAMEONS DETALL SHEETE
FOR SWALE DETAILE)

WOTES DEFTH OF MOCESSED WGOREGATE SBRASE Sl BE
EWCREASED TO Aniee 4T THE FOLLOVING LOZATIONS: 15eem -5 (Goem W
206em FROCESSED AMSEGATE BASE

LiF

ARTES - ok 50375 1500w MAKTIM LIFT)
- TN LIFT)

[ e e —]
5
gz

Ll sooe ® 3 o
P59
[
s R
Py
H EE
*E ii ;
Pd L
i 3
kS
WBRESHISESDE
it
B s
N
i
EE

i T omecn
2478 T0 2e820 UIKIMM CRUSS SLORE 4% OR 45 SHOWW ON CRDSS. SECTIONS 20 nimpacE pusnsity
24408 T0 3020 VETAL BEAN RALL (SEE FLANS POR LINATS) 2 PRDIESSED MGGREC 1
34308 10 300 1500 GTTIMINLS CHERETE LIP UMD IR CEr5S SLOPE 1.5 08 A5 o O oG FODT B
12 W CINCRETE LRI Choss SECTIONS . et
248 T0 24T 1380 CONCIETE. S10ENALK 2t b 52375 > "
34308 10 3eaze i RGN H - -
[ s et - -
[ STATE OF CONNECTICUT
o MY TO BEALE i i JEPARTMENT OF TRANSPORTATION -

Figure 404 - Sheets in the Set File
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.
You will notice that sheet opens up on the right:

@ CT_CON_ADP_0102-0278_01-04_TYP_A02 >

Scroll down to the
sheet that is to be
marked up and click

on it. You will notice it — - o
opens up on the right. S %4 -

=i
-5
-
=i
-4
-
-3
-
-
~if

[P —— - \_@ E g/s. s>/
_ TIPS urTe (SEE VESELNEDA BT SHETS v Ttz B
P SR BETARLS ) o §
o pE Las synsone i
WL SEETION ST 5|
STh, 2+560 10 2e101 sta, 23 1
et

® rom - w508 imceo e
g
0m - W 54 (BLAEE Du T . LIFTE)
By —
T8 e ) . 1 omen
ks 10 2se20 o
petide] & i s 2 o s e
Si3m 1 doene o e
it e s M
Tt 10 1m0 fosagh < Y i
ety i - oo
perdiged o .
i
T T - . S — :
= — & STATE OF CONNECTICUT = .
— s [ DEPARTMENT OF TRANSPORTATION -
N — — . EPARTMENT OF T TATH "
Pt = (e L
] i | | e A
| = =

|V Fiter §

Figure 405 - Marking Up a Sheet
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3. Next to markup the document we must unlock it (Check Out of ProjectWise). To do this,
right click on the lock and select Check Out.

- = - ot -
=| 7, E
[ 7y L P P B M M 9 1
i
L
@ DEPAR’
,-|LocrnoN oF
T
ENDHG OF STATE
FROECT MO, 02-278
185 STA 4300

Right click on the lock _
and select Check Qut ———

01.01.001

AOIE

Figure 406 - Checking Out a Document

4. Notice the lock changes to a Check and you will be able to markup the document.

New Open

Save . -ma Studio

B wEEom - SEeVER:

" i £ B W CT_CON_ADP_0102-0278_01-04_TYP_A02 =

UMLESS OTWERYISE SPECIFIED 1N
WP-7. | SEE WISCELLANEOUS. DETAIL SSEETS
AL

SEE DETAIL B
ST TrR-1z

[
STA. 24520 TO 2+660

Figure 407 - Checking Out a Document for Editing

5. To mark up the plans use the tools located in the tool chest shown below:
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NS EE a P LA

Click on the . TREATMENT UNLESS 0

S TYP-T.
tool chest WALE DETAILS)

B )

Subject ~ |Comment

L R ey Markup the plans using - [ComtcionSsted s Conctucion St

STA. 2+420 TO 2+653 the CTDOT As Built Tools \ . - T sheet
“o | As-Buit Stamps This sheet comected

As Built S s Secton
Example\’  sew  Teeosme

PROPOSED 1-91 SB WIDENING

8Pe A Tt Box
a
EXISTING I-95 NB ) & o ez i an
‘ : / Line Use to Cross Out
EXISTING GROUND A
3g6m _  356m _,  366m _  360m _, _3.60m 4 ==
LANE LANE LANE LANE SHLDR
1 1 1 1 °
e Q[
-
P K |Group Cross Out
-
VARIES veries| vaRIES | 2.00% A @ Cloud

SWALE TREATMENT UNLESS OTHERWISE SPEC
TYP-6+TYP-7. (SEE MISCELLANEOUS DETAI

®_/®/EE DETAIL A

ON SHT TYP-12

o]
i

Figure 408 - Marking up the Plan Sheets

6. When finished, click Save and then right click on the Check and select “Check In”.

S -

Print E-mail

Then right click on
the check and select
Check In

& I-95
TING I-95 SB EXISTING I-95 NB
A 1.80m A
366m . 366m MED. 366m . 366m . 366
LANE LANE LANE LANE LA
1 1 3.20m 3.20m 1 t T
&L

Figure 409 - Saving Markups and Checking Into ProjectWise
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Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows
how to search a set file:
1. Click on the Search Set file icon and then type in what you want to search for as shown

below:

5L

Click on the
search set file
icon

‘ Current Set

Search Pages

[] Search File Propetties
Search Form Fislds

. | &
Type in what you > e
want to search for &=
Select "Current Set"
[ Search Markups
[] Case Sensitive

01.01.02 [ Whale ‘wWaords Only

Figure 410 - Searching the Set File

Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.
Printing the entire set will print all the sheets in the set file. Printing the latest revisions will
print the most up to date sheets and not print the previous revisions. Printing the previous
revisions will only print the sheets that were changed by a revision.
The following shows how print a set file:

1. Select the print set file icon and select the desired option:
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Q foevu  File Edit Wi Document Farm Markup Measure Window

vik-wB-amag @ < §

Open Save Frint E-mail Studio Security Signatures Fagesz

YL I RITY2 Y% - o I

Select the arrow on the
print icon and select the
desired option

———
01.01.02

Figure 411 - Printing a Set File
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Appendix D - Consultant Submittal Review
Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile
imports all the commenting tools in the correct format.
Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file
located in the zip file and the profile will be imported.
After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

I+ £ -
In the tool chest P

select the Submittal N —
- * LCTDOS - hopAsforking Drawing Beview Tools
stamp and click

— Subject Comment

th e d e I ete ico n ‘ - S ubmittal Contractor Submittal
- Review Stampl
- Highlight
= Highlight
é Text Box |Jze to Add et
& Callout IJze to Add a Callout
IJze to Cloud
@ s Corections
/ Line IJze ta Cross Out

CTDOT &

4k
4r CTDO

Figure 412 - Deleting the Stamp

2. Next Consultant Designers will need to save the following stamps to their computer and
edit it to add their company name and address. The following will show how to do that:

3. This file contains the Designer’s Review stamp and Action Stamp. Save these stamp files
to your computer in a folder somewhere called Bluebeam Stamps. Note: The stamp
files will be a PDF- Consultant Submittal Review Stamp
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4. Open the stamp files using Bluebeam.
5. Update the Company Name and Address on both the Action stamp and the Designer’s

Review stamp as shown below:

Edit the firm
name and
address on both

ACTION STAMP

Mo Exceptions Noted D
Exceptions as Noted |
Revise and Resubmit D
Rejected D

S

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIAMCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM. THE CONTRACTOR REMAINS RESPONSIBLE FOR
DETAILS AND ACCURACY, FOR  CONFIRMING AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.

g Enter Firm Name and nddress)

By: &[User] Date:

DESIGNER'S REVIEW

Reviewed, No Comments I:I
Reviewed With Comments D

hi\sstamp Shall Only be Applied to

Enter Firm Name and Address

By: Date:

Figure 413 - Updating Stamp for Company Name and Address

After the company name and address is updated it should look like the following:

ACTION STAMP

Mo Exceptions Noted (|
Exceptions as Noted (|
Revise and Resubmit D
Rejected D

—_—

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIANCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM. THE CONTRACTOR REMAINS RESPONSIBLE FOR
DETAILS AND ACCURACY, FOR  CONFIRMING AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.,

BL Companies 150 Trumbull St. Hartford CT 06103

By: &[User] Date:

DESIGNER'S REVIEW

Reviewed, No Comments D
Reviewed With Comments :l

This Stamp Shall Only be Applied to
Working Drawings

BL Companies 150 Trumbull St. Hartford CT 06103

&[User]
By: Date:
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6. After the stamps have been updated click save.

7. Next go to Markup>Stamp> and Select Change Stamp Folder.

cument Farm Markup Measure Window

E‘ﬁ'd _

Fint E-mail Studio . o
Consultant_subrmittal

1_11 - Environmel | =i

Click on Markup
ol then Stamp
then change stamp folder

159-0181_11 - E...

ittal_Review. pdf

| IT=ENVIEKURMENTAL
Figure 415 - Changing the Stamp Folder

8. Browse out to where the stamps had been saved and click OK:

Browse out to the
folder where the
[a Deskbop .
=Qmoemens  Stamp is located
G e @nd click OK
2 Recydle Bin
AdobeCA

Mew Folder

H
&

||||||||||

15 old watermarks
IC3) POF Farms
1) Revisions Forms

1) schoal
[#-IC3) STC FORMS

MMake Mew Folder ] ' Cancel

Figure 416 - Browsing to the Stamp

9. Now when you click on Markup>Stamp the stamps will be in the list.
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10. Next go into the tool chest and open the “Recent tools” as shown below:

Sattings

X, Bluebeam Studio Frojects - "'

v o /9
[« | .

| & I
1) My Tools
Recent Tools
Sequenc
Curves

Shapes

Ll LU s o 1o

A4 CTDOT Mizcelaneou

Figure 417 - Bluebeam Recent Tools
11. Now place the stamps on any PDF document by selecting it in Markup>Stamp as shown
below:

Markup Measure

ot

Image Hyperlink Altachment ==ty ;
|“I consultant_submitkal

- RN 2 (.0 .

wmiAw, 7S

. .' |ﬂ consultant_subitta
sl Markup Stamp oo st
and then select
the stamp Chenge Stamp Falder...

Figure 418 - Placing a Stamp in Bluebeam
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12. After the stamps have been placed you will see them in the recent tools. Drag them
from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown
below:

In the tool
chest drag the
recently placed

stamp and drop T i
it into this tool o Comment
bar — |submital

Highlight

Highlight
Text Box IJze to Add text

Callout ze to Add a Callout

|Jze to Cloud

Cloud Comections

Line IJze to Cross Out

4» CTDOT AsB
L
4» CTDOT

Figure 419 - Adding the Custom Stamp to the Tool Chest

13. Then Save Profile so the stamps will always be in the Tool Chest.

Q (Gvs  File Edit Wiew Document Markup Measure Window Help

vhow@ om q = )

Mty Open Save Frint E-mzil Studio Tabs Tawlbars — .
Construction

i‘ i w s E ';' , 5 . " C TDOT Bluebeam User
Al L aEEl GO to View, Financial In
all_Rell ) then click on the

Recents

Supplementary Progr a rrow a n d t h e n F, I'||:|';
iviigins save profile S

Tealet

Fuil Screen

Save Profile

EEEEGEIE-GS

Figure 420 - Saving Bluebeam Profile
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Appendix E - COMPASS Resources

A. COMPASS Training Resources

The following resources are available for users to enhance their knowledge of MS Project
Online, SharePoint and other Office 365 products.

COMPASS Knowledge Center: Website with Support resources and program updates.

MS Project Online: https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-

4bca-ac9c-202a183a1656#IDOEAABAAA=Projects

B. COMPASS Data Sources and Computations

The following table identifies the data source and / or computation of each item listed below.

ITEM DATA SOURCE(S) COMPUTATION(S)
Town data Project Asset Form —
“Location Towns”
Project Description CORE — “Project
Description”
Project Title CORE — “Project Title”
Tasks Count MS Project Schedule —
total number of tasks
Project Health Average of Project Schedule and
Budget scores
ROW Expenditures ViewPort
g Construction Expenditures | ViewPort, Site Manager
E PE Expenditures ViewPort
& | ROW Estimated Budget ViewPort
= | Construction Estimate ViewPort
a Budget
PE Estimated Budget Obligation Plan
Schedule Phase RPM date, Design Approval date,
FDP date, CCD date
Schedule Milestones MS Project Schedule
Permits ESTP
ROW and Acquisitions Data | IRMS
Overall Projects Score Rounded average of all project
health scores
>9 = Green / Good
[a) 7-8.9 = Yellow / At Risk
5,:‘ <7 =Red/ Poor
% Projects Health Average of all Project Schedule
e and Budget scores
(=) > 89% = Green / Good
> 70-89% = Yellow / At Risk
5 < 70% = Red / Poor
E Budgets Sum of outstanding projects
[ >95% = Red / Poor
80-95% = Yellow / At Risk
<79% = Green / Good
Schedule Average of all past due project
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ITEM DATA SOURCE(S) COMPUTATION(S)

milestones
> 89% = Green / Good
70-89% = Yellow / At Risk
< 70% = Red / Poor

C. COMPASS Best Practices

Business Processes

All project staff — including project managers, reviewers, designers, consultants, contractors, etc.
— should monitor their COMPASS accounts daily to assess Ball-In-Court statuses and ensure
there is no lag in reviewing and routing submittals.

Naming Conventions

File names should not exceed 50 characters in length. Characters include letters, numbers,
symbols and spaces. Submittal and file names should not contain any of the following restricted

characters:

~H%&*:<>?2/\{]}
Submittal names should accurately describe the contents of the submittal.
Individual file document names should be in the following format:

Project Number [###H-####] Submittal Type [WD, SD, RFI ###, RFC #i##, etc.] [Description]
Examples:
1234-5678 WD Access Platform
1234-5678 SD Exodermic Precast Panel
1234-5678 RFI 001 Structural Steel
1234-5678 Letter from Smith to Jones Winter Work

Revising Working Drawings & Shop Drawings

If the submittal owner returns a shop drawing submittal with different dispositions stamped on
each sheet, the Submitter / Contractor shall revise individual sheets as needed. When the
replacement document is ready to submit, the Submitter / Contractor shall combine into one
file the approved sheets and replacement sheets.

Revise and Resubmit Comments

When an submittal owner returns a submittal via the Revise and Resubmit function, comments
should be included to focus and guide the revision process. For example, if a submittal contains
three documents, two of which are accepted and one of which requires revision, the following
details would be appropriate to provide in the pop-up comment box:

Submittal reviewed.

Two of three documents accepted.

One document to revise and resubmit.
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D. COMPASS Frequently Asked Questions

Computer Requirements

Devices

COMPASS can be accessed through a desktop computer, laptop computer, tablet or mobile
phone. The device must have internet access. For details on ensuring access to the COMPASS
website, see Trusted Sites.

Software Requirements

COMPASS is a cloud-based application built on Microsoft SharePoint pages. The following
software and account requirements are necessary for CTDOT and Consultant users to
experience full functionality of the COMPASS S&T application, including reviewing and routing
Contractor submittals:

e Office 365 / Microsoft online account

e Project-specific access to COMPASS

e Bluebeam Studio account (Site Owners and Submittal Owners only)

e Bluebeam desktop application

Maximum File Size

SharePoint has a maximum file size of 250 MB. This applies to individual file attachments and
documents uploaded directly into the Internal Documents or Documents folders. If a document
exceeds this maximum, the user can break it up into multiple documents contained within the
same submittal.

E. COMPASS Troubleshooting

COMPASS Access Troubleshooting Tips

Below is a list of troubleshooting tips for users to implement if problems are encountered when
trying to access COMPASS:
e Confirm the user has the proper permissions to access the project.

e Confirm the correct log-in name and password are used.

e Confirm all Trusted Sites are added.

e Completely sign out of Office 365 and COMPASS, then log back in.

e Press CTRL+F5 to perform a hard refresh on the page.

o Delete the browser history and cache.

e Verify with local IT support that there are no firewalls, securities or other issues that
would interfere with connecting to COMPASS.

e Attempt access using more than one web browser.

Reset 0365 Password

Problem: | need to reset my Office 365 sign in password.
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Be Microsoft

Enter password

Your account or password is incorrect. If you aont

Figure 421 - Reset Password

Solution: CTDOT users cannot reset their passwords via the “reset it now” default prompt that
comes with 0365. See Office 365 Login Instructions for sign in name and password information.

Missing Office 365 Apps

Problem: When I sign in to Office 365, | do not have any apps.
Office 365 o & 7

New to Office 3657
This is your Office 365 home page—where you can see and access all of

your Office 365 apps. If it's empty, it could be that your user license was
very recently assigned to you. Wait 10 minutes and refresh this page. If you
still don't see any apps, contact your IT department. They can help you get
up and running.

Good morning Install Office

>

Add-In All apps

Figure 422 - 0365 Apps

Solution: Ensure the correct Office 365 Sign In credentials are inputted to access all the
applications available with the CTDOT 0365 license.

Loading Projects

Problem: When | log-in to COMPASS, all | see is the COMPASS header and a spinning wheel that
says “Loading Projects.”
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L]
[

Loading Projects...

Figure 423 - Loading Projects
Solution: Add COMPASS Trusted Sites to Internet Explorer web browser.

MS Project Button Does Not Work
Problem: When | press the MS Project button in my COMPASS project, nothing happens.

o D o

Figure 424 - MS Project does not Work

Solution: If the MS Project button does not open a schedule,
1. Confirm with the PM that an MS Project schedule is attached to the COMPASS project

site. See Open MS Project from COMPASS PWA Site for instructions.
2. Confirm that the user trying to access the schedule has an MS Project Online license.

Contact Chris Smith in AEC Applications with any MS Project questions.

Bluebeam Studio Sessions

Bluebeam Studio Session Finalization Process

In order to maintain the Bluebeam integration with COMPASS, Studio Sessions should only be
finalized via COMPASS as shown below and described in the Finalize Bluebeam Studio Session
section. Bluebeam Studio Sessions should not be finalized directly inside the Bluebeam Studio

Session.
Y E S .
(]
Item Number.- not required Date Submitted Submitted By Date Completed
0101000 - ENVIRONMENTAL HEALTH AND SAFETY, 0202447 - COLD MILLING REMOVAL OF BITUMINOUS Gur | 04-03-2013 EEn D MA
{- Add Item Number
Mark if this is Urgent
Submittal Type Urgent
Shop Drawing - Highways
DOCUMENTI(S)

@ S D [f Finalize Bluebeam Studio Session ]

Attach File(s):

E Drag files to upload, or click to select files
1 manually.

Figure 425 - Closing a Studio Session
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NO:

Studio |
0310-0059 external test - 769-930-953 ~

My Status:

~  Attendees

¢} Smithcd

~ Documents

external test.pdf

Notifications

Figure 426 - Closing a Studio Session

Bluebeam Studio Session Expiration Date

B B m

Finish Session

!

Pending

A Bluebeam Studio Session created through COMPASS is set to expire by default one month
after its creation. If additional time is needed a user can either finalize the Session and launch a
new one within COMPASS or extend the Session’s expiration date.

To extend the Session’s expiration date:

Studio ~ H
2) C | I C k here 0310-0059 external test - 769-930-953 ~
to expand [ settings
v Attendees
3) Click to open { smithed
Settings

« Documents

@ external test. pdf

Recornd Natifications
' [2) Smithed: Added’
2 € Smithed: Joined Sa
¢ ) Smithed: Le
& {’ Smithed: Joined Session
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General | Atendees I Pemissions

Session Name:  0310-0059 extemal test

Session |D: 769-930-953

Disable expiration
by unchecking here

Total Users: 1
Total Files: 1
Total Space: 82.11 KB
- 4872019 21828 FM

Studio v2

Expiration:  [¥] Enabled May 08,2019 [+ Z18FM |2

Manage Motffications

Modify expiration
date here
Click OK to

accept changes

Figure 427 - Studio Session Settings

Restoring Archived Bluebeam Studio Session

Only the user who started a Bluebeam Studio Session can restore the Session if it becomes
archived. The below information is only applicable within 30 days of a Session being archived.
Bluebeam fully purges Studio Sessions from its server that have been closed in excess of 30

days.
1) Hover of the document link in COMPASS to identify the Bluebeam Studio Session ID.

2) Locate §

{R) COMPASS

Figure 428 - Restoring a Studio Session

2) Navigate to https://studio.bluebeam.com and enter the Session host’s log-in
credentials.
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P ¥ Blucbeamsude x _

&« C ﬂ‘ @ https://studio.bluebeam.com

4 DOoTsL

EDMaps.. [] Core Intranet Applica

neering Inform... Imported From IE

Bluebeam Studio

Sign In

Figure 429 - Studio Log In

3) Locate and click on the archived Studio Session.

Name Permission 2 Last Connected (GMT) Status
Finished Session

. 4/2018 3:48:44 P11 Deisted
055 Testing bridge cho ...

Deleted
Deloted

3-0468 Testing CC in Dev 2
5 extermal test

4/8/2019 6:18:28 P 19 7:05:19 M
4752019 6:57:33 P 6/2019 1:54:05 PM
4412019 7:26:19 PM /2019 7:26:19 PM
/472019 4:53:38 PM

Restricted
Restricted
open

0310-0059 Traffic project

Figure 430 - Restoring a Studio Session

4) Change the status to Active, then Update data.
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Sesson Name 310-0059 Traffic project data

Public 1D 491-546-995
Restncted
Status De'eted

Netbcaton sne 1) Click to expand
.

Update data Deleted

2) Select "Active"
3) Click here

Figure 431 - Restoring a Studio Session

Now the Session can be finalized inside COMPASS and the document in COMPASS will reflect
any changes made in the Session.

Bluebeam / Internet Explorer Integration

Edits not saving in COMPASS

Q: | set-up the integration, but changes are not being saved.
A: Manually map the SharePoint interface. Open Preferences with CTRL+K.

Preferences

General Flie Access Markups List
Interface
20
Tools
s Show peeview of PDF

Recent history Emit 90 Days Clear

om toolbar onty

Import/Export

Advanced SharePoint Opt)

DMS Type Location

SharePoint hitps.//cigovdot sharepoint.com

SharePoint hitps jfcigovdot sharepoint.com

SharePoint https ovoot sharepoint.com

SharePoint https//cigovdot shasepoint.com
hitps:/fcigovdot sharepoint com

https ovdot sharepoint.com

SharePoint https ovdot shasepoint com

$

Cancel

Figure 432 - Bluebeam Integration
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Select add your project
SharePoint number in "XXXX-
Add Document Mandgognt System XXXX" format

Type:  SharePoint

Site: hitps://ctgovdot sharepoint.com/projects/ U p tO U Se r
Site Display Name:

Default Library: LeaVe blank

Login Name: smithcd@dot.ct.gov O 36 5
Password: eesessesssssese Credentials

| Checkout on Open

Checkout on Open from Hyperlinks

Figure 433 - Bluebeam Integration

PDF Documents Not Opening in Bluebeam

Q: | set-up the integration and am using Internet Explorer, but PDFs in SharePoint are still
opening in the browser instead of Bluebeam.
A: Disable the Adobe Internet Explorer plug-in.

Print ’

File >
Zoom (100%) >
Safety

Open with Microsoft Edge Ctrl+Shift+E

Add site to Apps

View downloads Ctri+)

Manage add-ons

F12 Developer Tools
Go to pinned sites
Compatibility View settings

Internet options

About Internet Explorer

Figure 434 - PDF Documents
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Manage Add-ons E3

View and manage your Internet Explorer add-ons

Name Publisher Status Architecture A
Adobe S)".tcm'., Incorporated
Adobe Acrobat Create PDF Toolbar Adobe Systems, Incorporat..  Enabled 32-bit and 64-bit
Adobe Acrobat Create POF Helper  Adcobe Systems, Incorporat...  Enabled 32-bit and 64-bat
Adobe Acrobat Create POF from S...  Adobe Systems, Incorporat...  Enabled 32-bit and 64-bit
© Tracking Protection Adobe PDF Reader Adobe Systems, Incorporat... Ensbled  32-bit
Apple Inc,
QuickTime Object Apple Inc. Enabled 32-bit
i Behavior Object Apple Inc, Enabled 32-bit 9
; >
Adobe PDF Reader
Adobe Systems, Incorporated
Version 15.8.20082.147029 Type ActiveX Control
File date Thursday, July 2, 2015, 10:09 PM Search for this add-on via defauit search provider

More information

Disstle i—
Find more toolbars and extensions...

Leam more about toolbars and extensions Close

Figure 435 - PDF Documents

Incorrect Owner

Q: | was incorrectly assigned Owner of a submittal. What should | do?

A: The two most common reasons a submittal is assigned improperly are that the project PM
incorrectly completed the Approval Matrix, or the Submitter / Contractor selected the incorrect
Submittal type in the Document Submittal page. If this occurs, do not Start the review session.
First, check with the PM to ensure the Approval Matrix is properly set-up. If this is confirmed,
press Revise and Resubmit; in the comment pop-up box provide instructions to the Submitter /
Contractor to select the correct Submittal Type in the drop-down menu.

Incorrect Information

Q: Information in COMPASS is incorrect. How do | fix this data?

A: Alert the project PM to the incorrect information. Take screen shots if possible. The
majority of the data found in COMPASS (e.g., finances, schedules, ROW, etc.) is pulled from
source locations such as CORE. The Staff names and Approval Matrix are manually inputted by
the PM. If there are errors in the data, the PM needs to correct manually inputted information
or request a correction in the data source from which COMPASS is pulling information.

Following Project Sites

To follow a COMPASS Submittal / Transmittal Pilot Project Site:
1. Navigate to the Submittal / Transmittal page of the given pilot project.

2. Inthe upper right hand corner of the screen, click Follow.
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SELECT TO FOLLOW AN
S&T PILOT PROJECT SITE

Figure 436 - Follow Projects

3. When accessing the SharePoint Online dashboard, the project site will be listed in the
Following section. Clicking on the project number will route the user directly to the pilot
project S&T page.

F.

Office 365 SharePoint
O Search in SharePaoint
Following
0310-0059 *
0018-0134 *

Figure 437 - Projects that you Follow

Data Dictionary - S & T Table

COLUMN HEADINGS

Column Description

Submittal Submitter / Contractor enters manually in the “Submittal Name” field on
the Document Submittal Page

Sub Type Submitter / Contractor selects from “Submittal Type” drop-down list on
the Document Submittal Page

Item No. Optional. Submitter / Contractor selects from “Item Number” project-

specific drop-down list on the Document Submittal Page. One or more
items can be selected.

Review Status

Updates automatically. Identifies status of the submittal in the
workflow. Does not provide the Department’s disposition on the
submittal or the documents contained therein.

Ball In Court

Updates automatically. ldentifies the person(s) responsible for taking
the next action in the workflow.

Submittal Date

Auto-populates when the Submittal is first initiated.

Final Due Date

Owner sets Due Date on the Process Assignment Page

REVIEW STATUS COLUMN

Status

Description

Process Assignment

First status to appear after a new submittal is added. Based on the
Approval Matrix, COMPASS automatically assigns the submittal owner to
set-up the review process and schedule.

In Review (# of #)

Shows that the submittal is in review and identifies number of steps in
the review series. Submittal Owner is the final reviewer by default.

Revise and Resubmit

Alerts Submitter / Contractor to requested revisions. Submitter /
Contractor to review comments and/or marked-up documents.
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Send Back Assigned reviewer declines the Owner’s review request and returns the
submittal back to the Owner.

Complete Review process is complete. Submitter / Contractor to review comments
and/or marked-up documents for the Department’s disposition.

Draft A submittal is saved in draft form. The submittal has not been advanced
in the workflow but is available for the user to edit and process.

G. COMPASS Support

Construction District COMPASS SMEs

District COMPASS Rep. Email Phone

District 1 Sabrina Pace sabrina.pace@ct.gov 860-258-4668
Darlene Salokas darlene.salokas@ct.gov 860-258-4644

District 2 Jim Paul jim.paul@ct.gov 860-823-3269
Matthew Collins matthew.collins@ct.gov 860-823-3275

District 3 Steve Hebert steven.hebert@ct.gov 203-389-3154
Aliaksei Sidarenka aliaksei.sidarenka@ct.gov 203-389-3177

District 4 Shawn Beaulieu shawn.beaulieu@ct.gov 203-232-5786
Jason Cichon jason.cichon@ct.gov 203-591-3575

District 5 Jennifer Sweeney jennifer.sweeney@ct.gov 203-401-5170
Basel Hashem basel.hashem@ct.gov 203-401-5169
Sal Hussein shalal.hussein@ct.gov

00cC Doug Harz douglas.harz@ct.gov 860-594-2681
John Rorrio john.rorrio@ct.gov 860-258-4643

AEC Applications

Name Email Phone

Bruce Bourgoin
John Dudzinski
Julie Annino
Chris Smith
Lynne Lofberg
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Appendix F - Bluebeam 2016 Integration

To set-up the SharePoint / Internet Explorer integration using Bluebeam 2016:
1. From the Start menu, open Bluebeam Administrator 2016.

2. Select the Revu tab

Blucheam Admmistrator .lgl x’

Fie Took Help

Piugins | Net Config | Printer | Logging
Plug into Applications:

(] Microsoft Office - Revu 2015

¥ Microsoft Outiook - Revu 2016
¥ ProjectWise Explorer - Revu 2016 3]
SELECTTHEREVUTAB = Dluebeamr

NO LI

Cheaing this selection will iced the
plugin into Microscht Office 2007 -
2016 - Revu 2010

NOTE: Applications need 1o be restarted for plugin 1o be activaled/deactivated

sy | [ o Cancel |

3. Check the box to Display PDF in Internet Explorer
4. Select Apply

5. Select OK to close the Bluebeam Administrator window
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L0l

Fie 00N M

Plugins | Net Config | Printer | Logging Rew |

Bluebeam Rewu 164 POF icon Color
™ Use as Default POF Viewer B
@ e4. e 2o @ Re
™ Quick Launch
Reset Setings |
Backup Settings
Roshns.lncs
Web Browser Language
%mmmuw«u Language
1. CHECK BOX |Engtish Sl
3. PRESSOK TO
CLOSE WINDOW

2. PRESS APPLY
3’@ C-Tﬁ =

6. After setting up the PDF settings, use Internet Explorer to navigate to the correct
submittal in the Submittals/Transmittals table.

7. Select the preferred PDF submittal document.
8. The PDF will open in an Internet Explorer viewer.

9. Select the Bluebeam Revu button in the menu bar.

€ https:/ /ctgovdot.sharepoint.com/projects /008

SELECT BLUEBEAM
REVU BUTTON

10. A window may display, indicating that Bluebeam Revu is Communicating with
SharePoint (COMPASS pages).
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5

)

;“ Communicating with SharePoint ...

11. A Microsoft sign-in window will appear. Input the same Office 365 / Microsoft Online
Sign-In information used to access COMPASS.

2= Microsoft

Sign in

Email pt

12. A window titled SharePoint Open from Web Browser will appear. Select the Check Out
& Open button.

x|
Biviso i SELECT CHECK OUT & OPEN
Name: DISTRICT 3 TEST DOCUMENT Parallel review pdf,
From: https://ctgovdot sharepoint.com/projects/0083-0264

13. The document will open in Bluebeam Revu. The user can then edit, mark-up, scrub or
digitally sign the document as needed. Previous versions of the document are preserved
by COMPASS’s Version Control feature.

14. When complete, press save.

15. Close the document by closing the individual Bluebeam tab or closing the entire
Bluebeam program.

16. A window titled Close SharePoint Document will appear. Note: Comments inputted in
this window will not be provided to the Submitter / Contractor. Comments intended for
the Submitter / Contractor must be added to the PDF document itself or inputted in the
COMPASS Comment Pop-Up Windows.
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17. Select the Check In button to save any changes. Press Release Checkout if no changes
are made.

Close SharePoint Document 3 x|

Document Path: |https://ctgovdot sharepoint com/projects/0083-0264/Intemal D
Checkin Comments (optional): PRESS RELEASE

| PRESS CHECK IN CHECKOUT IF NO
— 10 Sisvg CH%NGES CHANGES ARE MADE

. 4 I
Check In LbdaeSetv«Copy Cancel |

18. A new version saves in COMPASS. The previous version(s) are preserved through
COMPASS’s Version Control feature.
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